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Introduction

The [image: OpenModelica logotype] [https://openmodelica.org] system described in this document has both short-term
and long-term goals:


	The short-term goal is to develop an efficient interactive
computational environment for the Modelica language, as well as a
rather complete implementation of the language. It turns out that
with support of appropriate tools and libraries, Modelica is very
well suited as a computational language for development and
execution of both low level and high level numerical algorithms,
e.g. for control system design, solving nonlinear equation
systems, or to develop optimization algorithms that are applied
to complex applications.


	The long-term goal is to have a complete reference implementation
of the Modelica language, including simulation of equation based
models and additional facilities in the programming environment,
as well as convenient facilities for research and experimentation
in language design or other research activities. However, our
goal is not to reach the level of performance and quality
provided by current commercial Modelica environments that can
handle large models requiring advanced analysis and optimization
by the Modelica compiler.




The long-term research related goals and issues of the OpenModelica
open source implementation of a Modelica environment include but are not
limited to the following:


	Development of a complete formal specification of Modelica,
including both static and dynamic semantics. Such a specification
can be used to assist current and future Modelica implementers by
providing a semantic reference, as a kind of reference
implementation.


	Language design, e.g. to further extend the scope of the
language, e.g. for use in diagnosis, structural analysis, system
identification, etc., as well as modeling problems that require
extensions such as partial differential equations, enlarged scope
for discrete modeling and simulation, etc.


	Language design to improve abstract properties such as
expressiveness, orthogonality, declarativity, reuse,
configurability, architectural properties, etc.


	Improved implementation techniques, e.g. to enhance the performance
of compiled Modelica code by generating code for parallel
hardware.


	Improved debugging support for equation based languages such as
Modelica, to make them even easier to use.


	Easy-to-use specialized high-level (graphical) user interfaces
for certain application domains.


	Visualization and animation techniques for interpretation and
presentation of results.


	Application usage and model library development by researchers in
various application areas.




The OpenModelica environment provides a test bench for language design
ideas that, if successful, can be submitted to the Modelica Association
for consideration regarding possible inclusion in the official Modelica
standard.

The current version of the OpenModelica environment allows most of the
expression, algorithm, and function parts of Modelica to be executed
interactively, as well as equation models and Modelica functions to be
compiled into efficient C code. The generated C code is combined with a
library of utility functions, a run-time library, and a numerical DAE
solver.


System Overview

The OpenModelica environment consists of several interconnected
subsystems, as depicted in Figure 1.


[image: _images/systemoverview.svg]Figure 1 The architecture of the OpenModelica environment.
Arrows denote data and control flow.
The interactive session handler receives commands and shows results from evaluating commands and expressions that are translated and executed.
Several subsystems provide different forms of browsing and textual editing of Modelica code.
The debugger currently provides debugging of an extended algorithmic subset of Modelica.



The following subsystems are currently integrated in the OpenModelica
environment:


	An interactive session handler, that parses and interprets commands
and Modelica expressions for evaluation, simulation, plotting,
etc. The session handler also contains simple history facilities,
and completion of file names and certain identifiers in commands.


	A Modelica compiler subsystem, translating Modelica to C code, with
a symbol table containing definitions of classes, functions, and
variables. Such definitions can be predefined, user-defined, or
obtained from libraries. The compiler also includes a Modelica
interpreter for interactive usage and constant expression
evaluation. The subsystem also includes facilities for building
simulation executables linked with selected numerical ODE or DAE
solvers.


	An execution and run-time module. This module currently executes
compiled binary code from translated expressions and functions,
as well as simulation code from equation based models, linked
with numerical solvers. In the near future event handling
facilities will be included for the discrete and hybrid parts of
the Modelica language.


	Eclipse plugin editor/browser. The Eclipse plugin called MDT
(Modelica Development Tooling) provides file and class hierarchy
browsing and text editing capabilities, rather analogous to
previously described Emacs editor/browser. Some syntax
highlighting facilities are also included. The Eclipse framework
has the advantage of making it easier to add future extensions
such as refactoring and cross referencing support.


	OMNotebook DrModelica model editor. This subsystem provides a
lightweight notebook editor, compared to the more advanced
Mathematica notebooks available in MathModelica. This basic
functionality still allows essentially the whole DrModelica
tutorial to be handled. Hierarchical text documents with chapters
and sections can be represented and edited, including basic
formatting. Cells can contain ordinary text or Modelica models
and expressions, which can be evaluated and simulated. However,
no mathematical typesetting facilities are yet available in the
cells of this notebook editor.


	Graphical model editor/browser OMEdit. This is a graphical
connection editor, for component based model design by connecting
instances of Modelica classes, and browsing Modelica model
libraries for reading and picking component models. The graphical
model editor also includes a textual editor for editing model
class definitions, and a window for interactive Modelica command
evaluation.


	Optimization subsystem OMOptim. This is an optimization subsystem
for OpenModelica, currently for design optimization choosing an
optimal set of design parameters for a model. The current version
has a graphical user interface, provides genetic optimization
algorithms and Pareto front optimization, works integrated with
the simulators and automatically accesses variables and design
parameters from the Modelica model.


	Dynamic Optimization subsystem. This is dynamic optimization using
collocation methods, for Modelica models extended with
optimization specifications with goal functions and additional
constraints. This subsystem is integrated with in the
OpenModelica compiler.


	Modelica equation model debugger. The equation model debugger shows
the location of an error in the model equation source code. It
keeps track of the symbolic transformations done by the compiler
on the way from equations to low-level generated C code, and also
explains which transformations have been done.


	Modelica algorithmic code debugger. The algorithmic code Modelica
debugger provides debugging for an extended algorithmic subset of
Modelica, excluding equation-based models and some other
features, but including some meta-programming and model
transformation extensions to Modelica. This is a conventional
full-feature debugger, using Eclipse for displaying the source
code during stepping, setting breakpoints, etc. Various
back-trace and inspection commands are available. The debugger
also includes a data-view browser for browsing hierarchical data
such as tree- or list structures in extended Modelica.







Interactive Session with Examples

The following is an interactive session using the interactive session
handler in the OpenModelica environment, called OMShell – the
OpenModelica Shell). Most of these examples are also available in the
OMNotebook with DrModelica and DrControl UsersGuideExamples.onb as well as the testmodels in:

>>> getInstallationDirectoryPath() + "/share/doc/omc/testmodels/"
"«OPENMODELICAHOME»/share/doc/omc/testmodels/"





The following commands were run using OpenModelica version:

>>> getVersion()
"OMCompiler v1.14.0-dev.beta2.11+gc12c3df1ee"






Starting the Interactive Session

The Windows version which at installation is made available in the start
menu as OpenModelica->OpenModelica Shell which responds with an
interaction window:

We enter an assignment of a vector expression, created by the range
construction expression 1:12, to be stored in the variable x. The value
of the expression is returned.

>>> x := 1:12
{1,2,3,4,5,6,7,8,9,10,11,12}








Using the Interactive Mode

When running OMC in interactive mode (for instance using OMShell) one
can make load classes and execute commands.
Here we give a few example sessions.


Example Session 1

To get help on using OMShell and OpenModelica, type "help()" and press
enter.

>>> model A Integer t = 1.5; end A; //The type is Integer but 1.5 is of Real Type
{A}
>>> instantiateModel(A)
""
"[<interactive>:1:9-1:23:writable] Error: Type mismatch in binding t = 1.5, expected subtype of Integer, got type Real.
Error: Error occurred while flattening model A
"








Example Session 2

To get help on using OMShell and OpenModelica, type "help()" and press
enter.

model C
  Integer a;
  Real b;
equation
  der(a) = b;
  der(b) = 12.0;
end C;





>>> instantiateModel(C)
""






Error

[<interactive>:5:3-5:13:writable] Error: Argument 'a' to der has illegal type Integer, must be a subtype of Real.

Error: Error occurred while flattening model C










Trying the Bubblesort Function

Load the function bubblesort, either by using the pull-down menu
File->Load Model, or by explicitly giving the command:

>>> loadFile(getInstallationDirectoryPath() + "/share/doc/omc/testmodels/bubblesort.mo")
true





The function bubblesort is called below to sort the vector x in
descending order. The sorted result is returned together with its type.
Note that the result vector is of type Real[:], instantiated as
Real[12], since this is the declared type of the function result. The
input Integer vector was automatically converted to a Real vector
according to the Modelica type coercion rules. The function is
automatically compiled when called if this has not been done before.

>>> bubblesort(x)
{12.0,11.0,10.0,9.0,8.0,7.0,6.0,5.0,4.0,3.0,2.0,1.0}





Another call:

>>> bubblesort({4,6,2,5,8})
{8.0,6.0,5.0,4.0,2.0}








Trying the system and cd Commands

It is also possible to give operating system commands via the system
utility function. A command is provided as a string argument. The
example below shows the system utility applied to the UNIX command cat,
which here outputs the contents of the file bubblesort.mo to the output
stream when running omc from the command-line.

>>> system("cat '"+getInstallationDirectoryPath()+"/share/doc/omc/testmodels/bubblesort.mo' > bubblesort.mo")
0





function bubblesort
  input Real[:] x;
  output Real[size(x,1)] y;
protected
  Real t;
algorithm
  y := x;
  for i in 1:size(x,1) loop
    for j in 1:size(x,1) loop
      if y[i] > y[j] then
        t := y[i];
        y[i] := y[j];
        y[j] := t;
      end if;
    end for;
  end for;
end bubblesort;





Note: The output emitted into stdout by system commands is put into
log-files when running the CORBA-based clients, not into the visible GUI
windows. Thus the text emitted by the above cat command would not be
returned, which is why it is redirected to another file.

A better way to read the content of files would be the readFile command:

>>> readFile("bubblesort.mo")
function bubblesort
  input Real[:] x;
  output Real[size(x,1)] y;
protected
  Real t;
algorithm
  y := x;
  for i in 1:size(x,1) loop
    for j in 1:size(x,1) loop
      if y[i] > y[j] then
        t := y[i];
        y[i] := y[j];
        y[j] := t;
      end if;
    end for;
  end for;
end bubblesort;





The system command only returns a success code (0 = success).

>>> system("dir")
0
>>> system("Non-existing command")
127





Another built-in command is cd, the change current directory command.
The resulting current directory is returned as a string.

>>> dir:=cd()
"«DOCHOME»"
>>> cd("source")
"«DOCHOME»/source"
>>> cd(getInstallationDirectoryPath() + "/share/doc/omc/testmodels/")
"/var/lib/jenkins1/ws/OpenModelica_maintenance_v1.14/build/share/doc/omc/testmodels"
>>> cd(dir)
"«DOCHOME»"








Modelica Library and DCMotor Model

We load a model, here the whole Modelica standard library, which also
can be done through the File->Load Modelica Library menu item:

>>> loadModel(Modelica)
true





We also load a file containing the dcmotor model:

>>> loadFile(getInstallationDirectoryPath() + "/share/doc/omc/testmodels/dcmotor.mo")
true






Warning

Warning: Requested package Modelica of version 3.2.2, but this package was already loaded with version 3.2.3. You might experience problems if these versions are incompatible.





It is simulated:

>>> simulate(dcmotor, startTime=0.0, stopTime=10.0)
record SimulationResult
    resultFile = "«DOCHOME»/dcmotor_res.mat",
    simulationOptions = "startTime = 0.0, stopTime = 10.0, numberOfIntervals = 500, tolerance = 1e-06, method = 'dassl', fileNamePrefix = 'dcmotor', options = '', outputFormat = 'mat', variableFilter = '.*', cflags = '', simflags = ''",
    messages = "LOG_SUCCESS       | info    | The initialization finished successfully without homotopy method.
LOG_SUCCESS       | info    | The simulation finished successfully.
",
    timeFrontend = 0.6592157839999999,
    timeBackend = 0.010331809,
    timeSimCode = 0.002959981,
    timeTemplates = 0.013256745,
    timeCompile = 0.5313305559999999,
    timeSimulation = 0.012039622,
    timeTotal = 1.229287334
end SimulationResult;






Warning

Warning: Requested package Modelica of version 3.2.2, but this package was already loaded with version 3.2.3. You might experience problems if these versions are incompatible.





We list the source code of the model:

>>> list(dcmotor)
model dcmotor
  import Modelica.Electrical.Analog.Basic;
  Basic.Resistor resistor1(R = 10);
  Basic.Inductor inductor1(L = 0.2, i.fixed = true);
  Basic.Ground ground1;
  Modelica.Mechanics.Rotational.Components.Inertia load(J = 1, phi.fixed = true, w.fixed = true);
  Basic.EMF emf1(k = 1.0);
  Modelica.Blocks.Sources.Step step1;
  Modelica.Electrical.Analog.Sources.SignalVoltage signalVoltage1;
equation
  connect(step1.y, signalVoltage1.v);
  connect(signalVoltage1.p, resistor1.p);
  connect(resistor1.n, inductor1.p);
  connect(inductor1.n, emf1.p);
  connect(emf1.flange, load.flange_a);
  connect(signalVoltage1.n, ground1.p);
  connect(ground1.p, emf1.n);
  annotation(
    uses(Modelica(version = "3.2.2")));
end dcmotor;





We test code instantiation of the model to flat code:

>>> instantiateModel(dcmotor)
class dcmotor
  Real resistor1.v(quantity = "ElectricPotential", unit = "V") "Voltage drop of the two pins (= p.v - n.v)";
  Real resistor1.i(quantity = "ElectricCurrent", unit = "A") "Current flowing from pin p to pin n";
  Real resistor1.p.v(quantity = "ElectricPotential", unit = "V") "Potential at the pin";
  Real resistor1.p.i(quantity = "ElectricCurrent", unit = "A") "Current flowing into the pin";
  Real resistor1.n.v(quantity = "ElectricPotential", unit = "V") "Potential at the pin";
  Real resistor1.n.i(quantity = "ElectricCurrent", unit = "A") "Current flowing into the pin";
  parameter Boolean resistor1.useHeatPort = false "=true, if heatPort is enabled";
  parameter Real resistor1.T(quantity = "ThermodynamicTemperature", unit = "K", displayUnit = "degC", min = 0.0, start = 288.15, nominal = 300.0) = resistor1.T_ref "Fixed device temperature if useHeatPort = false";
  Real resistor1.LossPower(quantity = "Power", unit = "W") "Loss power leaving component via heatPort";
  Real resistor1.T_heatPort(quantity = "ThermodynamicTemperature", unit = "K", displayUnit = "degC", min = 0.0, start = 288.15, nominal = 300.0) "Temperature of heatPort";
  parameter Real resistor1.R(quantity = "Resistance", unit = "Ohm", start = 1.0) = 10.0 "Resistance at temperature T_ref";
  parameter Real resistor1.T_ref(quantity = "ThermodynamicTemperature", unit = "K", displayUnit = "degC", min = 0.0, start = 288.15, nominal = 300.0) = 300.15 "Reference temperature";
  parameter Real resistor1.alpha(quantity = "LinearTemperatureCoefficient", unit = "1/K") = 0.0 "Temperature coefficient of resistance (R_actual = R*(1 + alpha*(T_heatPort - T_ref))";
  Real resistor1.R_actual(quantity = "Resistance", unit = "Ohm") "Actual resistance = R*(1 + alpha*(T_heatPort - T_ref))";
  Real inductor1.v(quantity = "ElectricPotential", unit = "V") "Voltage drop of the two pins (= p.v - n.v)";
  Real inductor1.i(quantity = "ElectricCurrent", unit = "A", start = 0.0, fixed = true) "Current flowing from pin p to pin n";
  Real inductor1.p.v(quantity = "ElectricPotential", unit = "V") "Potential at the pin";
  Real inductor1.p.i(quantity = "ElectricCurrent", unit = "A") "Current flowing into the pin";
  Real inductor1.n.v(quantity = "ElectricPotential", unit = "V") "Potential at the pin";
  Real inductor1.n.i(quantity = "ElectricCurrent", unit = "A") "Current flowing into the pin";
  parameter Real inductor1.L(quantity = "Inductance", unit = "H", start = 1.0) = 0.2 "Inductance";
  Real ground1.p.v(quantity = "ElectricPotential", unit = "V") "Potential at the pin";
  Real ground1.p.i(quantity = "ElectricCurrent", unit = "A") "Current flowing into the pin";
  Real load.flange_a.phi(quantity = "Angle", unit = "rad", displayUnit = "deg") "Absolute rotation angle of flange";
  Real load.flange_a.tau(quantity = "Torque", unit = "N.m") "Cut torque in the flange";
  Real load.flange_b.phi(quantity = "Angle", unit = "rad", displayUnit = "deg") "Absolute rotation angle of flange";
  Real load.flange_b.tau(quantity = "Torque", unit = "N.m") "Cut torque in the flange";
  parameter Real load.J(quantity = "MomentOfInertia", unit = "kg.m2", min = 0.0, start = 1.0) = 1.0 "Moment of inertia";
  parameter enumeration(never, avoid, default, prefer, always) load.stateSelect = StateSelect.default "Priority to use phi and w as states";
  Real load.phi(quantity = "Angle", unit = "rad", displayUnit = "deg", fixed = true, stateSelect = StateSelect.default) "Absolute rotation angle of component";
  Real load.w(quantity = "AngularVelocity", unit = "rad/s", fixed = true, stateSelect = StateSelect.default) "Absolute angular velocity of component (= der(phi))";
  Real load.a(quantity = "AngularAcceleration", unit = "rad/s2") "Absolute angular acceleration of component (= der(w))";
  parameter Boolean emf1.useSupport = false "= true, if support flange enabled, otherwise implicitly grounded";
  parameter Real emf1.k(quantity = "ElectricalTorqueConstant", unit = "N.m/A", start = 1.0) = 1.0 "Transformation coefficient";
  Real emf1.v(quantity = "ElectricPotential", unit = "V") "Voltage drop between the two pins";
  Real emf1.i(quantity = "ElectricCurrent", unit = "A") "Current flowing from positive to negative pin";
  Real emf1.phi(quantity = "Angle", unit = "rad", displayUnit = "deg") "Angle of shaft flange with respect to support (= flange.phi - support.phi)";
  Real emf1.w(quantity = "AngularVelocity", unit = "rad/s") "Angular velocity of flange relative to support";
  Real emf1.tau(quantity = "Torque", unit = "N.m") "Torque of flange";
  Real emf1.tauElectrical(quantity = "Torque", unit = "N.m") "Electrical torque";
  Real emf1.p.v(quantity = "ElectricPotential", unit = "V") "Potential at the pin";
  Real emf1.p.i(quantity = "ElectricCurrent", unit = "A") "Current flowing into the pin";
  Real emf1.n.v(quantity = "ElectricPotential", unit = "V") "Potential at the pin";
  Real emf1.n.i(quantity = "ElectricCurrent", unit = "A") "Current flowing into the pin";
  Real emf1.flange.phi(quantity = "Angle", unit = "rad", displayUnit = "deg") "Absolute rotation angle of flange";
  Real emf1.flange.tau(quantity = "Torque", unit = "N.m") "Cut torque in the flange";
  protected Real emf1.internalSupport.tau(quantity = "Torque", unit = "N.m") = -emf1.tau "External support torque (must be computed via torque balance in model where InternalSupport is used; = flange.tau)";
  protected Real emf1.internalSupport.phi(quantity = "Angle", unit = "rad", displayUnit = "deg") "External support angle (= flange.phi)";
  protected Real emf1.internalSupport.flange.phi(quantity = "Angle", unit = "rad", displayUnit = "deg") "Absolute rotation angle of flange";
  protected Real emf1.internalSupport.flange.tau(quantity = "Torque", unit = "N.m") "Cut torque in the flange";
  protected parameter Real emf1.fixed.phi0(quantity = "Angle", unit = "rad", displayUnit = "deg") = 0.0 "Fixed offset angle of housing";
  protected Real emf1.fixed.flange.phi(quantity = "Angle", unit = "rad", displayUnit = "deg") "Absolute rotation angle of flange";
  protected Real emf1.fixed.flange.tau(quantity = "Torque", unit = "N.m") "Cut torque in the flange";
  Real step1.y "Connector of Real output signal";
  parameter Real step1.offset = 0.0 "Offset of output signal y";
  parameter Real step1.startTime(quantity = "Time", unit = "s") = 0.0 "Output y = offset for time < startTime";
  parameter Real step1.height = 1.0 "Height of step";
  Real signalVoltage1.p.v(quantity = "ElectricPotential", unit = "V") "Potential at the pin";
  Real signalVoltage1.p.i(quantity = "ElectricCurrent", unit = "A") "Current flowing into the pin";
  Real signalVoltage1.n.v(quantity = "ElectricPotential", unit = "V") "Potential at the pin";
  Real signalVoltage1.n.i(quantity = "ElectricCurrent", unit = "A") "Current flowing into the pin";
  Real signalVoltage1.v(unit = "V") "Voltage between pin p and n (= p.v - n.v) as input signal";
  Real signalVoltage1.i(quantity = "ElectricCurrent", unit = "A") "Current flowing from pin p to pin n";
equation
  assert(1.0 + resistor1.alpha * (resistor1.T_heatPort - resistor1.T_ref) >= 1e-15, "Temperature outside scope of model!");
  resistor1.R_actual = resistor1.R * (1.0 + resistor1.alpha * (resistor1.T_heatPort - resistor1.T_ref));
  resistor1.v = resistor1.R_actual * resistor1.i;
  resistor1.LossPower = resistor1.v * resistor1.i;
  resistor1.v = resistor1.p.v - resistor1.n.v;
  0.0 = resistor1.p.i + resistor1.n.i;
  resistor1.i = resistor1.p.i;
  resistor1.T_heatPort = resistor1.T;
  inductor1.L * der(inductor1.i) = inductor1.v;
  inductor1.v = inductor1.p.v - inductor1.n.v;
  0.0 = inductor1.p.i + inductor1.n.i;
  inductor1.i = inductor1.p.i;
  ground1.p.v = 0.0;
  load.phi = load.flange_a.phi;
  load.phi = load.flange_b.phi;
  load.w = der(load.phi);
  load.a = der(load.w);
  load.J * load.a = load.flange_a.tau + load.flange_b.tau;
  emf1.internalSupport.flange.tau = emf1.internalSupport.tau;
  emf1.internalSupport.flange.phi = emf1.internalSupport.phi;
  emf1.fixed.flange.phi = emf1.fixed.phi0;
  emf1.v = emf1.p.v - emf1.n.v;
  0.0 = emf1.p.i + emf1.n.i;
  emf1.i = emf1.p.i;
  emf1.phi = emf1.flange.phi - emf1.internalSupport.phi;
  emf1.w = der(emf1.phi);
  emf1.k * emf1.w = emf1.v;
  emf1.tau = (-emf1.k) * emf1.i;
  emf1.tauElectrical = -emf1.tau;
  emf1.tau = emf1.flange.tau;
  step1.y = step1.offset + (if time < step1.startTime then 0.0 else step1.height);
  signalVoltage1.v = signalVoltage1.p.v - signalVoltage1.n.v;
  0.0 = signalVoltage1.p.i + signalVoltage1.n.i;
  signalVoltage1.i = signalVoltage1.p.i;
  resistor1.p.i + signalVoltage1.p.i = 0.0;
  resistor1.n.i + inductor1.p.i = 0.0;
  inductor1.n.i + emf1.p.i = 0.0;
  ground1.p.i + emf1.n.i + signalVoltage1.n.i = 0.0;
  load.flange_a.tau + emf1.flange.tau = 0.0;
  load.flange_b.tau = 0.0;
  emf1.fixed.flange.tau + emf1.internalSupport.flange.tau = 0.0;
  emf1.fixed.flange.phi = emf1.internalSupport.flange.phi;
  signalVoltage1.v = step1.y;
  resistor1.p.v = signalVoltage1.p.v;
  inductor1.p.v = resistor1.n.v;
  emf1.p.v = inductor1.n.v;
  emf1.flange.phi = load.flange_a.phi;
  emf1.n.v = ground1.p.v;
  emf1.n.v = signalVoltage1.n.v;
end dcmotor;






Warning

Warning: Requested package Modelica of version 3.2.2, but this package was already loaded with version 3.2.3. You might experience problems if these versions are incompatible.





We plot part of the simulated result:


[image: _images/dcmotor.svg]Figure 2 Rotation and rotational velocity of the DC motor






The val() function

The val(variableName,time) scription function can be used to
retrieve the interpolated value of a simulation result variable at a
certain point in the simulation time, see usage in the BouncingBall
simulation below.




BouncingBall and Switch Models

We load and simulate the BouncingBall example containing when-equations
and if-expressions (the Modelica keywords have been bold-faced by hand
for better readability):

>>> loadFile(getInstallationDirectoryPath() + "/share/doc/omc/testmodels/BouncingBall.mo")
true





>>> list(BouncingBall)
model BouncingBall
  parameter Real e = 0.7 "coefficient of restitution";
  parameter Real g = 9.81 "gravity acceleration";
  Real h(fixed = true, start = 1) "height of ball";
  Real v(fixed = true) "velocity of ball";
  Boolean flying(fixed = true, start = true) "true, if ball is flying";
  Boolean impact;
  Real v_new(fixed = true);
  Integer foo;
equation
  impact = h <= 0.0;
  foo = if impact then 1 else 2;
  der(v) = if flying then -g else 0;
  der(h) = v;
  when {h <= 0.0 and v <= 0.0, impact} then
    v_new = if edge(impact) then -e * pre(v) else 0;
    flying = v_new > 0;
    reinit(v, v_new);
  end when;
end BouncingBall;





Instead of just giving a simulate and plot command, we perform a
runScript command on a .mos (Modelica script) file sim_BouncingBall.mos
that contains these commands:

>>> writeFile("sim_BouncingBall.mos", "
  loadFile(getInstallationDirectoryPath() + \"/share/doc/omc/testmodels/BouncingBall.mo\");
  simulate(BouncingBall, stopTime=3.0);
  /* plot({h,flying}); */
")
true
>>> runScript("sim_BouncingBall.mos")
"true
record SimulationResult
    resultFile = \"«DOCHOME»/BouncingBall_res.mat\",
    simulationOptions = \"startTime = 0.0, stopTime = 3.0, numberOfIntervals = 500, tolerance = 1e-06, method = 'dassl', fileNamePrefix = 'BouncingBall', options = '', outputFormat = 'mat', variableFilter = '.*', cflags = '', simflags = ''\",
    messages = \"LOG_SUCCESS       | info    | The initialization finished successfully without homotopy method.
LOG_SUCCESS       | info    | The simulation finished successfully.
\",
    timeFrontend = 0.006844958999999928,
    timeBackend = 0.004512714,
    timeSimCode = 0.001395537,
    timeTemplates = 0.23390383,
    timeCompile = 0.5420021820000001,
    timeSimulation = 0.021202769,
    timeTotal = 0.809977909
end SimulationResult;
"





model Switch
  Real v;
  Real i;
  Real i1;
  Real itot;
  Boolean open;
equation
  itot = i + i1;
  if open then
    v = 0;
  else
    i = 0;
  end if;
  1 - i1 = 0;
  1 - v - i = 0;
  open = time >= 0.5;
end Switch;





>>> simulate(Switch, startTime=0, stopTime=1)
record SimulationResult
    resultFile = "«DOCHOME»/Switch_res.mat",
    simulationOptions = "startTime = 0.0, stopTime = 1.0, numberOfIntervals = 500, tolerance = 1e-06, method = 'dassl', fileNamePrefix = 'Switch', options = '', outputFormat = 'mat', variableFilter = '.*', cflags = '', simflags = ''",
    messages = "LOG_SUCCESS       | info    | The initialization finished successfully without homotopy method.
LOG_SUCCESS       | info    | The simulation finished successfully.
",
    timeFrontend = 0.004740943,
    timeBackend = 0.005581529,
    timeSimCode = 0.001094183,
    timeTemplates = 0.010390028,
    timeCompile = 0.545182407,
    timeSimulation = 0.020692923,
    timeTotal = 0.587815812
end SimulationResult;





Retrieve the value of itot at time=0 using the
val(variableName, time) function:

>>> val(itot,0)
1.0





Plot itot and open:


[image: _images/switch.svg]Figure 3 Plot when the switch opens



We note that the variable open switches from false (0) to true (1),
causing itot to increase from 1.0 to 2.0.




Clear All Models

Now, first clear all loaded libraries and models:

>>> clear()
true





List the loaded models – nothing left:

>>> list()
""








VanDerPol Model and Parametric Plot

We load another model, the VanDerPol model (or via the menu File->Load
Model):

>>> loadFile(getInstallationDirectoryPath() + "/share/doc/omc/testmodels/VanDerPol.mo")
true





It is simulated:

>>> simulate(VanDerPol, stopTime=80)
record SimulationResult
    resultFile = "«DOCHOME»/VanDerPol_res.mat",
    simulationOptions = "startTime = 0.0, stopTime = 80.0, numberOfIntervals = 500, tolerance = 1e-06, method = 'dassl', fileNamePrefix = 'VanDerPol', options = '', outputFormat = 'mat', variableFilter = '.*', cflags = '', simflags = ''",
    messages = "LOG_SUCCESS       | info    | The initialization finished successfully without homotopy method.
LOG_SUCCESS       | info    | The simulation finished successfully.
",
    timeFrontend = 0.03698502,
    timeBackend = 0.002334538,
    timeSimCode = 0.000637947,
    timeTemplates = 0.019134009,
    timeCompile = 0.5084736649999999,
    timeSimulation = 0.016259256,
    timeTotal = 0.583939242
end SimulationResult;





It is plotted:

>>> plotParametric("x","y")






[image: _images/VanDerPol.svg]Figure 4 VanDerPol plotParametric(x,y)



Perform code instantiation to flat form of the VanDerPol model:

>>> instantiateModel(VanDerPol)
class VanDerPol "Van der Pol oscillator model"
  Real x(start = 1.0, fixed = true);
  Real y(start = 1.0, fixed = true);
  parameter Real lambda = 0.3;
equation
  der(x) = y;
  der(y) = lambda * (1.0 - x ^ 2.0) * y - x;
end VanDerPol;








Using Japanese or Chinese Characters

Japenese, Chinese, and other kinds of UniCode characters can be used
within quoted (single quote) identifiers, see for example the variable
name to the right in the plot below:

[image: _images/bb-japanese.png]



Scripting with For-Loops, While-Loops, and If-Statements

A simple summing integer loop (using multi-line input without evaluation
at each line into OMShell requires copy-paste as one operation from
another document):

>>> k := 0;
>>> for i in 1:1000 loop
  k := k + i;
end for;
>>> k
500500





A nested loop summing reals and integers:

>>> g := 0.0;
>>> h := 5;
>>> for i in {23.0,77.12,88.23} loop
  for j in i:0.5:(i+1) loop
    g := g + j;
    g := g + h / 2;
  end for;
  h := h + g;
end for;





By putting two (or more) variables or assignment statements separated by
semicolon(s), ending with a variable, one can observe more than one
variable value:

>>> h; g
1997.45
1479.09





A for-loop with vector traversal and concatenation of string elements:

>>> i:="";
>>> lst := {"Here ", "are ","some ","strings."};
>>> s := "";
>>> for i in lst loop
  s := s + i;
end for;
>>> s
"Here are some strings."





Normal while-loop with concatenation of 10 "abc " strings:

>>> s:="";
>>> i:=1;
>>> while i<=10 loop
  s:="abc "+s;
  i:=i+1;
end while;
>>> s
"abc abc abc abc abc abc abc abc abc abc "





A simple if-statement. By putting the variable last, after the
semicolon, its value is returned after evaluation:

>>> if 5>2 then a := 77; end if; a
77





An if-then-else statement with elseif:

>>> if false then
  a := 5;
elseif a > 50 then
  b:= "test"; a:= 100;
else
  a:=34;
end if;





Take a look at the variables a and b:

>>> a;b
100
"test"








Variables, Functions, and Types of Variables

Assign a vector to a variable:

>>> a:=1:5
{1,2,3,4,5}





Type in a function:

function mySqr
  input Real x;
  output Real y;
algorithm
  y:=x*x;
end mySqr;





Call the function:

>>> b:=mySqr(2)
4.0





Look at the value of variable a:

>>> a
{1,2,3,4,5}





Look at the type of a:

>>> typeOf(a)
"Integer[5]"





Retrieve the type of b:

>>> typeOf(b)
"Real"





What is the type of mySqr? Cannot currently be handled.

>>> typeOf(mySqr)





List the available variables:

>>> listVariables()
{b,a,s,lst,i,h,g,k,currentSimulationResult}





Clear again:

>>> clear()
true








Getting Information about Error Cause

Call the function getErrorString() in order to get more information
about the error cause after a simulation failure:

>>> getErrorString()
""








Alternative Simulation Output Formats

There are several output format possibilities, with mat being the
default. plt and mat are the only formats that allow you to use the
val() or plot() functions after a simulation. Compared to the speed of
plt, mat is roughly 5 times for small files, and scales better for
larger files due to being a binary format. The csv format is roughly
twice as fast as plt on data-heavy simulations. The plt format allocates
all output data in RAM during simulation, which means that simulations
may fail due applications only being able to address 4GB of memory on
32-bit platforms. Empty does no output at all and should be by far the
fastest. The csv and plt formats are suitable when using an external
scripts or tools like gnuplot to generate plots or process data. The mat
format can be post-processed in MATLAB [http://www.mathworks.com/products/matlab]
or Octave [http://www.gnu.org/software/octave/].

>>> simulate(... , outputFormat="mat")
>>> simulate(... , outputFormat="csv")
>>> simulate(... , outputFormat="plt")
>>> simulate(... , outputFormat="empty")





It is also possible to specify which variables should be present in the
result-file. This is done by using POSIX Extended Regular Expressions [http://en.wikipedia.org/wiki/Regular_expression].
The given expression must match the full variable name
(^ and $ symbols are automatically added to the given regular
expression).

// Default, match everything

>>> simulate(... , variableFilter=".*")





// match indices of variable myVar that only contain the numbers using
combinations

// of the letters 1 through 3

>>> simulate(... , variableFilter="myVar\\\[[1-3]*\\\]")





// match x or y or z

>>> simulate(... , variableFilter="x|y|z")








Using External Functions

See Chapter Interoperability – C and Python for more information about calling functions in other
programming languages.




Using Parallel Simulation via OpenMP Multi-Core Support

Faster simulations on multi-core computers can be obtained by using a
new OpenModelica feature that automatically partitions the system of
equations and schedules the parts for execution on different cores using
shared-memory OpenMP based execution. The speedup obtained is dependent
on the model structure, whether the system of equations can be
partitioned well. This version in the current OpenModelica release is an
experimental version without load balancing. The following command, not
yet available from the OpenModelica GUI, will run a parallel simulation
on a model:

>>> omc -d=openmp model.mo








Loading Specific Library Version

There exist many different versiosn of Modelica libraries which are not
compatible. It is possible to keep multiple versions of the same library
stored in the directory given by calling getModelicaPath(). By calling
loadModel(Modelica,{"3.2"}), OpenModelica will search for a directory
called "Modelica 3.2" or a file called "Modelica 3.2.mo". It is possible
to give several library versions to search for, giving preference for a
pre-release version of a library if it is installed. If the searched
version is "default", the priority is: no version name (Modelica), main
release version (Modelica 3.1), pre-release version (Modelica 3.1Beta 1)
and unordered versions (Modelica Special Release).

The loadModel command will also look at the uses annotation of the
top-level class after it has been loaded. Given the following package,
Complex 1.0 and ModelicaServices 1.1 will also be loaded into the AST
automatically.

package Modelica
  annotation(uses(Complex(version="1.0"),
  ModelicaServices(version="1.1")));
end Modelica;





>>> clear()
true





Packages will also be loaded if a model has a uses-annotation:

model M
  annotation(uses(Modelica(version="3.2.1")));
end M;





>>> instantiateModel(M)
class M
end M;






Note

Notification: Automatically loaded package Modelica 3.2.1 due to uses annotation.

Notification: Automatically loaded package Complex 3.2.1 due to uses annotation.

Notification: Automatically loaded package ModelicaServices 3.2.1 due to uses annotation.





Packages will also be loaded by looking at the first identifier in the path:

>>> instantiateModel(Modelica.Electrical.Analog.Basic.Ground)
class Modelica.Electrical.Analog.Basic.Ground "Ground node"
  Real p.v(quantity = "ElectricPotential", unit = "V") "Potential at the pin";
  Real p.i(quantity = "ElectricCurrent", unit = "A") "Current flowing into the pin";
equation
  p.v = 0.0;
  p.i = 0.0;
end Modelica.Electrical.Analog.Basic.Ground;






Note

Notification: Automatically loaded package Complex 3.2.3 due to uses annotation.

Notification: Automatically loaded package ModelicaServices 3.2.3 due to uses annotation.

Notification: Automatically loaded package Modelica default due to uses annotation.








Calling the Model Query and Manipulation API

In the OpenModelica System Documentation, an external API (application
programming interface) is described which returns information about
models and/or allows manipulation of models. Calls to these functions
can be done interactively as below, but more typically by program
clients to the OpenModelica Compiler (OMC) server. Current examples of
such clients are the OpenModelica MDT Eclipse plugin, OMNotebook, the
OMEdit graphic model editor, etc. This API is untyped for performance
reasons, i.e., no type checking and minimal error checking is done on
the calls. The results of a call is returned as a text string in
Modelica syntax form, which the client has to parse. An example parser
in C++ is available in the OMNotebook source code, whereas another
example parser in Java is available in the MDT Eclipse plugin.

Below we show a few calls on the previously simulated BouncingBall
model. The full documentation on this API is available in the system
documentation. First we load and list the model again to show its
structure:

>>> loadFile(getInstallationDirectoryPath() + "/share/doc/omc/testmodels/BouncingBall.mo");
>>> list(BouncingBall)
model BouncingBall
  parameter Real e = 0.7 "coefficient of restitution";
  parameter Real g = 9.81 "gravity acceleration";
  Real h(fixed = true, start = 1) "height of ball";
  Real v(fixed = true) "velocity of ball";
  Boolean flying(fixed = true, start = true) "true, if ball is flying";
  Boolean impact;
  Real v_new(fixed = true);
  Integer foo;
equation
  impact = h <= 0.0;
  foo = if impact then 1 else 2;
  der(v) = if flying then -g else 0;
  der(h) = v;
  when {h <= 0.0 and v <= 0.0, impact} then
    v_new = if edge(impact) then -e * pre(v) else 0;
    flying = v_new > 0;
    reinit(v, v_new);
  end when;
end BouncingBall;





Different kinds of calls with returned results:

>>> getClassRestriction(BouncingBall)
"model"
>>> getClassInformation(BouncingBall)
("model","",false,false,false,"/var/lib/jenkins1/ws/OpenModelica_maintenance_v1.14/build/share/doc/omc/testmodels/BouncingBall.mo",false,1,1,23,17,{},false,false,"","",false,"")
>>> isFunction(BouncingBall)
false
>>> existClass(BouncingBall)
true
>>> getComponents(BouncingBall)
{{Real,e,"coefficient of restitution", "public", false, false, false, false, "parameter", "none", "unspecified",{}},{Real,g,"gravity acceleration", "public", false, false, false, false, "parameter", "none", "unspecified",{}},{Real,h,"height of ball", "public", false, false, false, false, "unspecified", "none", "unspecified",{}},{Real,v,"velocity of ball", "public", false, false, false, false, "unspecified", "none", "unspecified",{}},{Boolean,flying,"true, if ball is flying", "public", false, false, false, false, "unspecified", "none", "unspecified",{}},{Boolean,impact,"", "public", false, false, false, false, "unspecified", "none", "unspecified",{}},{Real,v_new,"", "public", false, false, false, false, "unspecified", "none", "unspecified",{}},{Integer,foo,"", "public", false, false, false, false, "unspecified", "none", "unspecified",{}}}
>>> getConnectionCount(BouncingBall)
0
>>> getInheritanceCount(BouncingBall)
0
>>> getComponentModifierValue(BouncingBall,e)
"0.7"
>>> getComponentModifierNames(BouncingBall,"e")
{}
>>> getClassRestriction(BouncingBall)
"model"
>>> getVersion() // Version of the currently running OMC
"OMCompiler v1.14.0-dev.beta2.11+gc12c3df1ee"








Quit OpenModelica

Leave and quit OpenModelica:

>>> quit()








Dump XML Representation

The command dumpXMLDAE dumps an XML representation of a model, according
to several optional parameters.

dumpXMLDAE(modelname[,asInSimulationCode=<Boolean>]
[,filePrefix=<String>] [,storeInTemp=<Boolean>] [,addMathMLCode
=<Boolean>])

This command dumps the mathematical representation of a model using an
XML representation, with optional parameters. In particular,
asInSimulationCode defines where to stop in the translation process
(before dumping the model), the other options are relative to the file
storage: filePrefix for specifying a different name and storeInTemp to
use the temporary directory. The optional parameter addMathMLCode gives
the possibility to don't print the MathML code within the xml file, to
make it more readable. Usage is trivial, just:
addMathMLCode=true/false (default value is false).




Dump Matlab Representation

The command export dumps an XML representation of a model, according to
several optional parameters.

exportDAEtoMatlab(modelname);

This command dumps the mathematical representation of a model using a
Matlab representation. Example:

>>> loadFile(getInstallationDirectoryPath() + "/share/doc/omc/testmodels/BouncingBall.mo")
true
>>> exportDAEtoMatlab(BouncingBall)
"The equation system was dumped to Matlab file:BouncingBall_imatrix.m"





% Incidence Matrix
% ====================================
% number of rows: 6
IM={{3,6},{1,{'if', 'true','==' {3},{},}},{{'if', 'true','==' {4},{},}},{5},{2,{'if', 'edge(impact)' {3},{5},}},{4,2}};
VL = {'foo','v_new','impact','flying','v','h'};


EqStr = {'impact = h <= 0.0;','foo = if impact then 1 else 2;','der(v) = if flying then -g else 0.0;','der(h) = v;','when {h <= 0.0 and v <= 0.0, impact} then v_new = if edge(impact) then (-e) * pre(v) else 0.0; end when;','when {h <= 0.0 and v <= 0.0, impact} then flying = v_new > 0.0; end when;'};


OldEqStr={'class BouncingBall','  parameter Real e = 0.7 "coefficient of restitution";','  parameter Real g = 9.81 "gravity acceleration";','  Real h(start = 1.0, fixed = true) "height of ball";','  Real v(fixed = true) "velocity of ball";','  Boolean flying(start = true, fixed = true) "true, if ball is flying";','  Boolean impact;','  Real v_new(fixed = true);','  Integer foo;','equation','  impact = h <= 0.0;','  foo = if impact then 1 else 2;','  der(v) = if flying then -g else 0.0;','  der(h) = v;','  when {h <= 0.0 and v <= 0.0, impact} then','    v_new = if edge(impact) then (-e) * pre(v) else 0.0;','    flying = v_new > 0.0;','    reinit(v, v_new);','  end when;','end BouncingBall;',''};










Summary of Commands for the Interactive Session Handler

The following is the complete list of commands currently available in
the interactive session hander.

simulate(modelname) Translate a model named modelname and simulate
it.


simulate(modelname[,startTime=<Real>][,stopTime=<Real>][,numberOfIntervals

=<Integer>][,outputInterval=<Real>][,method=<String>]

[,tolerance=<Real>][,fixedStepSize=<Real>]

[,outputFormat=<String>]) Translate and simulate a model, with
optional start time, stop time, and optional number of simulation
intervals or steps for which the simulation results will be computed.
More intervals will give higher time resolution, but occupy more space
and take longer to compute. The default number of intervals is 500. It
is possible to choose solving method, default is “dassl”, “euler” and
“rungekutta” are also available. Output format “mat” is default. “plt”
and “mat” (MATLAB) are the only ones that work with the val() command,
“csv” (comma separated values) and “empty” (no output) are also
available (see section Alternative Simulation Output Formats).



plot(vars) Plot the variables given as a vector or a scalar, e.g.
plot({x1,x2}) or plot(x1).

plotParametric(var1, var2) Plot var2 relative to var1 from the
most recently simulated model, e.g. plotParametric(x,y).

cd() Return the current directory.

cd(dir) Change directory to the directory given as string.

clear() Clear all loaded definitions.

clearVariables() Clear all defined variables.

dumpXMLDAE(modelname, ...) Dumps an XML representation of a model,
according to several optional parameters.

exportDAEtoMatlab(name) Dumps a Matlab representation of a model.

instantiateModel(modelname)Performs code instantiation of a
model/class and return a string containing the flat class definition.

list() Return a string containing all loaded class definitions.

list(modelname) Return a string containing the class definition of
the named class.

listVariables() Return a vector of the names of the currently defined
variables.

loadModel(classname) Load model or package of name classname from
the path indicated by the environment variable OPENMODELICALIBRARY.

loadFile(str) Load Modelica file (.mo) with name given as string
argument str.

readFile(str) Load file given as string str and return a string
containing the file content.

runScript(str) Execute script file with file name given as string
argument str.

system(str) Execute str as a system(shell) command in the
operating system; return integer success value. Output into stdout from
a shell command is put into the console window.

timing(expr) Evaluate expression expr and return the number of
seconds (elapsed time) the evaluation took.

typeOf(variable) Return the type of the variable as a string.

saveModel(str,modelname) Save the model/class with name
modelname in the file given by the string argument str.

val(variable,timePoint) Return the (interpolated) value of the
variable at time timePoint.

help() Print this helptext (returned as a string).

quit() Leave and quit the OpenModelica environment




Running the compiler from command line

The OpenModelica compiler can also be used from command line, in Windows
cmd.exe.

Example Session 1 – obtaining information about command line
parameters


C:\dev> C:\OpenModelica1.9.2 \bin\omc -h

OpenModelica Compiler 1.9.2

Copyright © 2015 Open Source Modelica Consortium (OSMC)

Distributed under OMSC-PL and GPL, see https://www.openmodelica.org/

Usage: omc [Options] (Model.mo | Script.mos) [Libraries | .mo-files]

...



Example Session 2 - create an TestModel.mo file and run omc on it


C:\dev> echo model TestModel parameter Real x = 1; end TestModel; >
TestModel.mo

C:\dev> C:\OpenModelica1.9.2 \bin\omc TestModel.mo

class TestModel


parameter Real x = 1.0;



end TestModel;

C:\dev>



Example Session 3 - create an script.mos file and run omc on it


Create a file script.mos using your editor containing these commands:

// start script.mos

loadModel(Modelica); getErrorString();

simulate(Modelica.Mechanics.MultiBody.Examples.Elementary.Pendulum);
getErrorString();

// end script.mos

C:\dev> notepad script.mos

C:\dev> C:\OpenModelica1.9.2 \bin\omc script.mos

true

""

record SimulationResult


resultFile =
"C:/dev/Modelica.Mechanics.MultiBody.Examples.Elementary.Pendulum_res.mat",

simulationOptions = "startTime = 0.0, stopTime = 5.0,
numberOfIntervals = 500, tolerance = 1e-006, method = 'dassl',
fileNamePrefix =
'Modelica.Mechanics.MultiBody.Examples.Elementary.Pendulum', options =
'', outputFormat = 'mat', variableFilter = '.*', cflags = '',
simflags = ''",

messages = "",

timeFrontend = 1.245787339209033,

timeBackend = 20.51007138993843,

timeSimCode = 0.1510248469321959,

timeTemplates = 0.5052317333954395,

timeCompile = 5.128213942691722,

timeSimulation = 0.4049189573103951,

timeTotal = 27.9458487395605



end SimulationResult;

""



In order to obtain more information from the compiler one can use the
command line options --showErrorMessages -d=failtrace when running
the compiler:

C:\dev> C:\OpenModelica1.9.2 \bin\omc --showErrorMessages
-d=failtrace script.mos







          

      

      

    

  

    
      
          
            
  
OMEdit – OpenModelica Connection Editor

OMEdit – OpenModelica Connection Editor is the new Graphical User
Interface for graphical model editing in OpenModelica. It is implemented
in C++ using the Qt graphical user interface library and supports
the Modelica Standard Library that is included in the latest
OpenModelica installation. This chapter gives a brief introduction to
OMEdit and also demonstrates how to create a DCMotor model using the
editor.

OMEdit provides several user friendly features for creating, browsing,
editing, and simulating models:


	Modeling – Easy model creation for Modelica models.


	Pre-defined models – Browsing the Modelica Standard library to
access the provided models.


	User defined models – Users can create their own models for
immediate usage and later reuse.


	Component interfaces – Smart connection editing for drawing and
editing connections between model interfaces.


	Simulation – Subsystem for running simulations and specifying
simulation parameters start and stop time, etc.


	Plotting – Interface to plot variables from simulated models.





Starting OMEdit

A splash screen similar to the one shown in Figure 5 will
appear indicating that it is starting OMEdit.
The executable is found in different places depending on the platform
(see below).


[image: _images/omedit_splashscreen.png]
Figure 5 OMEdit Splash Screen.




Microsoft Windows

OMEdit can be launched using the executable placed in
OpenModelicaInstallationDirectory/bin/OMEdit/OMEdit.exe. Alternately,
choose OpenModelica > OpenModelica Connection Editor from the start menu
in Windows.




Linux

Start OMEdit by either selecting the corresponding menu application item
or typing “OMEdit” at the shell or command prompt.




Mac OS X

The default installation is /Application/MacPorts/OMEdit.app.






MainWindow & Browsers

The MainWindow contains several dockable browsers,


	Libraries Browser


	Documentation Browser


	Variables Browser


	Messages Browser




Figure 6 shows the MainWindow and browsers.


[image: _images/omedit-mainwindow-browsers.png]
Figure 6 OMEdit MainWindow and Browsers.



The default location of the browsers are shown in Figure 6.
All browsers except for Message Browser can be docked into left or right
column. The Messages Browser can be docked into top or bottom
areas. If you want OMEdit to remember the new docked position of the
browsers then you must enable Preserve User's GUI Customizations option,
see section General.


Filter Classes

To filter a class click Edit > Filter Classes or press keyboard
shortcut Ctrl+Shift+F. The loaded Modelica classes can be filtered by
typing any part of the class name.




Libraries Browser

To view the Libraries Browser click View > Windows > Libraries Browser.
Shows the list of loaded Modelica classes. Each item of the Libraries
Browser has right click menu for easy manipulation and usage of the
class. The classes are shown in a tree structure with name and icon. The
protected classes are not shown by default. If you want to see the
protected classes then you must enable the Show Protected Classes
option, see section General.


[image: _images/omedit-libraries-browser.png]
Figure 7 Libraries Browser.






Documentation Browser

Displays the HTML documentation of Modelica classes. It contains the
navigation buttons for moving forward and backward. It also contains
a WYSIWYG editor which allows writing class documentation in HTML format.
To see documentation of any class, right click the Modelica class
in Libraries Browser and choose View Documentation.


[image: _images/omedit-documentation-browser.png]
Figure 8 Documentation Browser.






Variables Browser

The class variables are structured in the form of the tree and are
displayed in the Variables Browser. Each variable has a checkbox.
Ticking the checkbox will plot the variable values. There is a find box
on the top for filtering the variable in the tree. The filtering can be
done using Regular Expression, Wildcard and Fixed String. The complete
Variables Browser can be collapsed and expanded using the Collapse All
and Expand All buttons.

The browser allows manipulation of changeable parameters for
Re-simulating a Model. It also displays the unit and
description of the variable.

The browser also contains the slider and animation buttons. These controls
are used for variable graphics and schematic animation of models i.e.,
DynamicSelect annotation. They are also used for debugging of state machines.
Open the Diagram Window for animation. It is only possible
to animate one model at a time. This is achieved by marking the result
file active in the Variables Browser. The animation only read the values
from the active result file. It is possible to simulate several models.
In that case, the user will see a list of result files in the Variables Browser.
The user can switch between different result files by right clicking
on the result file and selecting Set Active in the context menu.


[image: _images/omedit-variables-browser.png]
Figure 9 Variables Browser.






Messages Browser

Shows the list of errors. Following kinds of error can occur,


	Syntax


	Grammar


	Translation


	Symbolic


	Simulation


	Scripting




See section Messages for Messages Browser options.






Perspectives

The perspective tabs are loacted at the bottom right of the MainWindow:


	Welcome Perspective


	Modeling Perspective


	Plotting Perspective


	Debugging Perspective





Welcome Perspective


[image: _images/omedit-welcome.png]
Figure 10 OMEdit Welcome Perspective.



The Welcome Perspective shows the list of recent files and the list of
latest news from https://www.openmodelica.org/.
See Figure 10. The orientation of recent files and latest news can be
horizontal or vertical. User is allowed to show/hide the latest news.
See section General.




Modeling Perspective

The Modeling Perpective provides the interface where user can create and
design their models. See Figure 11.


[image: _images/omedit-modeling-perspective.png]
Figure 11 OMEdit Modeling Perspective.



The Modeling Perspective interface can be viewed in two different modes,
the tabbed view and subwindow view, see section General.




Plotting Perspective

The Plotting Perspective shows the simulation results of the models.
Plotting Perspective will automatically become active when the
simulation of the model is finished successfully. It will also become
active when user opens any of the OpenModelica’s supported result file.
Similar to Modeling Perspective this perspective can also be viewed in
two different modes, the tabbed view and subwindow view, see section
General.


[image: _images/omedit-plotting-perspective.png]
Figure 12 OMEdit Plotting Perspective.






Debugging Perspective

The application automatically switches to Debugging Perpective
when user simulates the class with algorithmic debugger.
The prespective shows the list of stack frames, breakpoints and variables.


[image: _images/omedit-debugging-perspective.png]
Figure 13 OMEdit Debugging Perspective.








File Menu


	New Modelica Class - Creates a new Modelica class.


	Open Model/Library File(s) - Opens the Modelica file or a library.


	Open/Convert Modelica File(s) With Encoding - Opens the Modelica file or
a library with a specific encoding. It is also possible to convert to UTF-8.


	Load Library - Loads a Modelica library. Allows the user to select the
library path assuming that the path contains a package.mo file.


	Load Encrypted Library - Loads an encrypted library. see OpenModelica Encryption


	Open Result File(s) - Opens a result file.


	Open Transformations File - Opens a transformational debugger file.


	New Composite Model - Creates a new composite model.


	Open Composite Model(s) - Loads an existing composite model.


	Load External Model(s) - Loads the external models that can be used within
composite model.


	Open Directory - Loads the files of a directory recursively. The files
are loaded as text files.


	Save - Saves the class.


	Save As - Save as the class.


	Save Total - Saves the class and all the classes it uses in a single file. The class and its dependencies can only be loaded later by using the loadFile() API function in a script. Allows third parties to reproduce an issue with a class without worrying about library dependencies.


	Import






	FMU - Imports the FMU.


	FMU Model Description - Imports the FMU model description.


	From OMNotbook - Imports the Modelica models from OMNotebook.


	Ngspice netlist - Imports the ngspice netlist to Modelica code.








	"Export"






	To Clipboard - Exports the current model to clipboard.


	Image - Exports the current model to image.


	FMU - Exports the current model to FMU.


	Read-only Package - Exports a zipped Modelica library with file extension .mol


	Encrypted Package - Exports an encrypted package. see OpenModelica Encryption


	XML - Exports the current model to a xml file.


	Figaro - Exports the current model to Figaro.


	To OMNotebook - Exports the current model to a OMNotebook file.








	System Libraries - Contains a list of system libraries.


	Recent Files - Contains a list of recent files.


	Clear Recent Files - Clears the list of recent files.


	Print - Prints the current model.


	Quit - Quit the OpenModelica Connection Editor.







Edit Menu


	Undo - Undoes the last change.


	Redo - Redoes the last undone change.


	Filter Classes - Filters the classes in Libraries Browser. see Filter Classes







View Menu


	Toolbars - Toggle visibility of toolbars.


	Windows - Toggle visibility of windows.






	Close Window - Closes the current model window.


	Close All Windows - Closes all the model windows.


	Close All Windows But This - Closes all the model windows except the current.


	Cascade Windows - Arranges all the child windows in a cascade pattern.


	Tile Windows Horizontally - Arranges all child windows in a horizontally tiled pattern.


	Tile Windows Vertically - Arranges all child windows in a vertically tiled pattern.








	Toggle Tab/Sub-window View - Switches between tab and subwindow view.


	Grid Lines - Toggle grid lines of the current model.


	Reset Zoom - Resets the zoom of the current model.


	Zoom In - Zoom in the current model.


	Zoom Out - Zoom out the current model.







Simulation Menu


	Instantiate Model - Instantiates the current model.


	Check Model - Checks the current model.


	Check All Models - Checks all the models of a library.


	Simulate - Simulates the current model.


	Simulate with Transformational Debugger - Simulates the current model and
opens the transformational debugger.


	Simulate with Algorithmic Debugger - Simulates the current model and
opens the algorithmic debugger.


	Simulate with Animation - Simulates the current model and open the animation.


	Simulation Setup - Opens the simulation setup window.







Debugger Menu


	Debug Configurations - Opens the debug configurations window.


	Attach to Running Process - Attaches the algorithmic debugger to a running process.







OMSimulator Menu


	New OMSimulator Model - Creates a new OMSimulator model.


	Open OMSimulator Model(s) - Opens the OMSimulator model(s).


	Add System - Adds the system to a model.


	Add/Edit Icon - Add/Edit the system/submodel icon.


	Delete Icon - Deletes the system/submodel icon.


	Add Connector - Adds a connector to a system/submodel.


	Add Bus - Adds a bus to a system/submodel.


	Add TLM Bus - Adds a TLM bus to a system/submodel.


	Add SubModel - Adds a submodel to a system.


	Instantiate Model - Instantiates the model.


	Simulate - Simulates the model.


	Archived Simulations - Opens the archived simulations window.







Tools Menu


	OpenModelica Compiler CLI - Opens the OpenModelica Compiler command line
interface window.


	OpenModelica Command Prompt - Opens the OpenModelica Command Prompt (Only
available on Windows).


	Open Working Directory - Opens the current working directory.


	Open Terminal - Runs the terminal command set in General.


	Options - Opens the options window.







Help Menu


	OpenModelica Users Guide - Opens the OpenModelica Users Guide.


	OpenModelica Users Guide (PDF) - Opens the OpenModelica Users Guide (PDF).


	OpenModelica System Documentation - Opens the OpenModelica System Documentation.


	OpenModelica Scripting Documentation - Opens the OpenModelica Scripting Documentation.


	Modelica Documentation - Opens the Modelica Documentation.


	OMSimulator Users Guide - Opens the OMSimulator Users Guide.


	OpenModelica TLM Simulator Documentation - Opens the OpenModelica TLM Simulator Documentation.


	About OMEdit - Shows the information about OpenModelica Connection Editor.







Modeling a Model


Creating a New Modelica Class

Creating a new Modelica class in OMEdit is rather straightforward.
Choose any of the following methods,


	Select File > New Modelica Class from the menu.


	Click on New Modelica Class toolbar button.


	Click on the Create New Modelica Class button available at the left
bottom of Welcome Perspective.


	Press Ctrl+N.







Opening a Modelica File

Choose any of the following methods to open a Modelica file,


	Select File > Open Model/Library File(s) from the menu.


	Click on Open Model/Library File(s) toolbar button.


	Click on the Open Model/Library File(s) button available at the right
bottom of Welcome Perspective.


	Press Ctrl+O.




(Note, for editing Modelica system files like MSL (not recommended), see Editing Modelica Standard Library)




Opening a Modelica File with Encoding

Select File > Open/Convert Modelica File(s) With Encoding from the menu.
It is also possible to convert files to UTF-8.




Model Widget

For each Modelica class one Model Widget is created. It has a statusbar
and a view area. The statusbar contains buttons for navigation between
the views and labels for information. The view area is used to display
the icon, diagram and text layers of Modelica class. See Figure 14.


[image: _images/omedit-model-widget.png]
Figure 14 Model Widget showing the Diagram View.






Adding Component Models

Drag the models from the Libraries Browser and drop them on either
Diagram or Icon View of Model Widget.




Making Connections

In order to connect one component model to another the user first needs
to enable the connect mode ([image: OMEdit connect mode icon]) from the toolbar.

Move the mouse over the connector. The mouse cursor will change from arrow cursor to cross cursor.
To start the connection press left button and move while keeping the button pressed. Now release the left button.
Move towards the end connector and click when cursor changes to cross cursor.






Simulating a Model

The simulation options for each model are stored inside the OMEdit data structure.
They have the following sequence,


	Each model has its own simulation options.


	If the model is opened for the first time then the simulation options
are set to default.


	experiment and __OpenModelica_simulationFlags annotations are
applied if the model contains them.


	After that all the changes done via Simulation Setup window are
preserved for the whole session. If you want to use the same settings in
the future sessions then you should store them inside experiment and
__OpenModelica_simulationFlags.




The OMEdit Simulation Setup can be launched by,


	Selecting Simulation > Simulation Setup from the menu. (requires a
model to be active in ModelWidget)


	Clicking on the Simulation Setup toolbar button. (requires a model to
be active in ModelWidget)


	Right clicking the model from the Libraries Browser and choosing
Simulation Setup.





General Tab


	Simulation Interval






	Start Time – the simulation start time.


	Stop Time – the simulation stop time.


	Number of Intervals – the simulation number of intervals.


	Interval – the length of one interval (i.e., stepsize)








	Interactive Simulation






	Simulate with steps (makes the interactive simulation synchronous; plots nicer curves at the expense of performance)


	Simulation server port








	Integration






	Method – the simulation solver. See section Integration Methods for solver details.


	Tolerance – the simulation tolerance.


	Jacobian - the jacobain method to use.


	DASSL/IDA Options






	Root Finding - Activates the internal root finding procedure of dassl.


	Restart After Event - Activates the restart of dassl after an event is performed.


	Initial Step Size


	Maximum Step Size


	Maximum Integration Order











	C/C++ Compiler Flags (Optional) – the optional C/C++ compiler flags.


	Number of Processors – the number of processors used to build the simulation.


	Build Only – only builds the class.


	Launch Transformational Debugger – launches the transformational debugger.


	Launch Algorithmic Debugger – launches the algorithmic debugger.


	Launch Animation – launches the 3d animation window.







Output Tab


	Output Format – the simulation result file output format.


	Single Precision - Output results in single precision (only for mat output format).


	File Name Prefix (Optional) – the name is used as a prefix for the output files.


	Result File (Optional) - the simulation result file name.


	Variable Filter (Optional)


	Protected Variables – adds the protected variables in result file.


	Equidistant Time Grid – output the internal steps given by dassl instead of interpolating results into an equidistant time grid as given by stepSize or numberOfIntervals


	Store Variables at Events – adds the variables at time events.


	Show Generated File – displays the generated files in a dialog box.







Simulation Flags Tab


	Model Setup File (Optional) – specifies a new setup XML file to the generated simulation code.


	Initialization Method (Optional) – specifies the initialization method.


	Equation System Initialization File (Optional) – specifies an
external file for the initialization of the model.


	Equation System Initialization Time (Optional) – specifies a time
for the initialization of the model.


	Clock (Optional) – the type of clock to use.


	Linear Solver (Optional) – specifies the linear solver method.


	Non Linear Solver (Optional) – specifies the nonlinear solver.


	Linearization Time (Optional) – specifies a time where the
linearization of the model should be performed.


	Output Variables (Optional) – outputs the variables a, b and c at
the end of the simulation to the standard output.


	Profiling – creates a profiling HTML file.


	CPU Time – dumps the cpu-time into the result file.


	Enable All Warnings – outputs all warnings.


	Logging (Optional)






	stdout - standard output stream. This stream is always active, can be disabled with -lv=-stdout


	assert - This stream is always active, can be disabled with -lv=-assert


	LOG_DASSL - additional information about dassl solver.


	LOG_DASSL_STATES - outputs the states at every dassl call.


	LOG_DEBUG - additional debug information.


	LOG_DSS - outputs information about dynamic state selection.


	LOG_DSS_JAC - outputs jacobian of the dynamic state selection.


	LOG_DT - additional information about dynamic tearing.


	LOG_DT_CONS - additional information about dynamic tearing (local and global constraints).


	LOG_EVENTS - additional information during event iteration.


	LOG_EVENTS_V - verbose logging of event system.


	LOG_INIT - additional information during initialization.


	LOG_IPOPT - information from Ipopt.


	LOG_IPOPT_FULL - more information from Ipopt.


	LOG_IPOPT_JAC - check jacobian matrix with Ipopt.


	LOG_IPOPT_HESSE - check hessian matrix with Ipopt.


	LOG_IPOPT_ERROR - print max error in the optimization.


	LOG_JAC - outputs the jacobian matrix used by dassl.


	LOG_LS - logging for linear systems.


	LOG_LS_V - verbose logging of linear systems.


	LOG_NLS - logging for nonlinear systems.


	LOG_NLS_V - verbose logging of nonlinear systems.


	LOG_NLS_HOMOTOPY - logging of homotopy solver for nonlinear systems.


	LOG_NLS_JAC - outputs the jacobian of nonlinear systems.


	LOG_NLS_JAC_TEST - tests the analytical jacobian of nonlinear systems.


	LOG_NLS_RES - outputs every evaluation of the residual function.


	LOG_NLS_EXTRAPOLATE - outputs debug information about extrapolate process.


	LOG_RES_INIT - outputs residuals of the initialization.


	LOG_RT - additional information regarding real-time processes.


	LOG_SIMULATION - additional information about simulation process.


	LOG_SOLVER - additional information about solver process.


	LOG_SOLVER_V - verbose information about the integration process.


	LOG_SOLVER_CONTEXT - context information during the solver process.


	LOG_SOTI - final solution of the initialization.


	LOG_STATS - additional statistics about timer/events/solver.


	LOG_STATS_V - additional statistics for LOG_STATS.


	LOG_SUCCESS - This stream is always active, can be disabled with -lv=-LOG_SUCCESS.


	LOG_UTIL.


	LOG_ZEROCROSSINGS - additional information about the zerocrossings.








	Additional Simulation Flags (Optional) – specify any other
simulation flag.







Archived Simulations Tab

Shows the list of simulations already finished or running.
Double clicking on any of them opens the simulation output window.






Plotting the Simulation Results

Successful simulation of model produces the result file which contains
the instance variables that are candidate for plotting. Variables
Browser will show the list of such instance variables. Each variable has
a checkbox, checking it will plot the variable. See Figure 12.


Types of Plotting

The plotting type depends on the active Plot Window. By default the
plotting type is Time Plot.


Time Plot

Plots the variable over the simulation time. You can have multiple Time
Plot windows by clicking on New Plot Window toolbar button ([image: OMEdit New Plot Window Icon]).




Plot Parametric

Draws a two-dimensional parametric diagram, between variables x and y,
with y as a function of x. You can have multiple Plot Parametric
windows by clicking on the New Plot Parametric toolbar button ([image: OMEdit New Parametric Plot Window Icon]).




Array Plot

Plots an array variable so that the array elements' indexes are on the x-axis and corresponding
elements' values are on the y-axis. The time is controlled by the slider above the variable tree.
When an array is present in the model, it has a principal array node in the variable tree.
To plot this array as an Array Plot, match the principal node. The principal node may be expanded
into particular array elements. To plot a single element in the Time Plot, match the element.
A new Array Plot window is opened using the New Array Plot Window toolbar button ([image: OMEdit New Array Plot Window Icon]).




Array Parametric Plot

Plots the first array elements' values on the x-axis versus the second array elements' values on the y-axis. The time
is controlled by the slider above the variable tree. To create a new Array Parametric Plot, press
the New Array Parametric Plot Window toolbar button ([image: OMEdit New Array Parametric Plot Window Icon]), then match the principle
array node in the variable tree view to be plotted on the x-axis and match the principle array node to be plotted
on the y-axis.




Diagram Window

Shows the active ModelWidget as a read only diagram. You can only have one
Diagram Window. To show it click on Diagram Window toolbar button ([image: OMEdit Diagram Window Icon]).








Re-simulating a Model

The Variables Browser allows manipulation of changeable
parameters for re-simulation.
After changing the parameter values user can click on the re-simulate
toolbar button ([image: OMEdit Re-simulate button]), or right click the model in Variables Browser and choose
re-simulate from the menu.




3D Visualization

Since OpenModelica 1.11 , OMEdit has built-in 3D visualization,
which replaces third-party libraries (such as Modelica3D [https://github.com/OpenModelica/Modelica3D]) for 3D visualization.


Running a Visualization

The 3d visualization is based on OpenSceneGraph. In order to run the
visualization simply right click the class in Libraries Browser an
choose “Simulate with Animation” as shown in Figure 15.


[image: _images/omedit_simulate_animation.png]
Figure 15 OMEdit Simulate with Animation.



One can also run the visualization via Simulation > Simulate with Animation from the menu.

When simulating a model in animation mode, the flag +d=visxml is set.
Hence, the compiler will generate a scene description file _visual.xml which stores all information on the multibody shapes.
This scene description references all variables which are needed for the animation of the multibody system.
When simulating with +d=visxml, the compiler will always generate results for these variables.




Viewing a Visualization

After the successful simulation of the model, the visualization window will
show up automatically as shown in Figure 16.


[image: _images/omedit_visualization.png]
Figure 16 OMEdit 3D Visualization.



The animation starts with pushing the play button. The animation is played until stopTime or until the pause button is pushed.
By pushing the previous button, the animation jumps to the initial point of time.
Points of time can be selected by moving the time slider or by inserting a simulation time in the Time-box.
The speed factor of animation in relation to realtime can be set in the Speed-dialog.
Other animations can be openend by using the open file button and selecting a result file with a corresping scene description file.

The 3D camera view can be manipulated as follows:








	Operation

	Key

	Mouse Action





	Move Closer/Further

	none

	Wheel



	Move Closer/Further

	Right Mouse Hold

	Up/Down



	Move Up/Down/Left/Right

	Middle Mouse Hold

	Move Mouse



	Move Up/Down/Left/Right

	Left and Right Mouse Hold

	Move Mouse



	Rotate

	Left Mouse Hold

	Move Mouse



	Shape context menu

	Right Mouse + Shift

	





Predefined views (Isometric, Side, Front, Top) can be selected and the scene can be tilted by 90° either clock or anticlockwise with the rotation buttons.




Additional Visualization Features

The shapes that are displayed in the viewer can be selected with shift + right click.
If a shape is selected, a context menu pops up that offers additional visualization features


[image: _images/pick_shape.png]


The following features can be selected:







	Menu

	Description





	Change Transparency

	The shape becomes either transparent or intransparent.



	Make Shape Invisible

	The shape becomes invisible.



	Change Color

	A color dialog pops up and the color of the shape can be set.



	Apply Check Texture

	A checked texture is applied to the shape.



	Apply Custom Texture

	A file selection dialog pops up and an image file can be selected as a texture.



	Remove Texture

	Removes the current texture of the shape.







[image: _images/visual_features.png]







Animation of Realtime FMUs

Instead of a result file, OMEdit can load Functional Mock-up Units to retrieve the data for the animation of multibody systems.
Just like opening a mat-file from the animation-plotting view, one can open an FMU-file.
Necessarily, the FMU has to be generated with the +d=visxml flag activated, so that a scene description file is generated in the same directory as the FMU.
Currently, only FMU 1.0 and FMU 2.0 model exchange are supported.
When choosing an FMU, the simulation settings window pops up to choose solver and step size.
Afterwards, the model initializes and can be simulated by pressing the play button.


Interactive Realtime Animation of FMUs

FMUs can be simulated with realtime user interaction.
A possible solution is to equip the model with an interaction model from the Modelica_DeviceDrivers library (https://github.com/modelica/Modelica_DeviceDrivers).
The realtime synchronization is done by OMEdit so no additional time synchronization model is necessary.



[image: _images/interactive_model.png]










Interactive Simulation


Warning

Interactive simulation is an experimental feature.



Interactive simulation is enabled by selecting interactive
simulation in the General tab of the simulation setup.

There are two main modes of execution: asynchronous and synchronous
(simulate with steps). The difference is that in synchronous (step mode),
OMEdit sends a command to the simulation for each step that the simulation
should take. The asynchronous mode simply tells the simulation to run and
samples variables values in real-time; if the simulation runs very fast,
fewer values will be sampled.

When running in asynchronous mode, it is possible to simulate the model
in real-time (with a scaling factor just like simulation flag
-rt, but with the ability to change the scaling
factor during the interactive simulation). In the synchronous mode, the
speed of the simulation does not directly correspond to real-time.
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2D Plotting

This chapter covers the 2D plotting available in OpenModelica via
OMNotebook, OMShell and command line script. The plotting is based on
OMPlot application.


Example

class HelloWorld
  Real x(start = 1, fixed = true);
  parameter Real a = 1;
equation
  der(x) = - a * x;
end HelloWorld;





To create a simple time plot the above model HelloWorld is simulated. To
reduce the amount of simulation data in this example the number of
intervals is limited with the argument numberOfIntervals=5. The
simulation is started with the command below.

>>> simulate(HelloWorld, outputFormat="csv", startTime=0, stopTime=4, numberOfIntervals=5)
record SimulationResult
    resultFile = "«DOCHOME»/HelloWorld_res.csv",
    simulationOptions = "startTime = 0.0, stopTime = 4.0, numberOfIntervals = 5, tolerance = 1e-06, method = 'dassl', fileNamePrefix = 'HelloWorld', options = '', outputFormat = 'csv', variableFilter = '.*', cflags = '', simflags = ''",
    messages = "LOG_SUCCESS       | info    | The initialization finished successfully without homotopy method.
LOG_SUCCESS       | info    | The simulation finished successfully.
",
    timeFrontend = 0.008179121000000001,
    timeBackend = 0.012978042,
    timeSimCode = 0.000948899,
    timeTemplates = 0.008469916000000001,
    timeCompile = 0.496648856,
    timeSimulation = 0.009914766,
    timeTotal = 0.5373068759999999
end SimulationResult;





When the simulation is finished the file HelloWorld_res.csv contains the
simulation data:


Listing 1 HelloWorld_res.csv

"time","x","der(x)"
0,1,-1
0.8,0.4493289092712475,-0.4493289092712475
1.6,0.2018973974273906,-0.2018973974273906
2.4,0.09071896372718975,-0.09071896372718975
3.2,0.04076293845066793,-0.04076293845066793
4,0.01831609502171534,-0.01831609502171534
4,0.01831609502171534,-0.01831609502171534







Diagrams are now created with the new OMPlot program by using the
following plot command:


[image: _images/helloworld.svg]Figure 29 Simple 2D plot of the HelloWorld example.



By re-simulating and saving results at many more points, for example using the
default 500 intervals, a much smoother plot can be obtained.
Note that the default solver method dassl has more internal points than the output points in the initial plot.
The results are identical, except the detailed plot has a smoother curve.

>>> 0==system("./HelloWorld -override stepSize=0.008")
true
>>> res:=strtok(readFile("HelloWorld_res.csv"), "\n");
>>> res[end]
"4,0.01831609502171534,-0.01831609502171534"






[image: _images/helloworld-detailed.svg]Figure 30 Simple 2D plot of the HelloWorld example with a larger number of output points.






Plot Command Interface

Plot command have a number of optional arguments to
further customize the the resulting diagram.

>>> list(OpenModelica.Scripting.plot,interfaceOnly=true)
"function plot
  input VariableNames vars \"The variables you want to plot\";
  input Boolean externalWindow = false \"Opens the plot in a new plot window\";
  input String fileName = \"<default>\" \"The filename containing the variables. <default> will read the last simulation result\";
  input String title = \"\" \"This text will be used as the diagram title.\";
  input String grid = \"detailed\" \"Sets the grid for the plot i.e simple, detailed, none.\";
  input Boolean logX = false \"Determines whether or not the horizontal axis is logarithmically scaled.\";
  input Boolean logY = false \"Determines whether or not the vertical axis is logarithmically scaled.\";
  input String xLabel = \"time\" \"This text will be used as the horizontal label in the diagram.\";
  input String yLabel = \"\" \"This text will be used as the vertical label in the diagram.\";
  input Real xRange[2] = {0.0, 0.0} \"Determines the horizontal interval that is visible in the diagram. {0,0} will select a suitable range.\";
  input Real yRange[2] = {0.0, 0.0} \"Determines the vertical interval that is visible in the diagram. {0,0} will select a suitable range.\";
  input Real curveWidth = 1.0 \"Sets the width of the curve.\";
  input Integer curveStyle = 1 \"Sets the style of the curve. SolidLine=1, DashLine=2, DotLine=3, DashDotLine=4, DashDotDotLine=5, Sticks=6, Steps=7.\";
  input String legendPosition = \"top\" \"Sets the POSITION of the legend i.e left, right, top, bottom, none.\";
  input String footer = \"\" \"This text will be used as the diagram footer.\";
  input Boolean autoScale = true \"Use auto scale while plotting.\";
  input Boolean forceOMPlot = false \"if true launches OMPlot and doesn't call callback function even if it is defined.\";
  output Boolean success \"Returns true on success\";
end plot;"
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Solving Modelica Models


Integration Methods

By default OpenModelica transforms a Modelica model into an ODE
representation to perform a simulation by using numerical integration
methods. This section contains additional information about the different
integration methods in OpenModelica. They can be selected by the method
parameter of the simulate command or the -s simflag.

The different methods are also called solver and can be distinguished by
their characteristic:


	explicit vs. implicit


	order


	step size control


	multi step




A good introduction on this topic may be found in [CK06]
and a more mathematical approach can be found in [HNorsettW93].


DASSL

DASSL is the default solver in OpenModelica, because of a severals reasons.
It is an implicit, higher order, multi-step solver with a step-size control
and with these properties it is quite stable for a wide range of models.
Furthermore it has a mature source code, which was originally developed
in the eighties an initial description may be found in [Pet82].

This solver is based on backward differentiation formula (BDF), which is
a family of implicit methods for numerical integration. The used implementation
is called DASPK2.0 (see 2) and it is translated automatically to C
by f2c (see 3).

The following simulation flags can be used to adjust the behavior of the
solver for specific simulation problems:
jacobian,
noRootFinding,
noRestart,
initialStepSize,
maxStepSize,
maxIntegrationOrder,
noEquidistantTimeGrid.




IDA

The IDA solver is part of a software family called sundials: SUite of
Nonlinear and DIfferential/ALgebraic equation Solvers [HBG+05].
The implementation is based on DASPK with an extended linear solver
interface, which includes an interface to the high performance sparse
linear solver KLU [DN10].

The simulation flags of DASSL are also valid for the IDA
solver and furthermore it has the following IDA specific flags:
idaLS,
idaMaxNonLinIters,
idaMaxConvFails,
idaNonLinConvCoef,
idaMaxErrorTestFails.




Basic Explicit Solvers

The basic explicit solvers are performing with a fixed step-size and
differ only in the integration order. The step-size is based on the
numberOfIntervals, the startTime and stopTime parameters in the
simulate command:
[image: \mbox{stepSize} \approx \cfrac{\mbox{stopTime} - \mbox{startTime}}{\mbox{numberOfIntervals}}]


	euler - order 1


	heun - order 2


	rungekutta - order 4







Basic Implicit Solvers

The basic implicit solvers are all based on the non-linear solver KINSOL
from the SUNDIALS suite. The underlining linear solver can be modified
with the simflag -impRKLS. The step-size is
determined as for the basic explicit solvers.


	impeuler  - order 1


	trapezoid - order 2


	imprungekutta - Based on Radau IIA and Lobatto IIIA defined by its
Butcher tableau where the order can be adjusted by -impRKorder.







Experimental Solvers

The following solvers are marked as experimental, mostly because they
are till now not tested very well.


	rungekuttaSsc - Runge-Kutta based on Novikov (2016) - explicit, step-size control, order 4-5


	irksco - Own developed Runge-Kutta solver - implicit, step-size control, order 1-2


	symSolver - Symbolic inline solver (requires --symSolver) - fixed step-size, order 1


	symSolverSsc - Symbolic implicit inline Euler with step-size control (requires --symSolver) - step-size control, order 1-2


	qss - A QSS solver









DAE Mode Simulation

Beside the default ODE simulation, OpenModelica is able to simulate models in
DAE mode. The DAE mode is enabled by the flag --daeMode.
In general the whole equation system of a model is passed to the DAE integrator,
including all algebraic loops. This reduces the amount of work that needs to be
done in the post optimization phase of the OpenModelica backend.
Thus models with large algebraic loops might compile faster in DAE mode.

Once a model is compiled in DAE mode the simulation can be only performed
with SUNDIALS/IDA integrator and with enabled
-daeMode simulation flag. Both are enabled
automatically by default, when a simulation run is started.
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Debugging

There are two main ways to debug Modelica code, the
transformations browser, which shows the
transformations OpenModelica performs on the equations.
There is also a debugger for debugging of algorithm sections and functions.


The Equation-based Debugger

This section gives a short description how to get started using the
equation-based debugger in OMEdit.


Enable Tracing Symbolic Transformations

This enables tracing symbolic transformations of equations. It is
optional but strongly recommended in order to fully use the debugger.
The compilation time overhead from having this tracing on is less than
1%, however, in addition to that, some time is needed for the system to
write the xml file containing the transformation tracing information.

Enable -d=infoXmlOperations in Tools->Options->Simulation (see section
Simulation) OR alternatively click on the checkbox Generate operations in
the info xml in Tools->Options->Debugger (see section Debugger) which
performs the same thing.

This adds all the transformations performed by OpenModelica on the
equations and variables stored in the model_info.xml file. This is
necessary for the debugger to be able to show the whole path from the
source equation(s) to the position of the bug.




Load a Model to Debug

Load an interesting model. We will use the package Debugging.mo [https://github.com/OpenModelica/OMCompiler/blob/master/Examples/Debugging.mo]
since it contains suitable, broken models to demonstrate common errors.




Simulate and Start the Debugger

Select and simulate the model as usual. For example, if using the
Debugging package, select the model
Debugging.Chattering.ChatteringEvents1. If there is an error, you will
get a clickable link that starts the debugger. If the user interface is
unresponsive or the running simulation uses too much processing power,
click cancel simulation first.


[image: _images/omedit-debug-more.png]
Figure 31 Simulating the model.






Use the Transformation Debugger for Browsing

Use the transformation debugger. It opens on the equation where the
error was found. You can browse through the dependencies (variables that
are defined by the equation, or the equation is dependent on), and
similar for variables. The equations and variables form a bipartite
graph that you can walk.

If the -d=infoXmlOperations was used or you clicked the “generate
operations” button, the operations performed on the equations and
variables can be viewed. In the example package, there are not a lot of
operations because the models are small.

Try some larger models, e.g. in the MultiBody library or some other
library, to see more operations with several transformation steps
between different versions of the relevant equation(s). If you do not
trigger any errors in a model, you can still open the debugger, using
File->Open Transformations File (model_info.json).


[image: _images/omedit-transformationsbrowser.png]
Figure 32 Transfomations Browser.








The Algorithmic Debugger

This section gives a short description how to get started using the
algorithmic debugger in OMEdit. See section Simulation for further details
of debugger options.


Adding Breakpoints

There are two ways to add the breakpoints,


	Click directly on the line number in Text View, a red circle is
created indicating a breakpoint as shown in Figure 33.


	Open the Algorithmic Debugger window and add a breakpoint using the
right click menu of Breakpoints Browser window.





[image: _images/omedit-add-breakpoint.png]
Figure 33 Adding breakpoint in Text View.






Start the Algorithmic Debugger

You should add breakpoints before starting the debugger because
sometimes the simulation finishes quickly and you won’t get any chance
to add the breakpoints.

There are four ways to start the debugger,


	Open the Simulation Setup and click on Launch Algorithmic Debugger
before pressing Simulate.


	Right click the model in Libraries Browser and select Simulate with
Algorithmic Debugger.


	Open the Algorithmic Debugger window and from menu select
Debug-> Debug Configurations.


	Open the Algorithmic Debugger window and from menu select
Debug-> Attach to Running Process.







Debug Configurations

If you already have a simulation executable with debugging symbols
outside of OMEdit then you can use the Debug->Debug Configurations
option to load it.

The debugger also supports MetaModelica data structures so one can debug
omc executable. Select omc executable as program and write the name of
the mos script file in Arguments.


[image: _images/omedit-debug-config.png]
Figure 34 Debug Configurations.






Attach to Running Process

If you already have a running simulation executable with debugging
symbols outside of OMEdit then you can use the Debug->Attach to Running
Process option to attach the debugger with it. Figure 35 shows the
Attach to Running Process dialog. The dialog shows the list of processes
running on the machine. The user selects the program that he/she wish to
debug. OMEdit debugger attaches to the process.


[image: _images/omedit-attach-to-process.png]
Figure 35 Attach to Running Process.






Using the Algorithmic Debugger Window

Figure 36 shows the Algorithmic Debugger window. The window contains
the following browsers,


	Stack Frames Browser – shows the list of frames. It contains the
program context buttons like resume, interrupt, exit, step over,
step in, step return. It also contains a threads drop down which
allows switching between different threads.


	BreakPoints Browser – shows the list of breakpoints. Allows
adding/editing/removing breakpoints.


	Locals Browser – Shows the list of local variables with values.
Select the variable and the value will be shown in the bottom
right window. This is just for convenience because some variables
might have long values.


	Debugger CLI – shows the commands sent to gdb and their responses.
This is for advanced users who want to have more control of the
debugger. It allows sending commands to gdb.


	Output Browser – shows the output of the debugged executable.





[image: _images/omedit-algorithmic-debugger.png]
Figure 36 Algorithmic Debugger.
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Generating Graph Representations for Models

The system of equations after symbolic transformation is represented by a graph.
OpenModelica can generate graph representations which can be displayed in the graph tool yed (http://www.yworks.com/products/yed).
The graph generation is activated with the debug flag


+d=graphml



Two different graphml- files are generated in the working directory.
TaskGraph_model.graphml, showing the strongly-connected components of the model and BipartiteGraph_CompleteDAE_model.graphml showing all variables and equations.
When loading the graphs with yEd, all nodes are in one place. Please use the various layout algorithms to get a better overview.


[image: _images/taskgraph.png]
Figure 37 A task-graph representation of a model in yEd




[image: _images/bipartit.png]
Figure 38 A biparite graph representation of a model in yEd
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FMI and TLM-Based Simulation and Co-simulation of External Models


Functional Mock-up Interface - FMI

The new standard for model exchange and co-simulation with Functional
Mockup Interface (FMI [http://www.fmi-standard.org]) allows export of pre-compiled models, i.e.,
C-code or binary code, from a tool for import in another tool, and vice
versa. The FMI standard is Modelica independent. Import and export works
both between different Modelica tools, or between certain non-Modelica
tools. OpenModelica supports FMI 1.0 & 2.0,


	Model Exchange


	Co-Simulation (under development)





FMI Export

To export the FMU use the OpenModelica command
translateModelFMU(ModelName) [https://build.openmodelica.org/Documentation/OpenModelica.Scripting.translateModelFMU.html]
from command line interface, OMShell, OMNotebook or MDT.
The export FMU command is also integrated with OMEdit.
Select FMI > Export FMU the FMU package is generated in the
current directory of omc. You can use the cd() command to see the
current location. You can set which version of FMI to export through
OMEdit settings, see section FMI.

To export the bouncing ball example to an FMU, use the following commands:

>>> loadFile(getInstallationDirectoryPath() + "/share/doc/omc/testmodels/BouncingBall.mo")
true
>>> translateModelFMU(BouncingBall)
"«DOCHOME»/BouncingBall.fmu"
>>> system("unzip -l BouncingBall.fmu | egrep -v 'sources|files' | tail -n+3 | grep -o '[A-Za-z._0-9/]*$' > BB.log")
0





After the command execution is complete you will see that a file
BouncingBall.fmu has been created. Its contents varies depending on the
current platform.
On the machine generating this documentation, the contents in
Listing 2 are generated (along with the C source code).


Listing 2 BouncingBall FMU contents

binaries/
binaries/linux64/
binaries/linux64/BouncingBall_FMU.libs
binaries/linux64/BouncingBall.so
modelDescription.xml







A log file for FMU creation is also generated named ModelName_FMU.log.
If there are some errors while creating FMU they will be shown in the
command line window and logged in this log file as well.

By default an FMU that can be used for both Model Exchange and
Co-Simulation is generated. We only support FMI 2.0 for Co-Simulation FMUs.

Currently the Co-Simulation FMU supports only the forward Euler solver
with root finding which does an Euler step of communicationStepSize
in fmi2DoStep. Events are checked for before and after the call to
fmi2GetDerivatives.




FMI Import

To import the FMU package use the OpenModelica command importFMU,

>>> list(OpenModelica.Scripting.importFMU, interfaceOnly=true)
function importFMU
  input String filename "the fmu file name";
  input String workdir = "<default>" "The output directory for imported FMU files. <default> will put the files to current working directory.";
  input Integer loglevel = 3 "loglevel_nothing=0;loglevel_fatal=1;loglevel_error=2;loglevel_warning=3;loglevel_info=4;loglevel_verbose=5;loglevel_debug=6";
  input Boolean fullPath = false "When true the full output path is returned otherwise only the file name.";
  input Boolean debugLogging = false "When true the FMU's debug output is printed.";
  input Boolean generateInputConnectors = true "When true creates the input connector pins.";
  input Boolean generateOutputConnectors = true "When true creates the output connector pins.";
  output String generatedFileName "Returns the full path of the generated file.";
end importFMU;





The command could be used from command line interface, OMShell,
OMNotebook or MDT. The importFMU command is also integrated with OMEdit.
Select FMI > Import FMU the FMU package is extracted in the directory
specified by workdir, since the workdir parameter is optional so if its
not specified then the current directory of omc is used. You can use the
cd() command to see the current location.

The implementation supports FMI for Model Exchange 1.0 & 2.0 and FMI for
Co-Simulation 1.0 stand-alone. The support for FMI Co-Simulation is
still under development.

The FMI Import is currently a prototype. The prototype has been tested
in OpenModelica with several examples. It has also been tested with
example FMUs from FMUSDK and Dymola. A more fullfleged version for FMI
Import will be released in the near future.

When importing the model into OMEdit, roughly the following commands will be executed:

>>> imported_fmu_mo_file:=importFMU("BouncingBall.fmu")
"BouncingBall_me_FMU.mo"
>>> loadFile(imported_fmu_mo_file)
true





The imported FMU can then be simulated like any normal model:

>>> simulate(BouncingBall_me_FMU, stopTime=3.0)
record SimulationResult
    resultFile = "«DOCHOME»/BouncingBall_me_FMU_res.mat",
    simulationOptions = "startTime = 0.0, stopTime = 3.0, numberOfIntervals = 500, tolerance = 1e-06, method = 'dassl', fileNamePrefix = 'BouncingBall_me_FMU', options = '', outputFormat = 'mat', variableFilter = '.*', cflags = '', simflags = ''",
    messages = "LOG_SUCCESS       | info    | The initialization finished successfully without homotopy method.
LOG_SUCCESS       | info    | The simulation finished successfully.
",
    timeFrontend = 0.040319606,
    timeBackend = 0.012450914,
    timeSimCode = 0.014596719,
    timeTemplates = 0.008796319,
    timeCompile = 0.6137596040000001,
    timeSimulation = 0.03953983199999989,
    timeTotal = 0.72961125
end SimulationResult;






[image: _images/bouncingball_fmu.svg]Figure 39 Height of the bouncing ball, simulated through an FMU.








Transmission Line Modeling (TLM) Based Co-Simulation

This chapter gives a short description how to get started using the TLM-Based
co-simulation accessible via OMEdit.

The TLM Based co-simulation provides the following general functionalities:


	Import and add External non-Modelica models such as Matlab/SimuLink, Adams, and BEAST models


	Import and add External Modelica models e.g. from tools such as Dymola or Wolfram SystemModeler, etc.


	Specify startup methods and interfaces of the external model


	Build the composite models by connecting the external models


	Set the co-simulation parameters in the composite model


	Simulate the composite models using TLM based co-simulation







Composite Model Editing of External Models

The graphical composite model editor is an extension and specialization of the
OpenModelica connection editor OMEdit. A composite model is composed of several
external sub-models including the interconnections between these sub-models.
External models are models which need not be in Modelica, they can be FMUs,
or models accessed by proxies for co-simulation and connected by TLM-connections.
The standard way to store a composite model is in an XML format. The XML schema
standard is accessible from tlmModelDescription.xsd. Currently composite models
can only be used for TLM based co-simulation of external models.


Loading a Composite Model for Co-Simulation

To load the composite model, select File > Open Composite Model(s) from the
menu and select compositemodel.xml.

OMEdit loads the composite model and show it in the Libraries
Browser. Double-clicking the composite model in the Libraries Browser will display
the composite model as shown below in
Figure 40.


[image: _images/tlm-double-pendulum-compositemodel.png]
Figure 40 Composite Model with 3D View.






Co-Simulating the Composite Model

There are two ways to start co-simulation:


	Click TLM Co-Simulation setup button ([image: Composite Model simulate Icon]) from the toolbar (requires a composite model to be active in ModelWidget)





	Right click the composite model in the Libraries Browser and choose TLM Co-Simulation setup from the popup menu (see Figure 41)





[image: _images/tlm-library-browser-popup-menu.png]
Figure 41 Co-simulating and Fetching Interface Data of a composite model from the Popup Menu .



The TLM Co-Simulation setup appears as shown below in Figure 42.


[image: _images/tlm-cosimulation-setup.png]
Figure 42 TLM Co-simulation Setup.



Click Simulate from the Co-simulation setup to confirm the co-simulation.
Figure 43 will appears in which you will be able to see
the progress information of the running co-simulation.


[image: _images/tlm-cosimulation-progress.png]
Figure 43 TLM Co-Simulation Progress.



The editor also provides the means of reading the log files generated by the simulation manager and monitor.
When the simulation ends, click Open Manager Log File or Open Monitor Log File from the co-simulation progress bar
to check the log files.




Plotting the Simulation Results

When the co-simulation of the composite model is completed successful, simulation results are collected and visualized
in the OMEdit plotting perspective as shown in Figure 44 and Figure 45.
The Variables Browser display variables that can be plotted. Each variable has a checkbox, checking it will plot the variable.


[image: _images/tlm-plotting-cosimulation-results.png]
Figure 44 TLM Co-Simulation Results Plotting.




[image: _images/tlm-cosimulation-visualization.png]
Figure 45 TLM Co-Simulation Visualization.






Preparing External Models

First step in co-simulation Modeling is to prepare the different external simulation
models with TLM interfaces. Each external model belongs to a specific simulation
tool, such as MATLAB/Simulink*, BEAST, MSC/ADAMS, Dymola and Wolfram SystemModeler.

When the external models have all been prepared, the next step is to load external models
in OMEdit by selecting the File > Load External Model(s) from the menu.

OMEdit loads the external model and show it in the Libraries Browser
as shown below in Figure 46.


[image: _images/tlm-loaded-external-models-library-browser.png]
Figure 46 External Models in OMEdit.






Creating a New Composite Model

We will use the "Double pendulum" composite model which is a multibody system that
consists of three sub-models: Two OpenModelica Shaft sub-models (Shaft1
and Shaft2) and one SKF/BEAST bearing sub-model that together build a
double pendulum. The SKF/BEAST bearing sub-model is a simplified model with
only three balls to speed up the simulation. Shaft1 is connected with a
spherical joint to the world coordinate system. The end of Shaft1 is
connected via a TLM interface to the outer ring of the BEAST bearing model. The
inner ring of the bearing model is connected via another TLM interface to
Shaft2. Together they build the double pendulum with two shafts, one
spherical OpenModelica joint, and one BEAST bearing.

To create a new composite model select File > New Composite Model from the menu.

Your new composite model will appear in the in the Libraries Browser once created.
To facilitate the process of textual composite modeling and to provide users with a
starting point, the Text View (see Figure 47)
includes the composite model XML elements and the default simulation parameters.


[image: _images/tlm-new-compositemodel-textview.png]
Figure 47 New composite model text view.






Adding Submodels

It is possible to build the double pendulum by drag-and-drop of each simulation
model component (sub-model) from the Libraries Browser to the Diagram View.
To place a component in the Diagram View of the double pendulum model, drag each
external sub-model of the double pendulum (i.e. Shaft1, Shaft2, and
BEAST bearing sub-model) from the Libraries Browser to the Diagram
View.


[image: _images/tlm-add-submodels.png]
Figure 48 Adding sub-models to the double pendulum composite model.






Fetching Submodels Interface Data

To retrieve list of TLM interface data for sub-models, do any of the following methods:


	Click Fetch Interface Data button ([image: Composite Model Interface Data Icon]) from the toolbar (requires a composite model to be active in ModelWidget)





	Right click the composite model in the Library Browser and choose Fetch Interface Data from the popup menu
(see Figure 41).




To retrieve list of TLM interface data for a specific sub-model,


	Right click the sub-model inside the composite model and choose Fetch Interface Data from the popup menu.




Figure 49 will appear in which you will be able to see the progress information
of fetching the interface data.


[image: _images/tlm-fetch-interface-progress.png]
Figure 49 Fetching Interface Data Progress.



Once the TLM interface data of the sub-models are retrieved, the interface points will appear
in the diagram view as shown below in Figure 50.


[image: _images/tlm-fetched-interface-points.png]
Figure 50 Fetching Interface Data.






Connecting Submodels

When the sub-models and interface points have all been placed in the Diagram
View, similar to Figure 50, the next step is to
connect the sub-models. Sub-models are connected using the Connection Line
Button ([image: Connection Line Icon]) from the toolbar.

To connect two sub-models, select the Connection Line Button and place the mouse cursor over an interface
and click the left mouse button, then drag the cursor to the other sub-model interface, and
click the left mouse button again. A connection dialog box as shown below in Figure 51 will
appear in which you will be able to specify the connection attributes.


[image: _images/tlm-submodels-connection-dialog.png]
Figure 51 Sub-models Connection Dialog.



Continue to connect all sub-models until the composite model Diagram View looks like the one in Figure 52 below.


[image: _images/tlm-connecting-submodels-double-pendulum.png]
Figure 52 Connecting sub-models of the Double Pendulum Composite Model.






Changing Parameter Values of Submodels

To change a parameter value of a sub-model, do any of the following methods:


	Double-click on the sub-model you want to change its parameter


	Right click on the sub-model and choose Attributes from the popup menu




The parameter dialog of that sub-model appears as shown below in Figure 53
in which you will be able to specify the sub-models attributes.


[image: _images/tlm-change-submodel-parameters-dialog.png]
Figure 53 Changing Parameter Values of Sub-models Dialog.






Changing Parameter Values of Connections

To change a parameter value of a connection, do any of the following methods:


	Double-click on the connection you want to change its parameter


	Right click on the connection and choose Attributes from the popup menu.




The parameter dialog of that connection appears (see Figure 51)
in which you will be able to specify the connections attributes.




Changing Co-Simulation Parameters

To change the co-simulation parameters, do any of the following methods:


	Click Simulation Parameters button ([image: Composite Model Simulation Parameters Icon]) from the toolbar (requires a composite model to be active in ModelWidget)





	Right click an empty location in the Diagram View of the composite model and choose Simulation Parameters
from the popup menu (see Figure 54)





[image: _images/tlm-change-cosimulation-parameters-popup-menu.png]
Figure 54 Changing Co-Simulation Parameters from the Popup Menu.



The co-simulation parameter dialog of the composite model appears as shown below in Figure 55 in
which you will be able to specify the simulation parameters.


[image: _images/tlm-change-cosimulation-parameters-dialog.png]
Figure 55 Changing Co-Simulation Parameters Dialog.
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OMSimulator

OMSimulator [https://github.com/OpenModelica/OMSimulator] has its own documentation [https://openmodelica.org/doc/OMSimulator/master/html/].





          

      

      

    

  

  
    
    OpenModelica Encryption
    

    
 
  

    
      
          
            
  
OpenModelica Encryption

The encryption module allows the library developers to encrypt their libraries
for different platforms. Note that you need a special version of OpenModelica
with encryption support. Contact us if you want one.


Encrypting the Library

In order to encrypt the Modelica package call buildEncryptedPackage(TopLevelPackageName)
from mos script or from OMEdit right click the package in Libraries Browser and
select Export Encrypted Package or select Export > Export Encrypted Package
from the menu.

All the Modelica files are encrypted and the whole library is zipped into a
single file i.e., PackageName.mol. Note that you can only encrypt Modelica
packages saved in a folder structure. The complete folder structure remains
as it is. No encryption is done on the resource files.




Loading an Encrypted Library

To load the encrypted package call loadEncryptedPackage(EncryptedPackage.mol)
from the mos script or from OMEdit File > Load Encrypted Package.




Notes


	There is no license management and obfuscation of the generated code and
files. However just a basic encryption and decryption is supported along with
full support for protection access annotation as defined in
Modelica specification 18.9. This means that anyone who has an OpenModelica
version with encryption support can encrypt or decrypt files.


	OpenModelica encryption is based on
SEMLA (Safe/Superiour/Super Encryption of Modelica Libraries and Artifacts)
module from Modelon AB.
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OMNotebook with DrModelica and DrControl

This chapter covers the OpenModelica electronic notebook subsystem,
called OMNotebook, together with the DrModelica tutoring system for
teaching Modelica, and DrControl for teaching control together with
Modelica. Both are using such notebooks.


Interactive Notebooks with Literate Programming

Interactive Electronic Notebooks are active documents that may contain
technical computations and text, as well as graphics. Hence, these
documents are suitable to be used for teaching and experimentation,
simulation scripting, model documentation and storage, etc.


Mathematica Notebooks

Literate Programming [Knu84] is a form of
programming where programs are integrated with documentation in the same
document. Mathematica notebooks [Wol96] is one of the first
WYSIWYG systems that support Literate
Programming. Such notebooks are used, e.g., in the MathModelica modeling
and simulation environment, see e.g. Figure 56 below
and Chapter 19 in [Fri04].




OMNotebook

The OMNotebook software [Axe05][Fernstrom06]
is a new open source free software that gives an
interactive WYSIWYG realization of
Literate Programming, a form of programming where programs are
integrated with documentation in the same document.

The OMNotebook facility is actually an interactive WYSIWYG
realization of Literate Programming, a form of programming where programs are
integrated with documentation in the same document.
OMNotebook is a simple open-source software tool for an electronic notebook supporting Modelica.

A more advanced electronic notebook tool, also supporting mathematical
typesetting and many other facilities, is provided by Mathematica
notebooks in the MathModelica environment, see Figure 56.


[image: _images/mathematica-notebooks.svg]Figure 56 Examples of Mathematica notebooks in the MathModelica modeling and
simulation environment.



Traditional documents, e.g. books and reports, essentially always have a
hierarchical structure. They are divided into sections, subsections,
paragraphs, etc. Both the document itself and its sections usually have
headings as labels for easier navigation. This kind of structure is also
reflected in electronic notebooks. Every notebook corresponds to one
document (one file) and contains a tree structure of cells. A cell can
have different kinds of contents, and can even contain other cells. The
notebook hierarchy of cells thus reflects the hierarchy of sections and
subsections in a traditional document such as a book.






DrModelica Tutoring System – an Application of OMNotebook

Understanding programs is hard, especially code written by someone else.
For educational purposes it is essential to be able to show the source
code and to give an explanation of it at the same time.

Moreover, it is important to show the result of the source code’s
execution. In modeling and simulation it is also important to have the
source code, the documentation about the source code, the execution
results of the simulation model, and the documentation of the simulation
results in the same document. The reason is that the problem solving
process in computational simulation is an iterative process that often
requires a modification of the original mathematical model and its
software implementation after the interpretation and validation of the
computed results corresponding to an initial model.

Most of the environments associated with equation-based modeling
languages focus more on providing efficient numerical algorithms rather
than giving attention to the aspects that should facilitate the learning
and teaching of the language. There is a need for an environment
facilitating the learning and understanding of Modelica. These are the
reasons for developing the DrModelica teaching material for Modelica and
for teaching modeling and simulation.

An earlier version of DrModelica was developed using the MathModelica
(now Wolfram SystemModeler) environment. The rest of this chapter is
concerned with the OMNotebook version of DrModelica and on the
OMNotebook tool itself.

DrModelica has a hierarchical structure represented as notebooks. The
front-page notebook is similar to a table of contents that holds all
other notebooks together by providing links to them. This particular
notebook is the first page the user will see (Figure 57).


[image: _images/omnotebook-drmodelica.png]
Figure 57 The front-page notebook of the OMNotebook version of the DrModelica
tutoring system.



In each chapter of DrModelica the user is presented a short summary of
the corresponding chapter of the Modelica book [Fri04]. The
summary introduces some keywords, being hyperlinks that will lead the
user to other notebooks describing the keywords in detail.


[image: _images/omnotebook-helloworld.png]
Figure 58 The HelloWorld class simulated and plotted using the OMNotebook version of DrModelica.



Now, let us consider that the link “HelloWorld” in DrModelica
Section is clicked by the user. The new HelloWorld notebook (see Figure 58),
to which the user is being linked, is not only a textual
description but also contains one or more examples explaining the
specific keyword. In this class, HelloWorld, a differential equation is
specified.

No information in a notebook is fixed, which implies that the user can
add, change, or remove anything in a notebook. Alternatively, the user
can create an entirely new notebook in order to write his/her own
programs or copy examples from other notebooks. This new notebook can be
linked from existing notebooks.


[image: _images/omnotebook-drmodelica-ch9.png]
Figure 59 DrModelica Chapter on Algorithms and Functions in the main page of the
OMNotebook version of DrModelica.



When a class has been successfully evaluated the user can simulate and
plot the result, as previously depicted in Figure 58 for the simple
HelloWorld example model.

After reading a chapter in DrModelica the user can immediately practice
the newly acquired information by doing the exercises that concern the
specific chapter. Exercises have been written in order to elucidate
language constructs step by step based on the pedagogical assumption
that a student learns better “using the strategy of learning by
doing”. The exercises consist of either theoretical questions or
practical programming assignments. All exercises provide answers in
order to give the user immediate feedback.

Figure 59 shows part of Chapter 9 of the
DrModelica teaching material.
Here the user can read about language constructs, like algorithm sections,
when-statements, and reinit equations, and then practice these constructs
by solving the exercises corresponding to the recently studied section.


[image: _images/omnotebook-drmodelica-ex1.png]
Figure 60 Exercise 1 in Chapter 9 of DrModelica.



Exercise 1 from Chapter 9 is shown in Figure 60.
In this exercise the user has the opportunity to practice different
language constructs and then compare the solution to the answer for the exercise.
Notice that the answer is not visible until the Answer section is expanded.
The answer is shown in Figure 61.


[image: _images/omnotebook-drmodelica-ex1-answer.png]
Figure 61 The answer section to Exercise 1 in Chapter 9 of DrModelica.






DrControl Tutorial for Teaching Control Theory

DrControl is an interactive OMNotebook document aimed at teaching
control theory. It is included in the OpenModelica distribution and
appears under the directory:

>>> getInstallationDirectoryPath() + "/share/omnotebook/drcontrol"
"«OPENMODELICAHOME»/share/omnotebook/drcontrol"





The front-page of DrControl resembles a linked table of content that can
be used as a navigation center. The content list contains topics like:


	Getting started


	The control problem in ordinary life


	Feedback loop


	Mathematical modeling


	Transfer function


	Stability


	Example of controlling a DC-motor


	Feedforward compensation


	State-space form


	State observation


	Closed loop control system.


	Reconstructed system


	Linear quadratic optimization


	Linearization




Each entry in this list leads to a new notebook page where either the
theory is explained with Modelica examples or an exercise with a
solution is provided to illustrate the background theory. Below we show
a few sections of DrControl.


Feedback Loop

One of the basic concepts of control theory is using feedback loops
either for neutralizing the disturbances from the surroundings or a
desire for a smoother output.

In Figure 62, control of a simple car model is illustrated where the
car velocity on a road is controlled, first with an open loop control,
and then compared to a closed loop system with a feedback loop. The car
has a mass m, velocity y, and aerodynamic coefficient α. The θ is the
road slope, which in this case can be regarded as noise.


[image: _images/omnotebook-feedback.png]
Figure 62 Feedback loop.



Lets look at the Modelica model for the open loop controlled car:


[image: m \dot y = u - \alpha y - m g * sin(\theta)]


model noFeedback
  import SI = Modelica.SIunits;
  SI.Velocity y;                              // output signal without noise, theta = 0 -> v(t) = 0
  SI.Velocity yNoise;                         // output signal with noise,    theta <> 0 -> v(t) <> 0
  parameter SI.Mass m = 1500;
  parameter Real alpha = 200;
  parameter SI.Angle theta = 5*3.141592/180;
  parameter SI.Acceleration g = 9.82;
  SI.Force u;
  SI.Velocity r=20;
equation
  m*der(y)=u-alpha*y;                          // signal without noise
  m*der(yNoise)=u-alpha*yNoise-m*g*sin(theta); // with noise
  u = 250*r;
end noFeedback;





By applying a road slope angle different from zero the car velocity is
influenced which can be regarded as noise in this model. The output
signal in Figure 63 is stable but an overshoot can be observed
compared to the reference signal. Naturally the overshoot is not desired
and the student will in the next exercise learn how to get rid of this
undesired behavior of the system.

>>> loadModel(Modelica)
true
>>> simulate(noFeedback, stopTime=100)
record SimulationResult
    resultFile = "«DOCHOME»/noFeedback_res.mat",
    simulationOptions = "startTime = 0.0, stopTime = 100.0, numberOfIntervals = 500, tolerance = 1e-06, method = 'dassl', fileNamePrefix = 'noFeedback', options = '', outputFormat = 'mat', variableFilter = '.*', cflags = '', simflags = ''",
    messages = "LOG_SUCCESS       | info    | The initialization finished successfully without homotopy method.
LOG_SUCCESS       | info    | The simulation finished successfully.
",
    timeFrontend = 0.407447987,
    timeBackend = 0.004068031000000001,
    timeSimCode = 0.001868655,
    timeTemplates = 0.800983619,
    timeCompile = 2.475920052,
    timeSimulation = 0.014941906,
    timeTotal = 3.705388826
end SimulationResult;






Warning

Warning: The initial conditions are not fully specified. For more information set -d=initialization. In OMEdit Tools->Options->Simulation->OMCFlags, in OMNotebook call setCommandLineOptions("-d=initialization").






[image: _images/omnotebook-open-loop.svg]Figure 63 Open loop control example.



The closed car model with a proportional regulator is shown below:


[image: u = K*(r-y)]


model withFeedback
  import SI = Modelica.SIunits;
  SI.Velocity y;                                // output signal with feedback link and without noise, theta = 0 -> v(t) = 0
  SI.Velocity yNoise;                           // output signal with feedback link and noise,    theta <> 0 -> v(t) <> 0
  parameter SI.Mass m = 1500;
  parameter Real alpha = 250;
  parameter SI.Angle theta = 5*3.141592/180;
  parameter SI.Acceleration g = 9.82;
  SI.Force u;
  SI.Force uNoise;
  SI.Velocity r=20;
equation
  m*der(y)=u-alpha*y;
  m*der(yNoise)=uNoise-alpha*yNoise-m*g*sin(theta);
  u = 5000*(r-y);
  uNoise = 5000*(r-yNoise);
end withFeedback;





By using the information about the current level of the output signal
and re-tune the regulator the output quantity can be controlled towards
the reference signal smoothly and without an overshoot, as shown in
Figure 64.

In the above simple example the flat modeling approach was adopted since
it was the fastest one to quickly obtain a working model. However, one
could use the object oriented approach and encapsulate the car and
regulator models in separate classes with the Modelica connector
mechanism in between.

>>> loadModel(Modelica)
true
>>> simulate(withFeedback, stopTime=10)
record SimulationResult
    resultFile = "«DOCHOME»/withFeedback_res.mat",
    simulationOptions = "startTime = 0.0, stopTime = 10.0, numberOfIntervals = 500, tolerance = 1e-06, method = 'dassl', fileNamePrefix = 'withFeedback', options = '', outputFormat = 'mat', variableFilter = '.*', cflags = '', simflags = ''",
    messages = "LOG_SUCCESS       | info    | The initialization finished successfully without homotopy method.
LOG_SUCCESS       | info    | The simulation finished successfully.
",
    timeFrontend = 0.203244825,
    timeBackend = 0.002923875,
    timeSimCode = 0.0009526570000000001,
    timeTemplates = 0.013735343,
    timeCompile = 0.552115341,
    timeSimulation = 0.010318694,
    timeTotal = 0.7833793499999999
end SimulationResult;






Warning

Warning: The initial conditions are not fully specified. For more information set -d=initialization. In OMEdit Tools->Options->Simulation->OMCFlags, in OMNotebook call setCommandLineOptions("-d=initialization").






[image: _images/omnotebook-closed-loop.svg]Figure 64 Closed loop control example.






Mathematical Modeling with Characteristic Equations

In most systems the relation between the inputs and outputs can be
described by a linear differential equation. Tearing apart the solution
of the differential equation into homogenous and particular parts is an
important technique taught to the students in engineering courses, also
illustrated in Figure 65.


[image: {{\partial ^{n}y}\over{\partial t^n}} + a_1 {{\partial ^{n-1}y}\over{\partial t^{n-1}}} + \ldots + a_n y = b_0 {{\partial ^{m}u} \over {\partial t^m}} + \ldots + b_{m-1} {{\partial u}\over{\partial t}} + b_m u]


Now let us examine a second order system:


[image: \ddot y + a_1 \dot y + a_2 y = 1]


model NegRoots
  Real y;
  Real der_y;
  parameter Real a1 = 3;
  parameter Real a2 = 2;
equation
  der_y = der(y);
  der(der_y) + a1*der_y + a2*y = 1;
end NegRoots;





Choosing different values for a1 and a2 leads to
different behavior as shown in Figure 66 and Figure 67.


[image: _images/omnotebook-mathematical-modeling-with-characteristic-equation.png]
Figure 65 Mathematical modeling with characteristic equation.



In the first example the values of a1 and a2 are
chosen in such way that the characteristic equation has negative real
roots and thereby a stable output response, see Figure 66.

>>> simulate(NegRoots, stopTime=10)
record SimulationResult
    resultFile = "«DOCHOME»/NegRoots_res.mat",
    simulationOptions = "startTime = 0.0, stopTime = 10.0, numberOfIntervals = 500, tolerance = 1e-06, method = 'dassl', fileNamePrefix = 'NegRoots', options = '', outputFormat = 'mat', variableFilter = '.*', cflags = '', simflags = ''",
    messages = "LOG_SUCCESS       | info    | The initialization finished successfully without homotopy method.
LOG_SUCCESS       | info    | The simulation finished successfully.
",
    timeFrontend = 0.4357755089999999,
    timeBackend = 0.001713664,
    timeSimCode = 0.0005155170000000001,
    timeTemplates = 0.007371666000000001,
    timeCompile = 0.468487675,
    timeSimulation = 0.011291609,
    timeTotal = 0.925299592
end SimulationResult;






Warning

Warning: The initial conditions are not fully specified. For more information set -d=initialization. In OMEdit Tools->Options->Simulation->OMCFlags, in OMNotebook call setCommandLineOptions("-d=initialization").






[image: _images/omnotebook-drcontrol-negroots.svg]Figure 66 Characteristic equation with real negative roots.



The importance of the sign of the roots in the characteristic equation
is illustrated in Figure 66 and
Figure 67, e.g., a stable system
with negative real roots and an unstable system with positive imaginary
roots resulting in oscillations.

model ImgPosRoots
  Real y;
  Real der_y;
  parameter Real a1 = -2;
  parameter Real a2 = 10;
equation
  der_y = der(y);
  der(der_y) + a1*der_y + a2*y = 1;
end ImgPosRoots;





>>> simulate(ImgPosRoots, stopTime=10)
record SimulationResult
    resultFile = "«DOCHOME»/ImgPosRoots_res.mat",
    simulationOptions = "startTime = 0.0, stopTime = 10.0, numberOfIntervals = 500, tolerance = 1e-06, method = 'dassl', fileNamePrefix = 'ImgPosRoots', options = '', outputFormat = 'mat', variableFilter = '.*', cflags = '', simflags = ''",
    messages = "LOG_SUCCESS       | info    | The initialization finished successfully without homotopy method.
LOG_SUCCESS       | info    | The simulation finished successfully.
",
    timeFrontend = 0.567409558,
    timeBackend = 0.001725507,
    timeSimCode = 0.0005386810000000001,
    timeTemplates = 0.6184972,
    timeCompile = 1.431548394,
    timeSimulation = 0.015724714,
    timeTotal = 2.635561933
end SimulationResult;






Warning

Warning: The initial conditions are not fully specified. For more information set -d=initialization. In OMEdit Tools->Options->Simulation->OMCFlags, in OMNotebook call setCommandLineOptions("-d=initialization").






[image: _images/omnotebook-drcontrol-imgposroots.svg]Figure 67 Characteristic equation with imaginary roots with positive real part.




[image: _images/omnotebook-step-pulse.png]
Figure 68 Step and pulse (weight function) response.



The theory and application of Kalman filters is also explained in the
interactive course material.


[image: _images/omnotebook-theory-kalman.png]
Figure 69 Theory background about Kalman filter.



In reality noise is present in almost every physical system under study
and therefore the concept of noise is also introduced in the course
material, which is purely Modelica based.


[image: _images/omnotebook-kalman-noisy-feedback.png]
Figure 70 Comparison of a noisy system with feedback link in DrControl.








OpenModelica Notebook Commands

OMNotebook currently supports the commands and concepts that are
described in this section.


Cells

Everything inside an OMNotebook document is made out of cells. A cell
basically contains a chunk of data. That data can be text, images, or
other cells. OMNotebook has four types of cells: headercell, textcell,
inputcell, and groupcell. Cells are ordered in a tree structure, where
one cell can be a parent to one or more additional cells. A tree view is
available close to the right border in the notebook window to display
the relation between the cells.


	
	Textcell – This cell type is used to display ordinary text and
	images. Each textcell has a style that specifies how text is
displayed. The cell´s style can be changed in the menu
Format->Styles, example of different styles are: Text, Title, and
Subtitle. The Textcell type also has support for following links
to other notebook documents.







	
	Inputcell – This cell type has support for syntax highlighting and
	evaluation. It is intended to be used for writing program code,
e.g. Modelica code. Evaluation is done by pressing the key
combination Shift+Return or Shift+Enter. All the text in the cell
is sent to OMC (OpenModelica Compiler/interpreter), where the
text is evaluated and the result is displayed below the
inputcell. By double-clicking on the cell marker in the tree
view, the inputcell can be collapsed causing the result to be
hidden.







	
	Latexcell – This cell type has support for evaluation of latex scripts.
	It is intended to be mainly used for writing mathematical equations and
formulas for advanced documentation in OMNotebook. Each Latexcell supports
a maximum of one page document output.To evaluate this cell, latex must be
installed in your system.The users can copy and paste the latex scripts and
start the evaluation.Evaluation is done by pressing the key
combination Shift+Return or Shift+Enter or the green color eval button
present in the toolbar. The script in the cell is sent to latex compiler, where it
is evaluated and the output is displayed hiding the latex source. By double-clicking
on the cell marker in the tree view,the latex source is displayed for further modification.







	
	Groupcell – This cell type is used to group together other cell. A
	groupcell can be opened or closed. When a groupcell is opened all
the cells inside the groupcell are visible, but when the
groupcell is closed only the first cell inside the groupcell is
visible. The state of the groupcell is changed by the user
double-clicking on the cell marker in the tree view. When the
groupcell is closed the marker is changed and the marker has an
arrow at the bottom.












Cursors

An OMNotebook document contains cells which in turn contain text. Thus,
two kinds of cursors are needed for positioning, text cursor and cell
cursor:


	
	Textcursor – A cursor between characters in a cell, appearing as a
	small vertical line. Position the cursor by clicking on the text
or using the arrow buttons.







	
	Cellcursor – This cursor shows which cell currently has the input
	focus. It consists of two parts. The main cellcursor is basically
just a thin black horizontal line below the cell with input
focus. The cellcursor is positioned by clicking on a cell,
clicking between cells, or using the menu item Cell->Next Cell or
Cell->Previous Cell. The cursor can also be moved with the key
combination Ctrl+Up or Ctrl+Down. The dynamic cellcursor is a
short blinking horizontal line. To make this visible, you must
click once more on the main cellcursor (the long horizontal
line). NOTE: In order to paste cells at the cellcursor, the
dynamic cellcursor must be made active by clicking on the main
cellcursor (the horizontal line).












Selection of Text or Cells

To perform operations on text or cells we often need to select a range
of characters or cells.


	
	Select characters – There are several ways of selecting characters,
	e.g. double-clicking on a word, clicking and dragging the mouse,
or click followed by a shift-click at an adjacent positioin
selects the text between the previous click and the position of
the most recent shift-click.







	
	Select cells – Cells can be selected by clicking on them. Holding
	down Ctrl and clicking on the cell markers in the tree view
allows several cells to be selected, one at a time. Several cells
can be selected at once in the tree view by holding down the
Shift key. Holding down Shift selects all cells between last
selected cell and the cell clicked on. This only works if both
cells belong to the same groupcell.












File Menu

The following file related operations are available in the file menu:


	
	Create a new notebook – A new notebook can be created using the
	menu File->New or the key combination Ctrl+N. A new document
window will then open, with a new document inside.







	
	Open a notebook – To open a notebook use File->Open in the menu or
	the key combination Ctrl+O. Only files of the type .onb or .nb
can be opened. If a file does not follow the OMNotebook format or
the FullForm Mathematica Notebook format, a message box is
displayed telling the user what is wrong. Mathematica Notebooks
must be converted to fullform before they can be opened in
OMNotebook.







	
	Save a notebook – To save a notebook use the menu item File->Save
	or File->Save As. If the notebook has not been saved before the
save as dialog is shown and a filename can be selected.
OMNotebook can only save in xml format and the saved file is not
compatible with Mathematica. Key combination for save is Ctrl+S
and for save as Ctrl+Shift+S. The saved file by default obtains
the file extension .onb.







	
	Print – Printing a document to a printer is done by pressing the
	key combination Ctrl+P or using the menu item File->Print. A
normal print dialog is displayed where the usually properties can
be changed.







	
	Import old document – Old documents, saved with the old version of
	OMNotebook where a different file format was used, can be opened
using the menu item File->Import->Old OMNotebook file. Old
documents have the extension .xml.







	
	Export text – The text inside a document can be exported to a text
	document. The text is exported to this document without almost
any structure saved. The only structure that is saved is the cell
structure. Each paragraph in the text document will contain text
from one cell. To use the export function, use menu item
File->Export->Pure Text.







	
	Close a notebook window – A notebook window can be closed using the
	menu item File->Close or the key combination Ctrl+F4. Any unsaved
changes in the document are lost when the notebook window is
closed.







	
	Quitting OMNotebook – To quit OMNotebook, use menu item File->Quit
	or the key combination Crtl+Q. This closes all notebook windows;
users will have the option of closing OMC also. OMC will not
automatically shutdown because other programs may still use it.
Evaluating the command quit() has the same result as exiting
OMNotebook.












Edit Menu


	
	Editing cell text – Cells have a set of of basic editing functions.
	The key combination for these are: Undo (Ctrl+Z), Redo (Ctrl+Y),
Cut (Ctrl+X), Copy (Ctrl+C) and Paste (Ctrl+V). These functions
can also be accessed from the edit menu; Undo (Edit->Undo), Redo
(Edit->Redo), Cut (Edit->Cut), Copy (Edit->Copy) and Paste
(Edit->Paste). Selection of text is done in the usual way by
double-clicking, triple-clicking (select a paragraph), dragging
the mouse, or using (Ctrl+A) to select all text within the cell.







	
	Cut cell – Cells can be cut from a document with the menu item
	Edit->Cut or the key combination Ctrl+X. The cut function will
always cut cells if cells have been selected in the tree view,
otherwise the cut function cuts text.







	
	Copy cell – Cells can be copied from a document with the menu item
	Edit->Copy or the key combination Ctrl+C. The copy function will
always copy cells if cells have been selected in the tree view,
otherwise the copy function copy text.







	
	Paste cell – To paste copied or cut cells the cell cursor must be
	selected in the location where the cells should be pasted. This
is done by clicking on the cell cursor. Pasteing cells is done
from the menu Edit->Paste or the key combination Ctrl+V. If the
cell cursor is selected the paste function will always paste
cells. OMNotebook share the same application-wide clipboard.
Therefore cells that have been copied from one document can be
pasted into another document. Only pointers to the copied or cut
cells are added to the clipboard, thus the cell that should be
pasted must still exist. Consequently a cell can not be pasted
from a document that has been closed.







	
	Find – Find text string in the current notebook, with the options
	match full word, match cell, search within closed cells. Short
command Ctrl+F.







	
	Replace – Find and replace text string in the current notebook,
	with the options match full word, match cell, search+replace
within closed cells. Short command Ctrl+H.







	
	View expression – Text in a cell is stored internally as a subset
	of HTML code and the menu item Edit->View Expression let the user
switch between viewing the text or the internal HTML
representation. Changes made to the HTML code will affect how the
text is displayed.












Cell Menu


	
	Add textcell – A new textcell is added with the menu item Cell->Add
	Cell (previous cell style) or the key combination Alt+Enter. The
new textcell gets the same style as the previous selected cell
had.







	
	Add inputcell – A new inputcell is added with the menu item
	Cell->Add Inputcell or the key combination Ctrl+Shift+I.







	
	Add latexcell – A new latexcell is added with the menu item
	Cell->Add Latexcell or the key combination Ctrl+Shift+E.







	
	Add groupcell – A new groupcell is inserted with the menu item
	Cell->Groupcell or the key combination Ctrl+Shift+G. The selected
cell will then become the first cell inside the groupcell.







	
	Ungroup groupcell – A groupcell can be ungrouped by selecting it in
	the tree view and using the menu item Cell->Ungroup Groupcell or
by using the key combination Ctrl+Shift+U. Only one groupcell at
a time can be ungrouped.







	
	Split cell – Spliting a cell is done with the menu item Cell->Split
	cell or the key combination Ctrl+Shift+P. The cell is splited at
the position of the text cursor.







	
	Delete cell – The menu item Cell->Delete Cell will delete all cells
	that have been selected in the tree view. If no cell is selected
this action will delete the cell that have been selected by the
cellcursor. This action can also be called with the key
combination Ctrl+Shift+D or the key Del (only works when cells
have been selected in the tree view).







	
	Cellcursor – This cell type is a special type that shows which cell
	that currently has the focus. The cell is basically just a thin
black line. The cellcursor is moved by clicking on a cell or
using the menu item Cell->Next Cell or Cell->Previous Cell. The
cursor can also be moved with the key combination Ctrl+Up or
Ctrl+Down.












Format Menu


	
	Textcell – This cell type is used to display ordinary text and
	images. Each textcell has a style that specifies how text is
displayed. The cells style can be changed in the menu
Format->Styles, examples of different styles are: Text, Title,
and Subtitle. The Textcell type also have support for following
links to other notebook documents.







	
	Text manipulation – There are a number of different text
	manipulations that can be done to change the appearance of the
text. These manipulations include operations like: changing font,
changing color and make text bold, but also operations like:
changing the alignment of the text and the margin inside the
cell. All text manipulations inside a cell can be done on single
letters, words or the entire text. Text settings are found in the
Format menu. The following text manipulations are available in
OMNotebook:









> Font family

> Font face (Plain, Bold, Italic, Underline)

> Font size

> Font stretch

> Font color

> Text horizontal alignment

> Text vertical alignment

> Border thickness

> Margin (outside the border)

> Padding (inside the border)




Insert Menu


	
	Insert image – Images are added to a document with the menu item
	Insert->Image or the key combination Ctrl+Shift+M. After an image
has been selected a dialog appears, where the size of the image
can be chosen. The images actual size is the default value of the
image. OMNotebook stretches the image accordantly to the selected
size. All images are saved in the same file as the rest of the
document.







	
	Insert link – A document can contain links to other OMNotebook file
	or Mathematica notebook and to add a new link a piece of text
must first be selected. The selected text make up the part of the
link that the user can click on. Inserting a link is done from
the menu Insert->Link or with the key combination Ctrl+Shift+L. A
dialog window, much like the one used to open documents, allows
the user to choose the file that the link refers to. All links
are saved in the document with a relative file path so documents
that belong together easily can be moved from one place to
another without the links failing.












Window Menu


	
	Change window – Each opened document has its own document window.
	To switch between those use the Window menu. The window menu
lists all titles of the open documents, in the same order as they
were opened. To switch to another document, simple click on the
title of that document.












Help Menu


	
	About OMNotebook – Accessing the about message box for OMNotebook
	is done from the menu Help->About OMNotebook.







	
	About Qt – To access the message box for Qt, use the menu
	Help->About Qt.







	
	Help Text – Opening the help text (document OMNotebookHelp.onb) for
	OMNotebook can be done in the same way as any OMNotebook document
is opened or with the menu Help->Help Text. The menu item can
also be triggered with the key F1.












Additional Features


	
	Links – By clicking on a link, OMNotebook will open the document
	that is referred to in the link.







	
	Update link – All links are stored with relative file path.
	Therefore OMNotebook has functions that automatically updating
links if a document is resaved in another folder. Every time a
document is saved, OMNotebook checks if the document is saved in
the same folder as last time. If the folder has changed, the
links are updated.







	
	Evaluate whole Notebook – All the cells present in the Notebook can
	be evaluated in one step by pressing the red color evalall button
in the toolbar. The cells are evaluated in the same order as they
are in the Notebook.However the latexcells cannot be evaluated by
this feature.







	
	Evaluate several cells – Several inputcells can be evaluated at
	the same time by selecting them in the treeview and then pressing
the key combination Shift+Enter or Shift+Return. The cells are
evaluated in the same order as they have been selected. If a
groupcell is selected all inputcells in that groupcell are
evaluated, in the order they are located in the groupcell.







	
	Moving and Reordering cells in a Notebook – It is possible to shift cells
	to a new position and change the hierarchical order of the document.This can
be done by clicking the cell and press the Up and Down arrow button in
the tool bar to move either Up or Down. The cells are moved one cell
above or below.It is also possible to move a cell directly to a new
position with one single click by pressing the red color bidirectional
UpDown arrow button in the toolbar. To do this the user has to place
the cell cursor to a position where the selected cells must be moved.
After selecting the cell cursor position, select the cells you want to
shift and press the bidirectional UpDown arrow button. The cells are
shifted in the same order as they are selected.This is especially very
useful when shifting a group cell.







	
	Command completion – Inputcells have command completion support,
	which checks if the user is typing a command (or any keyword
defined in the file commands.xml) and finish the command. If the
user types the first two or three letters in a command, the
command completion function fills in the rest. To use command
completion, press the key combination Ctrl+Space or Shift+Tab.
The first command that matches the letters written will then
appear. Holding down Shift and pressing Tab (alternative holding
down Ctrl and pressing Space) again will display the second
command that matches. Repeated request to use command completion
will loop through all commands that match the letters written.
When a command is displayed by the command completion
functionality any field inside the command that should be edited
by the user is automatically selected. Some commands can have
several of these fields and by pressing the key combination
Ctrl+Tab, the next field will be selected inside the command. >
Active Command completion: Ctrl+Space / Shift+Tab > Next command:
Ctrl+Space / Shift+Tab > Next field in command: Ctrl+Tab’







	
	Generated plot – When plotting a simulation result, OMC uses the
	program Ptplot to create a plot. From Ptplot OMNotebook gets an
image of the plot and automatically adds that image to the output
part of an inputcell. Like all other images in a document, the
plot is saved in the document file when the document is saved.







	
	Stylesheet –OMNotebook follows the style settings defined in
	stylesheet.xml and the correct style is applied to a cell when
the cell is created.







	
	Automatic Chapter Numbering – OMNotebook automatically numbers
	different chapter, subchapter, section and other styles. The user
can specify which styles should have chapter numbers and which
level the style should have. This is done in the stylesheet.xml
file. Every style can have a <chapterLevel> tag that specifies
the chapter level. Level 0 or no tag at all, means that the style
should not have any chapter numbering.







	
	Scrollarea – Scrolling through a document can be done by using the
	mouse wheel. A document can also be scrolled by moving the cell
cursor up or down.







	
	Syntax highlighter – The syntax highlighter runs in a separated
	thread which speeds up the loading of large document that
contains many Modelica code cells. The syntax highlighter only
highlights when letters are added, not when they are removed. The
color settings for the different types of keywords are stored in
the file modelicacolors.xml. Besides defining the text color and
background color of keywords, whether or not the keywords should
be bold or/and italic can be defined.







	
	Change indicator – A star (*) will appear behind the filename in
	the title of notebook window if the document has been changed and
needs saving. When the user closes a document that has some
unsaved change, OMNotebook asks the user if he/she wants to save
the document before closing. If the document never has been saved
before, the save-as dialog appears so that a filename can be
choosen for the new document.







	
	Update menus – All menus are constantly updated so that only menu
	items that are linked to actions that can be performed on the
currently selected cell is enabled. All other menu items will be
disabled. When a textcell is selected the Format menu is updated
so that it indicates the text settings for the text, in the
current cursor position.
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Optimization with OpenModelica

The following facilities for model-based optimization are provided with
OpenModelica:


	
	Builtin Dynamic Optimization with OpenModelica and IpOpt using
	dynamic optimization is the recommended way of
performing dynamic optimization with OpenModelica.







	
	Dynamic Optimization with OpenModelica and CasADi. Use this if you want to employ
	the CasADi tool for dynamic optimization.







	
	Classical Parameter Sweep Optimization using OMOptim. Use
	this if you have a static optimization problem.










Builtin Dynamic Optimization with OpenModelica and IpOpt

Note: this is a very short preliminary decription which soon will be
considerably improved.

OpenModelica provides builtin dynamic optimization of models by using
the powerful symbolic machinery of the OpenModelica compiler for more
efficient and automatic solution of dynamic optimization problems.

The builtin dynamic optimization allows users to define optimal control
problems (OCP) using the Modelica language for the model and the
optimization language extension called Optimica (currently partially
supported) for the optimization part of the problem. This is used to
solve the underlying dynamic optimization model formulation using
collocation methods, using a single execution instead of multiple
simulations as in the parameter-sweep optimization described in section Parameter Sweep Optimization using OMOptim.

For more detailed information regarding background and methods, see [BOR+12][RBB+14]




Compiling the Modelica code

Before starting the optimization the model should be symbolically
instantiated by the compiler in order to get a single flat system of
equations. The model variables should also be scalarized. The compiler
frontend performs this, including syntax checking, semantics and type
checking, simplification and constant evaluation etc. are applied. Then
the complete flattened model can be used for initialization, simulation
and last but not least for model-based dynamic optimization.

The OpenModelica command optimize(ModelName) from OMShell, OMNotebook or
MDT runs immediately the optimization. The generated result file can be
read in and visualized with OMEdit or within OMNotebook.




An Example

In this section, a simple optimal control problem will be solved. When
formulating the optimization problems, models are expressed in the
Modelica language and optimization specifications. The optimization
language specification allows users to formulate dynamic optimization
problems to be solved by a numerical algorithm. It includes several
constructs including a new specialized class optimization, a constraint
section, startTime, finalTime etc. See the optimal control problem for
batch reactor model below.

Create a new file named BatchReactor.mo and save it in you working
directory. Notice that this model contains both the dynamic system to be
optimized and the optimization specification.

Once we have formulated the undelying optimal control problems, we can
run the optimization by using OMShell, OMNotebook, MDT, OMEdit using
command line terminals similar to the options described below:

>>> setCommandLineOptions("-g=Optimica");






Listing 3 BatchReactor.mo

model BatchReactor
  Real x1(start =1, fixed=true, min=0, max=1);
  Real x2(start =0, fixed=true, min=0, max=1);
  input Real u(min=0, max=5);
equation
  der(x1) = -(u+u^2/2)*x1;
  der(x2) = u*x1;
end BatchReactor;







optimization nmpcBatchReactor(objective=-x2)
  extends BatchReactor;
end nmpcBatchReactor;





>>> optimize(nmpcBatchReactor, numberOfIntervals=16, stopTime=1, tolerance=1e-8)
record SimulationResult
    resultFile = "«DOCHOME»/nmpcBatchReactor_res.mat",
    simulationOptions = "startTime = 0.0, stopTime = 1.0, numberOfIntervals = 16, tolerance = 1e-08, method = 'optimization', fileNamePrefix = 'nmpcBatchReactor', options = '', outputFormat = 'mat', variableFilter = '.*', cflags = '', simflags = ''",
    messages = "LOG_SUCCESS       | info    | The initialization finished successfully without homotopy method.

Optimizer Variables
========================================================
State[0]:x1(start = 1, nominal = 1, min = 0, max = 1, init = 1)
State[1]:x2(start = 0, nominal = 1, min = 0, max = 1, init = 0)
Input[2]:u(start = 0, nominal = 5, min = 0, max = 5)
--------------------------------------------------------
number of nonlinear constraints: 0
========================================================

******************************************************************************
This program contains Ipopt, a library for large-scale nonlinear optimization.
 Ipopt is released as open source code under the Eclipse Public License (EPL).
         For more information visit http://projects.coin-or.org/Ipopt
******************************************************************************

LOG_SUCCESS       | info    | The simulation finished successfully.
",
    timeFrontend = 0.168861614,
    timeBackend = 0.006655534,
    timeSimCode = 0.001403232,
    timeTemplates = 0.1671232539999999,
    timeCompile = 0.535202869,
    timeSimulation = 0.032845707,
    timeTotal = 0.91224193
end SimulationResult;





The control and state trajectories of the optimization results:


[image: _images/nmpc-input.svg]Figure 71 Optimization results for Batch Reactor model – input variables.




[image: _images/nmpc-states.svg]Figure 72 Optimization results for Batch Reactor model – state variables.






Different Options for the Optimizer IPOPT


Table 1 New meanings of the usual simualtion options for Ipopt.






	numberOfIntervals

	
	collocation intervals



	startTime, stopTime

	
	time horizon



	tolerance = 1e-8

	e.g. 1e-8

	solver tolerance



	simflags

	all run/debug options

	












Table 2 New simulation options for Ipopt.






	-lv

	LOG_IPOPT

	console output



	-ipopt_hesse

	CONST,BFGS,NUM

	hessian approximation



	-ipopt_max_iter

	number e.g. 10

	maximal number of iteration for ipopt



	externalInput.csv

	
	input guess









Dynamic Optimization with OpenModelica and CasADi

OpenModelica coupling with CasADi supports dynamic optimization of
models by OpenModelica exporting the optimization problem to CasADi
which performs the optimization. In order to convey the dynamic system
model information between Modelica and CasADi, we use an XML-based model
exchange format for differential-algebraic equations (DAE). OpenModelica
supports export of models written in Modelica and the Optimization
language extension using this XML format, while CasADi supports import
of models represented in this format. This allows users to define
optimal control problems (OCP) using Modelica and Optimization language
specifications, and solve the underlying model formulation using a range
of optimization methods, including direct collocation and direct
multiple shooting.


Compiling the Modelica code

Before exporting a model to XML, the model should be symbolically
instantiated by the compiler in order to get a single flat system of
equations. The model variables should also be scalarized. The compiler
frontend performs this, including syntax checking, semantics and type
checking, simplification and constant evaluation etc. are applied. Then
the complete flattened model is exported to XML code. The exported XML
document can then be imported to CasADi for model-based dynamic
optimization.

The OpenModelica command translateModelXML(ModelName) from OMShell,
OMNotebook or MDT exports the XML. The export XML command is also
integrated with OMEdit. Select XML > Export XML the XML document is
generated in the current directory of omc. You can use the cd() command
to see the current location. After the command execution is complete you
will see that a file ModelName.xml has been exported.

Assuming that the model is defined in the modelName.mo, the model can
also be exported to an XML code using the following steps from the
terminal window:


	Go to the path where your model file found


	Run command omc -g=Optimica --simCodeTarget=XML Model.mo







An example

In this section, a simple optimal control problem will be solved. When
formulating the optimization problems, models are expressed in the
Modelica language and optimization specifications. The optimization
language specification allows users to formulate dynamic optimization
problems to be solved by a numerical algorithm. It includes several
constructs including a new specialized class optimization, a constraint
section, startTime, finalTime etc. See the optimal control problem for
batch reactor model below.

Create a new file named BatchReactor.mo and save it in you working
directory. Notice that this model contains both the dynamic system to be
optimized and the optimization specification.

>>> list(BatchReactor)
model BatchReactor
  Real x1(start = 1, fixed = true, min = 0, max = 1);
  Real x2(start = 0, fixed = true, min = 0, max = 1);
  input Real u(min = 0, max = 5);
equation
  der(x1) = -(u + u ^ 2 / 2) * x1;
  der(x2) = u * x1;
end BatchReactor;





One we have formulated the undelying optimal control problems, we can
export the XML by using OMShell, OMNotebook, MDT, OMEdit or command
line terminals which are described in Section XML Import to CasADi via OpenModelica Python Script.

To export XML, we set the simulation target to XML:

>>> translateModelXML(BatchReactor)
"«DOCHOME»/BatchReactor.xml"





This will generate an XML file named BatchReactor.xml (Listing 4)
that contains a symbolic representation of the optimal control problem
and can be inspected in a standard XML editor.


Listing 4 BatchReactor.xml

<?xml version="1.0" encoding="UTF-8"?>
<OpenModelicaModelDescription
  xmlns:exp="https://svn.jmodelica.org/trunk/XML/daeExpressions.xsd"
  xmlns:equ="https://svn.jmodelica.org/trunk/XML/daeEquations.xsd"
  xmlns:fun="https://svn.jmodelica.org/trunk/XML/daeFunctions.xsd"
  xmlns:opt="https://svn.jmodelica.org/trunk/XML/daeOptimization.xsd"
  xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
  fmiVersion="1.0"
  modelName="BatchReactor"
  modelIdentifier="BatchReactor"
  guid="{de5bcbd1-9ac0-41b7-a26d-b6f2766379ba}"
  generationDateAndTime="2019-11-21T19:39:11"
  variableNamingConvention="structured"
  numberOfContinuousStates="2"
  numberOfEventIndicators="0"
  >
  
  <VendorAnnotations>
    <Tool name="OpenModelica Compiler OMCompiler v1.14.0-dev.beta2.11+gc12c3df1ee"> </Tool>
  </VendorAnnotations>


  <ModelVariables>
    <ScalarVariable name="x1"  valueReference="0" variability="continuous" causality="internal" alias="noAlias">
      <Real start="1.0" fixed="true" min="0.0" max="1.0"  />
      <QualifiedName>
        <exp:QualifiedNamePart name="x1"/>
      </QualifiedName>
    <isLinearTimedVariables>
      <TimePoint index="0" isLinear="true"/>
    </isLinearTimedVariables>
      <VariableCategory>state</VariableCategory>
    </ScalarVariable> 

    <ScalarVariable name="x2"  valueReference="1" variability="continuous" causality="internal" alias="noAlias">
      <Real start="0.0" fixed="true" min="0.0" max="1.0"  />
      <QualifiedName>
        <exp:QualifiedNamePart name="x2"/>
      </QualifiedName>
    <isLinearTimedVariables>
      <TimePoint index="0" isLinear="true"/>
    </isLinearTimedVariables>
      <VariableCategory>state</VariableCategory>
    </ScalarVariable> 
    <ScalarVariable name="der(x1)"  valueReference="2" variability="continuous" causality="internal" alias="noAlias">
      <Real     />
      <QualifiedName>
        <exp:QualifiedNamePart name="x1"/>
      </QualifiedName>
    <isLinearTimedVariables>
      <TimePoint index="0" isLinear="true"/>
    </isLinearTimedVariables>
      <VariableCategory>derivative</VariableCategory>
    </ScalarVariable> 

    <ScalarVariable name="der(x2)"  valueReference="3" variability="continuous" causality="internal" alias="noAlias">
      <Real     />
      <QualifiedName>
        <exp:QualifiedNamePart name="x2"/>
      </QualifiedName>
    <isLinearTimedVariables>
      <TimePoint index="0" isLinear="true"/>
    </isLinearTimedVariables>
      <VariableCategory>derivative</VariableCategory>
    </ScalarVariable> 
    <ScalarVariable name="u"  valueReference="4" variability="continuous" causality="input" alias="noAlias">
      <Real  min="0.0" max="5.0"  />
      <QualifiedName>
        <exp:QualifiedNamePart name="u"/>
      </QualifiedName>
    <isLinearTimedVariables>
      <TimePoint index="0" isLinear="true"/>
    </isLinearTimedVariables>
      <VariableCategory>algebraic</VariableCategory>
    </ScalarVariable> 
  </ModelVariables>

  <equ:BindingEquations>
  </equ:BindingEquations>

  <equ:DynamicEquations>
    <equ:Equation>
      <exp:Sub>
        <exp:Der>
          <exp:Identifier>
            <exp:QualifiedNamePart name="x2"/>
          </exp:Identifier>
        </exp:Der>
        <exp:Mul>
          <exp:Identifier>
            <exp:QualifiedNamePart name="u"/>
          </exp:Identifier>
          <exp:Identifier>
            <exp:QualifiedNamePart name="x1"/>
          </exp:Identifier>
        </exp:Mul>
      </exp:Sub>
    </equ:Equation>  
    <equ:Equation>
      <exp:Sub>
        <exp:Der>
          <exp:Identifier>
            <exp:QualifiedNamePart name="x1"/>
          </exp:Identifier>
        </exp:Der>
        <exp:Mul>
          <exp:Sub>
            <exp:Mul>
              <exp:RealLiteral>-0.5</exp:RealLiteral>
              <exp:Pow>
                <exp:Identifier>
                  <exp:QualifiedNamePart name="u"/>
                </exp:Identifier>
                <exp:RealLiteral>2.0</exp:RealLiteral>
              </exp:Pow>
            </exp:Mul>
            <exp:Identifier>
              <exp:QualifiedNamePart name="u"/>
            </exp:Identifier>
          </exp:Sub>
          <exp:Identifier>
            <exp:QualifiedNamePart name="x1"/>
          </exp:Identifier>
        </exp:Mul>
      </exp:Sub>
    </equ:Equation>  
  </equ:DynamicEquations>

  <equ:InitialEquations>
    <equ:Equation>
      <exp:Sub>
        <exp:Identifier>
          <exp:QualifiedNamePart name="x1"/>
        </exp:Identifier>
        <exp:RealLiteral>1.0</exp:RealLiteral>
      </exp:Sub>
    </equ:Equation>

    <equ:Equation>
      <exp:Sub>
        <exp:Identifier>
          <exp:QualifiedNamePart name="x2"/>
        </exp:Identifier>
        <exp:RealLiteral>0.0</exp:RealLiteral>
      </exp:Sub>
    </equ:Equation>
    <equ:Equation>
      <exp:Sub>
        <exp:Identifier>
          <exp:QualifiedNamePart name="x1"/>
        </exp:Identifier>
        <exp:Identifier>
          <exp:QualifiedNamePart name="$START"/>
          <exp:QualifiedNamePart name="x1"/>
        </exp:Identifier>
      </exp:Sub>
    </equ:Equation>  
    <equ:Equation>
      <exp:Sub>
         
      </exp:Sub>
    </equ:Equation>  
    <equ:Equation>
      <exp:Sub>
         
      </exp:Sub>
    </equ:Equation>  
    <equ:Equation>
      <exp:Sub>
        <exp:Identifier>
          <exp:QualifiedNamePart name="x2"/>
        </exp:Identifier>
        <exp:Identifier>
          <exp:QualifiedNamePart name="$START"/>
          <exp:QualifiedNamePart name="x2"/>
        </exp:Identifier>
      </exp:Sub>
    </equ:Equation>  
  </equ:InitialEquations>

  <fun:Algorithm>
  </fun:Algorithm>

  <fun:RecordsList>
  </fun:RecordsList>

  <fun:FunctionsList>
  </fun:FunctionsList>

  <opt:Optimization>
    <opt:TimePoints>
      <opt:TimePoint  >
      </opt:TimePoint>
    </opt:TimePoints>
    <opt:PathConstraints>
    </opt:PathConstraints>
  </opt:Optimization>

</OpenModelicaModelDescription>










XML Import to CasADi via OpenModelica Python Script

The symbolic optimal control problem representation (or just model
description) contained in BatchReactor.xml can be imported into CasADi
in the form of the SymbolicOCP class via OpenModelica python script.

The SymbolicOCP class contains symbolic representation of the optimal
control problem designed to be general and allow manipulation. For a
more detailed description of this class and its functionalities, we
refer to the API documentation of CasADi.

The following step compiles the model to an XML format, imports to
CasADi and solves an optimization problem in windows PowerShell:


	Create a new file named BatchReactor.mo and save it in you working
directory.


E.g. C:\OpenModelica1.9.2\share\casadi\testmodel









	Perform compilation and generate the XML file


	Go to your working directory





E.g. cd C:\OpenModelica1.9.2\share\casadi\testmodel









	Go to omc path from working directory and run the following command


E.g. ..\..\..\bin\omc +s -g=Optimica --simCodeTarget=XML
BatchReactor.mo








3. Run defaultStart.py python script from OpenModelica optimization
directory

E.g. Python.exe ..\share\casadi\scripts defaultStart.py
BatchReactor.xml

The control and state trajectories of the optimization results are shown
below:

[image: casadi-input] [image: casadi-state]






Parameter Sweep Optimization using OMOptim

OMOptim is a tool for parameter sweep design optimization of Modelica
models. By optimization, one should understand a procedure which
minimizes/maximizes one or more objective functions by adjusting one or
more parameters. This is done by the optimization algorithm performing a
parameter swep, i.e., systematically adjusting values of selected
parameters and running a number of simulations for different parameter
combinations to find a parameter setting that gives an optimal value of
the goal function.

OMOptim 0.9 contains meta-heuristic optimization algorithms which allow
optimizing all sorts of models with following functionalities:


	One or several objectives optimized simultaneously


	One or several parameters (integer or real variables)




However, the user must be aware of the large number of simulations an
optimization might require.


Preparing the Model

Before launching OMOptim, one must prepare the model in order to
optimize it.


Parameters

An optimization parameter is picked up from all model variables. The
choice of parameters can be done using the OMOptim interface.

For all intended parameters, please note that:


	
	The corresponding variable is constant during all simulations.
	The OMOptim optimization in version 0.9 only concerns static
parameters’ optimization i.e. values found for these parameters
will be constant during all simulation time.







	
	The corresponding variable should play an input role in the model
	i.e. its modification influences model simulation results.












Constraints

If some constraints should be respected during optimization, they must
be defined in the Modelica model itself.

For instance, if mechanical stress must be less than 5 N.m-2,
one should write in the model:

assert(mechanicalStress < 5, "Mechanical stress too high");





If during simulation, the variable mechanicalStress exceeds 5
N.m-2, the simulation will stop and be considered as a failure.




Objectives

As parameters, objectives are picked up from model variables.
Objectives’ values are considered by the optimizer at the final time.






Set problem in OMOptim


Launch OMOptim

OMOptim can be launched using the executable placed in
OpenModelicaInstallationDirectory/bin/ OMOptim/OMOptim.exe. Alternately,
choose OpenModelica > OMOptim from the start menu.




Create a new project

To create a new project, click on menu File -> New project

Then set a name to the project and save it in a dedicated folder. The
created file created has a .min extension. It will contain information
regarding model, problems, and results loaded.




Load models

First, you need to load the model(s) you want to optimize. To do so,
click on Add .mo button on main window or select menu Model -> Load
Mo file…

When selecting a model, the file will be loaded in OpenModelica which
runs in the background.

While OpenModelica is loading the model, you could have a frozen
interface. This is due to multi-threading limitation but the delay
should be short (few seconds).

You can load as many models as you want.

If an error occurs (indicated in log window), this might be because:


	Dependencies have not been loaded before (e.g. modelica library)


	Model use syntax incompatible with OpenModelica.




Dependencies

OMOptim should detect dependencies and load corresponding files.
However, it some errors occur, please load by yourself dependencies. You
can also load Modelica library using Model->Load Modelica library.

When the model correctly loaded, you should see a window similar to Figure 73.


[image: _images/omoptim-loaded.png]
Figure 73 OMOptim window after having loaded model.






Create a new optimization problem

Problem->Add Problem->Optimization

A dialog should appear. Select the model you want to optimize. Only
Model can be selected (no Package, Component, Block…).

A new form will be displayed. This form has two tabs. One is called
Variables, the other is called Optimization.


[image: _images/omoptim-define-new-problem.png]
Figure 74 Forms for defining a new optimization problem.



List of Variables is Empty

If variables are not displayed, right click on model name in model
hierarchy, and select Read variables.


[image: _images/omoptim-setup-model.png]
Figure 75 Selecting read variables, set parameters, and selecting simulator.






Select Optimized Variables

To set optimization, we first have to define the variables the optimizer
will consider as free i.e. those that it should find best values of.
To do this, select in the left list, the variables concerned. Then, add
them to Optimized variables by clicking on corresponding button
([image: omoptim-blue-cross]).

For each variable, you must set minimum and maximum values it can take.
This can be done in the Optimized variables table.




Select objectives

Objectives correspond to the final values of chosen variables. To select
these last, select in left list variables concerned and click [image: omoptim-blue-cross]
button of Optimization objectives table.

For each objective, you must:


	
	Set minimum and maximum values it can take. If a configuration does
	not respect these values, this configuration won’t be considered.
You also can set minimum and maximum equals to “-“ : it will then







	Define whether objective should be minimized or maximized.




This can be done in the Optimized variables table.




Select and configure algorithm

After having selected variables and objectives, you should now select
and configure optimization algorithm. To do this, click on
Optimization tab.

Here, you can select optimization algorithm you want to use. In version
0.9, OMOptim offers three different genetic algorithms. Let’s for
example choose SPEA2Adapt which is an auto-adaptative genetic algorithm.

By clicking on parameters… button, a dialog is opened allowing
defining parameters. These are:


	
	Population size: this is the number of configurations kept after a
	generation. If it is set to 50, your final result can’t contain
more than 50 different points.







	
	Off spring rate: this is the number of children per adult obtained
	after combination process. If it is set to 3, each generation
will contain 150 individual (considering population size is 50).







	
	Max generations: this number defines the number of generations
	after which optimization should stop. In our case, each
generation corresponds to 150 simulations. Note that you can
still stop optimization while it is running by clicking on stop
button (which will appear once optimization is launched).
Therefore, you can set a really high number and still stop
optimization when you want without losing results obtained until
there.







	
	Save frequency: during optimization, best configurations can be
	regularly saved. It allows to analyze evolution of best
configurations but also to restart an optimization from
previously obtained results. A Save Frequency parameter set to 3
means that after three generations, a file is automatically
created containing best configurations. These files are named
iteraion1.sav, iteration2.sav and are store in Temp directory,
and moved to SolvedProblems directory when optimization is
finished.







	
	ReinitStdDev: this is a specific parameter of EAAdapt1. It defines
	whether standard deviation of variables should be reinitialized.
It is used only if you start optimization from previously
obtained configurations (using Use start file option). Setting
it to yes (1) will, in most of cases, lead to a spread research
of optimized configurations, forgetting parameters’ variations’
reduction obtained in previous optimization.









Use start file

As indicated before, it is possible to pursue an optimization finished
or stopped. To do this, you must enable Use start file option and
select file from which optimization should be started. This file is an
iteration_.sav file created in previous optimization. It is stored in
corresponding SolvedProblems folder (iteration10.sav corresponds to
the tenth generation of previous optimization).

*Note that this functionality can only work with same variables and
objectives*. However, minimum, maximum of variables and objectives can
be changed before pursuing an optimization.




Launch

You can now launch Optimization by clicking Launch button.




Stopping Optimization

Optimization will be stopped when the generation counter will reach the
generation number defined in parameters. However, you can still stop the
optimization while it is running without loosing obtained results. To do
this, click on Stop button. Note that this will not immediately stop
optimization: it will first finish the current generation.

This stop function is especially useful when optimum points do not vary
any more between generations. This can be easily observed since at each
generation, the optimum objectives values and corresponding parameters
are displayed in log window.






Results

The result tab appear when the optimization is finished. It consists of
two parts: a table where variables are displayed and a plot region.


Obtaining all Variable Values

During optimization, the values of optimized variables and objectives
are memorized. The others are not. To get these last, you must
recomputed corresponding points. To achieve this, select one or several
points in point’s list region and click on recompute.

For each point, it will simulate model setting input parameters to point
corresponding values. All values of this point (including those which
are not optimization parameters neither objectives).






Window Regions in OMOptim GUI


[image: _images/omoptim-window-regions.png]
Figure 76 Window regions in OMOptim GUI.
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Parameter Sensitivities with OpenModelica

This section describes the use of OpenModelica to compute parameter
sensitivities using forward sensitivity analysis together with the
Sundials/IDA solver.

Note: this is a very short preliminary description which soon will be
considerably improved, since this a rather new feature and will
continuous improved.

Note: OpenModelica version 1.10 or newer is required.


Background

Parameter sensitivity analysis aims at analyzing the behavior of the
corresponding model states w.r.t. model parameters.

Formally, consider a Modelica model as a DAE system:


[image: F(x, \dot x, y, p, t) = 0 \; x(t_0) = x_0(p)]


where
[image: x(t) \in \mathbf{R}^n] represent state variables,
[image: \dot x(t) \in \mathbf{R}^n] represent state derivatives,
[image: y(t) \in \mathbf{R}^k] represent algebraic variables,
[image: p \in \mathbf{R}^m] model parameters.

For parameter sensitivity analysis the derivatives


[image: \frac{\partial x}{ \partial p}]


are required which quantify, according to their mathematical definition,
the impact of parameters [image: p] on states [image: x].
In the Sundials/IDA implementation the derivatives are used to evolve the
solution over the time by:


[image: \dot s_i = \frac{\partial x}{ \partial p_i}]





An Example

This section demonstrates the usage of the sensitivities analysis in
OpenModelica on an example. This module is enabled by the following
OpenModelica compiler flag:








Listing 5 LotkaVolterra.mo

model LotkaVolterra
  Real x(start=5, fixed=true),y(start=3, fixed=true);
  parameter Real mu1=5,mu2=2;
  parameter Real lambda1=3,lambda2=1;
equation
  0 = x*(mu1-lambda1*y) - der(x);
  0 = -y* (mu2 -lambda2*x) - der(y);
end LotkaVolterra;







Also for the simulation it is needed to set IDA as solver integration
method and add a further simulation flag -idaSensitivity to calculate
the parameter sensitivities during the normal simulation.

>>> simulate(LotkaVolterra, method="ida", simflags="-idaSensitivity")
record SimulationResult
    resultFile = "",
    simulationOptions = "startTime = 0.0, stopTime = 1.0, numberOfIntervals = 500, tolerance = 1e-06, method = 'ida', fileNamePrefix = 'LotkaVolterra', options = '', outputFormat = 'mat', variableFilter = '.*', cflags = '', simflags = '-idaSensitivity'",
    messages = "Simulation execution failed for model: LotkaVolterra
assert            | debug   | ##IDA## set IDASensInit failed!
",
    timeFrontend = 0.010409925,
    timeBackend = 0.012620141,
    timeSimCode = 0.001096496,
    timeTemplates = 0.007556313,
    timeCompile = 0.5129096550000001
end SimulationResult;





Now all calculated sensitivities are stored into the results mat file under
the $Sensitivities block, where all currently every
top-level parameter of the Real type is used to calculate the
sensitivities w.r.t. every state.


Error

Unable to execute gnuplot directive

Expected {quoted string, starting with " ending with " | Combine:({["-"] {"0" | W:(1234...,0123...)} [{"." W:(0123...)}] [{W:(eE) W:(0123...,0123...)}]}) | Forward: Group:({{{{{Suppress:("record") Suppress:(Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "." Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "." Forward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}}} | W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '})} Dict:(Group:({{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} Suppress:("=")} Forward: {{{{{{{{{quoted string, starting with " ending with " | Combine:({{{["-"] {"0" | W:(1234...,0123...)}} [{"." W:(0123...)}]} [{W:(eE) W:(0123...,0123...)}]})} | Forward: None} | Group:({{Suppress:("{") [Forward: None [, Forward: None]...]} Suppress:("}")})} | Group:({{Suppress:("(") [Forward: None [, Forward: None]...]} Suppress:(")")})} | {{{Suppress:("SOME") Suppress:("(")} Forward: ...} Suppress:(")")}} | "true"} | "false"} | {{"NONE" Suppress:("(")} Suppress:(")")}} | Combine:(Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "."} Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "."} Forward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}}} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}})}}) [, Group:({{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} Suppress:("=")} Forward: {{{{{{{{{quoted string, starting with " ending with " | Combine:({{{["-"] {"0" | W:(1234...,0123...)}} [{"." W:(0123...)}]} [{W:(eE) W:(0123...,0123...)}]})} | Forward: None} | Group:({{Suppress:("{") [Forward: None [, Forward: None]...]} Suppress:("}")})} | Group:({{Suppress:("(") [Forward: None [, Forward: None]...]} Suppress:(")")})} | {{{Suppress:("SOME") Suppress:("(")} Forward: ...} Suppress:(")")}} | "true"} | "false"} | {{"NONE" Suppress:("(")} Suppress:(")")}} | Combine:(Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "."} Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "."} Forward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}}} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}})}})]...)} Suppress:("end")} Suppress:(Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "." Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "." Forward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}}} | W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '})} Suppress:(";")}) | Group:({Suppress:("{") [Forward: None [, Forward: None]...] Suppress:("}")}) | Group:({Suppress:("(") [Forward: None [, Forward: None]...] Suppress:(")")}) | {Suppress:("SOME") Suppress:("(") Forward: {{{{{{{{{quoted string, starting with " ending with " | Combine:({["-"] {"0" | W:(1234...,0123...)} [{"." W:(0123...)}] [{W:(eE) W:(0123...,0123...)}]})} | Forward: Group:({{{{{Suppress:("record") Suppress:(Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "." Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "." Forward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}}} | W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '})} Dict:(Group:({{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} Suppress:("=")} Forward: {{{{{{{{{quoted string, starting with " ending with " | Combine:({{{["-"] {"0" | W:(1234...,0123...)}} [{"." W:(0123...)}]} [{W:(eE) W:(0123...,0123...)}]})} | Forward: None} | Group:({{Suppress:("{") [Forward: None [, Forward: None]...]} Suppress:("}")})} | Group:({{Suppress:("(") [Forward: None [, Forward: None]...]} Suppress:(")")})} | {{{Suppress:("SOME") Suppress:("(")} Forward: ...} Suppress:(")")}} | "true"} | "false"} | {{"NONE" Suppress:("(")} Suppress:(")")}} | Combine:(Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "."} Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "."} Forward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}}} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}})}}) [, Group:({{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} Suppress:("=")} Forward: {{{{{{{{{quoted string, starting with " ending with " | Combine:({{{["-"] {"0" | W:(1234...,0123...)}} [{"." W:(0123...)}]} [{W:(eE) W:(0123...,0123...)}]})} | Forward: None} | Group:({{Suppress:("{") [Forward: None [, Forward: None]...]} Suppress:("}")})} | Group:({{Suppress:("(") [Forward: None [, Forward: None]...]} Suppress:(")")})} | {{{Suppress:("SOME") Suppress:("(")} Forward: ...} Suppress:(")")}} | "true"} | "false"} | {{"NONE" Suppress:("(")} Suppress:(")")}} | Combine:(Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "."} Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "."} Forward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}}} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}})}})]...)} Suppress:("end")} Suppress:(Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "." Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "." Forward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}}} | W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '})} Suppress:(";")})} | Group:({{Suppress:("{") [Forward: None [, Forward: None]...]} Suppress:("}")})} | Group:({{Suppress:("(") [Forward: None [, Forward: None]...]} Suppress:(")")})} | {{{Suppress:("SOME") Suppress:("(")} Forward: ...} Suppress:(")")}} | "true"} | "false"} | {{"NONE" Suppress:("(")} Suppress:(")")}} | Combine:(Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "."} Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "."} Forward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}}} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}})} Suppress:(")")} | "true" | "false" | {"NONE" Suppress:("(") Suppress:(")")} | Combine:(Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "." Forward: ...} | W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '})} (at char 1), (line:2, col:1)
Traceback (most recent call last):
  File "/usr/local/lib/python3.6/dist-packages/pyparsing.py", line 1562, in _parseNoCache
    loc,tokens = self.parseImpl( instring, preloc, doActions )
  File "/usr/local/lib/python3.6/dist-packages/pyparsing.py", line 3235, in parseImpl
    result = instring[loc] == self.firstQuoteChar and self.re.match(instring,loc) or None
IndexError: string index out of range

During handling of the above exception, another exception occurred:

Traceback (most recent call last):
  File "/var/lib/jenkins1/ws/OpenModelica_maintenance_v1.14/doc/UsersGuide/source/sphinxcontribopenmodelica.py", line 173, in run
    filename = os.path.abspath(self.options.get('filename') or omc.sendExpression("currentSimulationResult"))
  File "/usr/local/lib/python3.6/dist-packages/OMPython/__init__.py", line 606, in sendExpression
    answer = OMTypedParser.parseString(result)
  File "/usr/local/lib/python3.6/dist-packages/OMPython/OMTypedParser.py", line 120, in parseString
    return omcGrammar.parseString(string)[0]
  File "/usr/local/lib/python3.6/dist-packages/pyparsing.py", line 1828, in parseString
    raise exc
  File "/usr/local/lib/python3.6/dist-packages/pyparsing.py", line 1818, in parseString
    loc, tokens = self._parse( instring, 0 )
  File "/usr/local/lib/python3.6/dist-packages/pyparsing.py", line 1562, in _parseNoCache
    loc,tokens = self.parseImpl( instring, preloc, doActions )
  File "/usr/local/lib/python3.6/dist-packages/pyparsing.py", line 3735, in parseImpl
    loc, resultlist = self.exprs[0]._parse( instring, loc, doActions, callPreParse=False )
  File "/usr/local/lib/python3.6/dist-packages/pyparsing.py", line 1562, in _parseNoCache
    loc,tokens = self.parseImpl( instring, preloc, doActions )
  File "/usr/local/lib/python3.6/dist-packages/pyparsing.py", line 4098, in parseImpl
    return self.expr._parse( instring, loc, doActions, callPreParse=False )
  File "/usr/local/lib/python3.6/dist-packages/pyparsing.py", line 1562, in _parseNoCache
    loc,tokens = self.parseImpl( instring, preloc, doActions )
  File "/usr/local/lib/python3.6/dist-packages/pyparsing.py", line 3917, in parseImpl
    raise maxException
  File "/usr/local/lib/python3.6/dist-packages/pyparsing.py", line 3902, in parseImpl
    ret = e._parse( instring, loc, doActions )
  File "/usr/local/lib/python3.6/dist-packages/pyparsing.py", line 1564, in _parseNoCache
    raise ParseException( instring, len(instring), self.errmsg, self )
pyparsing.ParseException: Expected {quoted string, starting with " ending with " | Combine:({["-"] {"0" | W:(1234...,0123...)} [{"." W:(0123...)}] [{W:(eE) W:(0123...,0123...)}]}) | Forward: Group:({{{{{Suppress:("record") Suppress:(Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "." Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "." Forward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}}} | W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '})} Dict:(Group:({{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} Suppress:("=")} Forward: {{{{{{{{{quoted string, starting with " ending with " | Combine:({{{["-"] {"0" | W:(1234...,0123...)}} [{"." W:(0123...)}]} [{W:(eE) W:(0123...,0123...)}]})} | Forward: None} | Group:({{Suppress:("{") [Forward: None [, Forward: None]...]} Suppress:("}")})} | Group:({{Suppress:("(") [Forward: None [, Forward: None]...]} Suppress:(")")})} | {{{Suppress:("SOME") Suppress:("(")} Forward: ...} Suppress:(")")}} | "true"} | "false"} | {{"NONE" Suppress:("(")} Suppress:(")")}} | Combine:(Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "."} Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "."} Forward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}}} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}})}}) [, Group:({{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} Suppress:("=")} Forward: {{{{{{{{{quoted string, starting with " ending with " | Combine:({{{["-"] {"0" | W:(1234...,0123...)}} [{"." W:(0123...)}]} [{W:(eE) W:(0123...,0123...)}]})} | Forward: None} | Group:({{Suppress:("{") [Forward: None [, Forward: None]...]} Suppress:("}")})} | Group:({{Suppress:("(") [Forward: None [, Forward: None]...]} Suppress:(")")})} | {{{Suppress:("SOME") Suppress:("(")} Forward: ...} Suppress:(")")}} | "true"} | "false"} | {{"NONE" Suppress:("(")} Suppress:(")")}} | Combine:(Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "."} Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "."} Forward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}}} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}})}})]...)} Suppress:("end")} Suppress:(Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "." Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "." Forward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}}} | W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '})} Suppress:(";")}) | Group:({Suppress:("{") [Forward: None [, Forward: None]...] Suppress:("}")}) | Group:({Suppress:("(") [Forward: None [, Forward: None]...] Suppress:(")")}) | {Suppress:("SOME") Suppress:("(") Forward: {{{{{{{{{quoted string, starting with " ending with " | Combine:({["-"] {"0" | W:(1234...,0123...)} [{"." W:(0123...)}] [{W:(eE) W:(0123...,0123...)}]})} | Forward: Group:({{{{{Suppress:("record") Suppress:(Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "." Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "." Forward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}}} | W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '})} Dict:(Group:({{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} Suppress:("=")} Forward: {{{{{{{{{quoted string, starting with " ending with " | Combine:({{{["-"] {"0" | W:(1234...,0123...)}} [{"." W:(0123...)}]} [{W:(eE) W:(0123...,0123...)}]})} | Forward: None} | Group:({{Suppress:("{") [Forward: None [, Forward: None]...]} Suppress:("}")})} | Group:({{Suppress:("(") [Forward: None [, Forward: None]...]} Suppress:(")")})} | {{{Suppress:("SOME") Suppress:("(")} Forward: ...} Suppress:(")")}} | "true"} | "false"} | {{"NONE" Suppress:("(")} Suppress:(")")}} | Combine:(Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "."} Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "."} Forward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}}} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}})}}) [, Group:({{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} Suppress:("=")} Forward: {{{{{{{{{quoted string, starting with " ending with " | Combine:({{{["-"] {"0" | W:(1234...,0123...)}} [{"." W:(0123...)}]} [{W:(eE) W:(0123...,0123...)}]})} | Forward: None} | Group:({{Suppress:("{") [Forward: None [, Forward: None]...]} Suppress:("}")})} | Group:({{Suppress:("(") [Forward: None [, Forward: None]...]} Suppress:(")")})} | {{{Suppress:("SOME") Suppress:("(")} Forward: ...} Suppress:(")")}} | "true"} | "false"} | {{"NONE" Suppress:("(")} Suppress:(")")}} | Combine:(Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "."} Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "."} Forward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}}} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}})}})]...)} Suppress:("end")} Suppress:(Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "." Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "." Forward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}}} | W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '})} Suppress:(";")})} | Group:({{Suppress:("{") [Forward: None [, Forward: None]...]} Suppress:("}")})} | Group:({{Suppress:("(") [Forward: None [, Forward: None]...]} Suppress:(")")})} | {{{Suppress:("SOME") Suppress:("(")} Forward: ...} Suppress:(")")}} | "true"} | "false"} | {{"NONE" Suppress:("(")} Suppress:(")")}} | Combine:(Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "."} Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "."} Forward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}}} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}})} Suppress:(")")} | "true" | "false" | {"NONE" Suppress:("(") Suppress:(")")} | Combine:(Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "." Forward: ...} | W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '})} (at char 1), (line:2, col:1)





Error

Unable to execute gnuplot directive

Expected {quoted string, starting with " ending with " | Combine:({["-"] {"0" | W:(1234...,0123...)} [{"." W:(0123...)}] [{W:(eE) W:(0123...,0123...)}]}) | Forward: Group:({{{{{Suppress:("record") Suppress:(Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "." Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "." Forward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}}} | W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '})} Dict:(Group:({{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} Suppress:("=")} Forward: {{{{{{{{{quoted string, starting with " ending with " | Combine:({{{["-"] {"0" | W:(1234...,0123...)}} [{"." W:(0123...)}]} [{W:(eE) W:(0123...,0123...)}]})} | Forward: None} | Group:({{Suppress:("{") [Forward: None [, Forward: None]...]} Suppress:("}")})} | Group:({{Suppress:("(") [Forward: None [, Forward: None]...]} Suppress:(")")})} | {{{Suppress:("SOME") Suppress:("(")} Forward: ...} Suppress:(")")}} | "true"} | "false"} | {{"NONE" Suppress:("(")} Suppress:(")")}} | Combine:(Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "."} Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "."} Forward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}}} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}})}}) [, Group:({{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} Suppress:("=")} Forward: {{{{{{{{{quoted string, starting with " ending with " | Combine:({{{["-"] {"0" | W:(1234...,0123...)}} [{"." W:(0123...)}]} [{W:(eE) W:(0123...,0123...)}]})} | Forward: None} | Group:({{Suppress:("{") [Forward: None [, Forward: None]...]} Suppress:("}")})} | Group:({{Suppress:("(") [Forward: None [, Forward: None]...]} Suppress:(")")})} | {{{Suppress:("SOME") Suppress:("(")} Forward: ...} Suppress:(")")}} | "true"} | "false"} | {{"NONE" Suppress:("(")} Suppress:(")")}} | Combine:(Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "."} Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "."} Forward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}}} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}})}})]...)} Suppress:("end")} Suppress:(Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "." Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "." Forward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}}} | W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '})} Suppress:(";")}) | Group:({Suppress:("{") [Forward: None [, Forward: None]...] Suppress:("}")}) | Group:({Suppress:("(") [Forward: None [, Forward: None]...] Suppress:(")")}) | {Suppress:("SOME") Suppress:("(") Forward: {{{{{{{{{quoted string, starting with " ending with " | Combine:({["-"] {"0" | W:(1234...,0123...)} [{"." W:(0123...)}] [{W:(eE) W:(0123...,0123...)}]})} | Forward: Group:({{{{{Suppress:("record") Suppress:(Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "." Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "." Forward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}}} | W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '})} Dict:(Group:({{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} Suppress:("=")} Forward: {{{{{{{{{quoted string, starting with " ending with " | Combine:({{{["-"] {"0" | W:(1234...,0123...)}} [{"." W:(0123...)}]} [{W:(eE) W:(0123...,0123...)}]})} | Forward: None} | Group:({{Suppress:("{") [Forward: None [, Forward: None]...]} Suppress:("}")})} | Group:({{Suppress:("(") [Forward: None [, Forward: None]...]} Suppress:(")")})} | {{{Suppress:("SOME") Suppress:("(")} Forward: ...} Suppress:(")")}} | "true"} | "false"} | {{"NONE" Suppress:("(")} Suppress:(")")}} | Combine:(Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "."} Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "."} Forward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}}} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}})}}) [, Group:({{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} Suppress:("=")} Forward: {{{{{{{{{quoted string, starting with " ending with " | Combine:({{{["-"] {"0" | W:(1234...,0123...)}} [{"." W:(0123...)}]} [{W:(eE) W:(0123...,0123...)}]})} | Forward: None} | Group:({{Suppress:("{") [Forward: None [, Forward: None]...]} Suppress:("}")})} | Group:({{Suppress:("(") [Forward: None [, Forward: None]...]} Suppress:(")")})} | {{{Suppress:("SOME") Suppress:("(")} Forward: ...} Suppress:(")")}} | "true"} | "false"} | {{"NONE" Suppress:("(")} Suppress:(")")}} | Combine:(Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "."} Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "."} Forward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}}} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}})}})]...)} Suppress:("end")} Suppress:(Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "." Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "." Forward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}}} | W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '})} Suppress:(";")})} | Group:({{Suppress:("{") [Forward: None [, Forward: None]...]} Suppress:("}")})} | Group:({{Suppress:("(") [Forward: None [, Forward: None]...]} Suppress:(")")})} | {{{Suppress:("SOME") Suppress:("(")} Forward: ...} Suppress:(")")}} | "true"} | "false"} | {{"NONE" Suppress:("(")} Suppress:(")")}} | Combine:(Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "."} Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "."} Forward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}}} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}})} Suppress:(")")} | "true" | "false" | {"NONE" Suppress:("(") Suppress:(")")} | Combine:(Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "." Forward: ...} | W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '})} (at char 1), (line:2, col:1)
Traceback (most recent call last):
  File "/usr/local/lib/python3.6/dist-packages/pyparsing.py", line 1562, in _parseNoCache
    loc,tokens = self.parseImpl( instring, preloc, doActions )
  File "/usr/local/lib/python3.6/dist-packages/pyparsing.py", line 3235, in parseImpl
    result = instring[loc] == self.firstQuoteChar and self.re.match(instring,loc) or None
IndexError: string index out of range

During handling of the above exception, another exception occurred:

Traceback (most recent call last):
  File "/var/lib/jenkins1/ws/OpenModelica_maintenance_v1.14/doc/UsersGuide/source/sphinxcontribopenmodelica.py", line 173, in run
    filename = os.path.abspath(self.options.get('filename') or omc.sendExpression("currentSimulationResult"))
  File "/usr/local/lib/python3.6/dist-packages/OMPython/__init__.py", line 606, in sendExpression
    answer = OMTypedParser.parseString(result)
  File "/usr/local/lib/python3.6/dist-packages/OMPython/OMTypedParser.py", line 120, in parseString
    return omcGrammar.parseString(string)[0]
  File "/usr/local/lib/python3.6/dist-packages/pyparsing.py", line 1828, in parseString
    raise exc
  File "/usr/local/lib/python3.6/dist-packages/pyparsing.py", line 1818, in parseString
    loc, tokens = self._parse( instring, 0 )
  File "/usr/local/lib/python3.6/dist-packages/pyparsing.py", line 1562, in _parseNoCache
    loc,tokens = self.parseImpl( instring, preloc, doActions )
  File "/usr/local/lib/python3.6/dist-packages/pyparsing.py", line 3735, in parseImpl
    loc, resultlist = self.exprs[0]._parse( instring, loc, doActions, callPreParse=False )
  File "/usr/local/lib/python3.6/dist-packages/pyparsing.py", line 1562, in _parseNoCache
    loc,tokens = self.parseImpl( instring, preloc, doActions )
  File "/usr/local/lib/python3.6/dist-packages/pyparsing.py", line 4098, in parseImpl
    return self.expr._parse( instring, loc, doActions, callPreParse=False )
  File "/usr/local/lib/python3.6/dist-packages/pyparsing.py", line 1562, in _parseNoCache
    loc,tokens = self.parseImpl( instring, preloc, doActions )
  File "/usr/local/lib/python3.6/dist-packages/pyparsing.py", line 3917, in parseImpl
    raise maxException
  File "/usr/local/lib/python3.6/dist-packages/pyparsing.py", line 3902, in parseImpl
    ret = e._parse( instring, loc, doActions )
  File "/usr/local/lib/python3.6/dist-packages/pyparsing.py", line 1564, in _parseNoCache
    raise ParseException( instring, len(instring), self.errmsg, self )
pyparsing.ParseException: Expected {quoted string, starting with " ending with " | Combine:({["-"] {"0" | W:(1234...,0123...)} [{"." W:(0123...)}] [{W:(eE) W:(0123...,0123...)}]}) | Forward: Group:({{{{{Suppress:("record") Suppress:(Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "." Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "." Forward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}}} | W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '})} Dict:(Group:({{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} Suppress:("=")} Forward: {{{{{{{{{quoted string, starting with " ending with " | Combine:({{{["-"] {"0" | W:(1234...,0123...)}} [{"." W:(0123...)}]} [{W:(eE) W:(0123...,0123...)}]})} | Forward: None} | Group:({{Suppress:("{") [Forward: None [, Forward: None]...]} Suppress:("}")})} | Group:({{Suppress:("(") [Forward: None [, Forward: None]...]} Suppress:(")")})} | {{{Suppress:("SOME") Suppress:("(")} Forward: ...} Suppress:(")")}} | "true"} | "false"} | {{"NONE" Suppress:("(")} Suppress:(")")}} | Combine:(Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "."} Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "."} Forward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}}} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}})}}) [, Group:({{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} Suppress:("=")} Forward: {{{{{{{{{quoted string, starting with " ending with " | Combine:({{{["-"] {"0" | W:(1234...,0123...)}} [{"." W:(0123...)}]} [{W:(eE) W:(0123...,0123...)}]})} | Forward: None} | Group:({{Suppress:("{") [Forward: None [, Forward: None]...]} Suppress:("}")})} | Group:({{Suppress:("(") [Forward: None [, Forward: None]...]} Suppress:(")")})} | {{{Suppress:("SOME") Suppress:("(")} Forward: ...} Suppress:(")")}} | "true"} | "false"} | {{"NONE" Suppress:("(")} Suppress:(")")}} | Combine:(Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "."} Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "."} Forward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}}} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}})}})]...)} Suppress:("end")} Suppress:(Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "." Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "." Forward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}}} | W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '})} Suppress:(";")}) | Group:({Suppress:("{") [Forward: None [, Forward: None]...] Suppress:("}")}) | Group:({Suppress:("(") [Forward: None [, Forward: None]...] Suppress:(")")}) | {Suppress:("SOME") Suppress:("(") Forward: {{{{{{{{{quoted string, starting with " ending with " | Combine:({["-"] {"0" | W:(1234...,0123...)} [{"." W:(0123...)}] [{W:(eE) W:(0123...,0123...)}]})} | Forward: Group:({{{{{Suppress:("record") Suppress:(Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "." Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "." Forward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}}} | W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '})} Dict:(Group:({{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} Suppress:("=")} Forward: {{{{{{{{{quoted string, starting with " ending with " | Combine:({{{["-"] {"0" | W:(1234...,0123...)}} [{"." W:(0123...)}]} [{W:(eE) W:(0123...,0123...)}]})} | Forward: None} | Group:({{Suppress:("{") [Forward: None [, Forward: None]...]} Suppress:("}")})} | Group:({{Suppress:("(") [Forward: None [, Forward: None]...]} Suppress:(")")})} | {{{Suppress:("SOME") Suppress:("(")} Forward: ...} Suppress:(")")}} | "true"} | "false"} | {{"NONE" Suppress:("(")} Suppress:(")")}} | Combine:(Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "."} Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "."} Forward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}}} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}})}}) [, Group:({{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} Suppress:("=")} Forward: {{{{{{{{{quoted string, starting with " ending with " | Combine:({{{["-"] {"0" | W:(1234...,0123...)}} [{"." W:(0123...)}]} [{W:(eE) W:(0123...,0123...)}]})} | Forward: None} | Group:({{Suppress:("{") [Forward: None [, Forward: None]...]} Suppress:("}")})} | Group:({{Suppress:("(") [Forward: None [, Forward: None]...]} Suppress:(")")})} | {{{Suppress:("SOME") Suppress:("(")} Forward: ...} Suppress:(")")}} | "true"} | "false"} | {{"NONE" Suppress:("(")} Suppress:(")")}} | Combine:(Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "."} Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "."} Forward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}}} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}})}})]...)} Suppress:("end")} Suppress:(Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "." Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "." Forward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}}} | W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '})} Suppress:(";")})} | Group:({{Suppress:("{") [Forward: None [, Forward: None]...]} Suppress:("}")})} | Group:({{Suppress:("(") [Forward: None [, Forward: None]...]} Suppress:(")")})} | {{{Suppress:("SOME") Suppress:("(")} Forward: ...} Suppress:(")")}} | "true"} | "false"} | {{"NONE" Suppress:("(")} Suppress:(")")}} | Combine:(Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "."} Forward: {{{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "."} Forward: ...} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}}} | {W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '}})} Suppress:(")")} | "true" | "false" | {"NONE" Suppress:("(") Suppress:(")")} | Combine:(Forward: {{{W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '} "." Forward: ...} | W:(ABCD...,ABCD...) | quoted string, starting with ' ending with '})} (at char 1), (line:2, col:1)
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PDEModelica1

PDEModelica1 is nonstandardised experimental Modelica language extension for 1-dimensional partial differential extensions (PDE).

It is enabled using compiler flag --grammar=PDEModelica. Compiler flags may be set e.g. in OMEdit (Tools->Options->Simulation->OMC Flags) or in the OpenModelica script using command








PDEModelica1 language elements

Let us introduce new PDEModelica1 language elements by an advection equation example model:

model Advection "advection equation"
  parameter Real pi = Modelica.Constants.pi;
  parameter DomainLineSegment1D omega(L = 1, N = 100)  "domain";
  field Real u(domain = omega)                         "field";
initial equation
  u = sin(2*pi*omega.x)                                "IC";
equation
  der(u) + pder(u,x) = 0   indomain omega              "PDE";
  u = 0                    indomain omega.left         "BC";
  u = extrapolateField(u)  indomain omega.right        "extrapolation";
end Advection;






Error

[<interactive>:4:14-4:14:writable] Error: Missing token: SEMICOLON





The domain omega represents the geometrical domain where the PDE holds. The domain is
defined using the built-in record DomainLineSegment1D. This   record contains among
others L – the length of the domain, N – the number of grid points, x –
the coordinate variable and the regions left, right and interior, representing
the left and right boundaries and the interior of the domain.

The field variable u is defined using a new keyword field. The domain
is a mandatory attribute to specify the domain of the field.

The indomain operator specifies where the equation containing the field variable holds. It
is utilised in the initial conditions (IC) of the fields, in the PDE and in the boundary
conditions (BC). The syntax is


anEquation indomain aDomain.aRegion;



If the region is omitted, interior is the default (e.g. the PDE in the example above).

The IC of the field variable u is written using an expression containing the coordinate
variable omega.x.

The PDE contains a partial space derivative written using the pder operator. Also
the second derivative is allowed (not in this example), the syntax is e.g. pder(u,x,x).
It is not necessary to specify the domain of coordinate in pder (to write e.g. pder(u,omega.x), even though x is a member of omega.




Limitations

BCs may be written only in terms of variables that are spatially differentiated currently.

All fields that are spatially differentiated must have either BC or extrapolation at each
boundary. This extrapolation should be done automatically by the compiler, but this has
not been implemented yet. The current workaround is the usage of the extrapolateField()
operator directly in the model.

If-equations are not spported yet, if-expressions must be used instead.




Viewing results

During translation field variables are replaced with arrays. These arrays may be plotted using Array Plot or even better using Array Parametric Plot (to plot x-coordinate versus a field).
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MDT – The OpenModelica Development Tooling Eclipse Plugin


Introduction

The Modelica Development Tooling (MDT) Eclipse Plugin as part of OMDev –
The OpenModelica Development Environment integrates the OpenModelica
compiler with Eclipse. MDT, together with the OpenModelica compiler,
provides an environment for working with Modelica and MetaModelica
development projects. This plugin is primarily intended for tool
developers rather than application Modelica modelers.

The following features are available:


	Browsing support for Modelica projects, packages, and classes


	Wizards for creating Modelica projects, packages, and classes


	Syntax color highlighting


	Syntax checking


	Browsing of the Modelica Standard Library or other libraries


	Code completion for class names and function argument lists


	Goto definition for classes, types, and functions


	Displaying type information when hovering the mouse over an
identifier.







Installation

The installation of MDT is accomplished by following the below
installation instructions. These instructions assume that you have
successfully downloaded and installed Eclipse (http://www.eclipse.org).

The latest installation instructions are available through the OpenModelica Trac [https://trac.openmodelica.org/MDT].


	Start Eclipse


	Select Help->Software Updates->Find and Install... from the
menu


	Select ‘Search for new features to install’ and click ‘Next’


	Select ‘New Remote Site...’


	Enter ‘MDT’ as name and
http://www.ida.liu.se/labs/pelab/modelica/OpenModelica/MDT
as URL and click ‘OK’


	Make sure ‘MDT’ is selected and click ‘Finish’


	In the updates dialog select the ‘MDT’ feature and click ‘Next’


	Read through the license agreement, select ‘I accept...’ and click
‘Next’


	Click ‘Finish’ to install MDT







Getting Started


Configuring the OpenModelica Compiler

MDT needs to be able to locate the binary of the compiler. It uses the
environment variable OPENMODELICAHOME to do so.

If you have problems using MDT, make sure that OPENMODELICAHOME is
pointing to the folder where the OpenModelica Compiler is installed. In
other words, OPENMODELICAHOME must point to the folder that contains the
Open Modelica Compiler (OMC) binary. On the Windows platform it’s called
omc.exe and on Unix platforms it’s called omc.




Using the Modelica Perspective

The most convenient way to work with Modelica projects is to use to the
Modelica perspective. To switch to the Modelica perspective, choose the
Window menu item, pick Open Perspective followed by Other...
Select the Modelica option from the dialog presented and click OK..




Selecting a Workspace Folder

Eclipse stores your projects in a folder called a workspace. You need to
choose a workspace folder for this session, see Figure 77.


[image: _images/mdt-switch-workspace.png]
Figure 77 Eclipse Setup – Switching Workspace.






Creating one or more Modelica Projects

To start a new project, use the New Modelica Project Wizard. It is
accessible through File->New-> Modelica Project or by right-clicking in
the Modelica Projects view and selecting New->Modelica Project.


[image: _images/mdt-create-project.svg]Figure 78 Eclipse Setup – creating a Modelica project in the workspace.



You need to disable automatic build for the project(s) (Figure 79).


[image: _images/mdt-disable-automatic-build.png]
Figure 79 Eclipse Setup – disable automatic build for the projects.



Repeat the procedure for all the projects you need, e.g. for the
exercises described in the MetaModelica users guide: 01_experiment,
02a_exp1, 02b_exp2, 03_assignment, 04a_assigntwotype, etc.

NOTE: Leave open only the projects you are working on! Close all the
others!




Building and Running a Project

After having created a project, you eventually need to build the project
(Figure 80).


[image: _images/mdt-build-project.png]
Figure 80 Eclipse MDT – Building a project.



The build options are the same as the make targets: you can build,
build from scratch (clean), or run simulations depending on how the
project is setup. See Figure 81 for an example of how omc
can be compiled (make omc builds OMC).


[image: _images/mdt-build-prompt.svg]Figure 81 Eclipse – building a project.




[image: _images/mdt-build-log.png]
Figure 82 Eclipse – building a project, resulting log.






Switching to Another Perspective

If you need, you can (temporarily) switch to another perspective, e.g.
to the Java perspective for working with an OpenModelica Java client as
in Figure 83.


[image: _images/mdt-switch-perspective.png]
Figure 83 Eclipse – Switching to another perspective – e.g. the Java Perspective.






Creating a Package

To create a new package inside a Modelica project, select
File->New->Modelica Package. Enter the desired name of the package
and a description of what it contains. Note: for the exercises we
already have existing packages.


[image: _images/mdt-create-package.png]
Figure 84 Creating a new Modelica package.






Creating a Class

To create a new Modelica class, select where in the hierarchy that you
want to add your new class and select File->New->Modelica Class. When
creating a Modelica class you can add different restrictions on what the
class can contain. These can for example be model, connector, block,
record, or function. When you have selected your desired class type, you
can select modifiers that add code blocks to the generated code.
‘Include initial code block’ will for example add the line ‘initial
equation’ to the class.


[image: _images/mdt-create-class.png]
Figure 85 Creating a new Modelica class.






Syntax Checking

Whenever a build command is given to the MDT environment, modified and
saved Modelica (.mo) files are checked for syntactical errors. Any
errors that are found are added to the Problems view and also marked in
the source code editor. Errors are marked in the editor as a red circle
with a white cross, a squiggly red line under the problematic construct,
and as a red marker in the right-hand side of the editor. If you want to
reach the problem, you can either click the item in the Problems view or
select the red box in the right-hand side of the editor.


[image: _images/mdt-syntax-checking.png]
Figure 86 Syntax checking.






Automatic Indentation Support

MDT currently has support for automatic indentation. When typing the
Return (Enter) key, the next line is indented correctly. You can also
correct indentation of the current line or a range selection using
CTRL+I or “Correct Indentation” action on the toolbar or in the Edit
menu.




Code Completion

MDT supports Code Completion in two variants. The first variant, code
completion when typing a dot after a class (package) name, shows
alternatives in a menu. Besides the alternatives, Modelica documentation
from comments is shown if is available. This makes the selection easyer.


[image: _images/mdt-code-completion.png]
Figure 87 Code completion when typing a dot.



The second variant is useful when typing a call to a function. It shows
the function signature (formal parameter names and types) in a popup
when typing the parenthesis after the function name, here the signature
Real sin(SI.Angle u) of the sin function:


[image: _images/mdt-code-completion-call.png]
Figure 88 Code completion at a function call when typing left parenthesis.






Code Assistance on Identifiers when Hovering

When hovering with the mouse over an identifier a popup with information
about the identifier is displayed. If the text is too long, the user can
press F2 to focus the popup dialog and scroll up and down to examine all
the text. As one can see the information in the popup dialog is
syntax-highlighted.


[image: _images/mdt-info-on-hover.png]
Figure 89 Displaying information for identifiers on hovering.






Go to Definition Support

Besides hovering information the user can press CTRL+click to go to the
definition of the identifier. When pressing CTRL the identifier will be
presented as a link and when pressing mouse click the editor will go to
the definition of the identifier.




Code Assistance on Writing Records

When writing records, the same functionality as for function calls is
used. This is useful especially in MetaModelica when writing cases in
match constructs.


[image: _images/mdt-assist-mm-record.png]
Figure 90 Code assistance when writing cases with records in MetaModelica.






Using the MDT Console for Plotting


[image: _images/mdt-console.png]
Figure 91 Activate the MDT Console.




[image: _images/mdt-console-simulate.png]
Figure 92 Simulation from MDT Console.
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MDT Debugger for Algorithmic Modelica

The algorithmic code debugger, used for the algorithmic subset of the
Modelica language as well as the MetaModelica language is described in
Section The Eclipse-based Debugger for Algorithmic Modelica.
Using this debugger replaces debugging of algorithmic code
by primitive means such as print statements or asserts which is complex,
time-consuming and error- prone. The usual debugging functionality found
in debuggers for procedural or traditional object-oriented languages is
supported, such as setting and removing breakpoints, stepping,
inspecting variables, etc. The debugger is integrated with Eclipse.


The Eclipse-based Debugger for Algorithmic Modelica

The debugging framework for the algorithmic subset of Modelica and
MetaModelica is based on the Eclipse environment and is implemented as a
set of plugins which are available from Modelica Development Tooling
(MDT) environment. Some of the debugger functionality is presented
below. In the right part a variable value is explored. In the top-left
part the stack trace is presented. In the middle-left part the execution
point is presented.

The debugger provides the following general functionalities:


	Adding/Removing breakpoints.


	Step Over – moves to the next line, skipping the function calls.


	Step In – takes the user into the function call.


	
	Step Return – complete the execution of the function and takes the
	user back to the point from where the function is called.







	Suspend – interrupts the running program.





[image: _images/mdt-debugger-overview.png]
Figure 93 Debugging functionality.




Starting the Modelica Debugging Perspective

To be able to run in debug mode, one has to go through the following
steps:


	create a mos file


	setting the debug configuration


	setting breakpoints


	running the debug configuration




All these steps are presented below using images.


Create mos file

In order to debug Modelica code we need to load the Modelica files into
the OpenModelica Compiler. For this we can write a small script file
like this:

function HelloWorld
  input Real r;
  output Real o;
algorithm
  o := 2 * r;
end HelloWorld;





>>> setCommandLineOptions({"-d=rml,noevalfunc","-g=MetaModelica"})
{true,true}
>>> setCFlags(getCFlags() + " -g")
true
>>> HelloWorld(120.0)





So lets say that we want to debug HelloWorld.mo. For that we must load
it into the compiler using the script file. Put all the Modelica files
there in the script file to be loaded. We should also initiate the
debugger by calling the starting function, in the above code
HelloWorld(120.0);




Setting the debug configuration

While the Modelica perspective is activated the user should click on the
bug icon on the toolbar and select Debug in order to access the dialog
for building debug configurations.


[image: _images/mdt-debugger-config-1.png]
Figure 94 Accessing the debug configuration dialog.



To create the debug configuration, right click on the classification
Modelica Development Tooling (MDT) GDB and select New as in figure
below. Then give a name to the configuration, select the debugging
executable to be executed and give it command line parameters. There are
several tabs in which the user can select additional debug configuration
settings like the environment in which the executable should be run.

Note that we require Gnu Debugger (GDB) for debugging session. We must
specify the GDB location, also we must pass our script file as an
argument to OMC.


[image: _images/mdt-debugger-config-2.png]
Figure 95 Creating the Debug Configuration.






Setting/Deleting Breakpoints

The Eclipse interface allows to add/remove breakpoints. At the moment
only line number based breakpoints are supported. Other alternative to
set the breakpoints is; function breakpoints.


[image: _images/mdt-debugger-breakpoint.png]
Figure 96 Setting/deleting breakpoints.






Starting the debugging session and enabling the debug perspective


[image: _images/mdt-debugger-start-1.png]
Figure 97 Starting the debugging session.




[image: _images/mdt-debugger-start-2.png]
Figure 98 Eclipse will ask if the user wants to switch to the debugging perspective.








The Debugging Perspective

The debug view primarily consists of two main views:


	Stack Frames View


	Variables View




The stack frame view, shown in the figure below, shows a list of frames
that indicates how the flow had moved from one function to another or
from one file to another. This allows backtracing of the code. It is
very much possible to select the previous frame in the stack and inspect
the values of the variables in that frame. However, it is not possible
to select any of the previous frame and start debugging from there. Each
frame is shown as <function_name at file_name:line_number>.

The Variables view shows the list of variables at a certain point in the
program, containing four colums:


	Name – the variable name.


	Declared Type – the Modelica type of the variable.


	Value – the variable value.


	Actual Type – the mapped C type.




By preserving the stack frames and variables it is possible to keep
track of the variables values. If the value of any variable is changed
while stepping then that variable will be highlighted yellow (the
standard Eclipse way of showing the change).


[image: _images/mdt-debugger-perspective.png]
Figure 99 The debugging perspective.




[image: _images/mdt-debugger-switch-perspective.png]
Figure 100 Switching between perspectives.
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Modelica Performance Analyzer

A common problem when simulating models in an equation-based language
like Modelica is that the model may contain non-linear equation systems.
These are solved in each time-step by extrapolating an initial guess and
running a non-linear system solver. If the simulation takes too long to
simulate, it is useful to run the performance analysis tool. The tool
has around 5~25% overhead, which is very low compared to
instruction-level profilers (30x-100x overhead). Due to being based on a
single simulation run, the report may contain spikes in the charts.

When running a simulation for performance analysis, execution times of
user-defined functions as well as linear, non-linear and mixed equation
systems are recorded.

To start a simulation in this mode, turn on profiling with the following
command line flag
>>> setCommandLineOptions("--profiling=all")

The generated report is in HTML format (with images in the SVG format),
stored in a file modelname_prof.html, but the XML database and measured
times that generated the report and graphs are also available if you
want to customize the report for comparison with other tools.

Below we use the performance profiler on the simple model A:

model ProfilingTest
  function f
    input Real r;
    output Real o = sin(r);
  end f;
  String s = "abc";
  Real x = f(x) "This is x";
  Real y(start=1);
  Real z1 = cos(z2);
  Real z2 = sin(z1);
equation
  der(y) = time;
end ProfilingTest;





We simulate as usual, after setting the profiling flag:

>>> setCommandLineOptions("--profiling=blocks+html")
true
>>> simulate(ProfilingTest)
record SimulationResult
    resultFile = "«DOCHOME»/ProfilingTest_res.mat",
    simulationOptions = "startTime = 0.0, stopTime = 1.0, numberOfIntervals = 500, tolerance = 1e-06, method = 'dassl', fileNamePrefix = 'ProfilingTest', options = '', outputFormat = 'mat', variableFilter = '.*', cflags = '', simflags = ''",
    messages = "LOG_SUCCESS       | info    | The initialization finished successfully without homotopy method.
LOG_SUCCESS       | info    | The simulation finished successfully.
Warning: empty y range [1:1], adjusting to [0.99:1.01]
Warning: empty y range [1:1], adjusting to [0.99:1.01]
Warning: empty y range [1:1], adjusting to [0.99:1.01]
Warning: empty y range [1:1], adjusting to [0.99:1.01]
Warning: empty y range [1:1], adjusting to [0.99:1.01]
Warning: empty y range [1:1], adjusting to [0.99:1.01]
stdout            | info    | Time measurements are stored in ProfilingTest_prof.html (human-readable) and ProfilingTest_prof.xml (for XSL transforms or more details)
",
    timeFrontend = 0.015662247,
    timeBackend = 0.019280674,
    timeSimCode = 0.00163656,
    timeTemplates = 0.011055356,
    timeCompile = 0.492185925,
    timeSimulation = 0.067692587,
    timeTotal = 0.607636068
end SimulationResult;
"Warning: There are nonlinear iteration variables with default zero start attribute found in NLSJac0. For more information set -d=initialization. In OMEdit Tools->Options->Simulation->OMCFlags, in OMNotebook call setCommandLineOptions("-d=initialization").
Warning: The initial conditions are not fully specified. For more information set -d=initialization. In OMEdit Tools->Options->Simulation->OMCFlags, in OMNotebook call setCommandLineOptions("-d=initialization").
"






Profiling information for ProfilingTest


Information

All times are measured using a real-time wall clock. This means context
switching produces bad worst-case execution times (max times) for
blocks. If you want better results, use a CPU-time clock or run the
command using real-time priviliges (avoiding context switches).

Note that for blocks where the individual execution time is close to the
accuracy of the real-time clock, the maximum measured time may deviate a
lot from the average.

For more details, see
ProfilingTest_prof.xml.




Settings







	Name

	Value





	Integration method

	dassl



	Output format

	mat



	Output name

	ProfilingTest_res.mat



	Output size

	24.0 kB



	Profiling data

	ProfilingTest_prof.data



	Profiling size

	0 B









Summary








	Task

	Time

	Fraction





	Pre-Initialization

	0.000171

	2.50%



	Initialization

	0.000174

	2.54%



	Event-handling

	0.000000

	0.00%



	Creating output file

	0.000542

	7.93%



	Linearization

	
	NaN%



	Time steps

	0.004812

	70.36%



	Overhead

	0.000309

	4.52%



	Unknown

	NaN

	NaN%



	Total simulation time

	0.006839

	100.00%









Global Steps












	
	Steps

	Total
Time

	Fractio
n

	Average
Time

	Max
Time

	Deviati
on





	|Graph
thumbna
il
999|

	499

	0.00481
2

	70.36%

	9.64328
6573146
29e-06

	0.00011
8306

	11.27x









Measured Function Calls












	
	Name

	Calls

	Time

	Fractio
n

	Max
Time

	Deviati
on





	|Graph
thumbna
il
functio
n
fun0||Graph
thumbna
il
count
functio
n
fun0|

	Profil
ingTest
.f
_

	506

	0.00007
4520

	1.09%

	0.00000
1267

	7.60x









Measured Blocks












	
	Name

	Calls

	Time

	Fractio
n

	Max
Time

	Deviati
on





	|Graph
thumbna
il
eq0||
Graph
thumbna
il
count
eq0|

	` <#eq0
>`__

	7

	0.00010
5917

	1.55%

	0.00010
6915

	6.07x



	|Graph
thumbna
il
eq12||Graph
thumbna
il
count
eq12|

	` <#eq1
2>`__

	2

	0.00000
3285

	0.05%

	0.00000
3451

	1.10x



	|Graph
thumbna
il
eq20||Graph
thumbna
il
count
eq20|

	` <#eq2
0>`__

	504

	0.00090
1593

	13.18%

	0.00004
8334

	26.02x



	|Graph
thumbna
il
eq22||Graph
thumbna
il
count
eq22|

	` <#eq2
2>`__

	504

	0.00111
0831

	16.24%

	0.00003
2356

	13.68x







Equations







	Name

	Variables





	eq0

	


	eq1

	y



	eq2

	s



	eq3

	


	eq4

	z2



	eq5

	


	eq6

	` <#var0>`__



	eq7

	` <#var0>`__



	eq8

	` <#var0>`__



	eq9

	` <#var0>`__



	eq10

	z1



	eq11

	


	eq12

	x



	eq13

	der(y)



	eq14

	z2



	eq15

	


	eq16

	` <#var0>`__



	eq17

	` <#var0>`__



	eq18

	` <#var0>`__



	eq19

	` <#var0>`__



	eq20

	z1



	eq21

	


	eq22

	x



	eq23

	








Variables







	Name

	Comment





	y

	


	der(y)

	


	x

	This is x



	z1

	


	z2

	


	s

	







This report was generated by OpenModelica [http://openmodelica.org]
on 2019-11-21 19:39:14.








Genenerated JSON for the Example


Listing 6 ProfilingTest_prof.json

{
"name":"ProfilingTest",
"prefix":"ProfilingTest",
"date":"2019-11-21 19:39:14",
"method":"dassl",
"outputFormat":"mat",
"outputFilename":"ProfilingTest_res.mat",
"outputFilesize":24581,
"overheadTime":0.000331099,
"preinitTime":0.000170564,
"initTime":0.000173981,
"eventTime":0,
"outputTime":0.000542279,
"jacobianTime":3.70105e-05,
"totalTime":0.00683925,
"totalStepsTime":9.07075e-06,
"totalTimeProfileBlocks":0.00212162,
"numStep":499,
"maxTime":0.000118305751,
"functions":[
{"name":"ProfilingTest.f","ncall":506,"time":0.000074520,"maxTime":0.000001267}
],
"profileBlocks":[
{"id":0,"ncall":7,"time":0.000105917,"maxTime":0.000106915},
{"id":12,"ncall":2,"time":0.000003285,"maxTime":0.000003451},
{"id":20,"ncall":504,"time":0.000901593,"maxTime":0.000048334},
{"id":22,"ncall":504,"time":0.001110831,"maxTime":0.000032356}
]
}










Using the Profiler from OMEdit

When running a simulation from OMEdit, it is possible to enable profiling
information, which can be combined with the transformations browser.


[image: Profiling setup]
Figure 101 Setting up the profiler from OMEdit.



When profiling the DoublePendulum example from MSL, the following output in Figure 102 is a typical result.
This information clearly shows which system takes longest to simulate (a linear system, where most of the time overhead probably comes from initializing LAPACK [http://www.netlib.org/lapack/] over and over).


[image: Profiling results]
Figure 102 Profiling results of the Modelica standard library DoublePendulum example, sorted by execution time.
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Simulation in Web Browser

OpenModelica can simulate in a web browser on a client computer by model
code being compiled to efficient Javacript code.

For more information, see https://github.com/tshort/openmodelica-javascript

Below used on the MSL MultiBody RobotR3.fullRobot example model.

[image: _images/emscripten-model.png]
[image: _images/emscripten-result.png]
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Interoperability – C and Python

Below is information and examples about the OpenModelica external C
interfaces, as well as examples of Python interoperability.


Calling External C functions

The following is a small example (ExternalLibraries.mo) to show the use
of external C functions:

model ExternalLibraries

  function ExternalFunc1
    input Real x;
    output Real y;
  external y=ExternalFunc1_ext(x) annotation(Library="ExternalFunc1.o", LibraryDirectory="modelica://ExternalLibraries", Include="#include \"ExternalFunc1.h\"");
  end ExternalFunc1;

  function ExternalFunc2
    input Real x;
    output Real y;
  external "C" annotation(Library="ExternalFunc2", LibraryDirectory="modelica://ExternalLibraries");
  end ExternalFunc2;

  Real x(start=1.0, fixed=true), y(start=2.0, fixed=true);
equation
  der(x)=-ExternalFunc1(x);
  der(y)=-ExternalFunc2(y);
end ExternalLibraries;





These C (.c) files and header files (.h) are needed (note that the headers are not needed since OpenModelica will generate the correct definition if it is not present; using the headers it is possible to write C-code directly in the Modelica source code or declare non-standard calling conventions):


Listing 7 ExternalFunc1.c

double ExternalFunc1_ext(double x)
{
  double res;
  res = x+2.0*x*x;
  return res;
}








Listing 8 ExternalFunc1.h

double ExternalFunc1_ext(double);








Listing 9 ExternalFunc2.c

double ExternalFunc2(double x)
{
  double res;
  res = (x-1.0)*(x+2.0);
  return res;
}







The following script file ExternalLibraries.mos will perform everything
that is needed, provided you have gcc installed in your path:

>>> system(getCompiler() + " -c -o ExternalFunc1.o ExternalFunc1.c")
0
>>> system(getCompiler() + " -c -o ExternalFunc2.o ExternalFunc2.c")
0
>>> system("ar rcs libExternalFunc2.a ExternalFunc2.o")
0
>>> simulate(ExternalLibraries)
record SimulationResult
    resultFile = "«DOCHOME»/ExternalLibraries_res.mat",
    simulationOptions = "startTime = 0.0, stopTime = 1.0, numberOfIntervals = 500, tolerance = 1e-06, method = 'dassl', fileNamePrefix = 'ExternalLibraries', options = '', outputFormat = 'mat', variableFilter = '.*', cflags = '', simflags = ''",
    messages = "LOG_SUCCESS       | info    | The initialization finished successfully without homotopy method.
LOG_SUCCESS       | info    | The simulation finished successfully.
",
    timeFrontend = 0.007484839,
    timeBackend = 0.002825199,
    timeSimCode = 0.001235447,
    timeTemplates = 0.003960959,
    timeCompile = 0.545864867,
    timeSimulation = 0.011984959,
    timeTotal = 0.573476187
end SimulationResult;





And plot the results:


[image: _images/externallibraries.svg]Figure 103 Plot generated by OpenModelica+gnuplot






Calling external Python Code from a Modelica model

The following calls external Python code through a very simplistic
external function (no data is retrieved from the Python code).
By making it a dynamically linked library, you might get the code to
work without changing the linker settings.

function pyRunString
  input String s;
external "C" annotation(Include="
#include <Python.h>

void pyRunString(const char *str)
{
  Py_SetProgramName(\"pyRunString\");  /* optional but recommended */
  Py_Initialize();
  PyRun_SimpleString(str);
  Py_Finalize();
}
");
end pyRunString;

model CallExternalPython
algorithm
  pyRunString("
print 'Python says: simulation time',"+String(time)+"
");
end CallExternalPython;





>>> system("python-config --cflags > pycflags")
0
>>> system("python-config --ldflags > pyldflags")
0
>>> pycflags := stringReplace(readFile("pycflags"),"\n","");
>>> pyldflags := stringReplace(readFile("pyldflags"),"\n","");
>>> setCFlags(getCFlags()+pycflags)
true
>>> setLinkerFlags(getLinkerFlags()+pyldflags)
true
>>> simulate(CallExternalPython, stopTime=2)
record SimulationResult
    resultFile = "«DOCHOME»/CallExternalPython_res.mat",
    simulationOptions = "startTime = 0.0, stopTime = 2.0, numberOfIntervals = 500, tolerance = 1e-06, method = 'dassl', fileNamePrefix = 'CallExternalPython', options = '', outputFormat = 'mat', variableFilter = '.*', cflags = '', simflags = ''",
    messages = "Python says: simulation time 0
Python says: simulation time 0
LOG_SUCCESS       | info    | The initialization finished successfully without homotopy method.
Python says: simulation time 2
LOG_SUCCESS       | info    | The simulation finished successfully.
",
    timeFrontend = 0.005989555000000001,
    timeBackend = 0.013864324,
    timeSimCode = 0.000780224,
    timeTemplates = 0.003309127,
    timeCompile = 0.576275316,
    timeSimulation = 0.04138977200000001,
    timeTotal = 0.6417570770000001
end SimulationResult;








Calling OpenModelica from Python Code

This section describes a simple-minded approach to calling Python code
from OpenModelica. For a description of Python scripting with
OpenModelica, see OMPython – OpenModelica Python Interface.

The interaction with Python can be perfomed in four different ways
whereas one is illustrated below. Assume that we have the following
Modelica code:


Listing 10 CalledbyPython.mo

model CalledbyPython
  Real x(start=1.0), y(start=2.0);
  parameter Real b = 2.0;
equation
  der(x) = -b*y;
  der(y) = x;
end CalledbyPython;







In the following Python (.py) files the above Modelica model is
simulated via the OpenModelica scripting interface:


Listing 11 PythonCaller.py

#!/usr/bin/python
import sys,os
global newb = 0.5
execfile('CreateMosFile.py')
os.popen(r"omc CalledbyPython.mos").read()
execfile('RetrResult.py')








Listing 12 CreateMosFile.py

#!/usr/bin/python
mos_file = open('CalledbyPython.mos','w', 1)
mos_file.write('loadFile("CalledbyPython.mo");\n')
mos_file.write('setComponentModifierValue(CalledbyPython,b,$Code(="+str(newb)+"));\n')
mos_file.write('simulate(CalledbyPython,stopTime=10);\n')
mos_file.close()








Listing 13 RetrResult.py

#!/usr/bin/python
def zeros(n): #
  vec = [0.0]
  for i in range(int(n)-1): vec = vec + [0.0]
  return vec
res_file = open("CalledbyPython_res.plt",'r',1)
line = res_file.readline()
size = int(res_file.readline().split('=')[1])
time = zeros(size)
y = zeros(size)
while line != ['DataSet: time\\n']:
  line = res_file.readline().split(',')[0:1]
for j in range(int(size)):
  time[j]=float(res\_file.readline().split(',')[0])
while line != ['DataSet: y\\n']:
  line=res_file.readline().split(',')[0:1]
for j in range(int(size)):
  y[j]=float(res\_file.readline().split(',')[1])
res_file.close()







A second option of simulating the above Modelica model is to use the
command buildModel instead of the simulate command and setting the
parameter value in the initial parameter file, CalledbyPython_init.txt
instead of using the command setComponentModifierValue. Then the file
CalledbyPython.exe is just executed.

The third option is to use the Corba interface for invoking the compiler
and then just use the scripting interface to send commands to the
compiler via this interface.

The fourth variant is to use external function calls to directly
communicate with the executing simulation process.
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OpenModelica Python Interface and PySimulator

This chapter describes the OpenModelica Python integration facilities.


	OMPython – the OpenModelica Python scripting interface, see OMPython – OpenModelica Python Interface.


	EnhancedOMPython - Enhanced OMPython scripting interface, see Enhanced OMPython Features.


	PySimulator – a Python package that provides simulation and post
processing/analysis tools integrated with OpenModelica, see PySimulator.





OMPython – OpenModelica Python Interface

OMPython – OpenModelica Python API is a free, open source, highly
portable Python based interactive session handler for Modelica
scripting. It provides the modeler with components for creating a
complete Modelica modeling, compilation and simulation environment based
on the latest OpenModelica library standard available. OMPython is
architectured to combine both the solving strategy and model building.
So domain experts (people writing the models) and computational
engineers (people writing the solver code) can work on one unified tool
that is industrially viable for optimization of Modelica models, while
offering a flexible platform for algorithm development and research.
OMPython is not a standalone package, it depends upon the
OpenModelica installation.

OMPython is implemented in Python and depends either on
the OmniORB and OmniORBpy - high performance CORBA ORBs for Python
or ZeroMQ - high performance asynchronous
messaging library and it supports the Modelica
Standard Library version 3.2 that is included in starting with
OpenModelica 1.9.2.

To install OMPython follow the instructions at https://github.com/OpenModelica/OMPython


Features of OMPython

OMPython provides user friendly features like:


	Interactive session handling, parsing, interpretation of commands and
Modelica expressions for evaluation, simulation, plotting, etc.


	Interface to the latest OpenModelica API calls.


	Optimized parser results that give control over every element of the output.


	Helper functions to allow manipulation on Nested dictionaries.


	Easy access to the library and testing of OpenModelica commands.







Test Commands

OMPython provides two classes for communicating with OpenModelica i.e.,
OMCSession and OMCSessionZMQ. Both classes have the same interface,
the only difference is that OMCSession uses omniORB and OMCSessionZMQ
uses ZeroMQ. All the examples listed down uses OMCSessionZMQ but if you
want to test OMCSession simply replace OMCSessionZMQ with OMCSession. We
recommend to use OMCSessionZMQ.

To test the command outputs, simply create an OMCSessionZMQ object by
importing from the OMPython library within Python interepreter. The
module allows you to interactively send commands to the OMC server and
display their output.

To get started, create an OMCSessionZMQ object:

>>> from OMPython import OMCSessionZMQ
>>> omc = OMCSessionZMQ()





>>> omc.sendExpression("getVersion()")
OMCompiler v1.14.0-dev.beta2.11+gc12c3df1ee
>>> omc.sendExpression("cd()")
«DOCHOME»
>>> omc.sendExpression("loadModel(Modelica)")
True
>>> omc.sendExpression("loadFile(getInstallationDirectoryPath() + \"/share/doc/omc/testmodels/BouncingBall.mo\")")
True
>>> omc.sendExpression("instantiateModel(BouncingBall)")
class BouncingBall
  parameter Real e = 0.7 "coefficient of restitution";
  parameter Real g = 9.81 "gravity acceleration";
  Real h(start = 1.0, fixed = true) "height of ball";
  Real v(fixed = true) "velocity of ball";
  Boolean flying(start = true, fixed = true) "true, if ball is flying";
  Boolean impact;
  Real v_new(fixed = true);
  Integer foo;
equation
  impact = h <= 0.0;
  foo = if impact then 1 else 2;
  der(v) = if flying then -g else 0.0;
  der(h) = v;
  when {h <= 0.0 and v <= 0.0, impact} then
    v_new = if edge(impact) then (-e) * pre(v) else 0.0;
    flying = v_new > 0.0;
    reinit(v, v_new);
  end when;
end BouncingBall;





We get the name and other properties of a class:

>>> omc.sendExpression("getClassNames()")
('BouncingBall', 'ModelicaServices', 'Complex', 'Modelica')
>>> omc.sendExpression("isPartial(BouncingBall)")
False
>>> omc.sendExpression("isPackage(BouncingBall)")
False
>>> omc.sendExpression("isModel(BouncingBall)")
True
>>> omc.sendExpression("checkModel(BouncingBall)")
Check of BouncingBall completed successfully.
Class BouncingBall has 6 equation(s) and 6 variable(s).
1 of these are trivial equation(s).
>>> omc.sendExpression("getClassRestriction(BouncingBall)")
model
>>> omc.sendExpression("getClassInformation(BouncingBall)")
('model', '', False, False, False, '/var/lib/jenkins1/ws/OpenModelica_maintenance_v1.14/build/share/doc/omc/testmodels/BouncingBall.mo', False, 1, 1, 23, 17, (), False, False, '', '', False, '')
>>> omc.sendExpression("getConnectionCount(BouncingBall)")
0
>>> omc.sendExpression("getInheritanceCount(BouncingBall)")
0
>>> omc.sendExpression("getComponentModifierValue(BouncingBall,e)")
0.7
>>> omc.sendExpression("checkSettings()")
{'OPENMODELICAHOME': '«OPENMODELICAHOME»', 'OPENMODELICALIBRARY': '«OPENMODELICAHOME»/lib/omlibrary', 'OMC_PATH': '«OPENMODELICAHOME»/bin/omc', 'SYSTEM_PATH': '/usr/local/sbin:/usr/local/bin:/usr/sbin:/usr/bin:/sbin:/bin', 'OMDEV_PATH': '', 'OMC_FOUND': True, 'MODELICAUSERCFLAGS': '', 'WORKING_DIRECTORY': '«DOCHOME»', 'CREATE_FILE_WORKS': True, 'REMOVE_FILE_WORKS': True, 'OS': 'linux', 'SYSTEM_INFO': 'Linux 399de463d027 4.15.0-55-generic #60-Ubuntu SMP Tue Jul 2 18:22:20 UTC 2019 x86_64 x86_64 x86_64 GNU/Linux\n', 'RTLIBS': ' -Wl,--no-as-needed -Wl,--disable-new-dtags -lOpenModelicaRuntimeC  -llapack -lblas   -lm -lomcgc -lpthread -rdynamic', 'C_COMPILER': 'clang', 'C_COMPILER_VERSION': 'clang version 6.0.0-1ubuntu2 (tags/RELEASE_600/final)\nTarget: x86_64-pc-linux-gnu\nThread model: posix\nInstalledDir: /usr/bin\n', 'C_COMPILER_RESPONDING': True, 'HAVE_CORBA': True, 'CONFIGURE_CMDLINE': "Configured 2019-11-21 19:23:37 using arguments:  '--disable-option-checking' '--prefix=/var/lib/jenkins2/ws/OpenModelica_maintenance_v1.14/build' 'CC=clang' 'CXX=clang++' 'FC=gfortran' 'CFLAGS=-Os' '--with-cppruntime' '--without-omc' '--without-omlibrary' '--with-omniORB' '--enable-modelica3d' '--without-hwloc' '--with-ombuilddir=/var/lib/jenkins2/ws/OpenModelica_maintenance_v1.14/build' '--cache-file=/dev/null' '--srcdir=.'"}





The common combination of a simulation followed by getting a value and
doing a plot:

>>> omc.sendExpression("simulate(BouncingBall, stopTime=3.0)")
{'resultFile': '«DOCHOME»/BouncingBall_res.mat', 'simulationOptions': "startTime = 0.0, stopTime = 3.0, numberOfIntervals = 500, tolerance = 1e-06, method = 'dassl', fileNamePrefix = 'BouncingBall', options = '', outputFormat = 'mat', variableFilter = '.*', cflags = '', simflags = ''", 'messages': 'LOG_SUCCESS       | info    | The initialization finished successfully without homotopy method.\nLOG_SUCCESS       | info    | The simulation finished successfully.\n', 'timeFrontend': 0.400311551, 'timeBackend': 0.003810708, 'timeSimCode': 0.001138315, 'timeTemplates': 0.217805465, 'timeCompile': 1.271492767, 'timeSimulation': 0.077956579, 'timeTotal': 1.972675765}
>>> omc.sendExpression("val(h , 2.0)")
0.04239430772884106






Import As Library

To use the module from within another python program, simply import
OMCSessionZMQ from within the using program.

For example:

# test.py
from OMPython import OMCSessionZMQ
omc = OMCSessionZMQ()
cmds = [
  'loadFile(getInstallationDirectoryPath() + "/share/doc/omc/testmodels/BouncingBall.mo")',
  "simulate(BouncingBall)",
  "plot(h)"
  ]
for cmd in cmds:
  answer = omc.sendExpression(cmd)
  print("\n{}:\n{}".format(cmd, answer))










Implementation


Client Implementation

The OpenModelica Python API Interface – OMPython, attempts to mimic the
OMShell's style of operations.

OMPython is designed to,


	Initialize the CORBA/ZeroMQ communication.


	Send commands to the OMC server via the CORBA/ZeroMQ interface.


	Receive the string results.


	Use the Parser module to format the results.


	Return or display the results.











Enhanced OMPython Features

Some more improvements are added to OMPython functionality for querying more information about the models
and simulate them. A list of new user friendly API functionality allows user to extract information about models using python
objects. A list of API functionality is described below.

To get started, create a ModelicaSystem object:

>>> from OMPython import OMCSessionZMQ
>>> omc = OMCSessionZMQ()
>>> model_path=omc.sendExpression("getInstallationDirectoryPath()") + "/share/doc/omc/testmodels/"
>>> from OMPython import ModelicaSystem
>>> mod=ModelicaSystem(model_path + "BouncingBall.mo","BouncingBall")





The object constructor requires a minimum of 2 input arguments which are strings, and may need a third string input argument.


	The first input argument must be a string with the file name of the Modelica code, with Modelica file extension ".mo".
If the Modelica file is not in the current directory of Python, then the file path must also be included.


	The second input argument must be a string with the name of the Modelica model
including the namespace if the model is wrapped within a Modelica package.


	The third input argument is used to specify the list of dependent libraries or dependent Modelica files e.g.,




>>> mod=ModelicaSystem(model_path + "BouncingBall.mo","BouncingBall",["Modelica"])






	By default ModelicaSystem uses OMCSessionZMQ but if you want to use OMCSession
then pass the argument useCorba=True to the constructor.





BuildModel

The buildModel API can be used after ModelicaSystem(), in case the model needs to be updated or additional simulationflags needs to be set using sendExpression()

>>> mod.buildModel()








Standard get methods


	getQuantities()


	getContinuous()


	getInputs()


	getOutputs()


	getParameters()


	getSimulationOptions()


	getSolutions()




Three calling possibilities are accepted using getXXX() where "XXX" can be any of the above functions (eg:) getParameters().


	getXXX() without input argument, returns a dictionary with names as keys and values as values.


	getXXX(S), where S is a string of names.


	getXXX(["S1","S2"]) where S1 and S1 are list of string elements







Usage of getMethods

>>> mod.getQuantities() // method-1, list of all variables from xml file
[{'aliasvariable': None, 'Name': 'height', 'Variability': 'continuous', 'Value': '1.0', 'alias': 'noAlias', 'Changeable': 'true', 'Description': None}, {'aliasvariable': None, 'Name': 'c', 'Variability': 'parameter', 'Value': '0.9', 'alias': 'noAlias', 'Changeable': 'true', 'Description': None}]





>>> mod.getQuantities("height") // method-2, to query information about single quantity
[{'aliasvariable': None, 'Name': 'height', 'Variability': 'continuous', 'Value': '1.0', 'alias': 'noAlias', 'Changeable': 'true', 'Description': None}]





>>> mod.getQuantities(["c","radius"]) // method-3, to query information about list of quantity
[{'aliasvariable': None, 'Name': 'c', 'Variability': 'parameter', 'Value': '0.9', 'alias': 'noAlias', 'Changeable': 'true', 'Description': None}, {'aliasvariable': None, 'Name': 'radius', 'Variability': 'parameter', 'Value': '0.1', 'alias': 'noAlias', 'Changeable': 'true', 'Description': None}]





>>> mod.getContinuous() // method-1, list of continuous variable
{'velocity': -1.825929609047952, 'der(velocity)': -9.8100000000000005, 'der(height)': -1.825929609047952, 'height': 0.65907039052943617}





>>> mod.getContinuous(["velocity","height"]) // method-2, get specific variable value information
(-1.825929609047952, 0.65907039052943617)





>>> mod.getInputs()
{}





>>>  mod.getOutputs()
{}





>>> mod.getParameters()  // method-1
{'c': 0.9, 'radius': 0.1}





>>> mod.getParameters(["c","radius"]) // method-2
[0.9, 0.1]





>>> mod.getSimulationOptions()  // method-1
{'stepSize': 0.002, 'stopTime': 1.0, 'tolerance': 1e-06, 'startTime': 0.0, 'solver': 'dassl'}





>>> mod.getSimulationOptions(["stepSize","tolerance"]) // method-2
[0.002, 1e-06]






	The getSolution method can be used in two different ways.
	
	using default result filename


	use the result filenames provided by user








This provides a way to compare simulation results and perform regression testing

>>> mod.getSolutions() // method-1 returns list of simulation variables for which results are available
['time', 'height', 'velocity', 'der(height)', 'der(velocity)', 'c', 'radius']





>>> mod.getSolutions(["time","height"])  // return list of numpy arrays





>>> mod.getSolutions(resultfile="c:/tmpbouncingBall.mat") // method-2 returns list of simulation variables for which results are available , the resulfile location is provided by user





>>> mod.getSolutions(["time","height"],resultfile="c:/tmpbouncingBall.mat") // return list of array








Standard set methods


	setInputs()


	setParameters()


	setSimulationOptions()




Two setting possibilities are accepted using setXXXs(),where "XXX" can be any of above functions.


	setXXX("Name=value") string of keyword assignments


	setXXX(["Name1=value1","Name2=value2","Name3=value3"])  list of string of keyword assignments







Usage of setMethods

>>> mod.setInputs(["cAi=1","Ti=2"]) // method-2





>>> mod.setParameters("radius=14") // method-1 setting parameter value





>>> mod.setParameters(["radius=14","c=0.5"]) // method-2 setting parameter value using second option





>>> mod.setSimulationOptions(["stopTime=2.0","tolerance=1e-08"]) // method-2








Simulation

An example of how to get parameter names and change the value of parameters using set methods and finally simulate the  "BouncingBall.mo" model is given below.

>>>  mod.getParameters()
{'c': 0.9, 'radius': 0.1}





>>>  mod.setParameters(["radius=14","c=0.5"]) //setting parameter value





To check whether new values are updated to model , we can again query the getParameters().

>>> mod.getParameters()
{'c': 0.5, 'radius': 14}






	And then finally we can simulate the model using, The simulate() API can be used in two methods
	
	without any arguments


	resultfile names provided by user (only filename is allowed and not the location)








>>> mod.simulate() // method-1 default result file name will be used
>>> mod.simulate(resultfile="tmpbouncingBall.mat")  // method-2 resultfile name provided by users








Linearization

The following methods are proposed for linearization.


	linearize()


	getLinearizationOptions()


	setLinearizationOptions()


	getLinearInputs()


	getLinearOutputs()


	getLinearStates()







Usage of Linearization methods

>>> mod.getLinearizationOptions()  // method-1
{'simflags': ' ', 'stepSize': 0.002, 'stopTime': 1.0, 'startTime': 0.0, 'numberOfIntervals': 500.0, 'tolerance': 1e-08}





>>> mod.getLinearizationOptions("startTime","stopTime") // method-2
[0.0, 1.0]





>>> mod.setLinearizationOptions(["stopTime=2.0","tolerance=1e-06"])





>>> mod.linearize()  //returns a tuple of 2D numpy arrays (matrices) A, B, C and D.





>>> mod.getLinearInputs()  //returns a list of strings of names of inputs used when forming matrices.





>>> mod.getLinearOutputs() //returns a list of strings of names of outputs used when forming matrices





>>> mod.getLinearStates() // returns a list of strings of names of states used when forming matrices.










PySimulator

PySimulator provides a graphical user interface for performing analyses
and simulating different model types (currently Functional Mockup Units
and Modelica Models are supported), plotting result variables and
applying simulation result analysis tools like Fast Fourier Transform.

Read more about the PySimulator at https://github.com/PySimulator/PySimulator.
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OMMatlab – OpenModelica Matlab Interface

OMMatlab – the OpenModelica Matlab API is a free, open source, highly
portable Matlab-based interactive session handler for Modelica
scripting. It provides the modeler with components for creating a
complete Modelica modeling, compilation and simulation environment based
on the latest OpenModelica library standard available. OMMatlab is
architectured to combine both the solving strategy and model building.
So domain experts (people writing the models) and computational
engineers (people writing the solver code) can work on one unified tool
that is industrially viable for optimization of Modelica models, while
offering a flexible platform for algorithm development and research.
OMMatlab is not a standalone package, it depends upon the
OpenModelica installation.

OMMatlab is implemented in Matlab and depends on
ZeroMQ - high performance asynchronous
messaging library and it supports the Modelica
Standard Library version 3.2 that is included in starting with
OpenModelica 1.9.2.

To install OMMatlab follow the instructions at https://github.com/OpenModelica/OMMatlab


Features of OMMatlab

The OMMatlab package contains the following features:


	Import the OMMatlab package in Matlab


	Connect with the OpenModelica compiler through zmq sockets


	Able to interact with the OpenModelica compiler through the available API


	All the API calls are communicated with the help of the sendExpression method implemented in a Matlab pacakge


	The results are returned as strings







Test Commands

To get started, create a OMMatlab session object:

>>> import OMMatlab.*
>>> omc= OMMatlab()
>>> omc.sendExpression("getVersion()")
'v1.13.0-dev-531-gde26b558a (64-bit)'
>>> omc.sendExpression("loadModel(Modelica)")
'true'
>>> omc.sendExpression("model a Real s; equation s=sin(10*time); end a;")
'{a}'
>>> omc.sendExpression("simulate(a)")
>>> omc.sendExpression("plot(s)")
'true'






[image: _images/sineplot.png]



Advanced OMMatlab Features

OMMatlab package has advanced functionality for querying more information about the models
and simulate them. A list of new user friendly API functionality allows user to extract information about models using matlab
objects. A list of API functionality is described below.

To get started, create a ModelicaSystem object:

>>> import OMMatlab.*
>>> omc= OMMatlab()
>>> omc.ModelicaSystem("BouncingBall.mo","BouncingBall")





The object constructor requires a minimum of 2 input arguments which are strings, and third input argument which is optional .


	The first input argument must be a string with the file name of the Modelica code, with Modelica file extension ".mo".
If the Modelica file is not in the current directory, then the file path must also be included.


	The second input argument must be a string with the name of the Modelica model
including the namespace if the model is wrapped within a Modelica package.


	The third input argument (optional) is used to specify the list of dependent libraries or dependent Modelica files
The argument can be passed as a string or array of strings e.g.,




>>> omc.ModelicaSystem("BouncingBall.mo","BouncingBall",["Modelica", "SystemDynamics", "dcmotor.mo"])










WorkDirectory

For each Matlab session a temporary work directory is created and the results are published in that working directory, Inorder to get the workdirectory the users can
use the following API

>>> omc.getWorkDirectory()
'C:/Users/arupa54/AppData/Local/Temp/tp7dd648e5_5de6_4f66_b3d6_90bce1fe1d58'








BuildModel

The buildModel API can be used after ModelicaSystem(), in case the model needs to be updated or additional simulationflags needs to be set using sendExpression()

>>> buildModel(mod)








Standard get methods


	getQuantities()


	showQuantities()


	getContinuous()


	getInputs()


	getOutputs()


	getParameters()


	getSimulationOptions()


	getSolutions()




Three calling possibilities are accepted using getXXX() where "XXX" can be any of the above functions (eg:) getParameters().


	getXXX() without input argument, returns a dictionary with names as keys and values as values.


	getXXX(S), where S is a string of names.


	getXXX(["S1","S2"]) where S1 and S1 are array of string elements







Usage of getMethods

>>> omc.getQuantities() // method-1, list of all variables from xml file
+----------+------------+-------------------------+--------------+------------+-----------+---------------+-------+
| name     | changeable | description             | variability  | causality  | alias     | aliasVariable | value |
+----------+------------+-------------------------+--------------+------------+-----------+---------------+-------+
| 'h'      | 'true'     | 'height of ball'        | 'continuous' | 'internal' | 'noAlias' | ''            | '1.0' |
+----------+------------+-------------------------+--------------+------------+-----------+---------------+-------+
| 'v'      | 'true'     | 'velocity of ball'      | 'continuous' | 'internal' | 'noAlias' | ''            | ''    |
+----------+------------+-------------------------+--------------+------------+-----------+---------------+-------+
| 'der(h)' | 'false'    | 'der(height of ball)'   | 'continuous' | 'internal' | 'noAlias' | ''            | ''    |
+----------+------------+-------------------------+--------------+------------+-----------+---------------+-------+
| 'der(v)' | 'false'    | 'der(velocity of ball)' | 'continuous' | 'internal' | 'noAlias' | ''            | ''    |
+----------+------------+-------------------------+--------------+------------+-----------+---------------+-------+





>>> omc.getQuantities("h") // method-2, to query information about single quantity
+----------+------------+-------------------------+--------------+------------+-----------+---------------+-------+
| name     | changeable | description             | variability  | causality  | alias     | aliasVariable | value |
+----------+------------+-------------------------+--------------+------------+-----------+---------------+-------+
| 'h'      | 'true'     | 'height of ball'        | 'continuous' | 'internal' | 'noAlias' | ''            | '1.0' |
+----------+------------+-------------------------+--------------+------------+-----------+---------------+-------+





>>> omc.getQuantities(["h","v"]) // method-3, to query information about list of quantity
+----------+------------+-------------------------+--------------+------------+-----------+---------------+-------+
| name     | changeable | description             | variability  | causality  | alias     | aliasVariable | value |
+----------+------------+-------------------------+--------------+------------+-----------+---------------+-------+
| 'h'      | 'true'     | 'height of ball'        | 'continuous' | 'internal' | 'noAlias' | ''            | '1.0' |
+----------+------------+-------------------------+--------------+------------+-----------+---------------+-------+
| 'v'      | 'true'     | 'velocity of ball'      | 'continuous' | 'internal' | 'noAlias' | ''            | ''    |
+----------+------------+-------------------------+--------------+------------+-----------+---------------+-------+





>>> omc.getContinuous() // method-1, returns struct of continuous variable
struct with fields:
  h     : '1.0'
  v     : ''
  der_h_: ''
  der_v_: ''





>>> omc.getContinuous(["h","v"])   // method-2, returns string array
"1.0"    ""





>>> omc.getInputs()
struct with no fields





>>> omc.getOutputs()
struct with no fields





>>> omc.getParameters()  // method-1
struct with fields:
        e: '0.7'
        g: '9.810000000000001'





>>> omc.getParameters(["c","radius"]) // method-2
"0.7"  "9.810000000000001"





>>> omc.getSimulationOptions()  // method-1
struct with fields:
        startTime: '0'
         stopTime: '1'
         stepSize: '0.002'
        tolerance: '1e-006'
           solver: 'dassl'





>>> omc.getSimulationOptions(["stepSize","tolerance"]) // method-2
"0.002", "1e-006"






	The getSolution method can be used in two different ways.
	
	using default result filename


	use the result filenames provided by user








This provides a way to compare simulation results and perform regression testing

>>> omc.getSolutions() // method-1 returns string arrays of simulation variables for which results are available, the default result filename is taken
"time", "height", ""velocity", "der(height)", "der(velocity)", "c", "radius"





>>> omc.getSolutions(["time","h"])  // return list of cell arrays
1×2 cell array
{1×506 double}    {1×506 double}





>>> omc.getSolutions([],"c:/tmpbouncingBall.mat") // method-2 returns string arrays of simulation variables for which results are available , the resulfile location is provided by user
"time", "height", "velocity", "der(height)", "der(velocity)", "c", "radius"





>>> omc.getSolutions(["time","h"],"c:/tmpbouncingBall.mat") // return list of cell arrays
1×2 cell array
{1×506 double}    {1×506 double}








Standard set methods


	setInputs()


	setParameters()


	setSimulationOptions()




Two setting possibilities are accepted using setXXXs(),where "XXX" can be any of above functions.


	setXXX("Name=value") string of keyword assignments


	setXXX(["Name1=value1","Name2=value2","Name3=value3"])  array of string of keyword assignments







Usage of setMethods

>>> omc.setInputs("cAi=1") // method-1





>>> omc.setInputs(["cAi=1","Ti=2"]) // method-2





>>> omc.setParameters("e=14") // method-1





>>> omc.setParameters(["e=14","g=10.8"]) // method-2 setting parameter value using array of string





>>> omc.setSimulationOptions(["stopTime=2.0","tolerance=1e-08"])








Advanced Simulation

An example of how to do advanced simulation to set parameter values using set methods and finally simulate the  "BouncingBall.mo" model is given below .

>>> omc.getParameters()
struct with fields:
        e: '0.7'
        g: '9.810000000000001'





>>> omc.setParameters(["e=0.9","g=9.83"])





To check whether new values are updated to model , we can again query the getParameters().

>>> omc.getParameters()
struct with fields:
    e: "0.9"
    g: "9.83"





Similary we can also use setInputs() to set a value for the inputs during various time interval can also be done using the following.

>>> omc.setInputs("cAi=1")






	And then finally we can simulate the model using, The simulate() API can be used in two methods
	
	without any arguments


	resultfile names provided by user (only filename is allowed and not the location)








>>> omc.simulate() // method-1 default result file name will be used
>>> omc.simulate("tmpbouncingBall.mat") // method-2 resultfile name provided by users








Linearization

The following methods are available for linearization of a modelica model


	linearize()


	getLinearizationOptions()


	setLinearizationOptions()


	getLinearInputs()


	getLinearOutputs()


	getLinearStates()







Usage of Linearization methods

>>> omc.getLinearizationOptions()  // method-1





>>> omc.getLinearizationOptions(["startTime","stopTime"]) // method-2
"0.0", "1.0"





>>> omc.setLinearizationOptions(["stopTime=2.0","tolerance=1e-08"])





>>> omc.linearize()  //returns a list 2D arrays (matrices) A, B, C and D.





>>> omc.getLinearInputs()  //returns a list of strings of names of inputs used when forming matrices.





>>> omc.getLinearOutputs() //returns a list of strings of names of outputs used when forming matrices.





>>> omc.getLinearStates() // returns a list of strings of names of states used when forming matrices.
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OMJulia – OpenModelica Julia Scripting

OMJulia – the OpenModelica Julia API is a free, open source,
highly portable Julia based interactive session handler for
Julia scripting of OpenModelica API functionality. It provides the modeler
with components for creating a complete Julia-Modelica modeling, compilation
and simulation environment based on the latest OpenModelica implementation
and Modelica library standard available. OMJulia is architectured to
combine both the solving strategy and model building.
Thus, domain experts (people writing the models) and computational
engineers (people writing the solver code) can work on one unified tool
that is industrially viable for optimization of Modelica models, while
offering a flexible platform for algorithm development and research.
OMJulia is not a standalone package, it depends upon the
OpenModelica installation.

OMJulia is implemented in Julia and depends on
ZeroMQ - high performance asynchronous messaging library and it supports the Modelica
Standard Library version 3.2 that is included in starting with
OpenModelica 1.9.2.

To install OMJulia follow the instructions at https://github.com/OpenModelica/OMJulia.jl


Features of OMJulia

The OMJulia package contains the following features:


	Interactive session handling, parsing, interpretation of commands and
Modelica expressions for evaluation, simulation, plotting, etc.


	Connect with the OpenModelica compiler through zmq sockets


	Able to interact with the OpenModelica compiler through the available API


	Easy access to the Modelica Standard library.


	All the API calls are communicated with the help of the sendExpression method implemented in a Julia module


	The results are returned as strings







Test Commands

To get started, create an OMJulia session object:

>>> using OMJulia
>>> omc= OMJulia.OMCSession()
>>> sendExpression(omc,"loadModel(Modelica)")
true
>>> sendExpression(omc,"model a Real s; equation s=sin(10*time); end a;")
1-element Array{Symbol,1}:
 :a
>>> sendExpression(omc,"simulate(a)")
>>> sendExpression(omc,"plot(s)")
true
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Advanced OMJulia Features

OMJulia package has advanced functionality for querying more information about the models
and simulate them. A list of new user friendly API functionality allows user to extract information about models using julia
objects. A list of API functionality is described below.

To get started, create a ModelicaSystem object:

>>> using OMJulia
>>> mod = OMJulia.OMCSession()
>>> ModelicaSystem(mod,"BouncingBall.mo","BouncingBall")





The object constructor requires a minimum of 2 input arguments which are strings, and third input argument which is optional .


	The first input argument must be a string with the file name of the Modelica code, with Modelica file extension ".mo".
If the Modelica file is not in the current directory, then the file path must also be included.


	The second input argument must be a string with the name of the Modelica model
including the namespace if the model is wrapped within a Modelica package.


	The third input argument (optional) is used to specify the list of dependent libraries or dependent Modelica files
The argument can be passed as a string or array of strings e.g.,




>>> ModelicaSystem(mod,"BouncingBall.mo","BouncingBall",["Modelica", "SystemDynamics", "dcmotor.mo"])










WorkDirectory

For each OMJulia session a temporary work directory is created and the results are published in that working directory, Inorder to get the workdirectory the users can
use the following API

>>> getWorkDirectory(mod)
"C:/Users/arupa54/AppData/Local/Temp/jl_5pbewl"








BuildModel

The buildModel API can be used after ModelicaSystem(), in case the model needs to be updated or additional simulationflags needs to be set using sendExpression()

>>> buildModel(mod)








Standard get methods


	getQuantities()


	showQuantities()


	getContinuous()


	getInputs()


	getOutputs()


	getParameters()


	getSimulationOptions()


	getSolutions()




Three calling possibilities are accepted using getXXX() where "XXX" can be any of the above functions (eg:) getParameters().


	getXXX() without input argument, returns a dictionary with names as keys and values as values.


	getXXX(S), where S is a string of names.


	getXXX(["S1","S2"]) where S1 and S1 are array of string elements







Usage of getMethods

>>> getQuantities(mod) // method-1, list of all variables from xml file
[{"aliasvariable": None, "Name": "height", "Variability": "continuous", "Value": "1.0", "alias": "noAlias", "Changeable": "true", "Description": None}, {"aliasvariable": None, "Name": "c", "Variability": "parameter", "Value": "0.9", "alias": "noAlias", "Changeable": "true", "Description": None}]





>>> getQuantities(mod,"height") // method-2, to query information about single quantity
[{"aliasvariable": None, "Name": "height", "Variability": "continuous", "Value": "1.0", "alias": "noAlias", "Changeable": "true", "Description": None}]





>>> getQuantities(mod,["c","radius"]) // method-3, to query information about list of quantity
[{"aliasvariable": None, "Name": "c", "Variability": "parameter", "Value": "0.9", "alias": "noAlias", "Changeable": "true", "Description": None}, {"aliasvariable": None, "Name": "radius", "Variability": "parameter", "Value": "0.1", "alias": "noAlias", "Changeable": "true", "Description": None}]





>>> getContinuous(mod) // method-1, list of continuous variable
{"velocity": "-1.825929609047952", "der(velocity)": "-9.8100000000000005", "der(height)": "-1.825929609047952", "height": "0.65907039052943617"}





>>> getContinuous(mod,["velocity","height"]) // method-2, get specific variable value information
["-1.825929609047952", "0.65907039052943617"]





>>> getInputs(mod)
{}





>>> getOutputs(mod)
{}





>>> getParameters(mod)  // method-1
{"c": "0.9", "radius": "0.1"}





>>> getParameters(mod,["c","radius"]) // method-2
["0.9", "0.1"]





>>> getSimulationOptions(mod)  // method-1
{"stepSize": "0.002", "stopTime": "1.0", "tolerance": "1e-06", "startTime": "0.0", "solver": "dassl"}





>>> getSimulationOptions(mod,["stepSize","tolerance"]) // method-2
["0.002", "1e-06"]






	The getSolution method can be used in two different ways.
	
	using default result filename


	use the result filenames provided by user








This provides a way to compare simulation results and perform regression testing

>>> getSolutions(mod) // method-1 returns list of simulation variables for which results are available
["time", "height", ""velocity", "der(height)", "der(velocity)", "c", "radius"]





>>> getSolutions(mod,["time","height"])  // return list of array





>>> getSolutions(mod,resultfile="c:/tmpbouncingBall.mat") // method-2 returns list of simulation variables for which results are available , the resulfile location is provided by user
["time", "height", ""velocity", "der(height)", "der(velocity)", "c", "radius"]





>>> getSolutions(mod,["time","h"],resultfile="c:/tmpbouncingBall.mat") // return list of array





>>> showQuantities(mod) // same as getQuantities() but returns the results in the form table








Standard set methods


	setInputs()


	setParameters()


	setSimulationOptions()




Two setting possibilities are accepted using setXXXs(),where "XXX" can be any of above functions.


	setXXX("Name=value") string of keyword assignments


	setXXX(["Name1=value1","Name2=value2","Name3=value3"])  array of string of keyword assignments







Usage of setMethods

>>> setInputs(mod,"cAi=1") // method-1





>>> setInputs(mod,["cAi=1","Ti=2"]) // method-2





>>> setParameters(mod,"radius=14") // method-1





>>> setParameters(mod,["radius=14","c=0.5"]) // method-2 setting parameter value using array of string





>>> setSimulationOptions(mod,["stopTime=2.0","tolerance=1e-08"])








Advanced Simulation

An example of how to do advanced simulation to set parameter values using set methods and finally simulate the  "BouncingBall.mo" model is given below .

>>> getParameters(mod)
{"c": "0.9", "radius": "0.1"}





>>> setParameters(mod,["radius=14","c=0.5"])





To check whether new values are updated to model , we can again query the getParameters().

>>> getParameters(mod)
{"c": "0.5", "radius": "14"}





Similary we can also use setInputs() to set a value for the inputs during various time interval can also be done using the following.

>>> setInputs(mod,"cAi=1")






	And then finally we can simulate the model using, The simulate() API can be used in two methods
	
	without any arguments


	resultfile names provided by user (only filename is allowed and not the location)








>>> simulate(mod) // method-1 default result file name will be used
>>> simulate(mod,resultfile="tmpbouncingBall.mat") // method-2 resultfile name provided by users








Linearization

The following methods are available for linearization of a modelica model


	linearize()


	getLinearizationOptions()


	setLinearizationOptions()


	getLinearInputs()


	getLinearOutputs()


	getLinearStates()







Usage of Linearization methods

>>> getLinearizationOptions(mod)  // method-1
{"stepSize": "0.002", "stopTime": "1.0", "startTime": "0.0", "numberOfIntervals": "500.0", "tolerance": "1e-08"}





>>> getLinearizationOptions(mod,["startTime","stopTime"]) // method-2
["0.0", "1.0"]





>>> setLinearizationOptions(mod,["stopTime=2.0","tolerance=1e-06"])





>>> linearize(mod)  //returns a list 2D arrays (matrices) A, B, C and D.





>>> getLinearInputs(mod)  //returns a list of strings of names of inputs used when forming matrices.





>>> getLinearOutputs(mod) //returns a list of strings of names of outputs used when forming matrices.





>>> getLinearStates(mod) // returns a list of strings of names of states used when forming matrices.








Sensitivity Analysis

A Method for computing numeric sensitivity of modelica model is available .


	(res1,res2) = sensitivity(arg1,arg2,arg3)




The constructor requires a minimum of 3 input arguments .


	arg1: Array of strings of Modelica Parameter names


	arg2: Array of strings of Modelica Variable names


	arg3: Array of float Excitations of parameters; defaults to scalar 1e-2




The results contains the following .


	res1: Vector of Sensitivity names.


	res2: Array of sensitivies: vector of elements per parameter, each element containing time series per variable.







Usage

>>> (Sn, Sa) = sensitivity(mod,["UA","EdR"],["T","cA"],[1e-2,1e-4])





With the above list of API calls implemented, the users can have more control over the result types, returned as Julia data structures.
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Jupyter-OpenModelica

An OpenModelica Kernel for Jupyter Notebook. All commands are interpreted by OMPython
which communicates with OpenModelica Compiler and the results are presented to user.

The project is available at https://github.com/OpenModelica/jupyter-openmodelica.

Follow the Readme file to install and start running modelica models directly in Jupyter Notebook
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Scripting API

The following are short summaries of OpenModelica scripting commands.
These commands are useful for loading and saving classes, reading and
storing data, plotting of results, and various other tasks.

The arguments passed to a scripting function should follow syntactic and
typing rules for Modelica and for the scripting function in question. In
the following tables we briefly indicate the types or character of the
formal parameters to the functions by the following notation:


	String typed argument, e.g. "hello", "myfile.mo".


	
	TypeName – class, package or function name, e.g. MyClass,
	Modelica.Math.







	VariableName – variable name, e.g. v1, v2, vars1[2].x, etc.


	Integer or Real typed argument, e.g. 35, 3.14, xintvariable.


	options – optional parameters with named formal parameter passing.





OpenModelica Scripting Commands

The following are brief descriptions of the scripting commands available
in the OpenModelica environment. All commands are shown in alphabetical order:


interactiveDumpAbsynToJL

function interactiveDumpAbsynToJL
  output String res;
end interactiveDumpAbsynToJL;








relocateFunctions

function relocateFunctions
  input String fileName;
  input String names[:, 2];
  output Boolean success;
end relocateFunctions;








toJulia

function toJulia
  output String res;
end toJulia;








GC_expand_hp

function GC_expand_hp
  input Integer size;
  output Boolean success;
end GC_expand_hp;








GC_gcollect_and_unmap




GC_get_prof_stats

function GC_get_prof_stats
  output GC_PROFSTATS gcStats;
end GC_get_prof_stats;








GC_set_max_heap_size

function GC_set_max_heap_size
  input Integer size;
  output Boolean success;
end GC_set_max_heap_size;








addClassAnnotation

function addClassAnnotation
  input TypeName class_;
  input ExpressionOrModification annotate;
  output Boolean bool;
end addClassAnnotation;








addInitialState

function addInitialState
  input TypeName cl;
  input String state;
  input ExpressionOrModification annotate;
  output Boolean bool;
end addInitialState;








addTransition

function addTransition
  input TypeName cl;
  input String from;
  input String to;
  input String condition;
  input Boolean immediate = true;
  input Boolean reset = true;
  input Boolean synchronize = false;
  input Integer priority = 1;
  input ExpressionOrModification annotate;
  output Boolean bool;
end addTransition;








alarm

impure function alarm
  input Integer seconds;
  output Integer previousSeconds;
end alarm;








appendEnvironmentVar

Appends a variable to the environment variables list.





function appendEnvironmentVar
  input String var;
  input String value;
  output String result "returns \"error\" if the variable could not be appended";
end appendEnvironmentVar;








basename

function basename
  input String path;
  output String basename;
end basename;








buildEncryptedPackage

function buildEncryptedPackage
  input TypeName className "the class that should encrypted";
  input Boolean encrypt = true;
  output Boolean success;
end buildEncryptedPackage;








buildLabel

builds Lable.





function buildLabel
  input TypeName className "the class that should be built";
  input Real startTime = 0.0 "the start time of the simulation. <default> = 0.0";
  input Real stopTime = 1.0 "the stop time of the simulation. <default> = 1.0";
  input Integer numberOfIntervals = 500 "number of intervals in the result file. <default> = 500";
  input Real tolerance = 1e-6 "tolerance used by the integration method. <default> = 1e-6";
  input String method = "dassl" "integration method used for simulation. <default> = dassl";
  input String fileNamePrefix = "" "fileNamePrefix. <default> = \"\"";
  input String options = "" "options. <default> = \"\"";
  input String outputFormat = "mat" "Format for the result file. <default> = \"mat\"";
  input String variableFilter = ".*" "Filter for variables that should store in result file. <default> = \".*\"";
  input String cflags = "" "cflags. <default> = \"\"";
  input String simflags = "" "simflags. <default> = \"\"";
  output String[2] buildModelResults;
end buildLabel;








buildModel

builds a modelica model by generating c code and build it.
It does not run the code!
The only required argument is the className, while all others have some default values.
simulate(className, [startTime], [stopTime], [numberOfIntervals], [tolerance], [method], [fileNamePrefix], [options], [outputFormat], [variableFilter], [cflags], [simflags])
Example command:
simulate(A);





function buildModel
  input TypeName className "the class that should be built";
  input Real startTime = "<default>" "the start time of the simulation. <default> = 0.0";
  input Real stopTime = 1.0 "the stop time of the simulation. <default> = 1.0";
  input Real numberOfIntervals = 500 "number of intervals in the result file. <default> = 500";
  input Real tolerance = 1e-6 "tolerance used by the integration method. <default> = 1e-6";
  input String method = "<default>" "integration method used for simulation. <default> = dassl";
  input String fileNamePrefix = "<default>" "fileNamePrefix. <default> = \"\"";
  input String options = "<default>" "options. <default> = \"\"";
  input String outputFormat = "mat" "Format for the result file. <default> = \"mat\"";
  input String variableFilter = ".*" "Filter for variables that should store in result file. <default> = \".*\"";
  input String cflags = "<default>" "cflags. <default> = \"\"";
  input String simflags = "<default>" "simflags. <default> = \"\"";
  output String[2] buildModelResults;
end buildModel;








buildModelFMU

translates a modelica model into a Functional Mockup Unit.
The only required argument is the className, while all others have some default values.
Example command:
buildModelFMU(className, version="2.0");





function buildModelFMU
  input TypeName className "the class that should translated";
  input String version = "2.0" "FMU version, 1.0 or 2.0.";
  input String fmuType = "me" "FMU type, me (model exchange), cs (co-simulation), me_cs (both model exchange and co-simulation)";
  input String fileNamePrefix = "<default>" "fileNamePrefix. <default> = \"className\"";
  input String platforms[:] = {"static"} "The list of platforms to generate code for. \"dynamic\"=current platform, dynamically link the runtime. \"static\"=current platform, statically link everything. Else, use a host triple, e.g. \"x86_64-linux-gnu\" or \"x86_64-w64-mingw32\"";
  input Boolean includeResources = false "include Modelica based resources via loadResource or not";
  output String generatedFileName "Returns the full path of the generated FMU.";
end buildModelFMU;








buildOpenTURNSInterface

generates wrapper code for OpenTURNS





function buildOpenTURNSInterface
  input TypeName className;
  input String pythonTemplateFile;
  input Boolean showFlatModelica = false;
  output String outPythonScript;
end buildOpenTURNSInterface;








cd

change directory to the given path (which may be either relative or absolute)
returns the new working directory on success or a message on failure
if the given path is the empty string, the function simply returns the current working directory.





function cd
  input String newWorkingDirectory = "";
  output String workingDirectory;
end cd;








checkAllModelsRecursive

Checks all models recursively and returns number of variables and equations.





function checkAllModelsRecursive
  input TypeName className;
  input Boolean checkProtected = false "Checks also protected classes if true";
  output String result;
end checkAllModelsRecursive;








checkCodeGraph

Checks if the given taskgraph has the same structure as the graph described in the codefile.





function checkCodeGraph
  input String graphfile;
  input String codefile;
  output String[:] result;
end checkCodeGraph;








checkInterfaceOfPackages

function checkInterfaceOfPackages
  input TypeName cl;
  input String dependencyMatrix[:, :];
  output Boolean success;
end checkInterfaceOfPackages;








checkModel

Checks a model and returns number of variables and equations.





function checkModel
  input TypeName className;
  output String result;
end checkModel;








checkSettings

Display some diagnostics.





function checkSettings
  output CheckSettingsResult result;
end checkSettings;








checkTaskGraph

Checks if the given taskgraph has the same structure as the reference taskgraph and if all attributes are set correctly.





function checkTaskGraph
  input String filename;
  input String reffilename;
  output String[:] result;
end checkTaskGraph;








classAnnotationExists

Check if annotation exists





function classAnnotationExists
  input TypeName className;
  input TypeName annotationName;
  output Boolean exists;
end classAnnotationExists;








clear

Clears everything: symboltable and variables.





function clear
  output Boolean success;
end clear;








clearCommandLineOptions

Resets all command-line flags to their default values.





function clearCommandLineOptions
  output Boolean success;
end clearCommandLineOptions;








clearDebugFlags

Resets all debug flags to their default values.





function clearDebugFlags
  output Boolean success;
end clearDebugFlags;








clearMessages

Clears the error buffer.





function clearMessages
  output Boolean success;
end clearMessages;








clearProgram

Clears loaded .





function clearProgram
  output Boolean success;
end clearProgram;








clearVariables

Clear all user defined variables.





function clearVariables
  output Boolean success;
end clearVariables;








closeSimulationResultFile

Closes the current simulation result file.
Only needed by Windows. Windows cannot handle reading and writing to the same file from different processes.
To allow OMEdit to make successful simulation again on the same file we must close the file after reading the Simulation Result Variables.
Even OMEdit only use this API for Windows.





function closeSimulationResultFile
  output Boolean success;
end closeSimulationResultFile;








codeToString

function codeToString
  input $Code className;
  output String string;
end codeToString;








compareFiles

impure function compareFiles
  input String file1;
  input String file2;
  output Boolean isEqual;
end compareFiles;








compareFilesAndMove

impure function compareFilesAndMove
  input String newFile;
  input String oldFile;
  output Boolean success;
end compareFilesAndMove;








compareSimulationResults

compares simulation results.





function compareSimulationResults
  input String filename;
  input String reffilename;
  input String logfilename;
  input Real relTol = 0.01;
  input Real absTol = 0.0001;
  input String[:] vars = fill("", 0);
  output String[:] result;
end compareSimulationResults;








convertUnits

function convertUnits
  input String s1;
  input String s2;
  output Boolean unitsCompatible;
  output Real scaleFactor;
  output Real offset;
end convertUnits;








copy

copies the source file to the destination file. Returns true if the file has been copied.





function copy
  input String source;
  input String destination;
  output Boolean success;
end copy;








copyClass

Copies a class within the same level





function copyClass
  input TypeName className "the class that should be copied";
  input String newClassName "the name for new class";
  input TypeName withIn = $Code(TopLevel) "the with in path for new class";
  output Boolean result;
end copyClass;








countMessages

function countMessages
  output Integer numMessages;
  output Integer numErrors;
  output Integer numWarnings;
end countMessages;








deleteFile

Deletes a file with the given name.





function deleteFile
  input String fileName;
  output Boolean success;
end deleteFile;








deleteInitialState

function deleteInitialState
  input TypeName cl;
  input String state;
  output Boolean bool;
end deleteInitialState;








deleteTransition

function deleteTransition
  input TypeName cl;
  input String from;
  input String to;
  input String condition;
  input Boolean immediate;
  input Boolean reset;
  input Boolean synchronize;
  input Integer priority;
  output Boolean bool;
end deleteTransition;








deltaSimulationResults

calculates the sum of absolute errors.





function deltaSimulationResults
  input String filename;
  input String reffilename;
  input String method "method to compute then error. choose 1norm, 2norm, maxerr";
  input String[:] vars = fill("", 0);
  output Real result;
end deltaSimulationResults;








diffModelicaFileListings

Creates diffs of two strings corresponding to Modelica files





function diffModelicaFileListings
  input String before, after;
  input DiffFormat diffFormat = DiffFormat.color;
  output String result;
end diffModelicaFileListings;








diffSimulationResults

compares simulation results.





function diffSimulationResults
  input String actualFile;
  input String expectedFile;
  input String diffPrefix;
  input Real relTol = 1e-3 "y tolerance";
  input Real relTolDiffMinMax = 1e-4 "y tolerance based on the difference between the maximum and minimum of the signal";
  input Real rangeDelta = 0.002 "x tolerance";
  input String[:] vars = fill("", 0);
  input Boolean keepEqualResults = false;
  output Boolean success;
  output String[:] failVars;
end diffSimulationResults;








diffSimulationResultsHtml

function diffSimulationResultsHtml
  input String var;
  input String actualFile;
  input String expectedFile;
  input Real relTol = 1e-3 "y tolerance";
  input Real relTolDiffMinMax = 1e-4 "y tolerance based on the difference between the maximum and minimum of the signal";
  input Real rangeDelta = 0.002 "x tolerance";
  output String html;
end diffSimulationResultsHtml;








directoryExists

function directoryExists
  input String dirName;
  output Boolean exists;
end directoryExists;








dirname

function dirname
  input String path;
  output String dirname;
end dirname;








disableNewInstantiation

function disableNewInstantiation
  output Boolean success;
end disableNewInstantiation;








dumpXMLDAE

Outputs the DAE system corresponding to a specific model.





function dumpXMLDAE
  input TypeName className;
  input String translationLevel = "flat" "flat, optimiser, backEnd, or stateSpace";
  input Boolean addOriginalIncidenceMatrix = false;
  input Boolean addSolvingInfo = false;
  input Boolean addMathMLCode = false;
  input Boolean dumpResiduals = false;
  input String fileNamePrefix = "<default>" "this is the className in string form by default";
  input String rewriteRulesFile = "" "the file from where the rewiteRules are read, default is empty which means no rewrite rules";
  output Boolean success "if the function succeeded true/false";
  output String xmlfileName "the Xml file";
end dumpXMLDAE;








echo

echo(false) disables Interactive output, echo(true) enables it again.





function echo
  input Boolean setEcho;
  output Boolean newEcho;
end echo;








enableNewInstantiation

function enableNewInstantiation
  output Boolean success;
end enableNewInstantiation;








escapeXML

function escapeXML
  input String inStr;
  output String outStr;
end escapeXML;








exit

function exit
  input Integer status;
end exit;








exportToFigaro

function exportToFigaro
  input TypeName path;
  input String directory = cd();
  input String database;
  input String mode;
  input String options;
  input String processor;
  output Boolean success;
end exportToFigaro;








extendsFrom

returns true if the given class extends from the given base class





function extendsFrom
  input TypeName className;
  input TypeName baseClassName;
  output Boolean res;
end extendsFrom;








filterSimulationResults

function filterSimulationResults
  input String inFile;
  input String outFile;
  input String[:] vars;
  input Integer numberOfIntervals = 0 "0=Do not resample";
  input Boolean removeDescription = false;
  output Boolean success;
end filterSimulationResults;








generateCode

The input is a function name for which C-code is generated and compiled into a dll/so





function generateCode
  input TypeName className;
  output Boolean success;
end generateCode;








generateEntryPoint

function generateEntryPoint
  input String fileName;
  input TypeName entryPoint;
  input String url = "https://trac.openmodelica.org/OpenModelica/newticket";
end generateEntryPoint;








generateHeader

function generateHeader
  input String fileName;
  output Boolean success;
end generateHeader;








generateJuliaHeader

function generateJuliaHeader
  input String fileName;
  output Boolean success;
end generateJuliaHeader;








generateScriptingAPI

function generateScriptingAPI
  input TypeName cl;
  input String name;
  output Boolean success;
  output String moFile;
  output String qtFile;
  output String qtHeader;
end generateScriptingAPI;








generateSeparateCode

function generateSeparateCode
  input TypeName className;
  input Boolean cleanCache = false "If true, the cache is reset between each generated package. This conserves memory at the cost of speed.";
  output Boolean success;
end generateSeparateCode;








generateSeparateCodeDependencies

function generateSeparateCodeDependencies
  input String stampSuffix = ".c" "Suffix to add to dependencies (often .c.stamp)";
  output String[:] dependencies;
end generateSeparateCodeDependencies;








generateSeparateCodeDependenciesMakefile

function generateSeparateCodeDependenciesMakefile
  input String filename "The file to write the makefile to";
  input String directory = "" "The relative path of the generated files";
  input String suffix = ".c" "Often .stamp since we do not update all the files";
  output Boolean success;
end generateSeparateCodeDependenciesMakefile;








generateVerificationScenarios

function generateVerificationScenarios
  input TypeName path;
  output Boolean success;
end generateVerificationScenarios;








getAlgorithmCount

Counts the number of Algorithm sections in a class.





function getAlgorithmCount
  input TypeName class_;
  output Integer count;
end getAlgorithmCount;








getAlgorithmItemsCount

Counts the number of Algorithm items in a class.





function getAlgorithmItemsCount
  input TypeName class_;
  output Integer count;
end getAlgorithmItemsCount;








getAllSubtypeOf

Returns the list of all classes that extend from class_ given a parentClass where the lookup for class_ should start





function getAllSubtypeOf
  input TypeName parentClass = $Code(AllLoadedClasses);
  input TypeName class_;
  input Boolean qualified = false;
  input Boolean includePartial = false;
  input Boolean sort = false;
  output TypeName classNames[:];
end getAllSubtypeOf;








getAnnotationCount

Counts the number of Annotation sections in a class.





function getAnnotationCount
  input TypeName class_;
  output Integer count;
end getAnnotationCount;








getAnnotationModifierValue

function getAnnotationModifierValue
  input TypeName name;
  input String vendorannotation;
  input String modifiername;
  output String modifiernamevalue;
end getAnnotationModifierValue;








getAnnotationNamedModifiers

function getAnnotationNamedModifiers
  input TypeName name;
  input String vendorannotation;
  output String[:] modifiernamelist;
end getAnnotationNamedModifiers;








getAnnotationVersion

Returns the current annotation version.





function getAnnotationVersion
  output String annotationVersion;
end getAnnotationVersion;








getAstAsCorbaString

Print the whole AST on the CORBA format for records, e.g.
record Absyn.PROGRAM
classes = ...,
within_ = ...,
globalBuildTimes = ...
end Absyn.PROGRAM;





function getAstAsCorbaString
  input String fileName = "<interactive>";
  output String result "returns the string if fileName is interactive; else it returns ok or error depending on if writing the file succeeded";
end getAstAsCorbaString;








getAvailableIndexReductionMethods

function getAvailableIndexReductionMethods
  output String[:] allChoices;
  output String[:] allComments;
end getAvailableIndexReductionMethods;








getAvailableLibraries

function getAvailableLibraries
  output String[:] libraries;
end getAvailableLibraries;








getAvailableMatchingAlgorithms

function getAvailableMatchingAlgorithms
  output String[:] allChoices;
  output String[:] allComments;
end getAvailableMatchingAlgorithms;








getAvailableTearingMethods

function getAvailableTearingMethods
  output String[:] allChoices;
  output String[:] allComments;
end getAvailableTearingMethods;








getBooleanClassAnnotation

Check if annotation exists and returns its value





function getBooleanClassAnnotation
  input TypeName className;
  input TypeName annotationName;
  output Boolean value;
end getBooleanClassAnnotation;








getBuiltinType

function getBuiltinType
  input TypeName cl;
  output String name;
end getBuiltinType;








getCFlags

CFLAGS





function getCFlags
  output String outString;
end getCFlags;








getCXXCompiler

CXX





function getCXXCompiler
  output String compiler;
end getCXXCompiler;








getClassComment

Returns the class comment.





function getClassComment
  input TypeName cl;
  output String comment;
end getClassComment;








getClassInformation

function getClassInformation
  input TypeName cl;
  output String restriction, comment;
  output Boolean partialPrefix, finalPrefix, encapsulatedPrefix;
  output String fileName;
  output Boolean fileReadOnly;
  output Integer lineNumberStart, columnNumberStart, lineNumberEnd, columnNumberEnd;
  output String dimensions[:];
  output Boolean isProtectedClass;
  output Boolean isDocumentationClass;
  output String version;
  output String preferredView;
  output Boolean state;
  output String access;
end getClassInformation;








getClassNames

Returns the list of class names defined in the class.





function getClassNames
  input TypeName class_ = $Code(AllLoadedClasses);
  input Boolean recursive = false;
  input Boolean qualified = false;
  input Boolean sort = false;
  input Boolean builtin = false "List also builtin classes if true";
  input Boolean showProtected = false "List also protected classes if true";
  input Boolean includeConstants = false "List also constants in the class if true";
  output TypeName classNames[:];
end getClassNames;








getClassRestriction

function getClassRestriction
  input TypeName cl;
  output String restriction;
end getClassRestriction;








getClassesInModelicaPath

MathCore-specific or not? Who knows!





function getClassesInModelicaPath
  output String classesInModelicaPath;
end getClassesInModelicaPath;








getCommandLineOptions

Returns all command line options who have non-default values as a list of
strings. The format of the strings is '--flag=value --flag2=value2'.





function getCommandLineOptions
  output String[:] flags;
end getCommandLineOptions;








getCompileCommand

function getCompileCommand
  output String compileCommand;
end getCompileCommand;








getCompiler

CC





function getCompiler
  output String compiler;
end getCompiler;








getComponentModifierNames

function getComponentModifierNames
  input TypeName class_;
  input String componentName;
  output String[:] modifiers;
end getComponentModifierNames;








getComponentModifierValue

function getComponentModifierValue
  input TypeName class_;
  input TypeName modifier;
  output String value;
end getComponentModifierValue;








getComponentModifierValues

function getComponentModifierValues
  input TypeName class_;
  input TypeName modifier;
  output String value;
end getComponentModifierValues;








getComponentsTest

function getComponentsTest
  input TypeName name;
  output Component[:] components;
  record Component
    String className;
    // when building record the constructor. Records are allowed to contain only components of basic types, arrays of basic types or other records.
    String name;
    String comment;
    Boolean isProtected;
    Boolean isFinal;
    Boolean isFlow;
    Boolean isStream;
    Boolean isReplaceable;
    String variability "'constant', 'parameter', 'discrete', ''";
    String innerOuter "'inner', 'outer', ''";
    String inputOutput "'input', 'output', ''";
    String dimensions[:];
  end Component;
end getComponentsTest;








getConfigFlagValidOptions

Returns the list of valid options for a string config flag, and the description strings for these options if available





function getConfigFlagValidOptions
  input String flag;
  output String validOptions[:];
  output String mainDescription;
  output String descriptions[:];
end getConfigFlagValidOptions;








getConnectionCount

Counts the number of connect equation in a class.





function getConnectionCount
  input TypeName className;
  output Integer count;
end getConnectionCount;








getDefaultOpenCLDevice

Returns the id for the default OpenCL device to be used.





function getDefaultOpenCLDevice
  output Integer defdevid;
end getDefaultOpenCLDevice;








getDerivedClassModifierNames

Returns the derived class modifier names.
Example command:
type Resistance = Real(final quantity="Resistance",final unit="Ohm");
getDerivedClassModifierNames(Resistance) => {"quantity","unit"}





function getDerivedClassModifierNames
  input TypeName className;
  output String[:] modifierNames;
end getDerivedClassModifierNames;








getDerivedClassModifierValue

Returns the derived class modifier value.
Example command:
type Resistance = Real(final quantity="Resistance",final unit="Ohm");
getDerivedClassModifierValue(Resistance, unit); => " = "Ohm""
getDerivedClassModifierValue(Resistance, quantity); => " = "Resistance""





function getDerivedClassModifierValue
  input TypeName className;
  input TypeName modifierName;
  output String modifierValue;
end getDerivedClassModifierValue;








getDerivedUnits

function getDerivedUnits
  input String baseUnit;
  output String[:] derivedUnits;
end getDerivedUnits;








getDocumentationAnnotation

Returns the documentaiton annotation defined in the class.





function getDocumentationAnnotation
  input TypeName cl;
  output String out[3] "{info,revision,infoHeader} TODO: Should be changed to have 2 outputs instead of an array of 2 Strings...";
end getDocumentationAnnotation;








getEnvironmentVar

Returns the value of the environment variable.





function getEnvironmentVar
  input String var;
  output String value "returns empty string on failure";
end getEnvironmentVar;








getEquationCount

Counts the number of Equation sections in a class.





function getEquationCount
  input TypeName class_;
  output Integer count;
end getEquationCount;








getEquationItemsCount

Counts the number of Equation items in a class.





function getEquationItemsCount
  input TypeName class_;
  output Integer count;
end getEquationItemsCount;








getErrorString

Returns the current error message. [file.mo:n:n-n:n:b] Error: message





impure function getErrorString
  input Boolean warningsAsErrors = false;
  output String errorString;
end getErrorString;








getImportCount

Counts the number of Import sections in a class.





function getImportCount
  input TypeName class_;
  output Integer count;
end getImportCount;








getIndexReductionMethod

function getIndexReductionMethod
  output String selected;
end getIndexReductionMethod;








getInheritedClasses

function getInheritedClasses
  input TypeName name;
  output TypeName inheritedClasses[:];
end getInheritedClasses;








getInitialAlgorithmCount

Counts the number of Initial Algorithm sections in a class.





function getInitialAlgorithmCount
  input TypeName class_;
  output Integer count;
end getInitialAlgorithmCount;








getInitialAlgorithmItemsCount

Counts the number of Initial Algorithm items in a class.





function getInitialAlgorithmItemsCount
  input TypeName class_;
  output Integer count;
end getInitialAlgorithmItemsCount;








getInitialEquationCount

Counts the number of Initial Equation sections in a class.





function getInitialEquationCount
  input TypeName class_;
  output Integer count;
end getInitialEquationCount;








getInitialEquationItemsCount

Counts the number of Initial Equation items in a class.





function getInitialEquationItemsCount
  input TypeName class_;
  output Integer count;
end getInitialEquationItemsCount;








getInitialStates

function getInitialStates
  input TypeName cl;
  output String[:, :] initialStates;
end getInitialStates;








getInstallationDirectoryPath

This returns OPENMODELICAHOME if it is set; on some platforms the default path is returned if it is not set.





function getInstallationDirectoryPath
  output String installationDirectoryPath;
end getInstallationDirectoryPath;








getInstantiatedParametersAndValues

function getInstantiatedParametersAndValues
  input TypeName cls;
  output String[:] values;
end getInstantiatedParametersAndValues;








getLanguageStandard

Returns the current Modelica Language Standard in use.





function getLanguageStandard
  output String outVersion;
end getLanguageStandard;








getLinker

function getLinker
  output String linker;
end getLinker;








getLinkerFlags

function getLinkerFlags
  output String linkerFlags;
end getLinkerFlags;








getLoadedLibraries

function getLoadedLibraries
  output String[:, 2] libraries;
end getLoadedLibraries;








getMatchingAlgorithm

function getMatchingAlgorithm
  output String selected;
end getMatchingAlgorithm;








getMemorySize

function getMemorySize
  output Real memory(unit = "MiB");
end getMemorySize;








getMessagesString

see getErrorString()





function getMessagesString
  output String messagesString;
end getMessagesString;








getModelicaPath

Get the Modelica Library Path.





function getModelicaPath
  output String modelicaPath;
end getModelicaPath;








getNoSimplify

Returns true if noSimplify flag is set.





function getNoSimplify
  output Boolean noSimplify;
end getNoSimplify;








getNthAlgorithm

Returns the Nth Algorithm section.





function getNthAlgorithm
  input TypeName class_;
  input Integer index;
  output String result;
end getNthAlgorithm;








getNthAlgorithmItem

Returns the Nth Algorithm Item.





function getNthAlgorithmItem
  input TypeName class_;
  input Integer index;
  output String result;
end getNthAlgorithmItem;








getNthAnnotationString

Returns the Nth Annotation section as string.





function getNthAnnotationString
  input TypeName class_;
  input Integer index;
  output String result;
end getNthAnnotationString;








getNthConnection

Returns the Nth connection.
Example command:
getNthConnection(A) => {"from", "to", "comment"}





function getNthConnection
  input TypeName className;
  input Integer index;
  output String[:] result;
end getNthConnection;








getNthEquation

Returns the Nth Equation section.





function getNthEquation
  input TypeName class_;
  input Integer index;
  output String result;
end getNthEquation;








getNthEquationItem

Returns the Nth Equation Item.





function getNthEquationItem
  input TypeName class_;
  input Integer index;
  output String result;
end getNthEquationItem;








getNthImport

Returns the Nth Import as string.





function getNthImport
  input TypeName class_;
  input Integer index;
  output String out[3] "{\"Path\",\"Id\",\"Kind\"}";
end getNthImport;








getNthInitialAlgorithm

Returns the Nth Initial Algorithm section.





function getNthInitialAlgorithm
  input TypeName class_;
  input Integer index;
  output String result;
end getNthInitialAlgorithm;








getNthInitialAlgorithmItem

Returns the Nth Initial Algorithm Item.





function getNthInitialAlgorithmItem
  input TypeName class_;
  input Integer index;
  output String result;
end getNthInitialAlgorithmItem;








getNthInitialEquation

Returns the Nth Initial Equation section.





function getNthInitialEquation
  input TypeName class_;
  input Integer index;
  output String result;
end getNthInitialEquation;








getNthInitialEquationItem

Returns the Nth Initial Equation Item.





function getNthInitialEquationItem
  input TypeName class_;
  input Integer index;
  output String result;
end getNthInitialEquationItem;








getOrderConnections

Returns true if orderConnections flag is set.





function getOrderConnections
  output Boolean orderConnections;
end getOrderConnections;








getPackages

Returns the list of packages defined in the class.





function getPackages
  input TypeName class_ = $Code(AllLoadedClasses);
  output TypeName classNames[:];
end getPackages;








getParameterNames

function getParameterNames
  input TypeName class_;
  output String[:] parameters;
end getParameterNames;








getParameterValue

function getParameterValue
  input TypeName class_;
  input String parameterName;
  output String parameterValue;
end getParameterValue;








getSettings

function getSettings
  output String settings;
end getSettings;








getShowAnnotations

function getShowAnnotations
  output Boolean show;
end getShowAnnotations;








getSimulationOptions

function getSimulationOptions
  input TypeName name;
  input Real defaultStartTime = 0.0;
  input Real defaultStopTime = 1.0;
  input Real defaultTolerance = 1e-6;
  input Integer defaultNumberOfIntervals = 500 "May be overridden by defining defaultInterval instead";
  input Real defaultInterval = 0.0 "If = 0.0, then numberOfIntervals is used to calculate the step size";
  output Real startTime;
  output Real stopTime;
  output Real tolerance;
  output Integer numberOfIntervals;
  output Real interval;
end getSimulationOptions;








getSourceFile

Returns the filename of the class.





function getSourceFile
  input TypeName class_;
  output String filename "empty on failure";
end getSourceFile;








getTearingMethod

function getTearingMethod
  output String selected;
end getTearingMethod;








getTempDirectoryPath

Returns the current user temporary directory location.





function getTempDirectoryPath
  output String tempDirectoryPath;
end getTempDirectoryPath;








getTimeStamp

function getTimeStamp
  input TypeName cl;
  output Real timeStamp;
  output String timeStampAsString;
end getTimeStamp;








getTransitions

function getTransitions
  input TypeName cl;
  output String[:, :] transitions;
end getTransitions;








getUsedClassNames

Returns the list of class names used in the total program defined by the class.





function getUsedClassNames
  input TypeName className;
  output TypeName classNames[:];
end getUsedClassNames;








getUses

function getUses
  input TypeName pack;
  output String[:, :] uses;
end getUses;








getVectorizationLimit

function getVectorizationLimit
  output Integer vectorizationLimit;
end getVectorizationLimit;








getVersion

Returns the version of the Modelica compiler.





function getVersion
  input TypeName cl = $Code(OpenModelica);
  output String version;
end getVersion;








help

display the OpenModelica help text.





function help
  input String topic = "topics";
  output String helpText;
end help;








iconv

The iconv() function converts one multibyte characters from one character
set to another.
See man (3) iconv for more information.





function iconv
  input String string;
  input String from;
  input String to = "UTF-8";
  output String result;
end iconv;








importFMU

Imports the Functional Mockup Unit
Example command:
importFMU("A.fmu");





function importFMU
  input String filename "the fmu file name";
  input String workdir = "<default>" "The output directory for imported FMU files. <default> will put the files to current working directory.";
  input Integer loglevel = 3 "loglevel_nothing=0;loglevel_fatal=1;loglevel_error=2;loglevel_warning=3;loglevel_info=4;loglevel_verbose=5;loglevel_debug=6";
  input Boolean fullPath = false "When true the full output path is returned otherwise only the file name.";
  input Boolean debugLogging = false "When true the FMU's debug output is printed.";
  input Boolean generateInputConnectors = true "When true creates the input connector pins.";
  input Boolean generateOutputConnectors = true "When true creates the output connector pins.";
  output String generatedFileName "Returns the full path of the generated file.";
end importFMU;








importFMUModelDescription

Imports modelDescription.xml
Example command:
importFMUModelDescription("A.xml");





function importFMUModelDescription
  input String filename "the fmu file name";
  input String workdir = "<default>" "The output directory for imported FMU files. <default> will put the files to current working directory.";
  input Integer loglevel = 3 "loglevel_nothing=0;loglevel_fatal=1;loglevel_error=2;loglevel_warning=3;loglevel_info=4;loglevel_verbose=5;loglevel_debug=6";
  input Boolean fullPath = false "When true the full output path is returned otherwise only the file name.";
  input Boolean debugLogging = false "When true the FMU's debug output is printed.";
  input Boolean generateInputConnectors = true "When true creates the input connector pins.";
  input Boolean generateOutputConnectors = true "When true creates the output connector pins.";
  output String generatedFileName "Returns the full path of the generated file.";
end importFMUModelDescription;








inferBindings

function inferBindings
  input TypeName path;
  output Boolean success;
end inferBindings;








instantiateModel

Instantiates the class and returns the flat Modelica code.





function instantiateModel
  input TypeName className;
  output String result;
end instantiateModel;








isBlock

function isBlock
  input TypeName cl;
  output Boolean b;
end isBlock;








isClass

function isClass
  input TypeName cl;
  output Boolean b;
end isClass;








isConnector

function isConnector
  input TypeName cl;
  output Boolean b;
end isConnector;








isEnumeration

function isEnumeration
  input TypeName cl;
  output Boolean b;
end isEnumeration;








isExperiment

function isExperiment
  input TypeName name;
  output Boolean res;
end isExperiment;








isFunction

function isFunction
  input TypeName cl;
  output Boolean b;
end isFunction;








isModel

function isModel
  input TypeName cl;
  output Boolean b;
end isModel;








isOperator

function isOperator
  input TypeName cl;
  output Boolean b;
end isOperator;








isOperatorFunction

function isOperatorFunction
  input TypeName cl;
  output Boolean b;
end isOperatorFunction;








isOperatorRecord

function isOperatorRecord
  input TypeName cl;
  output Boolean b;
end isOperatorRecord;








isOptimization

function isOptimization
  input TypeName cl;
  output Boolean b;
end isOptimization;








isPackage

function isPackage
  input TypeName cl;
  output Boolean b;
end isPackage;








isPartial

function isPartial
  input TypeName cl;
  output Boolean b;
end isPartial;








isProtectedClass

function isProtectedClass
  input TypeName cl;
  input String c2;
  output Boolean b;
end isProtectedClass;








isRecord

function isRecord
  input TypeName cl;
  output Boolean b;
end isRecord;








isShortDefinition

returns true if the definition is a short class definition





function isShortDefinition
  input TypeName class_;
  output Boolean isShortCls;
end isShortDefinition;








isType

function isType
  input TypeName cl;
  output Boolean b;
end isType;








linearize

creates a model with symbolic linearization matrixes





function linearize
  input TypeName className "the class that should simulated";
  input Real startTime = "<default>" "the start time of the simulation. <default> = 0.0";
  input Real stopTime = 1.0 "the stop time of the simulation. <default> = 1.0";
  input Real numberOfIntervals = 500 "number of intervals in the result file. <default> = 500";
  input Real stepSize = 0.002 "step size that is used for the result file. <default> = 0.002";
  input Real tolerance = 1e-6 "tolerance used by the integration method. <default> = 1e-6";
  input String method = "<default>" "integration method used for simulation. <default> = dassl";
  input String fileNamePrefix = "<default>" "fileNamePrefix. <default> = \"\"";
  input Boolean storeInTemp = false "storeInTemp. <default> = false";
  input Boolean noClean = false "noClean. <default> = false";
  input String options = "<default>" "options. <default> = \"\"";
  input String outputFormat = "mat" "Format for the result file. <default> = \"mat\"";
  input String variableFilter = ".*" "Filter for variables that should store in result file. <default> = \".*\"";
  input String cflags = "<default>" "cflags. <default> = \"\"";
  input String simflags = "<default>" "simflags. <default> = \"\"";
  output String linearizationResult;
end linearize;








list

Lists the contents of the given class, or all loaded classes.





function list
  input TypeName class_ = $Code(AllLoadedClasses);
  input Boolean interfaceOnly = false;
  input Boolean shortOnly = false "only short class definitions";
  input ExportKind exportKind = ExportKind.Absyn;
  output String contents;
end list;








listFile

Lists the contents of the file given by the class.





function listFile
  input TypeName class_;
  input Boolean nestedClasses = true;
  output String contents;
end listFile;








listVariables

Lists the names of the active variables in the scripting environment.





function listVariables
  output TypeName variables[:];
end listVariables;








loadEncryptedPackage

function loadEncryptedPackage
  input String fileName;
  input String workdir = "<default>" "The output directory for imported encrypted files. <default> will put the files to current working directory.";
  output Boolean success;
end loadEncryptedPackage;








loadFile

load file (*.mo) and merge it with the loaded AST.





function loadFile
  input String fileName;
  input String encoding = "UTF-8";
  input Boolean uses = true;
  output Boolean success;
end loadFile;








loadFileInteractive

function loadFileInteractive
  input String filename;
  input String encoding = "UTF-8";
  output TypeName names[:];
end loadFileInteractive;








loadFileInteractiveQualified

function loadFileInteractiveQualified
  input String filename;
  input String encoding = "UTF-8";
  output TypeName names[:];
end loadFileInteractiveQualified;








loadFiles

load files (*.mo) and merges them with the loaded AST.





function loadFiles
  input String[:] fileNames;
  input String encoding = "UTF-8";
  input Integer numThreads = OpenModelica.Scripting.numProcessors();
  output Boolean success;
end loadFiles;








loadModel

Loads the Modelica Standard Library.





function loadModel
  input TypeName className;
  input String[:] priorityVersion = {"default"};
  input Boolean notify = false "Give a notification of the libraries and versions that were loaded";
  input String languageStandard = "" "Override the set language standard. Parse with the given setting, but do not change it permanently.";
  input Boolean requireExactVersion = false "If the version is required to be exact, if there is a uses Modelica(version=\"3.2\"), Modelica 3.2.1 will not match it.";
  output Boolean success;
end loadModel;








loadModelica3D

function loadModelica3D
  input String version = "3.2.1";
  output Boolean status;
end loadModelica3D;








loadOMSimulator

loads the OMSimulator DLL from default path





function loadOMSimulator
  output Integer status;
end loadOMSimulator;








loadString

Parses the data and merges the resulting AST with ithe
loaded AST.
If a filename is given, it is used to provide error-messages as if the string
was read in binary format from a file with the same name.
The file is converted to UTF-8 from the given character set.
When merge is true the classes cNew in the file will be merged with the already loaded classes cOld in the following way:
1. get all the inner class definitions from cOld that were loaded from a different file than itself
2. append all elements from step 1 to class cNew public list
NOTE: Encoding is deprecated as *ALL* strings are now UTF-8 encoded.





function loadString
  input String data;
  input String filename = "<interactive>";
  input String encoding = "UTF-8";
  input Boolean merge = false "if merge is true the parsed AST is merged with the existing AST, default to false which means that is replaced, not merged";
  output Boolean success;
end loadString;








mkdir

create directory of given path (which may be either relative or absolute)
returns true if directory was created or already exists.





function mkdir
  input String newDirectory;
  output Boolean success;
end mkdir;








moveClass

Moves a class up or down depending on the given offset, where a positive
offset moves the class down and a negative offset up. The offset is truncated
if the resulting index is outside the class list. It retains the visibility of
the class by adding public/protected sections when needed, and merges sections
of the same type if the class is moved from a section it was alone in. Returns
true if the move was successful, otherwise false.





function moveClass
  input TypeName className "the class that should be moved";
  input Integer offset "Offset in the class list.";
  output Boolean result;
end moveClass;








moveClassToBottom

Moves a class to the bottom of its enclosing class. Returns true if the move
was successful, otherwise false.





function moveClassToBottom
  input TypeName className;
  output Boolean result;
end moveClassToBottom;








moveClassToTop

Moves a class to the top of its enclosing class. Returns true if the move
was successful, otherwise false.





function moveClassToTop
  input TypeName className;
  output Boolean result;
end moveClassToTop;








ngspicetoModelica

Converts ngspice netlist to Modelica code. Modelica file is created in the same directory as netlist file.





function ngspicetoModelica
  input String netlistfileName;
  output Boolean success = false;
end ngspicetoModelica;








numProcessors

function numProcessors
  output Integer result;
end numProcessors;








oms_RunFile

function oms_RunFile
  input String filename;
  output Integer status;
end oms_RunFile;








oms_addBus

function oms_addBus
  input String cref;
  output Integer status;
end oms_addBus;








oms_addConnection

function oms_addConnection
  input String crefA;
  input String crefB;
  output Integer status;
end oms_addConnection;








oms_addConnector

function oms_addConnector
  input String cref;
  input oms_causality causality;
  input oms_signal_type type_;
  output Integer status;
end oms_addConnector;








oms_addConnectorToBus

function oms_addConnectorToBus
  input String busCref;
  input String connectorCref;
  output Integer status;
end oms_addConnectorToBus;








oms_addConnectorToTLMBus

function oms_addConnectorToTLMBus
  input String busCref;
  input String connectorCref;
  input String type_;
  output Integer status;
end oms_addConnectorToTLMBus;








oms_addDynamicValueIndicator

function oms_addDynamicValueIndicator
  input String signal;
  input String lower;
  input String upper;
  input Real stepSize;
  output Integer status;
end oms_addDynamicValueIndicator;








oms_addEventIndicator

function oms_addEventIndicator
  input String signal;
  output Integer status;
end oms_addEventIndicator;








oms_addExternalModel

function oms_addExternalModel
  input String cref;
  input String path;
  input String startscript;
  output Integer status;
end oms_addExternalModel;








oms_addSignalsToResults

function oms_addSignalsToResults
  input String cref;
  input String regex;
  output Integer status;
end oms_addSignalsToResults;








oms_addStaticValueIndicator

function oms_addStaticValueIndicator
  input String signal;
  input Real lower;
  input Real upper;
  input Real stepSize;
  output Integer status;
end oms_addStaticValueIndicator;








oms_addSubModel

function oms_addSubModel
  input String cref;
  input String fmuPath;
  output Integer status;
end oms_addSubModel;








oms_addSystem

function oms_addSystem
  input String cref;
  input oms_system type_;
  output Integer status;
end oms_addSystem;








oms_addTLMBus

function oms_addTLMBus
  input String cref;
  input oms_tlm_domain domain;
  input Integer dimensions;
  input oms_tlm_interpolation interpolation;
  output Integer status;
end oms_addTLMBus;








oms_addTLMConnection

function oms_addTLMConnection
  input String crefA;
  input String crefB;
  input Real delay;
  input Real alpha;
  input Real linearimpedance;
  input Real angularimpedance;
  output Integer status;
end oms_addTLMConnection;








oms_addTimeIndicator

function oms_addTimeIndicator
  input String signal;
  output Integer status;
end oms_addTimeIndicator;








oms_cancelSimulation_asynchronous

function oms_cancelSimulation_asynchronous
  input String cref;
  output Integer status;
end oms_cancelSimulation_asynchronous;








oms_compareSimulationResults

function oms_compareSimulationResults
  input String filenameA;
  input String filenameB;
  input String var;
  input Real relTol;
  input Real absTol;
  output Integer status;
end oms_compareSimulationResults;








oms_copySystem

function oms_copySystem
  input String source;
  input String target;
  output Integer status;
end oms_copySystem;








oms_delete

function oms_delete
  input String cref;
  output Integer status;
end oms_delete;








oms_deleteConnection

function oms_deleteConnection
  input String crefA;
  input String crefB;
  output Integer status;
end oms_deleteConnection;








oms_deleteConnectorFromBus

function oms_deleteConnectorFromBus
  input String busCref;
  input String connectorCref;
  output Integer status;
end oms_deleteConnectorFromBus;








oms_deleteConnectorFromTLMBus

function oms_deleteConnectorFromTLMBus
  input String busCref;
  input String connectorCref;
  output Integer status;
end oms_deleteConnectorFromTLMBus;








oms_export

function oms_export
  input String cref;
  input String filename;
  output Integer status;
end oms_export;








oms_exportDependencyGraphs

function oms_exportDependencyGraphs
  input String cref;
  input String initialization;
  input String simulation;
  output Integer status;
end oms_exportDependencyGraphs;








oms_extractFMIKind

function oms_extractFMIKind
  input String filename;
  output Integer status;
  output Integer kind;
end oms_extractFMIKind;








oms_faultInjection

function oms_faultInjection
  input String signal;
  input oms_fault_type_enu_t faultType;
  input Real faultValue;
  output Integer status;
end oms_faultInjection;








oms_getBoolean

function oms_getBoolean
  input String cref;
  output Integer status;
  output Boolean value;
end oms_getBoolean;








oms_getFixedStepSize

function oms_getFixedStepSize
  input String cref;
  output Integer status;
  output Real stepSize;
end oms_getFixedStepSize;








oms_getInteger

function oms_getInteger
  input String cref;
  output Integer status;
  input Integer value;
end oms_getInteger;








oms_getModelState

function oms_getModelState
  input String cref;
  output Integer status;
  output Integer modelState;
end oms_getModelState;








oms_getReal

function oms_getReal
  input String cref;
  output Integer status;
  output Real value;
end oms_getReal;








oms_getSolver

function oms_getSolver
  input String cref;
  output Integer status;
  output Integer solver;
end oms_getSolver;








oms_getStartTime

function oms_getStartTime
  input String cref;
  output Integer status;
  output Real startTime;
end oms_getStartTime;








oms_getStopTime

function oms_getStopTime
  input String cref;
  output Integer status;
  output Real stopTime;
end oms_getStopTime;








oms_getSubModelPath

function oms_getSubModelPath
  input String cref;
  output Integer status;
  output String path;
end oms_getSubModelPath;








oms_getSystemType

function oms_getSystemType
  input String cref;
  output Integer status;
  output Integer type_;
end oms_getSystemType;








oms_getTolerance

function oms_getTolerance
  input String cref;
  output Integer status;
  output Real absoluteTolerance;
  output Real relativeTolerance;
end oms_getTolerance;








oms_getVariableStepSize

function oms_getVariableStepSize
  input String cref;
  output Integer status;
  output Real initialStepSize;
  output Real minimumStepSize;
  output Real maximumStepSize;
end oms_getVariableStepSize;








oms_getVersion

Returns the version of the OMSimulator.





function oms_getVersion
  output String version;
end oms_getVersion;








oms_importFile

function oms_importFile
  input String filename;
  output Integer status;
  output String cref;
end oms_importFile;








oms_initialize

function oms_initialize
  input String cref;
  output Integer status;
end oms_initialize;








oms_instantiate

function oms_instantiate
  input String cref;
  output Integer status;
end oms_instantiate;








oms_list

function oms_list
  input String cref;
  output Integer status;
  output String contents;
end oms_list;








oms_listUnconnectedConnectors

function oms_listUnconnectedConnectors
  input String cref;
  output Integer status;
  output String contents;
end oms_listUnconnectedConnectors;








oms_loadSnapshot

function oms_loadSnapshot
  input String cref;
  input String snapshot;
  output Integer status;
end oms_loadSnapshot;








oms_newModel

function oms_newModel
  input String cref;
  output Integer status;
end oms_newModel;








oms_parseModelName

function oms_parseModelName
  input String contents;
  output Integer status;
  output String cref;
end oms_parseModelName;








oms_removeSignalsFromResults

function oms_removeSignalsFromResults
  input String cref;
  input String regex;
  output Integer status;
end oms_removeSignalsFromResults;








oms_rename

function oms_rename
  input String cref;
  input String newCref;
  output Integer status;
end oms_rename;








oms_reset

function oms_reset
  input String cref;
  output Integer status;
end oms_reset;








oms_setBoolean

function oms_setBoolean
  input String cref;
  input Boolean value;
  output Integer status;
end oms_setBoolean;








oms_setCommandLineOption

function oms_setCommandLineOption
  input String cmd;
  output Integer status;
end oms_setCommandLineOption;








oms_setFixedStepSize

function oms_setFixedStepSize
  input String cref;
  input Real stepSize;
  output Integer status;
end oms_setFixedStepSize;








oms_setInteger

function oms_setInteger
  input String cref;
  input Integer value;
  output Integer status;
end oms_setInteger;








oms_setLogFile

function oms_setLogFile
  input String filename;
  output Integer status;
end oms_setLogFile;








oms_setLoggingInterval

function oms_setLoggingInterval
  input String cref;
  input Real loggingInterval;
  output Integer status;
end oms_setLoggingInterval;








oms_setLoggingLevel

function oms_setLoggingLevel
  input Integer logLevel;
  output Integer status;
end oms_setLoggingLevel;








oms_setReal

function oms_setReal
  input String cref;
  input Real value;
  output Integer status;
end oms_setReal;








oms_setRealInputDerivative

function oms_setRealInputDerivative
  input String cref;
  input Real value;
  output Integer status;
end oms_setRealInputDerivative;








oms_setResultFile

function oms_setResultFile
  input String cref;
  input String filename;
  input Integer bufferSize;
  output Integer status;
end oms_setResultFile;








oms_setSignalFilter

function oms_setSignalFilter
  input String cref;
  input String regex;
  output Integer status;
end oms_setSignalFilter;








oms_setSolver

function oms_setSolver
  input String cref;
  input oms_solver solver;
  output Integer status;
end oms_setSolver;








oms_setStartTime

function oms_setStartTime
  input String cref;
  input Real startTime;
  output Integer status;
end oms_setStartTime;








oms_setStopTime

function oms_setStopTime
  input String cref;
  input Real stopTime;
  output Integer status;
end oms_setStopTime;








oms_setTLMPositionAndOrientation

function oms_setTLMPositionAndOrientation
  input String cref;
  input Real x1;
  input Real x2;
  input Real x3;
  input Real A11;
  input Real A12;
  input Real A13;
  input Real A21;
  input Real A22;
  input Real A23;
  input Real A31;
  input Real A32;
  input Real A33;
  output Integer status;
end oms_setTLMPositionAndOrientation;








oms_setTLMSocketData

function oms_setTLMSocketData
  input String cref;
  input String address;
  input Integer managerPort;
  input Integer monitorPort;
  output Integer status;
end oms_setTLMSocketData;








oms_setTempDirectory

function oms_setTempDirectory
  input String newTempDir;
  output Integer status;
end oms_setTempDirectory;








oms_setTolerance

function oms_setTolerance
  input String cref;
  input Real absoluteTolerance;
  input Real relativeTolerance;
  output Integer status;
end oms_setTolerance;








oms_setVariableStepSize

function oms_setVariableStepSize
  input String cref;
  input Real initialStepSize;
  input Real minimumStepSize;
  input Real maximumStepSize;
  output Integer status;
end oms_setVariableStepSize;








oms_setWorkingDirectory

function oms_setWorkingDirectory
  input String newWorkingDir;
  output Integer status;
end oms_setWorkingDirectory;








oms_simulate

function oms_simulate
  input String cref;
  output Integer status;
end oms_simulate;








oms_stepUntil

function oms_stepUntil
  input String cref;
  input Real stopTime;
  output Integer status;
end oms_stepUntil;








oms_terminate

function oms_terminate
  input String cref;
  output Integer status;
end oms_terminate;








optimize

optimize a modelica/optimica model by generating c code, build it and run the optimization executable.
The only required argument is the className, while all others have some default values.
simulate(className, [startTime], [stopTime], [numberOfIntervals], [stepSize], [tolerance], [fileNamePrefix], [options], [outputFormat], [variableFilter], [cflags], [simflags])
Example command:
simulate(A);





function optimize
  input TypeName className "the class that should simulated";
  input Real startTime = "<default>" "the start time of the simulation. <default> = 0.0";
  input Real stopTime = 1.0 "the stop time of the simulation. <default> = 1.0";
  input Real numberOfIntervals = 500 "number of intervals in the result file. <default> = 500";
  input Real stepSize = 0.002 "step size that is used for the result file. <default> = 0.002";
  input Real tolerance = 1e-6 "tolerance used by the integration method. <default> = 1e-6";
  input String method = DAE.SCONST("optimization") "optimize a modelica/optimica model.";
  input String fileNamePrefix = "<default>" "fileNamePrefix. <default> = \"\"";
  input Boolean storeInTemp = false "storeInTemp. <default> = false";
  input Boolean noClean = false "noClean. <default> = false";
  input String options = "<default>" "options. <default> = \"\"";
  input String outputFormat = "mat" "Format for the result file. <default> = \"mat\"";
  input String variableFilter = ".*" "Filter for variables that should store in result file. <default> = \".*\"";
  input String cflags = "<default>" "cflags. <default> = \"\"";
  input String simflags = "<default>" "simflags. <default> = \"\"";
  output String optimizationResults;
end optimize;








parseEncryptedPackage

function parseEncryptedPackage
  input String fileName;
  input String workdir = "<default>" "The output directory for imported encrypted files. <default> will put the files to current working directory.";
  output TypeName names[:];
end parseEncryptedPackage;








parseFile

function parseFile
  input String filename;
  input String encoding = "UTF-8";
  output TypeName names[:];
end parseFile;








parseString

function parseString
  input String data;
  input String filename = "<interactive>";
  output TypeName names[:];
end parseString;








plot

Launches a plot window using OMPlot.





function plot
  input VariableNames vars "The variables you want to plot";
  input Boolean externalWindow = false "Opens the plot in a new plot window";
  input String fileName = "<default>" "The filename containing the variables. <default> will read the last simulation result";
  input String title = "" "This text will be used as the diagram title.";
  input String grid = "detailed" "Sets the grid for the plot i.e simple, detailed, none.";
  input Boolean logX = false "Determines whether or not the horizontal axis is logarithmically scaled.";
  input Boolean logY = false "Determines whether or not the vertical axis is logarithmically scaled.";
  input String xLabel = "time" "This text will be used as the horizontal label in the diagram.";
  input String yLabel = "" "This text will be used as the vertical label in the diagram.";
  input Real xRange[2] = {0.0, 0.0} "Determines the horizontal interval that is visible in the diagram. {0,0} will select a suitable range.";
  input Real yRange[2] = {0.0, 0.0} "Determines the vertical interval that is visible in the diagram. {0,0} will select a suitable range.";
  input Real curveWidth = 1.0 "Sets the width of the curve.";
  input Integer curveStyle = 1 "Sets the style of the curve. SolidLine=1, DashLine=2, DotLine=3, DashDotLine=4, DashDotDotLine=5, Sticks=6, Steps=7.";
  input String legendPosition = "top" "Sets the POSITION of the legend i.e left, right, top, bottom, none.";
  input String footer = "" "This text will be used as the diagram footer.";
  input Boolean autoScale = true "Use auto scale while plotting.";
  input Boolean forceOMPlot = false "if true launches OMPlot and doesn't call callback function even if it is defined.";
  output Boolean success "Returns true on success";
end plot;








plotAll

Works in the same way as plot(), but does not accept any
variable names as input. Instead, all variables are part of the plot window.
Example command sequences:
simulate(A);plotAll();
simulate(A);plotAll(externalWindow=true);
simulate(A,fileNamePrefix="B");simulate(C);plotAll(x,fileName="B.mat");





function plotAll
  input Boolean externalWindow = false "Opens the plot in a new plot window";
  input String fileName = "<default>" "The filename containing the variables. <default> will read the last simulation result";
  input String title = "" "This text will be used as the diagram title.";
  input String grid = "detailed" "Sets the grid for the plot i.e simple, detailed, none.";
  input Boolean logX = false "Determines whether or not the horizontal axis is logarithmically scaled.";
  input Boolean logY = false "Determines whether or not the vertical axis is logarithmically scaled.";
  input String xLabel = "time" "This text will be used as the horizontal label in the diagram.";
  input String yLabel = "" "This text will be used as the vertical label in the diagram.";
  input Real xRange[2] = {0.0, 0.0} "Determines the horizontal interval that is visible in the diagram. {0,0} will select a suitable range.";
  input Real yRange[2] = {0.0, 0.0} "Determines the vertical interval that is visible in the diagram. {0,0} will select a suitable range.";
  input Real curveWidth = 1.0 "Sets the width of the curve.";
  input Integer curveStyle = 1 "Sets the style of the curve. SolidLine=1, DashLine=2, DotLine=3, DashDotLine=4, DashDotDotLine=5, Sticks=6, Steps=7.";
  input String legendPosition = "top" "Sets the POSITION of the legend i.e left, right, top, bottom, none.";
  input String footer = "" "This text will be used as the diagram footer.";
  input Boolean autoScale = true "Use auto scale while plotting.";
  input Boolean forceOMPlot = false "if true launches OMPlot and doesn't call callback function even if it is defined.";
  output Boolean success "Returns true on success";
end plotAll;








plotParametric

Launches a plotParametric window using OMPlot. Returns true on success.
Example command sequences:
simulate(A);plotParametric(x,y);
simulate(A);plotParametric(x,y, externalWindow=true);





function plotParametric
  input VariableName xVariable;
  input VariableName yVariable;
  input Boolean externalWindow = false "Opens the plot in a new plot window";
  input String fileName = "<default>" "The filename containing the variables. <default> will read the last simulation result";
  input String title = "" "This text will be used as the diagram title.";
  input String grid = "detailed" "Sets the grid for the plot i.e simple, detailed, none.";
  input Boolean logX = false "Determines whether or not the horizontal axis is logarithmically scaled.";
  input Boolean logY = false "Determines whether or not the vertical axis is logarithmically scaled.";
  input String xLabel = "time" "This text will be used as the horizontal label in the diagram.";
  input String yLabel = "" "This text will be used as the vertical label in the diagram.";
  input Real xRange[2] = {0.0, 0.0} "Determines the horizontal interval that is visible in the diagram. {0,0} will select a suitable range.";
  input Real yRange[2] = {0.0, 0.0} "Determines the vertical interval that is visible in the diagram. {0,0} will select a suitable range.";
  input Real curveWidth = 1.0 "Sets the width of the curve.";
  input Integer curveStyle = 1 "Sets the style of the curve. SolidLine=1, DashLine=2, DotLine=3, DashDotLine=4, DashDotDotLine=5, Sticks=6, Steps=7.";
  input String legendPosition = "top" "Sets the POSITION of the legend i.e left, right, top, bottom, none.";
  input String footer = "" "This text will be used as the diagram footer.";
  input Boolean autoScale = true "Use auto scale while plotting.";
  input Boolean forceOMPlot = false "if true launches OMPlot and doesn't call callback function even if it is defined.";
  output Boolean success "Returns true on success";
end plotParametric;








readFile

The contents of the given file are returned.
Note that if the function fails, the error message is returned as a string instead of multiple output or similar.





impure function readFile
  input String fileName;
  output String contents;
end readFile;








readFileNoNumeric

Returns the contents of the file, with anything resembling a (real) number stripped out, and at the end adding:
Filter count from number domain: n.
This should probably be changed to multiple outputs; the filtered string and an integer.
Does anyone use this API call?





function readFileNoNumeric
  input String fileName;
  output String contents;
end readFileNoNumeric;








readSimulationResult

Reads a result file, returning a matrix corresponding to the variables and size given.





function readSimulationResult
  input String filename;
  input VariableNames variables;
  input Integer size = 0 "0=read any size... If the size is not the same as the result-file, this function fails";
  output Real result[:, :];
end readSimulationResult;








readSimulationResultSize

The number of intervals that are present in the output file.





function readSimulationResultSize
  input String fileName;
  output Integer sz;
end readSimulationResultSize;








readSimulationResultVars

Returns the variables in the simulation file; you can use val() and plot() commands using these names.





function readSimulationResultVars
  input String fileName;
  input Boolean readParameters = true;
  input Boolean openmodelicaStyle = false;
  output String[:] vars;
end readSimulationResultVars;








realpath

Get full path name of file or directory name





function realpath
  input String name "Absolute or relative file or directory name";
  output String fullName "Full path of 'name'";
end realpath;








reduceTerms

reduce terms.





function reduceTerms
  input TypeName className "the class that should be built";
  input Real startTime = 0.0 "the start time of the simulation. <default> = 0.0";
  input Real stopTime = 1.0 "the stop time of the simulation. <default> = 1.0";
  input Integer numberOfIntervals = 500 "number of intervals in the result file. <default> = 500";
  input Real tolerance = 1e-6 "tolerance used by the integration method. <default> = 1e-6";
  input String method = "dassl" "integration method used for simulation. <default> = dassl";
  input String fileNamePrefix = "" "fileNamePrefix. <default> = \"\"";
  input String options = "" "options. <default> = \"\"";
  input String outputFormat = "mat" "Format for the result file. <default> = \"mat\"";
  input String variableFilter = ".*" "Filter for variables that should store in result file. <default> = \".*\"";
  input String cflags = "" "cflags. <default> = \"\"";
  input String simflags = "" "simflags. <default> = \"\"";
  input String labelstoCancel = "";
  output String[2] buildModelResults;
end reduceTerms;








regex

Sets the error buffer and returns -1 if the regex does not compile.
The returned result is the same as POSIX regex():
The first value is the complete matched string
The rest are the substrings that you wanted.
For example:
regex(lorem," \([A-Za-z]*\) \([A-Za-z]*\) ",maxMatches=3)
=> {" ipsum dolor ","ipsum","dolor"}
This means if you have n groups, you want maxMatches=n+1





function regex
  input String str;
  input String re;
  input Integer maxMatches = 1 "The maximum number of matches that will be returned";
  input Boolean extended = true "Use POSIX extended or regular syntax";
  input Boolean caseInsensitive = false;
  output Integer numMatches "-1 is an error, 0 means no match, else returns a number 1..maxMatches";
  output String matchedSubstrings[maxMatches] "unmatched strings are returned as empty";
end regex;








regexBool

Returns true if the string matches the regular expression.





function regexBool
  input String str;
  input String re;
  input Boolean extended = true "Use POSIX extended or regular syntax";
  input Boolean caseInsensitive = false;
  output Boolean matches;
end regexBool;








regularFileExists

function regularFileExists
  input String fileName;
  output Boolean exists;
end regularFileExists;








reloadClass

reloads the file associated with the given (loaded class)





function reloadClass
  input TypeName name;
  input String encoding = "UTF-8";
  output Boolean success;
end reloadClass;








remove

removes a file or directory of given path (which may be either relative or absolute).





function remove
  input String path;
  output Boolean success "Returns true on success.";
end remove;








removeComponentModifiers

function removeComponentModifiers
  input TypeName class_;
  input String componentName;
  input Boolean keepRedeclares = false;
  output Boolean success;
end removeComponentModifiers;








removeExtendsModifiers

function removeExtendsModifiers
  input TypeName className;
  input TypeName baseClassName;
  input Boolean keepRedeclares = false;
  output Boolean success;
end removeExtendsModifiers;








reopenStandardStream

function reopenStandardStream
  input StandardStream _stream;
  input String filename;
  output Boolean success;
end reopenStandardStream;








rewriteBlockCall

Function for property modeling, transforms block calls into instantiations for a loaded model





function rewriteBlockCall
  input TypeName className;
  input TypeName inDefs;
  output Boolean success;
end rewriteBlockCall;








runOpenTURNSPythonScript

runs OpenTURNS with the given python script returning the log file





function runOpenTURNSPythonScript
  input String pythonScriptFile;
  output String logOutputFile;
end runOpenTURNSPythonScript;








runScript

Runs the mos-script specified by the filename.





impure function runScript
  input String fileName "*.mos";
  output String result;
end runScript;








runScriptParallel

function runScriptParallel
  input String scripts[:];
  input Integer numThreads = numProcessors();
  input Boolean useThreads = false;
  output Boolean results[:];
end runScriptParallel;








save

function save
  input TypeName className;
  output Boolean success;
end save;








saveAll

save the entire loaded AST to file.





function saveAll
  input String fileName;
  output Boolean success;
end saveAll;








saveModel

function saveModel
  input String fileName;
  input TypeName className;
  output Boolean success;
end saveModel;








saveTotalModel

Save the className model in a single file, together with all
the other classes that it depends upon, directly and indirectly.
This file can be later reloaded with the loadFile() API function,
which loads className and all the other needed classes into memory.
This is useful to allow third parties to run a certain model (e.g. for debugging)
without worrying about all the library dependencies.
Please note that SaveTotal file is not a valid Modelica .mo file according to the
specification, and cannot be loaded in OMEdit - it can only be loaded with loadFile().





function saveTotalModel
  input String fileName;
  input TypeName className;
  input Boolean stripAnnotations = false;
  input Boolean stripComments = false;
  output Boolean success;
end saveTotalModel;








saveTotalSCode




searchClassNames

Searches for the class name in the all the loaded classes.
Example command:
searchClassNames("ground");
searchClassNames("ground", true);





function searchClassNames
  input String searchText;
  input Boolean findInText = false;
  output TypeName classNames[:];
end searchClassNames;








setAnnotationVersion

Sets the annotation version.





function setAnnotationVersion
  input String annotationVersion;
  output Boolean success;
end setAnnotationVersion;








setCFlags

CFLAGS





function setCFlags
  input String inString;
  output Boolean success;
end setCFlags;








setCXXCompiler

CXX





function setCXXCompiler
  input String compiler;
  output Boolean success;
end setCXXCompiler;








setCheapMatchingAlgorithm

example input: 3





function setCheapMatchingAlgorithm
  input Integer matchingAlgorithm;
  output Boolean success;
end setCheapMatchingAlgorithm;








setClassComment

Sets the class comment.





function setClassComment
  input TypeName class_;
  input String filename;
  output Boolean success;
end setClassComment;








setCommandLineOptions

The input is a regular command-line flag given to OMC, e.g. -d=failtrace or -g=MetaModelica





function setCommandLineOptions
  input String option;
  output Boolean success;
end setCommandLineOptions;








setCompileCommand

function setCompileCommand
  input String compileCommand;
  output Boolean success;
end setCompileCommand;








setCompiler

CC





function setCompiler
  input String compiler;
  output Boolean success;
end setCompiler;








setCompilerFlags

function setCompilerFlags
  input String compilerFlags;
  output Boolean success;
end setCompilerFlags;








setCompilerPath

function setCompilerPath
  input String compilerPath;
  output Boolean success;
end setCompilerPath;








setDebugFlags

example input: failtrace,-noevalfunc





function setDebugFlags
  input String debugFlags;
  output Boolean success;
end setDebugFlags;








setDefaultOpenCLDevice

Sets the default OpenCL device to be used.





function setDefaultOpenCLDevice
  input Integer defdevid;
  output Boolean success;
end setDefaultOpenCLDevice;








setDocumentationAnnotation

function setDocumentationAnnotation
  input TypeName class_;
  input String info = "";
  input String revisions = "";
  output Boolean bool;
end setDocumentationAnnotation;








setEnvironmentVar

function setEnvironmentVar
  input String var;
  input String value;
  output Boolean success;
end setEnvironmentVar;








setIndexReductionMethod

example input: dynamicStateSelection





function setIndexReductionMethod
  input String method;
  output Boolean success;
end setIndexReductionMethod;








setInitXmlStartValue

function setInitXmlStartValue
  input String fileName;
  input String variableName;
  input String startValue;
  input String outputFile;
  output Boolean success = false;
end setInitXmlStartValue;








setInstallationDirectoryPath

Sets the OPENMODELICAHOME environment variable. Use this method instead of setEnvironmentVar.





function setInstallationDirectoryPath
  input String installationDirectoryPath;
  output Boolean success;
end setInstallationDirectoryPath;








setLanguageStandard

Sets the Modelica Language Standard.





function setLanguageStandard
  input String inVersion;
  output Boolean success;
end setLanguageStandard;








setLinker

function setLinker
  input String linker;
  output Boolean success;
end setLinker;








setLinkerFlags

function setLinkerFlags
  input String linkerFlags;
  output Boolean success;
end setLinkerFlags;








setMatchingAlgorithm

example input: omc





function setMatchingAlgorithm
  input String matchingAlgorithm;
  output Boolean success;
end setMatchingAlgorithm;








setModelicaPath

The Modelica Library Path - MODELICAPATH in the language specification; OPENMODELICALIBRARY in OpenModelica.





function setModelicaPath
  input String modelicaPath;
  output Boolean success;
end setModelicaPath;








setNoSimplify

Sets the noSimplify flag.





function setNoSimplify
  input Boolean noSimplify;
  output Boolean success;
end setNoSimplify;








setOrderConnections

Sets the orderConnection flag.





function setOrderConnections
  input Boolean orderConnections;
  output Boolean success;
end setOrderConnections;








setPlotCommand

function setPlotCommand
  input String plotCommand;
  output Boolean success;
end setPlotCommand;








setPostOptModules

example input: lateInline,inlineArrayEqn,removeSimpleEquations.





function setPostOptModules
  input String modules;
  output Boolean success;
end setPostOptModules;








setPreOptModules

example input: removeFinalParameters,removeSimpleEquations,expandDerOperator





function setPreOptModules
  input String modules;
  output Boolean success;
end setPreOptModules;








setShowAnnotations

function setShowAnnotations
  input Boolean show;
  output Boolean success;
end setShowAnnotations;








setSourceFile

function setSourceFile
  input TypeName class_;
  input String filename;
  output Boolean success;
end setSourceFile;








setTearingMethod

example input: omcTearing





function setTearingMethod
  input String tearingMethod;
  output Boolean success;
end setTearingMethod;








setTempDirectoryPath

function setTempDirectoryPath
  input String tempDirectoryPath;
  output Boolean success;
end setTempDirectoryPath;








setVectorizationLimit

function setVectorizationLimit
  input Integer vectorizationLimit;
  output Boolean success;
end setVectorizationLimit;








simulate

simulates a modelica model by generating c code, build it and run the simulation executable.
The only required argument is the className, while all others have some default values.
simulate(className, [startTime], [stopTime], [numberOfIntervals], [tolerance], [method], [fileNamePrefix], [options], [outputFormat], [variableFilter], [cflags], [simflags])
Example command:
simulate(A);





function simulate
  input TypeName className "the class that should simulated";
  input Real startTime = "<default>" "the start time of the simulation. <default> = 0.0";
  input Real stopTime = 1.0 "the stop time of the simulation. <default> = 1.0";
  input Real numberOfIntervals = 500 "number of intervals in the result file. <default> = 500";
  input Real tolerance = 1e-6 "tolerance used by the integration method. <default> = 1e-6";
  input String method = "<default>" "integration method used for simulation. <default> = dassl";
  input String fileNamePrefix = "<default>" "fileNamePrefix. <default> = \"\"";
  input String options = "<default>" "options. <default> = \"\"";
  input String outputFormat = "mat" "Format for the result file. <default> = \"mat\"";
  input String variableFilter = ".*" "Filter for variables that should store in result file. <default> = \".*\"";
  input String cflags = "<default>" "cflags. <default> = \"\"";
  input String simflags = "<default>" "simflags. <default> = \"\"";
  output SimulationResult simulationResults;
  record SimulationResult
    String resultFile;
    String simulationOptions;
    String messages;
    Real timeFrontend;
    Real timeBackend;
    Real timeSimCode;
    Real timeTemplates;
    Real timeCompile;
    Real timeSimulation;
    Real timeTotal;
  end SimulationResult;
end simulate;








solveLinearSystem

Solve A*X = B, using dgesv or lp_solve (if any variable in X is integer)
Returns for solver dgesv: info>0: Singular for element i. info<0: Bad input.
For solver lp_solve: ???





function solveLinearSystem
  input Real[size(B, 1), size(B, 1)] A;
  input Real[:] B;
  input LinearSystemSolver solver = LinearSystemSolver.dgesv;
  input Integer[:] isInt = {-1} "list of indices that are integers";
  output Real[size(B, 1)] X;
  output Integer info;
end solveLinearSystem;








sortStrings

function sortStrings
  input String arr[:];
  output String sorted[:];
end sortStrings;








stat

impure function stat
  input String fileName;
  output Boolean success;
  output Real fileSize;
  output Real mtime;
end stat;








stringReplace

function stringReplace
  input String str;
  input String source;
  input String target;
  output String res;
end stringReplace;








stringSplit

Splits the string at the places given by the character





function stringSplit
  input String string;
  input String token "single character only";
  output String[:] strings;
end stringSplit;








stringTypeName

function stringTypeName
  input String str;
  output TypeName cl;
end stringTypeName;








stringVariableName

function stringVariableName
  input String str;
  output VariableName cl;
end stringVariableName;








strtok

Splits the strings at the places given by the token, for example:
strtok("abcbdef","b") => {"a","c","def"}
strtok("abcbdef","cd") => {"ab","ef"}





function strtok
  input String string;
  input String token;
  output String[:] strings;
end strtok;








system

Similar to system(3). Executes the given command in the system shell.





impure function system
  input String callStr "String to call: sh -c $callStr";
  input String outputFile = "" "The output is redirected to this file (unless already done by callStr)";
  output Integer retval "Return value of the system call; usually 0 on success";
end system;








system_parallel

Similar to system(3). Executes the given commands in the system shell, in parallel if omc was compiled using OpenMP.





impure function system_parallel
  input String callStr[:] "String to call: sh -c $callStr";
  input Integer numThreads = numProcessors();
  output Integer retval[:] "Return value of the system call; usually 0 on success";
end system_parallel;








testsuiteFriendlyName

function testsuiteFriendlyName
  input String path;
  output String fixed;
end testsuiteFriendlyName;








threadWorkFailed




translateGraphics

function translateGraphics
  input TypeName className;
  output String result;
end translateGraphics;








translateModelFMU

translates a modelica model into a Functional Mockup Unit.
The only required argument is the className, while all others have some default values.
Example command:
translateModelFMU(className, version="2.0");





function translateModelFMU
  input TypeName className "the class that should translated";
  input String version = "2.0" "FMU version, 1.0 or 2.0.";
  input String fmuType = "me" "FMU type, me (model exchange), cs (co-simulation), me_cs (both model exchange and co-simulation)";
  input String fileNamePrefix = "<default>" "fileNamePrefix. <default> = \"className\"";
  input Boolean includeResources = false "include Modelica based resources via loadResource or not";
  output String generatedFileName "Returns the full path of the generated FMU.";
end translateModelFMU;








typeNameString

function typeNameString
  input TypeName cl;
  output String out;
end typeNameString;








typeNameStrings

function typeNameStrings
  input TypeName cl;
  output String out[:];
end typeNameStrings;








typeOf

function typeOf
  input VariableName variableName;
  output String result;
end typeOf;








unloadOMSimulator

free the OMSimulator instances





function unloadOMSimulator
  output Integer status;
end unloadOMSimulator;








updateConnection

function updateConnection
  input TypeName className;
  input String from;
  input String to;
  input ExpressionOrModification annotate;
  output Boolean result;
end updateConnection;








updateConnectionNames

function updateConnectionNames
  input TypeName className;
  input String from;
  input String to;
  input String fromNew;
  input String toNew;
  output Boolean result;
end updateConnectionNames;








updateInitialState

function updateInitialState
  input TypeName cl;
  input String state;
  input ExpressionOrModification annotate;
  output Boolean bool;
end updateInitialState;








updateTransition

function updateTransition
  input TypeName cl;
  input String from;
  input String to;
  input String oldCondition;
  input Boolean oldImmediate;
  input Boolean oldReset;
  input Boolean oldSynchronize;
  input Integer oldPriority;
  input String newCondition;
  input Boolean newImmediate;
  input Boolean newReset;
  input Boolean newSynchronize;
  input Integer newPriority;
  input ExpressionOrModification annotate;
  output Boolean bool;
end updateTransition;








uriToFilename

function uriToFilename
  input String uri;
  output String filename = "";
end uriToFilename;








val

Return the value of a variable at a given time in the simulation results





function val
  input VariableName var;
  input Real timePoint = 0.0;
  input String fileName = "<default>" "The contents of the currentSimulationResult variable";
  output Real valAtTime;
end val;








verifyCompiler

function verifyCompiler
  output Boolean compilerWorks;
end verifyCompiler;








writeFile

Write the data to file. Returns true on success.





impure function writeFile
  input String fileName;
  input String data;
  input Boolean append = false;
  output Boolean success;
end writeFile;










Simulation Parameter Sweep

Following example shows how to update the parameters and re-run the simulation without compiling the model.

loadFile("BouncingBall.mo");
getErrorString();
// build the model once
buildModel(BouncingBall);
getErrorString();
for i in 1:3 loop
  // We update the parameter e start value from 0.7 to "0.7 + i".
  value := 0.7 + i;
  // call the generated simulation code to produce a result file BouncingBall%i%_res.mat
  system("./BouncingBall -override=e="+String(value)+" -r=BouncingBall" + String(i) + "_res.mat");
  getErrorString();
end for;





We used the BouncingBall.mo [https://github.com/OpenModelica/OMCompiler/blob/master/Examples/BouncingBall.mo] in the example above.
The above example produces three result files each containing different start value for e i.e., 1.7, 2.7, 3.7.




Examples

The following is an interactive session with the OpenModelica
environment including some of the abovementioned commands and examples.
First we start the system, and use the command line interface from
OMShell, OMNotebook, or command window of some of the other tools.

We type in a very small model:

model Test "Testing OpenModelica Scripts"
  Real x, y;
equation
  x = 5.0+time; y = 6.0;
end Test;





We give the command to flatten a model:

>>> instantiateModel(Test)
class Test "Testing OpenModelica Scripts"
  Real x;
  Real y;
equation
  x = 5.0 + time;
  y = 6.0;
end Test;





A range expression is typed in:

>>> a:=1:10
{1,2,3,4,5,6,7,8,9,10}





It is multiplied by 2:

>>> a*2
{2,4,6,8,10,12,14,16,18,20}





The variables are cleared:

>>> clearVariables()
true





We print the loaded class test from its internal representation:

>>> list(Test)
model Test "Testing OpenModelica Scripts"
  Real x, y;
equation
  x = 5.0 + time;
  y = 6.0;
end Test;





We get the name and other properties of a class:

>>> getClassNames()
{Test,ProfilingTest}
>>> getClassComment(Test)
"Testing OpenModelica Scripts"
>>> isPartial(Test)
false
>>> isPackage(Test)
false
>>> isModel(Test)
true
>>> checkModel(Test)
"Check of Test completed successfully.
Class Test has 2 equation(s) and 2 variable(s).
2 of these are trivial equation(s)."





The common combination of a simulation followed by getting a value and
doing a plot:

>>> simulate(Test, stopTime=3.0)
record SimulationResult
    resultFile = "«DOCHOME»/Test_res.mat",
    simulationOptions = "startTime = 0.0, stopTime = 3.0, numberOfIntervals = 500, tolerance = 1e-06, method = 'dassl', fileNamePrefix = 'Test', options = '', outputFormat = 'mat', variableFilter = '.*', cflags = '', simflags = ''",
    messages = "LOG_SUCCESS       | info    | The initialization finished successfully without homotopy method.
LOG_SUCCESS       | info    | The simulation finished successfully.
stdout            | info    | Time measurements are stored in Test_prof.html (human-readable) and Test_prof.xml (for XSL transforms or more details)
",
    timeFrontend = 0.016358954,
    timeBackend = 0.002795494,
    timeSimCode = 0.0007325740000000001,
    timeTemplates = 0.014660188,
    timeCompile = 0.5195888829999999,
    timeSimulation = 0.038369868,
    timeTotal = 0.592638649
end SimulationResult;
>>> val(x , 2.0)
7.0






[image: _images/testmodel.svg]Figure 106 Plot generated by OpenModelica+gnuplot



>>> plotall()






[image: _images/testmodel-plotall.svg]Figure 107 Plot generated by OpenModelica+gnuplot




Interactive Function Calls, Reading, and Writing

We enter an assignment of a vector expression, created by the range
construction expression 1:12, to be stored in the variable x. The type
and the value of the expression is returned.

>>> x := 1:12
{1,2,3,4,5,6,7,8,9,10,11,12}





The function bubblesort is called to sort this vector in descending
order. The sorted result is returned together with its type. Note that
the result vector is of type Real[:], instantiated as Real[12], since
this is the declared type of the function result. The input Integer
vector was automatically converted to a Real vector according to the
Modelica type coercion rules.

>>> loadFile(getInstallationDirectoryPath() + "/share/doc/omc/testmodels/bubblesort.mo")
true
>>> bubblesort(x)
{12.0,11.0,10.0,9.0,8.0,7.0,6.0,5.0,4.0,3.0,2.0,1.0}





Now we want to try another small application, a simplex algorithm for
optimization. First read in a small matrix containing coefficients that
define a simplex problem to be solved:

>>> a := {
  {-1,-1,-1, 0, 0, 0, 0, 0, 0},
  {-1, 1, 0, 1, 0, 0, 0, 0, 5},
  { 1, 4, 0, 0, 1, 0, 0, 0, 45},
  { 2, 1, 0, 0, 0, 1, 0, 0, 27},
  { 3,-4, 0, 0, 0, 0, 1, 0, 24},
  { 0, 0, 1, 0, 0, 0, 0, 1, 4}
}
{{-1,-1,-1,0,0,0,0,0,0},{-1,1,0,1,0,0,0,0,5},{1,4,0,0,1,0,0,0,45},{2,1,0,0,0,1,0,0,27},{3,-4,0,0,0,0,1,0,24},{0,0,1,0,0,0,0,1,4}}





function pivot1
  input Real b[:,:];
  input Integer p;
  input Integer q;
  output Real a[size(b,1),size(b,2)];
protected
  Integer M;
  Integer N;
algorithm
  a := b;
  N := size(a,1)-1;
  M := size(a,2)-1;
  for j in 1:N loop
    for k in 1:M loop
      if j<>p and k<>q then
       a[j,k] := a[j,k]-0.3*j;
      end if;
    end for;
  end for;
  a[p,q] := 0.05;
end pivot1;

function misc_simplex1
  input Real matr[:,:];
  output Real x[size(matr,2)-1];
  output Real z;
  output  Integer q;
  output  Integer p;
protected
  Real a[size(matr,1),size(matr,2)];
  Integer M;
  Integer N;
algorithm
  N := size(a,1)-1;
  M := size(a,2)-1;
  a := matr;
  p:=0;q:=0;
  a := pivot1(a,p+1,q+1);
  while not (q==(M) or p==(N)) loop
    q := 0;
    while not (q == (M) or a[0+1,q+1]>1) loop
      q:=q+1;
    end while;
    p := 0;
    while not (p == (N) or a[p+1,q+1]>0.1) loop
      p:=p+1;
    end while;
    if (q < M) and (p < N) and(p>0) and (q>0) then
      a := pivot1(a,p,q);
    end if;
  if(p<=0) and (q<=0) then
     a := pivot1(a,p+1,q+1);
  end if;
  if(p<=0) and (q>0) then
     a := pivot1(a,p+1,q);
  end if;
  if(p>0) and (q<=0) then
     a := pivot1(a,p,q+1);
  end if;
  end while;
  z := a[1,M];
  x := {a[1,i] for i in 1:size(x,1)};
  for i in 1:10 loop
   for j in 1:M loop
    x[j] := x[j]+x[j]*0.01;
   end for;
  end for;
end misc_simplex1;





Then call the simplex algorithm implemented as the Modelica function
simplex1. This function returns four results, which are represented as a
tuple of four return values:

>>> misc_simplex1(a)
({0.05523110627056022,-1.104622125411205,-1.104622125411205,0.0,0.0,0.0,0.0,0.0},0.0,8,1)
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OpenModelica Compiler Flags

Usage: omc [Options] (Model.mo | Script.mos) [Libraries | .mo-files]


	Libraries: Fully qualified names of libraries to load before processing Model or Script.
The libraries should be separated by spaces: Lib1 Lib2 ... LibN.





Options

-d, --debug

Sets debug flags. Use --help=debug to see available flags.

String list (default empty).

-h, --help

Displays the help text. Use --help=topics for more information.

String (default empty).

--v, --version

Print the version and exit.

Boolean (default false).

--target

Sets the target compiler to use.

String (default gcc). Valid options:


	gcc


	msvc


	msvc10


	msvc12


	msvc13


	msvc15


	msvc19


	vxworks69


	debugrt




-g, --grammar

Sets the grammar and semantics to accept.

String (default  Modelica). Valid options:


	Modelica


	MetaModelica


	ParModelica


	Optimica


	PDEModelica




--annotationVersion

Sets the annotation version that should be used.

String (default 3.x). Valid options:


	1.x


	2.x


	3.x




--std

Sets the language standard that should be used.

String (default  latest). Valid options:


	1.x


	2.x


	3.1


	3.2


	3.3


	latest




--showErrorMessages

Show error messages immediately when they happen.

Boolean (default false).

--showAnnotations

Show annotations in the flattened code.

Boolean (default false).

--noSimplify

Do not simplify expressions if set.

Boolean (default false).

--preOptModules

Sets the pre optimization modules to use in the back end. See --help=optmodules for more info.

String list (default normalInlineFunction,evaluateParameters,simplifyIfEquations,expandDerOperator,clockPartitioning,findStateOrder,replaceEdgeChange,inlineArrayEqn,removeEqualRHS,removeSimpleEquations,comSubExp,resolveLoops,evalFunc,encapsulateWhenConditions). Valid options:


	introduceOutputAliases (Introduces aliases for top-level outputs.)


	clockPartitioning (Does the clock partitioning.)


	collapseArrayExpressions (Simplifies {x[1],x[2],x[3]} → x for arrays of whole variable references (simplifies code generation).)


	comSubExp (Introduces alias assignments for variables which are assigned to simple terms i.e. a = b/c; d = b/c; --> a=d)


	dumpDAE (dumps the DAE representation of the current transformation state)


	dumpDAEXML (dumps the DAE as xml representation of the current transformation state)


	encapsulateWhenConditions (This module replaces each when condition with a boolean variable.)


	evalFunc (evaluates functions partially)


	evaluateParameters (Evaluates parameters with annotation(Evaluate=true). Use '--evaluateFinalParameters=true' or '--evaluateProtectedParameters=true' to specify additional parameters to be evaluated. Use '--replaceEvaluatedParameters=true' if the evaluated parameters should be replaced in the DAE. To evaluate all parameters in the Frontend use -d=evaluateAllParameters.)


	expandDerOperator (Expands der(expr) using Derive.differentiteExpTime.)


	findStateOrder (Sets derivative information to states.)


	inlineArrayEqn (This module expands all array equations to scalar equations.)


	normalInlineFunction (Perform function inlining for function with annotation Inline=true.)


	inputDerivativesForDynOpt (Allowed derivatives of inputs in dyn. optimization.)


	introduceDerAlias (Adds for every der-call an alias equation e.g. dx = der(x).)


	removeEqualRHS (Detects equal expressions of the form a=<exp> and b=<exp> and substitutes them to get speed up.)


	removeProtectedParameters (Replace all parameters with protected=true in the system.)


	removeSimpleEquations (Performs alias elimination and removes constant variables from the DAE, replacing all occurrences of the old variable reference with the new value (constants) or variable reference (alias elimination).)


	removeUnusedParameter (Strips all parameter not present in the equations from the system.)


	removeUnusedVariables (Strips all variables not present in the equations from the system.)


	removeVerySimpleEquations ([Experimental] Like removeSimpleEquations, but less thorough. Note that this always uses the experimental new alias elimination, --removeSimpleEquations=new, which makes it unstable. In particular, MultiBody systems fail to translate correctly. It can be used for simple (but large) systems of equations.)


	replaceEdgeChange (Replace edge(b) = b and not pre(b) and change(b) = v <> pre(v).)


	residualForm (Transforms simple equations x=y to zero-sum equations 0=y-x.)


	resolveLoops (resolves linear equations in loops)


	simplifyAllExpressions (Does simplifications on all expressions.)


	simplifyIfEquations (Tries to simplify if equations by use of information from evaluated parameters.)


	sortEqnsVars (Heuristic sorting for equations and variables.)


	unitChecking (Does advanced unit checking which consists of two parts: 1. calculation of unspecified unit information for variables; 2. consistency check for all equations based on unit information. Please note: This module is still experimental.)


	wrapFunctionCalls (This module introduces variables for each function call and substitutes all these calls with the newly introduced variables.)




--cheapmatchingAlgorithm

Sets the cheap matching algorithm to use. A cheap matching algorithm gives a jump start matching by heuristics.

Integer (default 3). Valid options:


	0 (No cheap matching.)


	1 (Cheap matching, traverses all equations and match the first free variable.)


	3 (Random Karp-Sipser: R. M. Karp and M. Sipser. Maximum matching in sparse random graphs.)




--matchingAlgorithm

Sets the matching algorithm to use. See --help=optmodules for more info.

String (default PFPlusExt). Valid options:


	BFSB (Breadth First Search based algorithm.)


	DFSB (Depth First Search based algorithm.)


	MC21A (Depth First Search based algorithm with look ahead feature.)


	PF (Depth First Search based algorithm with look ahead feature.)


	PFPlus (Depth First Search based algorithm with look ahead feature and fair row traversal.)


	HK (Combined BFS and DFS algorithm.)


	HKDW (Combined BFS and DFS algorithm.)


	ABMP (Combined BFS and DFS algorithm.)


	PR (Matching algorithm using push relabel mechanism.)


	DFSBExt (Depth First Search based Algorithm external c implementation.)


	BFSBExt (Breadth First Search based Algorithm external c implementation.)


	MC21AExt (Depth First Search based Algorithm with look ahead feature external c implementation.)


	PFExt (Depth First Search based Algorithm with look ahead feature external c implementation.)


	PFPlusExt (Depth First Search based Algorithm with look ahead feature and fair row traversal external c implementation.)


	HKExt (Combined BFS and DFS algorithm external c implementation.)


	HKDWExt (Combined BFS and DFS algorithm external c implementation.)


	ABMPExt (Combined BFS and DFS algorithm external c implementation.)


	PRExt (Matching algorithm using push relabel mechanism external c implementation.)


	BB (BBs try.)




--indexReductionMethod

Sets the index reduction method to use. See --help=optmodules for more info.

String (default dynamicStateSelection). Valid options:


	none (Skip index reduction)


	uode (Use the underlying ODE without the constraints.)


	dynamicStateSelection (Simple index reduction method, select (dynamic) dummy states based on analysis of the system.)


	dummyDerivatives (Simple index reduction method, select (static) dummy states based on heuristic.)




--postOptModules

Sets the post optimization modules to use in the back end. See --help=optmodules for more info.

String list (default lateInlineFunction,wrapFunctionCalls,inlineArrayEqn,constantLinearSystem,simplifysemiLinear,removeSimpleEquations,simplifyComplexFunction,solveSimpleEquations,tearingSystem,inputDerivativesUsed,calculateStrongComponentJacobians,calculateStateSetsJacobians,symbolicJacobian,removeConstants,simplifyTimeIndepFuncCalls,simplifyAllExpressions,findZeroCrossings,collapseArrayExpressions). Valid options:


	addScaledVars_states (added var_norm = var/nominal, where var is state)


	addScaledVars_inputs (added var_norm = var/nominal, where var is input)


	addTimeAsState (Experimental feature: this replaces each occurrence of variable time with a new introduced state $time with equation der($time) = 1.0)


	calculateStateSetsJacobians (Generates analytical jacobian for dynamic state selection sets.)


	calculateStrongComponentJacobians (Generates analytical jacobian for torn linear and non-linear strong components. By default linear components and non-linear components with user-defined function calls are skipped. See also debug flags: LSanalyticJacobian, NLSanalyticJacobian and forceNLSanalyticJacobian)


	collapseArrayExpressions (Simplifies {x[1],x[2],x[3]} → x for arrays of whole variable references (simplifies code generation).)


	constantLinearSystem (Evaluates constant linear systems (a*x+b*y=c; d*x+e*y=f; a,b,c,d,e,f are constants) at compile-time.)


	countOperations (Count the mathematical operations of the system.)


	cseBinary (Common Sub-expression Elimination)


	dumpComponentsGraphStr (Dumps the assignment graph used to determine strong components to format suitable for Mathematica)


	dumpDAE (dumps the DAE representation of the current transformation state)


	dumpDAEXML (dumps the DAE as xml representation of the current transformation state)


	evaluateParameters (Evaluates parameters with annotation(Evaluate=true). Use '--evaluateFinalParameters=true' or '--evaluateProtectedParameters=true' to specify additional parameters to be evaluated. Use '--replaceEvaluatedParameters=true' if the evaluated parameters should be replaced in the DAE. To evaluate all parameters in the Frontend use -d=evaluateAllParameters.)


	extendDynamicOptimization (Move loops to constraints.)


	generateSymbolicLinearization (Generates symbolic linearization matrices A,B,C,D for linear model:[image: \dot{x} = Ax + Bu])


	generateSymbolicSensitivities (Generates symbolic Sensivities matrix, where der(x) is differentiated w.r.t. param.)


	inlineArrayEqn (This module expands all array equations to scalar equations.)


	inputDerivativesUsed (Checks if derivatives of inputs are need to calculate the model.)


	lateInlineFunction (Perform function inlining for function with annotation LateInline=true.)


	partlintornsystem (partitions linear torn systems.)


	recursiveTearing (inline and repeat tearing)


	reduceDynamicOptimization (Removes equations which are not needed for the calculations of cost and constraints. This module requires -d=reduceDynOpt.)


	relaxSystem (relaxation from gausian elemination)


	removeConstants (Remove all constants in the system.)


	removeEqualRHS (Detects equal function calls of the form a=f(b) and c=f(b) and substitutes them to get speed up.)


	removeSimpleEquations (Performs alias elimination and removes constant variables from the DAE, replacing all occurrences of the old variable reference with the new value (constants) or variable reference (alias elimination).)


	removeUnusedParameter (Strips all parameter not present in the equations from the system to get speed up for compilation of target code.)


	removeUnusedVariables (Strips all variables not present in the equations from the system to get speed up for compilation of target code.)


	reshufflePost (Reshuffles algebraic loops.)


	simplifyAllExpressions (Does simplifications on all expressions.)


	simplifyComplexFunction (Some simplifications on complex functions (complex refers to the internal data structure))


	simplifyConstraints (Rewrites nonlinear constraints into box constraints if possible. This module requires +gDynOpt.)


	simplifyLoops (Simplifies algebraic loops. This modules requires +simplifyLoops.)


	simplifyTimeIndepFuncCalls (Simplifies time independent built in function calls like pre(param) -> param, der(param) -> 0.0, change(param) -> false, edge(param) -> false.)


	simplifysemiLinear (Simplifies calls to semiLinear.)


	solveLinearSystem (solve linear system with newton step)


	solveSimpleEquations (Solves simple equations)


	symSolver (Rewrites the ode system for implicit Euler method. This module requires +symSolver.)


	symbolicJacobian (Detects the sparse pattern of the ODE system and calculates also the symbolic Jacobian if flag '--generateSymbolicJacobian' is enabled.)


	tearingSystem (For method selection use flag tearingMethod.)


	wrapFunctionCalls (This module introduces variables for each function call and substitutes all these calls with the newly introduced variables.)




--simCodeTarget

Sets the target language for the code generation.

String (default C). Valid options:


	None


	Adevs


	C


	Cpp


	CSharp


	ExperimentalEmbeddedC


	Java


	JavaScript


	omsic


	sfmi


	XML


	MidC




--orderConnections

Orders connect equations alphabetically if set.

Boolean (default true).

-t, --typeinfo

Prints out extra type information if set.

Boolean (default false).

-a, --keepArrays

Sets whether to split arrays or not.

Boolean (default false).

-m, --modelicaOutput

Enables valid modelica output for flat modelica.

Boolean (default false).

-q, --silent

Turns on silent mode.

Boolean (default false).

-c, --corbaSessionName

Sets the name of the corba session if -d=interactiveCorba or --interactive=corba is used.

String (default empty).

-n, --numProcs

Sets the number of processors to use (0=default=auto).

Integer (default 0).

-l, --latency

Sets the latency for parallel execution.

Integer (default 0).

-b, --bandwidth

Sets the bandwidth for parallel execution.

Integer (default 0).

-i, --instClass

Instantiate the class given by the fully qualified path.

String (default empty).

-v, --vectorizationLimit

Sets the vectorization limit, arrays and matrices larger than this will not be vectorized.

Integer (default 0).

-s, --simulationCg

Turns on simulation code generation.

Boolean (default false).

--evalAnnotationParams

Sets whether to evaluate parameters in annotations or not.

Boolean (default false).

--generateLabeledSimCode

Turns on labeled SimCode generation for reduction algorithms.

Boolean (default false).

--reduceTerms

Turns on reducing terms for reduction algorithms.

Boolean (default false).

--reductionMethod

Sets the reduction method to be used.

String (default deletion). Valid options:


	deletion


	substitution


	linearization




--demoMode

Disable Warning/Error Massages.

Boolean (default false).

--locale

Override the locale from the environment.

String (default empty).

-o, --defaultOCLDevice

Sets the default OpenCL device to be used for parallel execution.

Integer (default 0).

--maxTraversals

Maximal traversals to find simple equations in the acausal system.

Integer (default 2).

--dumpTarget

Redirect the dump to file. If the file ends with .html HTML code is generated.

String (default empty).

--delayBreakLoop

Enables (very) experimental code to break algebraic loops using the delay() operator. Probably messes with initialization.

Boolean (default true).

--tearingMethod

Sets the tearing method to use. Select no tearing or choose tearing method.

String (default cellier). Valid options:


	noTearing (Skip tearing.)


	minimalTearing (Minimal tearing method based on a brute force approuch.)


	omcTearing (Tearing method developed by TU Dresden: Frenkel, Schubert.)


	cellier (Tearing based on Celliers method, revised by FH Bielefeld: Täuber, Patrick)




--tearingHeuristic

Sets the tearing heuristic to use for Cellier-tearing.

String (default MC3). Valid options:


	MC1 (Original cellier with consideration of impossible assignments and discrete Vars.)


	MC2 (Modified cellier, drop first step.)


	MC11 (Modified MC1, new last step 'count impossible assignments'.)


	MC21 (Modified MC2, new last step 'count impossible assignments'.)


	MC12 (Modified MC1, step 'count impossible assignments' before last step.)


	MC22 (Modified MC2, step 'count impossible assignments' before last step.)


	MC13 (Modified MC1, build sum of impossible assignment and causalizable equations, choose var with biggest sum.)


	MC23 (Modified MC2, build sum of impossible assignment and causalizable equations, choose var with biggest sum.)


	MC231 (Modified MC23, Two rounds, choose better potentials-set.)


	MC3 (Modified cellier, build sum of impossible assignment and causalizable equations for all vars, choose var with biggest sum.)


	MC4 (Modified cellier, use all heuristics, choose var that occurs most in potential sets)




--disableLinearTearing

Disables the tearing of linear systems. That might improve the performance of large linear systems(N>1000) in combination with a sparse solver (e.g. umfpack) at runtime (usage with: -ls umfpack).
Deprecated flag: Use --maxSizeLinearTearing=0 instead.

Boolean (default false).

--scalarizeMinMax

Scalarizes the builtin min/max reduction operators if true.

Boolean (default false).

--scalarizeBindings

Always scalarizes bindings if set.

Boolean (default false).

--corbaObjectReferenceFilePath

Sets the path for corba object reference file if -d=interactiveCorba is used.

String (default empty).

--hpcomScheduler

Sets the scheduler for task graph scheduling (list | listr | level | levelfix | ext | metis | mcp | taskdep | tds | bls | rand | none). Default: level.

String (default level).

--hpcomCode

Sets the code-type produced by hpcom (openmp | pthreads | pthreads_spin | tbb | mpi). Default: openmp.

String (default openmp).

--rewriteRulesFile

Activates user given rewrite rules for Absyn expressions. The rules are read from the given file and are of the form rewrite(fromExp, toExp);

String (default empty).

--replaceHomotopy

Replaces homotopy(actual, simplified) with the actual expression or the simplified expression. Good for debugging models which use homotopy. The default is to not replace homotopy.

String (default none). Valid options:


	none (Default, do not replace homotopy.)


	actual (Replace homotopy(actual, simplified) with actual.)


	simplified (Replace homotopy(actual, simplified) with simplified.)




--generateSymbolicJacobian

Generates symbolic Jacobian matrix, where der(x) is differentiated w.r.t. x. This matrix can be used by dassl or ida solver with simulation flag '-jacobian'.

Boolean (default false).

--generateSymbolicLinearization


	Generates symbolic linearization matrices A,B,C,D for linear model:
	[image: \dot x = Ax + Bu]
[image: y = Cx +Du]





Boolean (default false).

--intEnumConversion

Allow Integer to enumeration conversion.

Boolean (default false).

--profiling

Sets the profiling level to use. Profiled equations and functions record execution time and count for each time step taken by the integrator.

String (default none). Valid options:


	none (Generate code without profiling)


	blocks (Generate code for profiling function calls as well as linear and non-linear systems of equations)


	blocks+html (Like blocks, but also run xsltproc and gnuplot to generate an html report)


	all (Generate code for profiling of all functions and equations)


	all_perf (Generate code for profiling of all functions and equations with additional performance data using the papi-interface (cpp-runtime))


	all_stat (Generate code for profiling of all functions and equations with additional statistics (cpp-runtime))




--reshuffle

sets tolerance of reshuffling algorithm: 1: conservative, 2: more tolerant, 3 resolve all

Integer (default 1).

--gDynOpt

Generate dynamic optimization problem based on annotation approach.

Boolean (default false).

--maxSizeSolveLinearSystem

Max size for solveLinearSystem.

Integer (default 0).

--cppFlags

Sets extra flags for compilation with the C++ compiler (e.g. +cppFlags=-O3,-Wall)

String list (default ).

--removeSimpleEquations

Specifies method that removes simple equations.

String (default default). Valid options:


	none (Disables module)


	default (Performs alias elimination and removes constant variables. Default case uses in preOpt phase the fastAcausal and in postOpt phase the causal implementation.)


	causal (Performs alias elimination and removes constant variables. Causal implementation.)


	fastAcausal (Performs alias elimination and removes constant variables. fastImplementation fastAcausal.)


	allAcausal (Performs alias elimination and removes constant variables. Implementation allAcausal.)


	new (New implementation (experimental))




--dynamicTearing

Activates dynamic tearing (TearingSet can be changed automatically during runtime, strict set vs. casual set.)

String (default false). Valid options:


	false (No dynamic tearing.)


	true (Dynamic tearing for linear and nonlinear systems.)


	linear (Dynamic tearing only for linear systems.)


	nonlinear (Dynamic tearing only for nonlinear systems.)




--symSolver

Activates symbolic implicit solver (original system is not changed).

String (default  none). Valid options:


	none


	impEuler


	expEuler




--loop2con

Specifies method that transform loops in constraints. hint: using initial guess from file!

String (default none). Valid options:


	none (Disables module)


	lin (linear loops --> constraints)


	noLin (no linear loops --> constraints)


	all (loops --> constraints)




--forceTearing

Use tearing set even if it is not smaller than the original component.

Boolean (default false).

--simplifyLoops

Simplify algebraic loops.

Integer (default 0). Valid options:


	0 (do nothing)


	1 (special modification of residual expressions)


	2 (special modification of residual expressions with helper variables)




--recursiveTearing

Inline and repeat tearing.

Integer (default 0). Valid options:


	0 (do nothing)


	1 (linear tearing set of size 1)


	2 (linear tearing)




--flowThreshold

Sets the minium threshold for stream flow rates

Real (default 1e-07).

--matrixFormat

Sets the matrix format type in cpp runtime which should be used (dense | sparse ). Default: dense.

String (default dense).

--partlintorn

Sets the limit for partitionin of linear torn systems.

Integer (default 0).

--initOptModules

Sets the initialization optimization modules to use in the back end. See --help=optmodules for more info.

String list (default simplifyComplexFunction,tearingSystem,solveSimpleEquations,calculateStrongComponentJacobians,simplifyAllExpressions,collapseArrayExpressions). Valid options:


	calculateStrongComponentJacobians (Generates analytical jacobian for torn linear and non-linear strong components. By default linear components and non-linear components with user-defined function calls are skipped. See also debug flags: LSanalyticJacobian, NLSanalyticJacobian and forceNLSanalyticJacobian)


	collapseArrayExpressions (Simplifies {x[1],x[2],x[3]} → x for arrays of whole variable references (simplifies code generation).)


	constantLinearSystem (Evaluates constant linear systems (a*x+b*y=c; d*x+e*y=f; a,b,c,d,e,f are constants) at compile-time.)


	extendDynamicOptimization (Move loops to constraints.)


	generateHomotopyComponents (Finds the parts of the DAE that have to be handled by the homotopy solver and creates a strong component out of it.)


	inlineHomotopy (Experimental: Inlines the homotopy expression to allow symbolic simplifications.)


	inputDerivativesUsed (Checks if derivatives of inputs are need to calculate the model.)


	recursiveTearing (inline and repeat tearing)


	reduceDynamicOptimization (Removes equations which are not needed for the calculations of cost and constraints. This module requires -d=reduceDynOpt.)


	replaceHomotopyWithSimplified (Replaces the homotopy expression homotopy(actual, simplified) with the simplified part.)


	simplifyAllExpressions (Does simplifications on all expressions.)


	simplifyComplexFunction (Some simplifications on complex functions (complex refers to the internal data structure))


	simplifyConstraints (Rewrites nonlinear constraints into box constraints if possible. This module requires +gDynOpt.)


	simplifyLoops (Simplifies algebraic loops. This modules requires +simplifyLoops.)


	solveSimpleEquations (Solves simple equations)


	tearingSystem (For method selection use flag tearingMethod.)


	wrapFunctionCalls (This module introduces variables for each function call and substitutes all these calls with the newly introduced variables.)




--maxMixedDeterminedIndex

Sets the maximum mixed-determined index that is handled by the initialization.

Integer (default 10).

--useLocalDirection

Keeps the input/output prefix for all variables in the flat model, not only top-level ones.

Boolean (default false).

--defaultOptModulesOrdering

If this is activated, then the specified pre-/post-/init-optimization modules will be rearranged to the recommended ordering.

Boolean (default true).

--preOptModules+

Enables additional pre-optimization modules, e.g. --preOptModules+=module1,module2 would additionally enable module1 and module2. See --help=optmodules for more info.

String list (default empty).

--preOptModules-

Disables a list of pre-optimization modules, e.g. --preOptModules-=module1,module2 would disable module1 and module2. See --help=optmodules for more info.

String list (default empty).

--postOptModules+

Enables additional post-optimization modules, e.g. --postOptModules+=module1,module2 would additionally enable module1 and module2. See --help=optmodules for more info.

String list (default empty).

--postOptModules-

Disables a list of post-optimization modules, e.g. --postOptModules-=module1,module2 would disable module1 and module2. See --help=optmodules for more info.

String list (default empty).

--initOptModules+

Enables additional init-optimization modules, e.g. --initOptModules+=module1,module2 would additionally enable module1 and module2. See --help=optmodules for more info.

String list (default empty).

--initOptModules-

Disables a list of init-optimization modules, e.g. --initOptModules-=module1,module2 would disable module1 and module2. See --help=optmodules for more info.

String list (default empty).

--instCacheSize

Sets the size of the internal hash table used for instantiation caching.

Integer (default 25343).

--maxSizeLinearTearing

Sets the maximum system size for tearing of linear systems (default 200).

Integer (default 200).

--maxSizeNonlinearTearing

Sets the maximum system size for tearing of nonlinear systems (default 10000).

Integer (default 10000).

--noTearingForComponent

Deactivates tearing for the specified components.
Use '-d=tearingdump' to find out the relevant indexes.

Unknown default valueFlags.FlagData.INT_LIST_FLAG(data = {NIL})

--daeMode

Generates code to simulate models in DAE mode. The whole system is passed directly to the DAE solver SUNDIALS/IDA and no algebraic solver is involved in the simulation process.

Boolean (default false).

--inlineMethod

Sets the inline method to use.
replace : This method inlines by replacing in place all expressions. Might lead to very long expression.
append  : This method inlines by adding additional variables to the whole system. Might lead to much bigger system.

String (default  replace). Valid options:


	replace


	append




--setTearingVars

Sets the tearing variables by its strong component indexes. Use '-d=tearingdump' to find out the relevant indexes.
Use following format: '--setTearingVars=(sci,n,t1,...,tn)*', with sci = strong component index, n = number of tearing variables, t1,...tn = tearing variables.
E.g.: '--setTearingVars=4,2,3,5' would select variables 3 and 5 in strong component 4.

Unknown default valueFlags.FlagData.INT_LIST_FLAG(data = {NIL})

--setResidualEqns

Sets the residual equations by its strong component indexes. Use '-d=tearingdump' to find out the relevant indexes for the collective equations.
Use following format: '--setResidualEqns=(sci,n,r1,...,rn)*', with sci = strong component index, n = number of residual equations, r1,...rn = residual equations.
E.g.: '--setResidualEqns=4,2,3,5' would select equations 3 and 5 in strong component 4.
Only works in combination with 'setTearingVars'.

Unknown default valueFlags.FlagData.INT_LIST_FLAG(data = {NIL})

--ignoreCommandLineOptionsAnnotation

Ignores the command line options specified as annotation in the class.

Boolean (default false).

--calculateSensitivities

Generates sensitivities variables and matrixes.

Boolean (default false).

-r, --alarm

Sets the number seconds until omc timeouts and exits. Used by the testing framework to terminate infinite running processes.

Integer (default 0).

--totalTearing

Activates total tearing (determination of all possible tearing sets) for the specified components.
Use '-d=tearingdump' to find out the relevant indexes.

Unknown default valueFlags.FlagData.INT_LIST_FLAG(data = {NIL})

--ignoreSimulationFlagsAnnotation

Ignores the simulation flags specified as annotation in the class.

Boolean (default false).

--dynamicTearingForInitialization

Enable Dynamic Tearing also for the initialization system.

Boolean (default false).

--preferTVarsWithStartValue

Prefer tearing variables with start value for initialization.

Boolean (default true).

--equationsPerFile

Generate code for at most this many equations per C-file (partially implemented in the compiler).

Integer (default 2000).

--evaluateFinalParameters

Evaluates all the final parameters in addition to parameters with annotation(Evaluate=true).

Boolean (default false).

--evaluateProtectedParameters

Evaluates all the protected parameters in addition to parameters with annotation(Evaluate=true).

Boolean (default false).

--replaceEvaluatedParameters

Replaces all the evaluated parameters in the DAE.

Boolean (default true).

--condenseArrays

Sets whether array expressions containing function calls are condensed or not.

Boolean (default true).

--wfcAdvanced

wrapFunctionCalls ignores more then default cases, e.g. exp, sin, cos, log, (experimental flag)

Boolean (default false).

--tearingStrictness

Sets the strictness of the tearing method regarding the solvability restrictions.

String (default strict). Valid options:


	casual (Loose tearing rules using ExpressionSolve to determine the solvability instead of considering the partial derivative. Allows to solve for everything that is analytically possible. This could lead to singularities during simulation.)


	strict (Robust tearing rules by consideration of the partial derivative. Allows to divide by parameters that are not equal to or close to zero.)


	veryStrict (Very strict tearing rules that do not allow to divide by any parameter. Use this if you aim at overriding parameters after compilation with values equal to or close to zero.)




--interactive

Sets the interactive mode for omc.

String (default none). Valid options:


	none (do nothing)


	corba (Starts omc as a server listening on the socket interface.)


	tcp (Starts omc as a server listening on the Corba interface.)


	zmq (Starts omc as a ZeroMQ server listening on the socket interface.)




-z, --zeroMQFileSuffix

Sets the file suffix for zeroMQ port file if --interactive=zmq is used.

String (default empty).

--homotopyApproach

Sets the homotopy approach.

String (default equidistantGlobal). Valid options:


	equidistantLocal (Local homotopy approach with equidistant lambda steps. The homotopy parameter only effects the local strongly connected component.)


	adaptiveLocal (Local homotopy approach with adaptive lambda steps. The homotopy parameter only effects the local strongly connected component.)


	equidistantGlobal (Default, global homotopy approach with equidistant lambda steps. The homotopy parameter effects the entire initialization system.)


	adaptiveGlobal (Global homotopy approach with adaptive lambda steps. The homotopy parameter effects the entire initialization system.)




--ignoreReplaceable

Sets whether to ignore replaceability or not when redeclaring.

Boolean (default false).

--postOptModulesDAE

Sets the optimization modules for the DAEmode in the back end. See --help=optmodules for more info.

String list (default lateInlineFunction,wrapFunctionCalls,simplifysemiLinear,simplifyComplexFunction,removeConstants,simplifyTimeIndepFuncCalls,simplifyAllExpressions,findZeroCrossings,createDAEmodeBDAE,detectDAEmodeSparsePattern,setEvaluationStage).

--evalLoopLimit

The loop iteration limit used when evaluating constant function calls.

Integer (default 100000).

--evalRecursionLimit

The recursion limit used when evaluating constant function calls.

Integer (default 256).

--singleInstanceAglSolver

Sets to instantiate only  one algebraic loop solver all algebraic loops

Boolean (default false).

--showStructuralAnnotations

Show annotations affecting the solution process in the flattened code.

Boolean (default false).

--initialStateSelection

Activates the state selection inside initialization to avoid singularities.

Boolean (default false).

--strict

Enables stricter enforcement of Modelica language rules.

Boolean (default false).

--linearizationDumpLanguage

Sets the target language for the produced code of linearization. Only works with '--generateSymbolicLinearization' and 'linearize(modelName)'.

String (default modelica). Valid options:


	modelica


	matlab


	julia


	python




--convertAnalyticalSingularities

Allows the compiler to try to convert analytical to structural singularities.

Boolean (default false).




Debug flags

The debug flag takes a comma-separated list of flags which are used by the
compiler for debugging or experimental purposes.
Flags prefixed with "-" or "no" will be disabled.
The available flags are (+ are enabled by default, - are disabled):


	Cache (default: on)
	Turns off the instantiation cache.






	LSanalyticJacobian (default: off)
	Enables analytical jacobian for linear strong components. Defaults to false






	NLSanalyticJacobian (default: on)
	Enables analytical jacobian for non-linear strong components without user-defined function calls, for that see forceNLSanalyticJacobian






	acceptTooManyFields (default: off)
	Accepts passing records with more fields than expected to a function. This is not allowed, but is used in Fluid.Dissipation. See https://trac.modelica.org/Modelica/ticket/1245 for details.






	addDerAliases (default: off)
	Adds for every der-call an alias equation e.g. dx = der(x). It's a work-a-round flag,
which helps in some cases to simulate the models e.g.
Modelica.Fluid.Examples.HeatExchanger.HeatExchangerSimulation.
Deprecated flag: Use --preOptModules+=introduceDerAlias instead.






	addScaledVars (default: off)
	Adds an alias equation var_nrom = var/nominal where var is state
Deprecated flag: Use --postOptModules+=addScaledVars_states instead.






	addScaledVarsInput (default: off)
	Adds an alias equation var_nrom = var/nominal where var is input
Deprecated flag: Use --postOptModules+=addScaledVars_inputs instead.






	aliasConflicts (default: off)
	Dumps alias sets with different start or nominal values.






	backendKeepEnv (default: on)
	When enabled, the environment is kept when entering the backend, which enables CevalFunction (function interpretation) to work. This module not essential for the backend to function in most cases, but can improve simulation performance by evaluating functions. The drawback to keeping the environment graph in memory is that it is huge (~80% of the total memory in use when returning the frontend DAE).






	backendReduceDAE (default: off)
	Prints all Reduce DAE debug information.






	backenddaeinfo (default: off)
	Enables dumping of back-end information about system (Number of equations before back-end,...).






	bltdump (default: off)
	Dumps information from index reduction.






	bltmatrixdump (default: off)
	Dumps the blt matrix in html file. IE seems to be very good in displaying large matrices.






	buildExternalLibs (default: on)
	Use the autotools project in the Resources folder of the library to build missing external libraries.






	ceval (default: off)
	Prints extra information from Ceval.






	cgraph (default: off)
	Prints out connection graph information.






	cgraphGraphVizFile (default: off)
	Generates a graphviz file of the connection graph.






	cgraphGraphVizShow (default: off)
	Displays the connection graph with the GraphViz lefty tool.






	checkASUB (default: off)
	Prints out a warning if an ASUB is created from a CREF expression.






	checkBackendDae (default: off)
	Do some simple analyses on the datastructure from the frontend to check if it is consistent.






	checkDAECrefType (default: off)
	Enables extra type checking for cref expressions.






	checkSimplify (default: off)
	Enables checks for expression simplification and prints a notification whenever an undesirable transformation has been performed.






	constjac (default: off)
	solves linear systems with constant Jacobian and variable b-Vector symbolically






	convertAnalyticalDump (default: off)
	Dumps the conversion process of analytical to structural singularities.






	countOperations (default: off)
	Count operations.






	daedumpgraphv (default: off)
	Dumps the DAE in graphviz format.






	debugAlgebraicLoopsJacobian (default: off)
	Dumps debug output while creating symbolic jacobians for non-linear systems.






	debugAlias (default: off)
	Dumps some information about the process of removeSimpleEquations.






	debugDAEmode (default: off)
	Dump debug output for the DAEmode.






	debugDifferentiation (default: off)
	Dumps debug output for the differentiation process.






	debugDifferentiationVerbose (default: off)
	Dumps verbose debug output for the differentiation process.






	disableColoring (default: off)
	Disables coloring algorithm while spasity detection.






	disableComSubExp (default: off)
	Deactivates module 'comSubExp'
Deprecated flag: Use --preOptModules-=comSubExp instead.






	disableDirectionalDerivatives (default: on)
	For FMI 2.0 only dependecy analysis will be perform.






	disableFMIDependency (default: off)
	Disables the dependency analysis and generation for FMI 2.0.






	disableJacsforSCC (default: off)
	Disables calculation of jacobians to detect if a SCC is linear or non-linear. By disabling all SCC will handled like non-linear.






	disablePartitioning (default: off)
	Deactivates partitioning of entire equation system.
Deprecated flag: Use --preOptModules-=clockPartitioning instead.






	disableRecordConstructorOutput (default: off)
	Disables output of record constructors in the flat code.






	disableSimplifyComplexFunction (default: off)
	disable simplifyComplexFunction
Deprecated flag: Use --postOptModules-=simplifyComplexFunction/--initOptModules-=simplifyComplexFunction instead.






	disableSingleFlowEq (default: off)
	Disables the generation of single flow equations.






	disableStartCalc (default: off)
	Deactivates the pre-calculation of start values during compile-time.






	disableWindowsPathCheckWarning (default: off)
	Disables warnings on Windows if OPENMODELICAHOME/MinGW is missing.






	discreteinfo (default: off)
	Enables dumping of discrete variables. Extends -d=backenddaeinfo.






	dummyselect (default: off)
	Dumps information from dummy state selection heuristic.






	dump (default: off)
	Dumps the absyn representation of a program.






	dumpBackendInline (default: off)
	Dumps debug output while inline function.






	dumpBackendInlineVerbose (default: off)
	Dumps debug output while inline function.






	dumpCSE (default: off)
	Additional output for CSE module.






	dumpCSE_verbose (default: off)
	Additional output for CSE module.






	dumpConstrepl (default: off)
	Dump the found replacements for constants.






	dumpEArepl (default: off)
	Dump the found replacements for evaluate annotations (evaluate=true) parameters.






	dumpEncapsulateConditions (default: off)
	Dumps the results of the preOptModule encapsulateWhenConditions.






	dumpEqInUC (default: off)
	Dumps all equations handled by the unit checker.






	dumpEqUCStruct (default: off)
	Dumps all the equations handled by the unit checker as tree-structure.






	dumpExcludedSymJacExps (default: off)
	This flags dumps all expression that are excluded from differentiation of a symbolic Jacobian.






	dumpFPrepl (default: off)
	Dump the found replacements for final parameters.






	dumpFunctions (default: off)
	Add functions to backend dumps.






	dumpHomotopy (default: off)
	Dumps the results of the postOptModule optimizeHomotopyCalls.






	dumpInlineSolver (default: off)
	Dumps the inline solver equation system.






	dumpJL (default: off)
	Dumps the absyn representation of a program as a Julia representation






	dumpLoops (default: off)
	Dumps loop equation.






	dumpPPrepl (default: off)
	Dump the found replacements for protected parameters.






	dumpParamrepl (default: off)
	Dump the found replacements for remove parameters.






	dumpRecursiveTearing (default: off)
	Dump between steps of recursiveTearing






	dumpSCCGraphML (default: off)
	Dumps graphml files with the strongly connected components.






	dumpSimCode (default: off)
	Dumps the simCode model used for code generation.






	dumpSimplifyLoops (default: off)
	Dump between steps of simplifyLoops






	dumpSortEqnsAndVars (default: off)
	Dumps debug output for the modules sortEqnsVars.






	dumpSparsePattern (default: off)
	Dumps sparse pattern with coloring used for simulation.






	dumpSparsePatternVerbose (default: off)
	Dumps in verbose mode sparse pattern with coloring used for simulation.






	dumpSynchronous (default: off)
	Dumps information of the clock partitioning.






	dumpTransformedModelica (default: off)
	Dumps the back-end DAE to a Modelica-like model after all symbolic transformations are applied.






	dumpUnits (default: off)
	Dumps all the calculated units.






	dumpdaelow (default: off)
	Dumps the equation system at the beginning of the back end.






	dumpdgesv (default: off)
	Enables dumping of the information whether DGESV is used to solve linear systems.






	dumpeqninorder (default: off)
	Enables dumping of the equations in the order they are calculated.






	dumpindxdae (default: off)
	Dumps the equation system after index reduction and optimization.






	dumpinitialsystem (default: off)
	Dumps the initial equation system.






	dumprepl (default: off)
	Dump the found replacements for simple equation removal.






	dynload (default: off)
	Display debug information about dynamic loading of compiled functions.






	evalConstFuncs (default: on)
	Evaluates functions complete and partially and checks for constant output.
Deprecated flag: Use --preOptModules+=evalFunc instead.






	evalFuncDump (default: off)
	dumps debug information about the function evaluation






	evalOutputOnly (default: off)
	Generates equations to calculate outputs only.






	evalParameterDump (default: off)
	Dumps information for evaluating parameters.






	evalfunc (default: on)
	Turns on/off symbolic function evaluation.






	evaluateAllParameters (default: off)
	Evaluates all parameters if set.






	events (default: on)
	Turns on/off events handling.






	execHash (default: off)
	Measures the time it takes to hash all simcode variables before code generation.






	execstat (default: off)
	Prints out execution statistics for the compiler.






	execstatGCcollect (default: off)
	When running execstat, also perform an extra full garbage collection.






	experimentalReductions (default: off)
	Turns on custom reduction functions (OpenModelica extension).






	failtrace (default: off)
	Sets whether to print a failtrace or not.






	fmuExperimental (default: off)
	Include an extra function in the FMU fmi2GetSpecificDerivatives.






	forceNLSanalyticJacobian (default: off)
	Forces calculation analytical jacobian also for non-linear strong components with user-defined functions.






	frontEndUnitCheck (default: off)
	Checks the consistency of units in equation.






	gcProfiling (default: off)
	Prints garbage collection stats to standard output.






	gen (default: off)
	Turns on/off dynamic loading of functions that are compiled during translation. Only enable this if external functions are needed to calculate structural parameters or constants.






	gendebugsymbols (default: off)
	Generate code with debugging symbols.






	generateCodeCheat (default: off)
	Used to generate code for the bootstrapped compiler.






	graphInst (default: off)
	Do graph based instantiation.






	graphInstGenGraph (default: off)
	Dumps a graph of the program. Use with -d=graphInst






	graphInstRunDep (default: off)
	Run scode dependency analysis. Use with -d=graphInst






	graphInstShowGraph (default: off)
	Display a graph of the program interactively. Use with -d=graphInst






	graphml (default: off)
	Dumps .graphml files for the bipartite graph after Index Reduction and a task graph for the SCCs. Can be displayed with yEd.






	graphviz (default: off)
	Dumps the absyn representation of a program in graphviz format.






	graphvizDump (default: off)
	Activates additional graphviz dumps (as .dot files). It can be used in addition to one of the following flags: {dumpdaelow|dumpinitialsystems|dumpindxdae}.






	hardcodedStartValues (default: off)
	Embed the start values of variables and parameters into the c++ code and do not read it from xml file.






	hpcom (default: off)
	Enables parallel calculation based on task-graphs.






	hpcomDump (default: off)
	Dumps additional information on the parallel execution with hpcom.






	hpcomMemoryOpt (default: off)
	Optimize the memory structure regarding the selected scheduler






	ignoreCycles (default: off)
	Ignores cycles between constant/parameter components.






	implOde (default: off)
	activates implicit codegen






	infoXmlOperations (default: off)
	Enables output of the operations in the _info.xml file when translating models.






	initialization (default: off)
	Shows additional information from the initialization process.






	inlineFunctions (default: on)
	Controls if function inlining should be performed.






	inlineSolver (default: off)
	Generates code for inline solver.






	instance (default: off)
	Prints extra failtrace from InstanceHierarchy.






	interactive (default: off)
	Starts omc as a server listening on the socket interface.






	interactiveCorba (default: off)
	Starts omc as a server listening on the Corba interface.






	interactivedump (default: off)
	Prints out debug information for the interactive server.






	iterationVars (default: off)
	Shows a list of all iteration variables.






	listAppendWrongOrder (default: on)
	Print notifications about bad usage of listAppend.






	lookup (default: off)
	Print extra failtrace from lookup.






	mergeAlgSections (default: off)
	Disables coloring algorithm while sparsity detection.






	metaModelicaRecordAllocWords (default: off)
	Instrument the source code to record memory allocations (requires run-time and generated files compiled with -DOMC_RECORD_ALLOC_WORDS).






	multirate (default: off)
	The solver can switch partitions in the system.






	newInst (default: off)
	Enables experimental new instantiation phase.






	nfAPI (default: off)
	Enables experimental new instantiation use in the OMC API.






	nfAPIDynamicSelect (default: off)
	Show DynamicSelect(static, dynamic) in annotations. Default to false and will select the first (static) expression






	nfAPINoise (default: off)
	Enables error display for the experimental new instantiation use in the OMC API.






	nfEvalConstArgFuncs (default: on)
	Evaluate all functions with constant arguments in the new frontend.






	nfExpandFuncArgs (default: off)
	Expand all function arguments in the new frontend.






	nfExpandOperations (default: on)
	Expand all unary/binary operations to scalar expressions in the new frontend.






	nfScalarize (default: on)
	Run scalarization in NF, default true.






	oldFrontEndUnitCheck (default: off)
	Checks the consistency of units in equation (for the old front-end).






	onRelaxation (default: off)
	Perform O(n) relaxation.
Deprecated flag: Use --postOptModules+=relaxSystem instead.






	optdaedump (default: off)
	Dumps information from the optimization modules.






	parallelCodegen (default: on)
	Enables code generation in parallel (disable this if compiling a model causes you to run out of RAM).






	paramdlowdump (default: off)
	Enables dumping of the parameters in the order they are calculated.






	parmodauto (default: off)
	Experimental: Enable parallelization of independent systems of equations in the translated model.






	partitionInitialization (default: on)
	This flag controls if partitioning is applied to the initialization system.






	patternmAllInfo (default: off)
	Adds notifications of all pattern-matching optimizations that are performed.






	patternmDeadCodeElimination (default: on)
	Performs dead code elimination in match-expressions.






	patternmMoveLastExp (default: on)
	Optimization that moves the last assignment(s) into the result of a match-expression. For example: equation c = fn(b); then c; => then fn(b);





patternmSkipFilterUnusedBindings (default: off)


	printStructuralParameters (default: off)
	Prints the structural parameters identified by the front-end






	pthreads (default: off)
	Experimental: Unused parallelization.






	reduceDynOpt (default: off)
	remove eqs which not need for the calculations of cost and constraints
Deprecated flag: Use --postOptModules+=reduceDynamicOptimization instead.






	relidx (default: off)
	Prints out debug information about relations, that are used as zero crossings.






	relocatableFunctions (default: off)
	Generates relocatable code: all functions become function pointers and can be replaced at run-time.






	reportSerializedSize (default: off)
	Reports serialized sizes of various data structures used in the compiler.






	reshufflePost (default: off)
	Reshuffles the systems of equations.






	resolveLoopsDump (default: off)
	Debug Output for ResolveLoops Module.






	rml (default: off)
	Converts Modelica-style arrays to lists.






	runtimeStaticLinking (default: off)
	Use the static simulation runtime libraries (C++ simulation runtime).






	scodeDep (default: on)
	Does scode dependency analysis prior to instantiation. Defaults to true.






	semiLinear (default: off)
	Enables dumping of the optimization information when optimizing calls to semiLinear.






	shortOutput (default: off)
	Enables short output of the simulate() command. Useful for tools like OMNotebook.






	showDaeGeneration (default: off)
	Show the dae variable declarations as they happen.






	showEquationSource (default: off)
	Display the element source information in the dumped DAE for easier debugging.






	showExpandableInfo (default: off)
	Show information about expandable connector handling.






	showInstCacheInfo (default: off)
	Prints information about instantiation cache hits and additions. Defaults to false.






	showStartOrigin (default: off)
	Enables dumping of the DAE startOrigin attribute of the variables.






	showStatement (default: off)
	Shows the statement that is currently being evaluated when evaluating a script.






	skipInputOutputSyntacticSugar (default: off)
	Used when bootstrapping to preserve the input output parsing of the code output by the list command.






	stateselection (default: off)
	Enables dumping of selected states. Extends -d=backenddaeinfo.






	static (default: off)
	Enables extra debug output from the static elaboration.






	stripPrefix (default: on)
	Strips the environment prefix from path/crefs. Defaults to true.






	susanDebug (default: off)
	Makes Susan generate code using try/else to better debug which function broke the expected match semantics.






	symJacConstantSplit (default: off)
	Generates all symbolic Jacobians with splitted constant parts.






	symjacdump (default: off)
	Dumps information about symbolic Jacobians. Can be used only with postOptModules: generateSymbolicJacobian, generateSymbolicLinearization.






	symjacdumpeqn (default: off)
	Dump for debug purpose of symbolic Jacobians. (deactivated now).






	symjacdumpverbose (default: off)
	Dumps information in verbose mode about symbolic Jacobians. Can be used only with postOptModules: generateSymbolicJacobian, generateSymbolicLinearization.






	symjacwarnings (default: off)
	Prints warnings regarding symoblic jacbians.






	tail (default: off)
	Prints out a notification if tail recursion optimization has been applied.






	tearingdump (default: off)
	Dumps tearing information.






	tearingdumpV (default: off)
	Dumps verbose tearing information.






	totaltearingdump (default: off)
	Dumps total tearing information.






	totaltearingdumpV (default: off)
	Dumps verbose total tearing information.






	tplPerfTimes (default: off)
	Enables output of template performance data for rendering text to file.






	transformsbeforedump (default: off)
	Applies transformations required for code generation before dumping flat code.






	types (default: off)
	Prints extra failtrace from Types.






	uncertainties (default: off)
	Enables dumping of status when calling modelEquationsUC.






	updmod (default: off)
	Prints information about modification updates.






	useMPI (default: off)
	Add MPI init and finalize to main method (CPPruntime).






	vectorize (default: off)
	Activates vectorization in the backend.






	visxml (default: off)
	Outputs a xml-file that contains information for visualization.






	warnMinMax (default: on)
	Makes a warning assert from min/max variable attributes instead of error.






	warnNoNominal (default: off)
	Prints the iteration variables in the initialization and simulation DAE, which do not have a nominal value.






	writeToBuffer (default: off)
	Enables writing simulation results to buffer.








Flags for Optimization Modules

Flags that determine which symbolic methods are used to produce the causalized equation system.

The --preOptModules flag sets the optimization modules which are used before the
matching and index reduction in the back end. These modules are specified as a comma-separated list.

The --matchingAlgorithm sets the method that is used for the matching algorithm, after the pre optimization modules.

The --indexReductionMethod sets the method that is used for the index reduction, after the pre optimization modules.

The --initOptModules then sets the optimization modules which are used after the index reduction to optimize the system for initialization, specified as a comma-separated list.

The --postOptModules then sets the optimization modules which are used after the index reduction to optimize the system for simulation, specified as a comma-separated list.
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Small Overview of Simulation Flags

This chapter contains a short overview of simulation flags
as well as additional details of the numerical integration methods.


OpenModelica (C-runtime) Simulation Flags

The simulation executable takes the following flags:


	-abortSlowSimulation
	Aborts if the simulation chatters.






	-alarm=value or -alarm value
	Aborts after the given number of seconds (default=0 disables the alarm).






	-clock=value or -clock value
	Selects the type of clock to use. Valid options include:


	RT (monotonic real-time clock)


	CYC (cpu cycles measured with RDTSC)


	CPU (process-based CPU-time)









	-cpu
	Dumps the cpu-time into the result file using the variable named $cpuTime.






	-csvOstep=value or -csvOstep value
	Value specifies csv-files for debug values for optimizer step.






	-daeMode
	Enables daeMode simulation if the model was compiled with the omc flag --daeMode and ida method is used.






	-deltaXLinearize=value or -deltaXLinearize value
	Value specifies the delta x value for numerical differentiation used by linearization. The default value is sqrt(DBL_EPSILON*2e1).






	-deltaXSolver=value or -deltaXSolver value
	Value specifies the delta x value for numerical differentiation used by integration method. The default values is sqrt(DBL_EPSILON).






	-embeddedServer=value or -embeddedServer value
	Enables an embedded server. Valid values:


	none - default, run without embedded server


	opc-da - [broken] run with embedded OPC DA server (WIN32 only, uses proprietary OPC SC interface)


	opc-ua - [experimental] run with embedded OPC UA server (TCP port 4841 for now; will have its own configuration option later)


	filename - path to a shared object implementing the embedded server interface (requires access to internal OMC data-structures if you want to read or write data)









	-embeddedServerPort=value or -embeddedServerPort value
	Value specifies the port number used by the embedded server. The default value is 4841.






	-mat_sync=value or -mat_sync value
	Syncs the mat file header after emitting every N time-points.






	-emit_protected
	Emits protected variables to the result-file.






	-eps=value or -eps value
	Value specifies the number of convergence iteration to be performed for DataReconciliation






	-f=value or -f value
	Value specifies a new setup XML file to the generated simulation code.






	-help=value or -help value
	Get detailed information that specifies the command-line flag

For example, -help=f prints detailed information for command-line flag f.






	-homAdaptBend=value or -homAdaptBend value
	Maximum trajectory bending to accept the homotopy step.
Default: 0.5, which means the corrector vector has to be smaller than half of the predictor vector.






	-homBacktraceStrategy=value or -homBacktraceStrategy value
	Value specifies the backtrace strategy in the homotopy corrector step. Valid values:


	fix - default, go back to the path by fixing one coordinate


	orthogonal - go back to the path in an orthogonal direction to the tangent vector









	-homHEps=value or -homHEps value
	Tolerance respecting residuals for the homotopy H-function (default: 1e-5).

In the last step (lambda=1) newtonFTol is used as tolerance.






	-homMaxLambdaSteps=value or -homMaxLambdaSteps value
	Maximum lambda steps allowed to run the homotopy path (default: system size * 100).






	-homMaxNewtonSteps=value or -homMaxNewtonSteps value
	Maximum newton steps in the homotopy corrector step (default: 20).






	-homMaxTries=value or -homMaxTries value
	Maximum number of tries for one homotopy lambda step (default: 10).






	-homNegStartDir
	Start to run along the homotopy path in the negative direction.

If one direction fails, the other direction is always used as fallback option.






	-homotopyOnFirstTry
	If the model contains the homotopy operator, directly use the homotopy method to solve the initialization problem.
Without this flag, the solver first tries to solve the initialization problem without homotopy and only uses homotopy as fallback option.






	-homTauDecFac=value or -homTauDecFac value
	Decrease homotopy step size tau by this factor if tau is too big in the homotopy corrector step (default: 10.0).






	-homTauDecFacPredictor=value or -homTauDecFacPredictor value
	Decrease homotopy step size tau by this factor if tau is too big in the homotopy predictor step (default: 2.0).






	-homTauIncFac=value or -homTauIncFac value
	Increase homotopy step size tau by this factor if tau can be increased after the homotopy corrector step (default: 2.0).






	-homTauIncThreshold=value or -homTauIncThreshold value
	Increase the homotopy step size tau if homAdaptBend/bend > homTauIncThreshold (default: 10).






	-homTauMax=value or -homTauMax value
	Maximum homotopy step size tau for the homotopy process (default: 10).






	-homTauMin=value or -homTauMin value
	Minimum homotopy step size tau for the homotopy process (default: 1e-4).






	-homTauStart=value or -homTauStart value
	Homotopy step size tau at the beginning of the homotopy process (default: 0.2).






	-idaMaxErrorTestFails=value or -idaMaxErrorTestFails value
	Value specifies the maximum number of error test failures in attempting one step. The default value is 7.






	-idaMaxNonLinIters=value or -idaMaxNonLinIters value
	Value specifies the maximum number of nonlinear solver iterations at one step. The default value is 3.






	-idaMaxConvFails=value or -idaMaxConvFails value
	Value specifies the maximum number of nonlinear solver convergence failures at one step. The default value is 10.






	-idaNonLinConvCoef=value or -idaNonLinConvCoef value
	Value specifies the safety factor in the nonlinear convergence test. The default value is 0.33.






	-idaLS=value or -idaLS value
	Value specifies the linear solver of the ida integration method. Valid values:


	dense (ida internal dense method.)


	klu (ida use sparse direct solver KLU. (default))


	spgmr (ida generalized minimal residual method. Iterative method)


	spbcg (ida Bi-CGStab. Iterative method)


	sptfqmr (ida TFQMR. Iterative method)









	-idaScaling
	Enable scaling of the IDA solver.






	-idaSensitivity
	Enables sensitivity analysis with respect to parameters if the model is compiled with omc flag --calculateSensitivities.






	-ignoreHideResult
	Emits also variables with HideResult=true annotation.






	-iif=value or -iif value
	Value specifies an external file for the initialization of the model.






	-iim=value or -iim value
	Value specifies the initialization method.
Following options are available: 'symbolic' (default) and 'none'.


	none (sets all variables to their start values and skips the initialization process)


	symbolic (solves the initialization problem symbolically - default)









	-iit=value or -iit value
	Value [Real] specifies a time for the initialization of the model.






	-ils=value or -ils value
	Value specifies the number of steps for homotopy method (required: -iim=symbolic).
The value is an Integer with default value 4.






	-impRKOrder=value or -impRKOrder value
	Value specifies the integration order of the implicit Runge-Kutta method. Valid values: 1 to 6. Default order is 5.






	-impRKLS=value or -impRKLS value
	Selects the linear solver of the integration methods impeuler, trapezoid and imprungekuta:


	iterativ - default, sparse iterativ linear solver with fallback case to dense solver


	dense - dense linear solver, SUNDIALS default method









	-initialStepSize=value or -initialStepSize value
	Value specifies an initial step size, used by the methods: dassl, ida






	-csvInput=value or -csvInput value
	Value specifies an csv-file with inputs for the simulation/optimization of the model






	-exInputFile=value or -exInputFile value
	Value specifies an external file with inputs for the simulation/optimization of the model.






	-stateFile=value or -stateFile value
	Value specifies an file with states start values for the optimization of the model.






	-inputPath=value or -inputPath value
	Value specifies a path for reading the input files i.e., model_init.xml and model_info.json






	-ipopt_hesse=value or -ipopt_hesse value
	Value specifies the hessematrix for Ipopt(OMC, BFGS, const).






	-ipopt_init=value or -ipopt_init value
	Value specifies the initial guess for optimization (sim, const).






	-ipopt_jac=value or -ipopt_jac value
	Value specifies the Jacobian for Ipopt(SYM, NUM, NUMDENSE).






	-ipopt_max_iter=value or -ipopt_max_iter value
	Value specifies the max number of iteration for ipopt.






	-ipopt_warm_start=value or -ipopt_warm_start value
	Value specifies lvl for a warm start in ipopt: 1,2,3,...






	-jacobian=value or -jacobian value
	Select the calculation method for Jacobian used by the integration method:


	coloredNumerical (Colored numerical Jacobian, which is default for dassl and ida. With option -idaLS=klu a sparse matrix is used.)


	internalNumerical (Dense solver internal numerical Jacobian.)


	coloredSymbolical (Colored symbolical Jacobian. Needs omc compiler flag --generateSymbolicJacobian. With option -idaLS=klu a sparse matrix is used.)


	numerical (Dense numerical Jacobian.)


	symbolical (Dense symbolical Jacobian. Needs omc compiler flag --generateSymbolicJacobian.)









	-jacobianThreads=value or -jacobianThreads value
	Value specifies the number of threads for jacobian evaluation in dassl or ida.  The value is an Integer with default value 1.






	-l=value or -l value
	Value specifies a time where the linearization of the model should be performed.






	-l_datarec
	Emit data recovery matrices with model linearization.






	-logFormat=value or -logFormat value
	Value specifies the log format of the executable:


	text (default)


	xml


	xmltcp (required -port flag)









	-ls=value or -ls value
	Value specifies the linear solver method


	lapack (method using LAPACK LU factorization)


	lis (method using iterative solver Lis)


	klu (method using KLU sparse linear solver)


	umfpack (method using UMFPACK sparse linear solver)


	totalpivot (method using a total pivoting LU factorization for underdetermination systems)


	default (default method - LAPACK with total pivoting as fallback)









	-ls_ipopt=value or -ls_ipopt value
	Value specifies the linear solver method for Ipopt, default mumps.
Note: Use if you build ipopt with other linear solver like ma27






	-lss=value or -lss value
	Value specifies the linear sparse solver method


	default (the default sparse linear solver (or a dense solver if there is none available) )


	lis (method using iterative solver Lis)


	klu (method using klu sparse linear solver)


	umfpack (method using umfpack sparse linear solver)









	-lssMaxDensity=value or -lssMaxDensity value
	Value specifies the maximum density for using a linear sparse solver.
The value is a Double with default value 0.2.






	-lssMinSize=value or -lssMinSize value
	Value specifies the minimum system size for using a linear sparse solver.
The value is an Integer with default value 4001.






	-lv=value or -lv value
	Value (a comma-separated String list) specifies which logging levels to
enable. Multiple options can be enabled at the same time.


	stdout (this stream is always active, can be disabled with -lv=-stdout)


	assert (this stream is always active, can be disabled with -lv=-assert)


	LOG_DASSL (additional information about dassl solver)


	LOG_DASSL_STATES (outputs the states at every dassl call)


	LOG_DEBUG (additional debug information)


	LOG_DSS (outputs information about dynamic state selection)


	LOG_DSS_JAC (outputs jacobian of the dynamic state selection)


	LOG_DT (additional information about dynamic tearing)


	LOG_DT_CONS (additional information about dynamic tearing (local and global constraints))


	LOG_EVENTS (additional information during event iteration)


	LOG_EVENTS_V (verbose logging of event system)


	LOG_INIT (additional information during initialization)


	LOG_IPOPT (information from Ipopt)


	LOG_IPOPT_FULL (more information from Ipopt)


	LOG_IPOPT_JAC (check jacobian matrix with Ipopt)


	LOG_IPOPT_HESSE (check hessian matrix with Ipopt)


	LOG_IPOPT_ERROR (print max error in the optimization)


	LOG_JAC (outputs the jacobian matrix used by dassl)


	LOG_LS (logging for linear systems)


	LOG_LS_V (verbose logging of linear systems)


	LOG_NLS (logging for nonlinear systems)


	LOG_NLS_V (verbose logging of nonlinear systems)


	LOG_NLS_HOMOTOPY (logging of homotopy solver for nonlinear systems)


	LOG_NLS_JAC (outputs the jacobian of nonlinear systems)


	LOG_NLS_JAC_TEST (tests the analytical jacobian of nonlinear systems)


	LOG_NLS_RES (outputs every evaluation of the residual function)


	LOG_NLS_EXTRAPOLATE (outputs debug information about extrapolate process)


	LOG_RES_INIT (outputs residuals of the initialization)


	LOG_RT (additional information regarding real-time processes)


	LOG_SIMULATION (additional information about simulation process)


	LOG_SOLVER (additional information about solver process)


	LOG_SOLVER_V (verbose information about the integration process)


	LOG_SOLVER_CONTEXT (context information during the solver process)


	LOG_SOTI (final solution of the initialization)


	LOG_STATS (additional statistics about timer/events/solver)


	LOG_STATS_V (additional statistics for LOG_STATS)


	LOG_SUCCESS (this stream is always active, unless deactivated with -lv=-LOG_SUCCESS)


	LOG_UTIL (???)


	LOG_ZEROCROSSINGS (additional information about the zerocrossings)









	-mbi=value or -mbi value
	Value specifies the maximum number of bisection iterations for state event
detection or zero for default behavior






	-mei=value or -mei value
	Value specifies the maximum number of event iterations.
The value is an Integer with default value 20.






	-maxIntegrationOrder=value or -maxIntegrationOrder value
	Value specifies maximum integration order, used by the methods: dassl, ida.






	-maxStepSize=value or -maxStepSize value
	Value specifies maximum absolute step size, used by the methods: dassl, ida.






	-measureTimePlotFormat=value or -measureTimePlotFormat value
	Value specifies the output format of the measure time functionality:


	svg


	jpg


	ps


	gif


	...









	-newtonFTol=value or -newtonFTol value
	Tolerance respecting residuals for updating solution vector in Newton solver.
Solution is accepted if the (scaled) 2-norm of the residuals is smaller than the tolerance newtonFTol and the (scaled) newton correction (delta_x) is smaller than the tolerance newtonXTol.
The value is a Double with default value 1e-12.






	-newtonMaxStepFactor=value or -newtonMaxStepFactor value
	Maximum newton step factor mxnewtstep = maxStepFactor * norm2(xScaling).  Used currently only by KINSOL.






	-newtonXTol=value or -newtonXTol value
	Tolerance respecting newton correction (delta_x) for updating solution vector in Newton solver.
Solution is accepted if the (scaled) 2-norm of the residuals is smaller than the tolerance newtonFTol and the (scaled) newton correction (delta_x) is smaller than the tolerance newtonXTol.
The value is a Double with default value 1e-12.






	-newton=value or -newton value
	Value specifies the damping strategy for the newton solver.


	damped (Newton with a damping strategy)


	damped2 (Newton with a damping strategy 2)


	damped_ls (Newton with a damping line search)


	damped_bt (Newton with a damping backtracking and a minimum search via golden ratio method)


	pure (Newton without damping strategy)









	-nls=value or -nls value
	Value specifies the nonlinear solver:


	hybrid (Modification of the Powell hybrid method from minpack - former default solver)


	kinsol (SUNDIALS/KINSOL includes an interface to the sparse direct solver, KLU. See simulation option -nlsLS for more information.)


	newton (Newton Raphson - prototype implementation)


	mixed (Mixed strategy. First the homotopy solver is tried and then as fallback the hybrid solver.)


	homotopy (Damped Newton solver if failing case fixed-point and Newton homotopies are tried.)









	-nlsInfo
	Outputs detailed information about solving process of non-linear systems into csv files.






	-nlsLS=value or -nlsLS value
	Value specifies the linear solver used by the non-linear solver:


	default (chooses the nls linear solver based on which nls is being used.)


	totalpivot (internal total pivot implementation. Solve in some case even under-determined systems.)


	lapack (use external LAPACK implementation.)


	klu (use KLU direct sparse solver. Only with KINSOL available.)









	-nlssMaxDensity=value or -nlssMaxDensity value
	Value specifies the maximum density for using a non-linear sparse solver.
The value is a Double with default value 0.2.






	-nlssMinSize=value or -nlssMinSize value
	Value specifies the minimum system size for using a non-linear sparse solver.
The value is an Integer with default value 10001.






	-noemit
	Do not emit any results to the result file.






	-noEquidistantTimeGrid
	Output the internal steps given by dassl/ida instead of interpolating results
into an equidistant time grid as given by stepSize or numberOfIntervals.






	-noEquidistantOutputFrequency=value or -noEquidistantOutputFrequency value
	Integer value n controls the output frequency in noEquidistantTimeGrid mode
and outputs every n-th time step






	-noEquidistantOutputTime=value or -noEquidistantOutputTime value
	Real value timeValue controls the output time point in noEquidistantOutputTime
mode and outputs every time>=k*timeValue, where k is an integer






	-noEventEmit
	Do not emit event points to the result file.






	-noRestart
	Disables the restart of the integration method after an event is performed, used by the methods: dassl, ida






	-noRootFinding
	Disables the internal root finding procedure of methods: dassl and ida.






	-noScaling
	Disables scaling for the variables and the residuals in the algebraic nonlinear solver KINSOL.






	-noSuppressAlg
	Flag to not suppress algebraic variables in the local error test of the ida solver in daeMode.
In general, the use of this option is discouraged when solving DAE systems of index 1,
whereas it is generally encouraged for systems of index 2 or more.






	-optDebugJac=value or -optDebugJac value
	Value specifies the number of iterations from the dynamic optimization, which
will be debugged, creating .csv and .py files.






	-optimizerNP=value or -optimizerNP value
	Value specifies the number of points in a subinterval.
Currently supports numbers 1 and 3.






	-optimizerTimeGrid=value or -optimizerTimeGrid value
	Value specifies external file with time points.






	-output=value or -output value
	Output the variables a, b and c at the end of the simulation to the standard
output: time = value, a = value, b = value, c = value






	-outputPath=value or -outputPath value
	Value specifies a path for writing the output files i.e., model_res.mat, model_prof.intdata, model_prof.realdata etc.






	-override=value or -override value
	Override the variables or the simulation settings in the XML setup file
For example: var1=start1,var2=start2,par3=start3,startTime=val1,stopTime=val2






	-overrideFile=value or -overrideFile value
	Will override the variables or the simulation settings in the XML setup file
with the values from the file.
Note that: -overrideFile CANNOT be used with -override.
Use when variables for -override are too many.
overrideFileName contains lines of the form: var1=start1






	-port=value or -port value
	Value specifies the port for simulation status (default disabled).






	-r=value or -r value
	Value specifies the name of the output result file.
The default file-name is based on the model name and output format.
For example: Model_res.mat.






	-reconcile
	Run the DataReconciliation algorithm for constrained equation






	-rt=value or -rt value
	Value specifies the scaling factor for real-time synchronization (0 disables).
A value > 1 means the simulation takes a longer time to simulate.






	-s=value or -s value
	Value specifies the integration method. For additional information see the User's Guide


	euler - Euler - explicit, fixed step size, order 1


	heun - Heun's method - explicit, fixed step, order 2


	rungekutta - classical Runge-Kutta - explicit, fixed step, order 4


	impeuler - Euler - implicit, fixed step size, order 1


	trapezoid - trapezoidal rule - implicit, fixed step size, order 2


	imprungekutta - Runge-Kutta methods based on Radau and Lobatto IIA - implicit, fixed step size, order 1-6(selected manually by flag -impRKOrder)


	irksco - own developed Runge-Kutta solver - implicit, step size control, order 1-2


	dassl - default solver - BDF method - implicit, step size control, order 1-5


	ida - SUNDIALS IDA solver - BDF method with sparse linear solver - implicit, step size control, order 1-5


	rungekuttaSsc - Runge-Kutta based on Novikov (2016) - explicit, step size control, order 4-5 [experimental]


	symSolver - symbolic inline Solver [compiler flag +symSolver needed] - fixed step size, order 1


	symSolverSsc - symbolic implicit Euler with step size control [compiler flag +symSolver needed] - step size control, order 1


	qss - A QSS solver [experimental]


	optimization - Special solver for dynamic optimization









	-single
	Output results in single precision (mat-format only).






	-steps
	Dumps the number of integration steps into the result file.






	-steadyState
	Aborts the simulation if steady state is reached.






	-steadyStateTol=value or -steadyStateTol value
	This relative tolerance is used to detect steady state: max(|d(x_i)/dt|/nominal(x_i)) < steadyStateTol






	-sx=value or -sx value
	Value specifies an csv-file with inputs as covariance matrix Sx for DataReconciliation






	-keepHessian=value or -keepHessian value
	Value specifies the number of steps, which keep Hessian matrix constant.






	-w
	Shows all warnings even if a related log-stream is inactive.
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Technical Details

This chapter gives an overview of some implementation details that might
be interesting when building tools around OpenModelica.


The MATv4 Result File Format

The default result-file format of OpenModelica is based on MATLAB level
4 MAT-files as described in the MATLAB documentation [https://www.mathworks.com/help/pdf_doc/matlab/matfile_format.pdf].
This format can be read by tools such as MATLAB, Octave [https://www.gnu.org/software/octave/], Scilab [https://www.scilab.org/], and SciPy [https://www.scipy.org/].
OpenModelica will write the result-files in a particular way that can be read by tools such as DyMat [https://pypi.python.org/pypi/DyMat] and Dymola [https://www.3ds.com/products-services/catia/products/dymola/] (OpenModelica can also read files generated by Dymola since the used format is the same).

The variables stored in the MAT-file are (in the order required by OpenModelica):


	Aclass
	
	Aclass(1,:) is always Atrajectory


	Aclass(2,:) is 1.1 in OpenModelica


	Aclass(3,:) is empty


	Aclass(4,:) is either binTrans or binNormal




The most important part of the variable is Aclass(4,:) since there are
two main ways the result-file is stored: transposed or not.
For efficiency, the result-file is written time-step by time-step during
simulation. But the best way to read the data for a single variable
is if the variables are stored variable by variable.
If Aclass(4,:) is binTrans, all matrices need to be transposed since
the file was not transposed for efficient reading of the file. Note that
this affects all matrices, even matrices that do not change during
simulation (such as name and description).



	name
	Is an n x m character (int8) matrix, where n is the number of variables stored in the
result-file (including time). m is the length of the longest variable.
OpenModelica stores the trailing part of the name as NIL bytes (0) whereas
other tools use spaces for the trailing part.



	description
	Is an n x m character (int8) matrix containing the comment-string corresponding to the
variable in the name matrix.



	dataInfo
	Is an n x 4 integer matrix containing information for each variable (in the
same order as the name and description matrices).


	dataInfo(i,1) is 1 or 2, saying if variable i is stored in the data_1 or data_2 matrix. If it is 0, it is the abscissa (time variable).


	dataInfo(i,2) contains the index in the data_1 or data_2 matrix.
The index is 1-based and may contain several variables pointing to the same row (alias variables).
A negative value means that the variable is a negated alias variable.


	dataInfo(i,3) is 0 to signify linear interpolation. In other tools the value is the number of times differentiable this variable is, which may improve plotting.


	dataInfo(i,4) is -1 in OpenModelica to signify that the value is not defined outside the time range. 0 keeps the first/last value when going outside the time range and 1 performs linear interpolation on the first/last two points.






	data_1
	If it is an n x 1 matrix it contains the values of parameters.
If it is an n x 2 matrix, the first and second column signify start
and stop-values.



	data_2
	Each row contains the values of a variable at the sampled times.
The corresponding time stamps are stored in data_2(1,:). data_2(2,1)
is the value of some variable at time data_2(1,1).











          

      

      

    

  

  
    
    DataReconciliation
    

    
 
  

    
      
          
            
  
DataReconciliation

The objective of data reconciliation is to use physical models to decrease measurement
uncertainties on physical quantities. Data reconciliation is possible only when redundant
measurements are available for a given physical quantity.


Defining DataReconciliation Problem in OpenModelica

To define DataReconciliation Problem in OpenModelica, The Modelica model must be defined with the following


	The list of variables of interest, which is defined in the modelica model as a special variable attribute (uncertain=Uncertainty.refine)


	The list of approximated equations. which is defined in the modelica model as a special annotation (__OpenModelica_ApproximatedEquation=true)




The list of Variable of interest are mandatory and the list of approximated equations are optional.
An example of modelica model with dataReconciliation problem is given below,

model Splitter1
  Real Q1(uncertain=Uncertainty.refine);
  Real Q2(uncertain=Uncertainty.refine);
  Real Q3(uncertain=Uncertainty.refine);
  parameter Real P01 =3;
  parameter Real P02 =1;
  parameter Real P03 =1;
  Real T1_P1, T1_P2, T2_P1, T2_P2, T3_P1, T3_P2;
  Real V_Q1, V_Q2, V_Q3;
  Real T1_Q1, T1_Q2, T2_Q1, T2_Q2, T3_Q1, T3_Q2;
  Real P, V_P1, V_P2, V_P3;
equation
  T1_P1 = P01;
  T2_P2 = P02;
  T3_P2 = P03;
  T1_P1 - T1_P2 = Q1^2 annotation (__OpenModelica_ApproximatedEquation=true);
  T2_P1 - T2_P2 = Q2^2 annotation (__OpenModelica_ApproximatedEquation=true);
  T3_P1 - T3_P2 = Q3^2 annotation (__OpenModelica_ApproximatedEquation=true);
  V_Q1 = V_Q2 + V_Q3;
  V_Q1 = T1_Q2;
  T1_Q2 = Q1;
  V_Q2 = T2_Q1;
  T2_Q1 = Q2;
  V_Q3 = T3_Q1;
  T3_Q1 = Q3;
  T1_P2 = V_P1;
  V_P1 = P;
  T2_P1 = V_P2;
  V_P2 = P;
  T3_P1 = V_P3;
  V_P3 = P;
  T1_Q1 = Q1;
  T2_Q2 = Q2;
  T3_Q2 = Q3;
end Splitter1;





After defining the modelica model, the users must define the dataReconciliation Input File.


DataReconciliationInputFile

The dataReconciliation Input file is a csv file with the the following headers,


	Variable Names - names of the Uncertainty variables, given in the modelica model


	Measured Value-x – Values given by the users


	HalfWidthConfidenceInterval – Values given by the users, which computes Covariance Matrix Sx


	xi – co-relation- coefficients


	xk - co-relation- coefficients


	rx_ik- value associated with co-relation coefficients




The first 3 column, Variable Names, Measured Value-x and HalfWidthConfidenceInterval are mandatory
The remaining column xi, xk, rx_ik are correlation-coefficients which are optional. An example csv file is given below


[image: _images/datareconciliationSplitter_Input.png]
Figure 108 An example DataReconciliationInput file(.csv)



The ordering of variables in the csv files should be defined in correct order on how it is declared in the model,
for example in the above example we have uncertain variables defined in the following order Q1,Q2 and Q3 and the same
order should be followed for the csv file in order to match the jacobian columns generated for dataReconciliation
Otherwise the dataReconciliation procedure computes wrong results.

Now we are ready to run the DataReconciliation procedure in OpenModelica.






DataReconcilation Support with Scripting Interface

The data Reconciliation procedure is possible to run through OpenModelica scripting interface(.mos file).
An example mos script (a.mos) is present below.

setCommandLineOptions("--preOptModules+=dataReconciliation");
getErrorString();
loadFile("DataReconciliationSimpleTests/package.mo");
getErrorString();
simulate(DataReconciliationTests.Splitter1,simflags="-reconcile -sx=./Splitter1_Sx.csv -eps=0.0023 -lv=LOG_JAC");
getErrorString();





To start the dataReconciliation procedure via command line interface, the users have to enable the dataReconciliation module which is done via
setCommandLineOptions("--preOptModules+=dataReconciliation") which runs the extraction algorithm for dataReconciliation procedure.
And finally the users must specify 3 runtime simulation flags given below


	reconcile – runtime flag which starts the dataReconciliation Procedure


	sx – csv file Input


	eps – small value given by users




The Flag -lv=LOG_JAC  is optional and can be used for debugging.

And finally run the mos script(a.mos) with omc

>> omc a.mos

The HTML Reports, the Csv files and the debugging log are generated in the current directory see DataReconcilation Results.




DataReconciliation Support in OMEdit

The DataReconciliation setup can be launched by,


	Selecting Simulation > Simulation Setup from the menu. (requires a model to be active in ModelWidget)


	Clicking on the Simulation Setup toolbar button. (requires a model to be active in ModelWidget)


	Right clicking the model from the Libraries Browser and choosing Simulation Setup.





TranslationFlag Tab

From the translationFlag tab, do the following,


	check the Enable dataReconciliation checkbox.





[image: _images/datareconciliation_translationFlag.png]
Figure 109 Setting DataReconciliation TraslationFlag






SimulationFlag Tab

From the SimulationFlag tab, do the following,


	check the DataReconciliation Algorithm for Constrained Equation checkbox.


	load the input file with dataReconciliation inputs, only csv file is accepted.


	fill in the Epsilon value (e.g) 0.001




And finally press the ok button to start the dataReconciliation procedure


[image: _images/datareconciliation_simulationFlag.png]
Figure 110 Setting DataReconciliation SimuationFlag






Generating the InputFile and Running the DataReconciliation

Generating an empty csv file with variable names makes it easy for the users to fill in the datas,
so that ordering of variables and names are not mismatched. This is an important step as variable ordering
should match with the jacobian columns generated for dataReconciliation procedure. The input file is
named as “modelname_Inputs.csv” which is generated in the current working directory of the model.
This step shall be done for the first time and the next time when running the dataReconciliation for the same model,
we can directly set the input file and run the DataReconciliation procedure.

This is done in 2 steps.


	Setting the TranslationFlag defined in TranslationFlag Tab. and press the Ok button.




And then from the plotting window variable browser, right click on the model and select the “re-simulate Setup” as shown below


[image: _images/datareconciliation_resimulate.png]
Figure 111 Select the re-simulate setup



Which opens the simulation set-up dialog window and select the simulation Flag tab defined in SimulationFlag Tab.
and load the csv file and fill in the epsilon value and press the “Ok” button to start the Data Reconciliation Procedure.






DataReconcilation Results

After the Data Reconciliation procedure is completed, the results are generated in the working directory.
The default working directory in OMEdit is set to local temp directory of the operating system.
The users can change the working directory of OMEdit by, Tools > Options > General > WorkingDirectory

A separate working directory is created in the working directory. The directory is named based on the modelName
and the result files are stored in that directory. Two result files are generated namely.


	HTML Report.


	CSV file




An Example of Result directory is given below,



[image: _images/datareconciliation_ResultDirectory.png]
Figure 112 Result Directory Structure







HTML Report

The html report is named with modelname.html. The Html report contains 3 section namely
1.      Overview
2.      Analysis and
3.      Results

The Overview section provides the general details of the model such as Modelicafile, ModelName,
ModelDirectory, InputFiles and Generated Date and Time of the Report.The Analysis section provides
information about the data Reconciliation procedure such as Number of Extracted equations in setC,
Number of variable to be Reconciled which are Variable of interest, Number of Iterations to Converge,
Final Converged Value ,Epsilon value provided by the users and Results of Global test.

The Results section provides the numerical values computed by the data Reconciliation algorithm. The table contains 8 columns namely,


	Variables to be Reconciled – names of the Uncertainty variables, given in the modelica model


	Initial Measured Values – numerical values given by the users


	Reconciled Values – Calculated values according to Data Reconciliation Procedure.


	Initial Uncertainty Values – Half Width confidence interval provides by the users, which is later used to compute the Covariance Matrix Sx.


	Reconciled Uncertainty Values – Calculated Values according to Data Reconciliation Procedure.


	Results of Local Tests – Calculated values according to Data Reconciliation Procedure


	Values of Local Tests – Calculated values according to Data Reconciliation Procedure


	Margin to correctness – Calculated values according to Data Reconciliation Procedure




A sample HTML Report generated for Splitter1.mo model is presented below.



[image: _images/datareconciliation_htmlreport.png]
Figure 113 HTML Report









Csv file

Along with the Html Report, an output csv file is also generated which mainly contains the Results section of the HTMl report in a csv format.
The csv file is named with modelname_Outputs.csv. An example output csv file is presented below.



[image: _images/datareconciliation_csv_report.png]
Figure 114 Output Csv file









Logging and Debugging

All the Computations of data Reconciliation procedure are logged into log file.
The log file is named as modelname_debug.log. For Detailed Debugging the flag LOG_JAC checkbox can be checked see SimulationFlag Tab.
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Frequently Asked Questions (FAQ)

Below are some frequently asked questions in three areas, with
associated answers.


OpenModelica General


	
	Q: OpenModelica does not read the MODELICAPATH environment variable,
	even though this is part of the Modelica Language Specification.







	
	A: Use the OPENMODELICALIBRARY environment variable instead. We have
	temporarily switched to this variable, in order not to interfere
with other Modelica tools which might be installed on the same
system. In the future, we might switch to a solution with a
settings file, that also allows the user to turn on the
MODELICAPATH functionality if desired.







	
	Q: How do I enter multi-line models into OMShell since it evaluates
	when typing the Enter/Return key?







	
	A: There are basically three methods: 1) load the model from a file
	using the pull-down menu or the loadModel command. 2) Enter the
model/function as one (possibly long) line. 3) Type in the model
in another editor, where using multiple lines is no problem, and
copy/paste the model into OMShell as one operation, then push
Enter. Another option is to use OMNotebook instead to enter and
evaluate models.












OMNotebook


	Q: OMNotebook hangs, what to do?


	
	A: It is probably waiting for the omc.exe (compiler) process. (Under
	windows): Kill the processes omc.exe, g++.exe (C-compiler),
as.exe (assembler), if present. If OMNotebook then asks whether
to restart OMC, answer yes. If not, kill the process
OMNotebook.exe and restart manually.







	
	Q: After a previous session, when starting OMNotebook again, I get a
	strange message.







	
	A: You probably quit the previous OpenModelica session in the wrong
	way, which left the process omc.exe running. Kill that process,
and try starting OMNotebook again.







	
	Q: I copy and paste a graphic figure from Word or some other
	application into OMNotebook, but the graphic does not appear.
What is wrong?







	
	A: OMNotebook supports the graphic picture formats supported by Qt 4,
	including the .png, .bmp (bitmap) formats, but not for example
the gif format. Try to convert your picture into one of the
supported formats, (e.g. in Word, first do paste as bitmap
format), and then copy the converted version into a text cell in
OMNotebook.







	
	Q: I select a cell, copy it (e.g. Ctrl-C), and try to paste it at
	another place in the notebook. However, this does not work.
Instead some other text that I earlier put on the clipboard is
pasted into the nearest text cell.







	
	A: The problem is wrong choice of cursor mode, which can be text
	insertion or cell insertion. If you click inside a cell, the
cursor become vertical, and OMNotebook expects you to paste text
inside the cell. To paste a cell, you must be in cell insertion
mode, i.e., click between two cells (or after a cell), you will
get a vertical line. Place the cursor carefully on that vertical
line until you see a small horizontal cursor. Then you should
past the cell.







	
	Q: I am trying to click in cells to place the vertical character
	cursor, but it does not seem to react.







	
	A: This seems to be a Qt feature. You have probably made a selection
	(e.g. for copying) in the output section of an evaluation cell.
This seems to block cursor position. Click again in the output
section to disable the selection. After that it will work
normally.







	
	Q: I have copied a text cell and start writing at the beginning of
	the cell. Strangely enough, the font becomes much smaller than it
should be.







	
	A: This seems to be a Qt feature. Keep some of the old text and start
	writing the new stuff inside the text, i.e., at least one
character position to the right. Afterwards, delete the old text
at the beginning of the cell.












OMDev - OpenModelica Development Environment


	
	Q: I get problems compiling and linking some files when using OMDev
	with the MINGW (Gnu) C compiler under Windows.







	
	A: You probably have some Logitech software installed. There is a
	known bug/incompatibility in Logitech products. For example, if
lvprcsrv.exe is running, kill it and/or prevent it to start again
at reboot; it does not do anything really useful, not needed for
operation of web cameras or mice.
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Major OpenModelica Releases

This Appendix lists the most important OpenModelica releases and a brief
description of their contents. Right now versions from 1.3.1 to 2.0.0 are described.


Release Notes for OpenModelica 2.0.0


OpenModelica Compiler (OMC)




Graphic Editor OMEdit




FMI Support




Other things
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Release Notes for OpenModelica 1.16.0


OpenModelica Compiler (OMC)




Graphic Editor OMEdit




FMI Support




Other things
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Release Notes for OpenModelica 1.15.0


OpenModelica Compiler (OMC)




Graphic Editor OMEdit




FMI Support




Other things
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Release Notes for OpenModelica 1.14.0


OpenModelica Compiler (OMC)

The most dramatic enhancement is the of the OpenModelica Compiler New
Frontend, which on the average gives a factor of 10-20 speed improvement
in the flattening phase of compilation. The new frontend is default in
this release, but a feature is implemented that allows the user to
switch to the old frontend if problems appear for a specific model The
speed of the OMEdit GUI has only slightly increased in this version,
since it is still dependent mostly on the old frontend. Further GUI
speed increases are available in the coming OpenModelica.1.15.0. About
200 issues have been fixed, including enhancements, compared to the
previous 1.13.2 release. The bug fixes are on trac.

OpenModelica Compiler New Frontend news: • Implementation of expandable
connectors completed, a rather large piece of work. • A number of
smaller enhancements and fixes • The New Frontend (NF)gives slightly
better simulation coverage on MSL 3.2.3 than the Old Frontend • The New
Frontend is on the average about 20 times faster on flattening. •
Remaining work is mainly on further bug fixing and testing the new
frontend for all other libraries, as well as more work on modifiers of
arrays in conjunction with non-expanded arrays. (The array modifiers
have now been implemented in 1.16.0 but not yet it 1.14.0 in order to
not delay the 1.14.0 release)




Graphic Editor OMEdit


	Drag and drop for the text layer. • Auto completion of class names,




components and annotations. • GUI for data reconciliation – a method for
increasing sensor data precision • Improved duplication functionality
for copying classes. • Better handling of Compiler flags. • Partly
completed: annotations for dynamic icon update. • Support for
connectorSizing annotation • Several bug fixes. You can find the list
here. • Docs:
https://openmodelica.org/doc/OpenModelicaUsersGuide/latest/omedit.html .
• Autocomplete annotations. • Support for Icon/Diagram map annotation •
Copy paste functionality • Reset OMEdit settings/options. • Array plots
update on re-simulation • Support for connectorSizing annotation. • Drag
and drop class names to text layer in OMEdit • OMPlot: Improved plotting
e.g., top and bottom margins for better view, snap to curve etc. • GUI
support for replaceable libraries is being tested in a separate branch
and will be made available in the coming 1.15.0 release.




OMC backend and run-time system


	A new more efficient and correct implementation of arrays and records.


	The FMI OMSimulator API calls are now also available in the OMC API




functions, e.g. for use from OMNotebook, Jupyter notebooks.


Backend new features


	Added possibility to generate analytic Jacobians for linear strong




components

``   * -Use flag LSanalyticJacobian to enable analytical Jacobian for linear loops. Default false.``


	Added output language options for linearization: matlab, python,




julia. • Available with
--linearizationDumpLanguage=modelica/matlab/python/julia. Default is
modelica.




Backend enhancements


	Unified Jacobian evaluation from DASSL and IDA integrators • Added




result check for linear solvers Lis, Klu, Total Pivot and Umfpack if a
residual function is available. • Improved debug dumping


``   * -d=bltdump (Index reduction information)``

``   * -d=initialization``

``   * -d=dumpLoops``




	Improved warning for iteration variables:





``   * Only warn about non-linear iteration variables with default start attribute.``

``   * Other variables have no influence on simulation at all.``




	Build instructions for OpenModelica on Windows Subsystem for Linux •




Improved Jacobian evaluation with translation flag
-d=symJacConstantSplit (requires --generateSymbolicJacobian) Generate
Jacobians with separated constant part to split equations that are
independent of the seed vector. These equations only need to be
evaluated only once per Jacobian evaluation.




Backend bugfixes


	Homotopy: Use simplified version only during initialization to avoid




errors during matching and differentiation. • Logging for Homotopy path
fixed so log can be loaded in OMEdit. • Support general function call
differentiation for equations in residual form. • Equations in residual
form don't fail during index reduction any more.






FMI Support

Bug fixes to FMI export, see below




Other things
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Release Notes for OpenModelica 1.13.0


	OMSimulator 2.0 – the second release of our efficient FMI Simulation




tool including a GUI for FMI Composition, co-simulation and
model-exchange simulation, and SSP standard support. - Model and library
encryption/decryption support. (Only for usage by OSMC member
organizations) - Improved OpenModelica DAEMode for efficient solution of
large Modelica models. - Julia scripting API to OpenModelica. - Basic
Matlab scripting API to OpenModelica. - OMSysIdent - parameter
estimation module for linear and non-linear parametric dynamic models. -
Interactive simulation and control of simulations with OPC-UA. -
PDEModelica1 - experimental support for one-dimensional PDEs in
Modelica. - Analytic directional derivatives for FMI export and
efficient calculation of multiple Jacobian columns – giving much faster
simulation for some models - Enhanced OMEdit – including fast multi-file
search. - Improved error messages and stability. - A version of the new
fast compiler frontend available for testing, can be enabled by a flag
Currently (December 10), simulates about 84% of MSL 3.2.2

Note: the replaceable GUI support has been moved to OpenModelica 1.14.0
and will be available in nightly builds.
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Release Notes for OpenModelica 1.12.0


	A new (stand-alone) FMI- and TLM-based simulation tool OMSimulator,
first version for connected FMUs, TLM objects, Simulink models (via
wrappers), Adams models (via wrappers), BEAST models (via wrappers),
Modelica models


	Graphic configuration editing of composite models consisting of FMUs


	Basic graphical editing support for state machines and transitions


	Faster lookup processing, making some libraries faster to browse and
compile


	Additional advanced visualization features for multibody animation


	Increased library coverage including significantly increased
verification coverage


	Increased tool interoperability by addition of the ZeroMQ
communications protocol


	Further enhanced OMPython including linearization, now also working
with Python 3


	Support for RedHat/Fedora binary builds of OpenModelica





OpenModelica Compiler (OMC)


	Faster lookup processing


	Initializing external objects together with parameters


	Handle exceptions in numeric solvers


	Support for higher-index discrete clock partitions


	Improved unit checking


	Improved initialization of start values


	Decreased compilation time of models with large size arrays


	New approach for homotopy-based initialization (still experimental)


	A bunch of fixes: Bugs, regressions, performance issues


	Improved Dynamic Tearing by adding constraints for the casual set


	Improved module wrapFunctionCalls with one-time evaluation of
Constant CSE-variables


	Added initOptModule for inlineHomotopy


	Added configuration flag tearingStrictness to influence solvability


	New methods for inline integration for continuous equations in
clocked partitions, now covering: ExplicitEuler, ImplicitEuler,
SemiImplicitEuler and ImplicitTrapezoid


	Complete implementation of synchronous features in C++ runtime


	Refactored linear solver of C++ runtime


	Improved Modelica_synchronous_cpp coverage


	New common linear solver module, optionally sparse, for the C++
runtime


	Coverage of most of the OpenHydraulics library


	Improved coverage of ThermoSysPro, IdealizedContact and Chemical
libraries


	Support of time events for cpp-simulation and enabled time events in
cpp-FMUs


	Global homotopy method for initialization


	Scripting API to compute accumulated errors (1-norm, 2-norm, max.
error) of 2 time series







Graphic Editor OMEdit


	Additional advanced visualization features for multibody animation
(transparency, textures, change colours by dialog)


	An HTML WYSIWYG Editor, e.g. useful for documentation


	Support for choices(checkBox=true) annotation.


	Support for loadSelector & saveSelector attribute of Dialog
annotation.


	Panning of icon/diagram view and plot window.


	AutoComplete feature in text editing for keywords, types, common
Modelica constructs


	Follow connector transformation from Diagram View to Icon View.


	Further stability improvements


	Improved performance for rendering some icons using the interactive
API


	Improved handling of parameters that cannot be evaluated in Icon
annotations


	Basic graphic editing support for state machines and transitions (not
yet support for showing state internals on diagram layer)


	Interactive state manipulation for FMU-based animations







FMI Support


	A new (stand-alone) FMI- and TLM-based simulation tool OMSimulator,
first version (a main deliverable of the OPENCPS project, significant
contributions and code donations from SKF)


	Graphic configuration editing of composite models consisting of FMUs


	Co-simulation/simulation of connected FMUs, TLM objects, Simulink
models (via wrappers), Adams models (via wrappers), BEAST models (via
wrappers), Modelica models.







Other things


	Increased OpenModelica tool interoperability by adding the ZeroMQ
communications protocol in addition to the previously available
Corba. This also enables Python 3 usage in OMPython on all platforms.


	Textual support through the OpenModelica API and graphical support in
OMEdit for generation of single or multiple requirement verification
scenarios


	VVDRlib – a small library for connecting requirements and models
together, with notions for mediators, scenarios, design alternatives


	Further enhanced OMPython including linearization, now also working
with Python 3.¨


	Jupyter notebooks also supported with OMPython and Python 3


	New enhanced library testing script
(libraries.openmodelica.org/branches).


	Addition of mutable reference data types in MetaModelica


	Support for RedHat/Fedora binary builds of OpenModelica


	Support for exporting the system of equations in GraphML (yEd) format
for debugging
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Release Notes for OpenModelica 1.11.0


	Dramatically improved compilation speed and performance, in
particular for large models.


	3D animation visualization of regular MSL MultiBody simulations and
for real-time FMUs.


	Better support for synchronous and state machine language elements,
now supports 90% of the clocked synchronous library.


	Several OMEdit improvements including folding of large annotations.


	64-bit OM on Windows further stabilized


	An updated OMDev (OpenModelica Development Environment), involving
msys2. This was needed for the shift to 64-bit on Windows.


	Integration of Sundials/IDA DAE solver with potentially large
increase of simulation performance for large models with sparse
structure.


	Improved library coverage.


	Parameter sensitivity analysis added to OMC.





OpenModelica Compiler (OMC)


	Real-time synchronization support by using simFlag -rt=1.0 (or some
other time scaling factor).


	A prototype implementation of OPC UA using an open source OPC UA
implementation [http://open62541.org]. The old OPC implementation
was not maintained and relied on a Windows-only proprietary OPC DA+UA
package. (At the moment, OPC is experimental and lacks documentation;
it only handles reading/writing Real/Boolean input/state variables.
It is planned for OMEdit to use OPC UA to re-implement interactive
simulations and plotting.)


	Dramatically improved compilation speed and dramatically reduced
memory requirements for very large models. In Nov 2015, the largest
power generation and transmission system model that OMC could handle
had 60000 equations and it took 700 seconds to generate the
simulation executable code; it now takes only 45 seconds to do so
with OMC 1.11.0, which can also handle a model 10 times bigger (600
000 equations) in less than 15 minutes and with less than 32 GB of
RAM. Simulation times are comparable to domain-specific simulation
tools. See for example
ScalableTestSuite [https://test.openmodelica.org/libraries/ScalableTestSuite_Experimental/BuildModelRecursive.html]
for some of the improvements.


	Improved library coverage


	Better support for synchronous and state machine language elements,
now simulates 90% of the clocked synchronous library.


	Enhanced Cpp runtime to support the PowerSystems library.


	Integration of Sundials/IDA solver as an alternative to DASSL.


	A DAEMode solver mode was added, which allows to use the sparse IDA
solver to handle the DAEs directly. This can lead to substantially
faster simulation on large systems with sparse structure, compared to
the traditional approach.


	The direct sparse solvers KLU and SuperLU have been added, with
benefits for models with large algebraic loops.


	Multi-parameter sensitivity analysis added to OMC.


	Progress on more efficient inline function mechanism.


	Stabilized 64-bit Windows support.


	Performance improvement of parameter evaluation.


	Enhanced tearing support, with prefer iteration variables and
user-defined tearing.


	Support for external object aliases in connectors and equations (a
non-standard Modelica extension).


	Code generation directly to file (saves maximum memory used). #3356


	Code generation in parallel is enabled since #3356 (controlled by omc
flag `-n`). This improves performance since generating code directly
to file avoid memory allocation.


	Allowing mixed dense and sparse linear solvers in the generated
simulation (chosen depending on simflags `-ls` (dense solver),
`-lss` (sparse solver), `-lssMaxDensity` and `-lssMinSize`).







Graphic Editor OMEdit


	Significantly faster browsing of most libraries.


	Several GUI improvements including folding of multi-line annotations.


	Further improved code formatting preservation during edits.


	Support for all simulation logging flags.


	Select and export variables after simulation.


	Support for Byte Order
Mark [https://en.wikipedia.org/wiki/Byte_order_mark]. Added
support enables other tools to correctly read the files written by
OMEdit.


	Save files with line endings according to OS (Windows (CRLF), Unix
(LF)).


	Added OMEdit support for FMU cross compilation. This makes it
possible to launch OMEdit on a remote or virtual Linux machine using
a Windows X server and export an FMU with Windows binaries.


	Support of DisplayUnit and unit conversion.


	Fixed automatic save.


	Initial support for DynamicSelect in model diagrams (texts and
visible attribute after simulation, no expressions yet).


	An HTML documentation editor (not WYSIWYG; that editor will be
available in the subsequent release).


	Improved logging in OMEdit of structured messages and standard output
streams for simulations.







FMI Support


	Cross compilation of C++ FMU export. Compared to the C runtime, the
C++ cross compilation covers the whole runtime for model exchange.


	Improved Newton solver for C++ FMUs (scaling and step size control).







Other things


	3D animation visualization of regular MSL MultiBody simulations and
for real-time FMUs.


	An updated OMDev (OpenModelica Development Environment), involving
msys2. This was needed for the shift to 64-bit on Windows.


	OMWebbook [http://omwebbook.openmodelica.org/], a web version of
OMNotebook online. Also, a script is available to convert an
OMNotebook to an OMWebbook.


	A Jupyter notebook Modelica mode, available in OpenModelica.
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Release Notes for OpenModelica 1.10.0

The most important enhancements in the OpenModelica 1.10.0 release:


OpenModelica Compiler (OMC)

New features:


	Real-time synchronization support by using simFlag -rt=1.0 (or some




other time scaling factor). - A prototype implementation of OPC UA using
an open source OPC UA implementation [http://open62541.org]. The old
OPC implementation was not maintained and relied on a Windows-only
proprietary OPC DA+UA package. (At the moment, OPC is experimental and
lacks documentation; it only handles reading/writing Real/Boolean
input/state variables. It is planned for OMEdit to use OPC UA to
re-implement interactive simulations and plotting.)

Performance enhancements:


	Code generation directly to file (saves maximum memory used). #3356 -




Code generation in parallel enabled since #3356 allows this without
allocating too much memory (controlled by omc flag `-n`). - Various
scalability enhancements, allowing the compiler to handle hundreds of
thousands of equations. See for example
ScalableTestSuite [https://test.openmodelica.org/libraries/ScalableTestSuite_Experimental/BuildModelRecursive.html]
for some of the improvements. - Better defaults for handling tearing
(OMC flags `--maxSizeLinearTearing` and `--maxSizeNonlinearTearing`).
- Allowing mixed dense and sparse linear solvers in the generated
simulation (chosen depending on simflags `-ls` (dense solver),
`-lss` (sparse solver), `-lssMaxDensity` and `-lssMinSize`).




Graphic Editor OMEdit




OpenModelica Notebook (OMNotebook)




Optimization




FMI Support




OpenModelica Development Environment (OMDev)






Release Notes for OpenModelica 1.9.4

OpenModelica v1.9.4 was released 2016-03-09. These notes cover the
v1.9.4 release and its subsequent bug-fix releases (now up to 1.9.7).


OpenModelica Compiler (OMC)


	Improved simulation speed for many models. simulation speed went up
for 80% of the models. The compiler frontend became faster for almost
all models, average about 40% faster.


	Initial support for synchronous models with clocked equations as
defined in the Modelica 3.3 standard


	Support for homotopy operator







Graphic Editor OMEdit


	Undo/Redo support.


	Preserving text formatting, including indentation and whitespace.
This is especially important for diff/merge with several
collaborating developers possibly using several different Modelica
tools.


	Better support for inherited classes.


	Allow simulating models using visual studio compiler.


	Support for saving Modelica package in a folder structure.


	Allow reordering of classes inside a package.


	Highlight matching parentheses in text view.


	When copying the text retain the text highlighting and formatting.


	Support for global head definition in the documentation by using
`__OpenModelica_infoHeader` annotation.


	Support for expandable connectors.


	Support for uses annotation.







FMI Support


	Full FMI 2.0 co-simulation support now available


	Upgrade Cpp runtime from C++03 to C++11 standard, minimizing external
link dependencies. Exported FMUs don't depend on additional libraries
such as boost anymore


	FMI 2.0 is broken for some models in 1.9.4. Upgrading to 1.9.6 is
advised.









Release Notes for OpenModelica 1.9.3

The most important enhancements in the OpenModelica 1.9.3 release:


	Enhanced collaborative development and testing of OpenModelica by
moving to the GIT-hub framework for versioning and parallel
development.


	More accessible and up-to-date automatically generated documentation
provided in both
html [https://www.openmodelica.org/doc/OpenModelicaUsersGuide/latest/]
and
pdf [https://openmodelica.org/doc/OpenModelicaUsersGuide/OpenModelicaUsersGuide-latest.pdf].


	Further improved simulation speed and coverage of several libraries.


	OMEdit graphic connection editor improvements.


	OMNotebook improvements.





OpenModelica Compiler (OMC)

This release mainly includes improvements of the OpenModelica Compiler
(OMC), including, but not restricted to the following:


	Further improved simulation speed and coverage for several libraries.


	Faster generated code for functions involving arrays, factor 2
speedup for many power generation models.


	Better initialization.


	An implicit inline Euler solver available.


	Code generation to enable vectorization of for-loops.


	Improved non-linear, linear and mixed system solving.


	Cross-compilation for the ARMhf architecture.


	A prototype state machine implementation.


	Improved performance and stability of the C++ runtime option.


	More accessible and up-to-date automatically generated documentation
provided in both html and .pdf.







Graphic Editor OMEdit

There are several improvements to the OpenModelica graphic connection
editor OMEdit:


	Support for uses annotations.


	Support for declaring components as vectors.


	Faster messages browser with clickable error messages.


	Support for managing the stacking order of graphical shapes.


	Several improvements to the plot tool and text editor in OMEdit.







OpenModelica Notebook (OMNotebook)

Several improvements:


	Support for moving cells from one place to another in a notebook.


	A button for evaluation of whole notebooks.


	A new cell type called Latex cells, supporting Latex formatted input
that provides mathematical typesetting of formulae when evaluated.







Optimization

Several improvements of the Dynamic Optimization module with
collocation, using Ipopt:


	Better performance due to smart treatment of algebraic loops for
optimization.


	Improved formulation of optimization problems with an annotation
approach which also allows graphical problem formulation.


	Proper handling of constraints at final time.







FMI Support

Further improved FMI 2.0 co-simulation support.




OpenModelica Development Environment (OMDev)

A big change: version handling and parallel development has been
improved by moving from SVN to GIThub. This makes it easier for each
developer to test his/her fixes and enhancements before committing the
code. Automatic mirroring of all code is still performed to the
OpenModelica SVN site.






Release Notes for OpenModelica 1.9.2

The OpenModelica 1.9.2 Beta release is available now, January 31, 2015.
Please try it and give feedback! The final release is planned within 1-2
weeks after some more testing. The most important enhancements in the
OpenModelica 1.9.2 release:


	The OpenModelica compiler has moved to a new development and release
platform: the bootstrapped OpenModelica compiler. This gives
advantages in terms of better programmability, maintenance,
debugging, modularity and current/future performance increases.


	The OpenModelica graphic connection editor OMEdit has become 3-5
times faster due to faster communication with the OpenModelica
compiler linked as a DLL. This was made possible by moving to the
bootstrapped compiler.


	Further improved simulation coverage for a number of libraries.


	OMEdit graphic connection editor improvements





OpenModelica Compiler (OMC)

This release mainly includes improvements of the OpenModelica Compiler
(OMC), including, but not restricted to the following:


	The OpenModelica compiler has moved to a new development and release
platform: the bootstrapped OpenModelica compiler. This gives
advantages in terms of better programmability, maintenance,
debugging, modularity and current/future performance increases.


	Further improved simulation coverage for a number of libraries
compared to 1.9.1. For example:


	MSL 3.2.1 100% compilation, 97% simulation (3% increase)


	MSL Trunk 99% compilation (1% increase), 93% simulation (3%
increase)


	ModelicaTest 3.2.1 99% compilation (2% increase), 95% simulation
(6% increase)


	ThermoSysPro 100% compilation, 80% simulation (17% increase)


	ThermoPower 97% compilation (5% increase), 85% simulation (5%
increase)


	Buildings 80% compilation (1% increase), 73% simulation (1%
increase)






	Further enhanced OMC compiler front-end coverage, scalability, speed
and memory.


	Better initialization.


	Improved tearing.


	Improved non-linear, linear and mixed system solving.


	Common subexpression elimination support - drastically increases
performance of some models.







Graphic Editor OMEdit


	The OpenModelica graphic connection editor OMEdit has become 3-5
times faster due to faster communication with the OpenModelica
compiler linked as a DLL. This was made possible by moving to the
bootstrapped compiler.


	Enhanced simulation setup window in OMEdit, which among other things
include better support for integration methods and dassl options.


	Support for running multiple simultaneous simulation.


	Improved handling of modifiers.


	Re-simulate with changed options, including history support and
re-simulating with previous options possibly edited.


	More user friendly user interface by improved connection line
drawing, added snap to grid for icons and conversion of icons from
PNG to SVG, and some additional fixes.







Optimization

Some smaller improvements of the Dynamic Optimization module with
collocation, using Ipopt.




FMI Support

Further improved for FMI 2.0 model exchange import and export, now
compliant according to the FMI compliance tests. FMI 1.0 support has
been further improved.






Release Notes for OpenModelica 1.9.1

The most important enhancements in the OpenModelica 1.9.1 release:


	Improved library support.


	Further enhanced OMC compiler front-end coverage and scalability


	Significant improved simulation support for libraries using Fluid and
Media.


	Dynamic model debugger for equation-based models integrated with
OMEdit.


	Dynamic algorithm model debugger with OMEdit; including support for
MetaModelica when using the bootstrapped compiler.




New features: Dynamic debugger for equation-based models; Dynamic
Optimization with collocation built into OpenModelica, performance
analyzer integrated with the equation model debugger.


OpenModelica Compiler (OMC)

This release mainly includes improvements of the OpenModelica Compiler
(OMC), including, but not restricted to the following:


	Further improved OMC model compiler support for a number of libraries
including MSL 3.2.1, ModelicaTest 3.2.1, PetriNet, Buildings,
PowerSystems, OpenHydraulics, ThermoPower, and ThermoSysPro.


	Further enhanced OMC compiler front-end coverage, scalability, speed
and memory.


	Better coverage of Modelica libraries using Fluid and Media.


	Automatic differentiation of algorithms and functions.


	Improved testing facilities and library coverage reporting.


	Improved model compilation speed by compiling model parts in parallel
(bootstrapped compiler).


	Support for running model simulations in a web browser.


	New faster initialization that handles over-determined systems,
under-determined systems, or both.


	Compiler back-end partly redesigned for improved scalability and
better modularity.


	Better tearing support.


	The first run-time Modelica equation-based model debugger, not
available in any other Modelica tool, integrated with OMEdit.


	Enhanced performance profiler integrated with the debugger.


	Improved parallelization prototype with several parallelization
strategies, task merging and duplication, shorter critical paths,
several scheduling strategies.


	Some support for general solving of mixed systems of equations.


	Better error messages.


	Improved bootstrapped OpenModelica compiler.


	Better handling of array subscripts and dimensions.


	Improved support for reduction functions and operators.


	Better support for partial functions.


	Better support for function tail recursion, which reduces memory
usage.


	Partial function evaluation in the back-end to improve solving
singular systems.


	Better handling of events/zero crossings.


	Support for colored Jacobians.


	New differentiation package that can handle a much larger number of
expressions.


	Support for sparse solvers.


	Better handling of asserts.


	Improved array and matrix support.


	Improved overloaded operators support.


	Improved handling of overconstrained connection graphs.


	Better support for the cardinality operator.


	Parallel compilation of generated code for speeding up compilation.


	Split of model files into several for better compilation scalability.


	Default linear tearing.


	Support for impure functions.


	Better compilation flag documentation.


	Better automatic generation of documentation.


	Better support for calling functions via instance.


	New text template based unparsing for DAE, Absyn, SCode, TaskGraphs,
etc.


	Better support for external objects (#2724, reject non-constructor
functions returning external objects)


	Improved C++ runtime.


	Improved testing facilities.


	New unit checking implementation.


	Support for model rewriting expressions via rewriting rules in an
external file.


	Reject more bad code (r19986, consider records with different
components type-incompatible)







OpenModelica Connection Editor (OMEdit)


	Convenient editing of model parameter values and re-simulation
without recompilation after parameter changes.


	Improved plotting.


	Better handling of flags/units/resources/crashes.


	Run-time Modelica equation-based model debugger that provides both
dynamic run-time debugging and debugging of symbolic transformations.


	Run-time Modelica algorithmic code debugger; also MetaModelica
debugger with the bootstrapped OpenModelica compiler.







OMPython

The interface was changed to version 2.0, which uses one object for each
OpenModelica instance you want active. It also features a new and
improved parser that returns easier to use datatypes like maps and
lists.




Optimization

A builtin integrated Dynamic Optimization module with collocation, using
Ipopt, is now available.




FMI Support

Support for FMI 2.0 model exchange import and export has been added. FMI
1.0 support has been further improved.






Release Notes for OpenModelica 1.9.0

This is the summary description of changes to OpenModelica from 1.8.1 to
1.9.0, released 2013-10-09. This release mainly includes improvements of
the OpenModelica Compiler (OMC), including, but not restricted to the
following:


OpenModelica Compiler (OMC)

This release mainly includes bug fixes and improvements of the
OpenModelica Compiler (OMC), including, but not restricted to the
following:


	A more stable and complete OMC model compiler. The 1.9.0 final
version simulates many more models than the previous 1.8.1 version
and OpenModelica 1.9.0 beta versions.


	Much better simulation support for MSL 3.2.1, now 270 out of 274
example models compile (98%) and 245 (89%) simulate, compared to 30%
simulating in the 1.9.0 beta1 release.


	Much better simulation for the ModelicaTest 3.2.1 library, now 401
out of 428 models build (93%) and 364 simulate (85%), compared to 32%
in November 2012.


	Better simulation support for several other libraries, e.g. more than
twenty examples simulate from ThermoSysPro, and all but one model
from PlanarMechanics simulate.


	Improved tearing algorithm for the compiler backend. Tearing is by
default used.


	Much faster matching and dynamic state selection algorithms for the
compiler backend.


	New index reduction algorithm implementation.


	New default initialization method that symbolically solves the
initialization problem much faster and more accurately. This is the
first version that in general initialize hybrid models correctly.


	Better class loading from files. The package.order file is now
respected and the file structure is more thoroughly examined (#1764).


	It is now possible to translate the error messages in the omc kernel
(#1767).


	FMI Support. FMI co-simulation with OpenModelica as master. Improved




FMI Import and export for model exchange. Most of FMI 2.0 is now also
supported.


	Checking (when possible) that variables have been assigned to before
they are used in algorithmic code (#1776).


	Full version of Python scripting.


	3D graphics visualization using the Modelica3D library.


	The PySimulator package from DLR for additional analysis is
integrated with OpenModelica (see Modelica2012
paper [http://dx.doi.org/10.3384/ecp12076537]), and included in
the OpenModelica distribution (Windows only).


	Prototype support for uncertainty computations, special feature
enabled by special flag.


	Parallel algorithmic Modelica support (ParModelica) for efficient
portable parallel algorithmic programming based on the OpenCL
standard, for CPUs and GPUs.


	Support for optimization of semiLinear according to MSL 3.3 chapter
3.7.2.5 semiLinear (r12657,r12658).


	The compiler is now fully bootstrapped and can compile itself using a
modest amount of heap and stack space (less than the RML-based
compiler, which is still the default).


	Some old debug-flags were removed. Others were renamed. Debug flags
can now be enabled by default.


	Removed old unused simulation flags noClean and storeInTemp (r15927).


	Many stack overflow issues were resolved.


	Dynamic Optimization with OpenModelica. Dynamic optimization with XML
export to the CasADi package is now integrated with OpenModelica.
Moreover, a native integrated Dynamic Optimization prototype using
Ipopt is now in the OpenModelica release, but currently needs a
special flag to be turned on since it needs more testing and
refinement before being generally made available.







OpenModelica Notebook (OMNotebook)


	A `shortOutput` option has been introduced in the simulate command




for less verbose output. The DrModelica interactive document has been
updated and the models tested. Almost all models now simulate with
OpenModelica.




OpenModelica Eclipse Plug-in (MDT)


	Enhanced debugger for algorithmic Modelica code, supporting both




standard Modelica algorithmic code called from simulation models, and
MetaModelica code.




OpenModelica Development Environment (OMDev)


	Migration of version handling and configuration management from




CodeBeamer to Trac.




Graphic Editor OMEdit


	General GUI: backward and forward navigation support in Documentation
view, enhanced parameters window with support for Dialog annotation.
Most of the images are converted from raster to vector graphics i.e
PNG to SVG.


	Libraries Browser: better loading of libraries, library tree can now
show protected classes, show library items class names as middle
ellipses if the class name text is larger, more options via the right
click menu for quick usage.


	ModelWidget: add the partial class as a replaceable component, look
for the default component prefixes and name when adding the
component.


	GraphicsView: coordinate system manipulation for icon and diagram
layers. Show red box for models that do not exist. Show default
graphical annotation for the components that doesn't have any
graphical annotations. Better resizing of the components. Properties
dialog for primitive shapes i.e Line, Polygon, Rectangle, Ellipse,
Text and Bitmap.


	File Opening: open one or more Modelica files, allow users to select
the encoding while opening the file, convert files to UTF-8 encoding,
allow users to open the OpenModelica result files.


	Variables Browser: find variables in the variables browser, sorting
in the variables browser.


	Plot Window: clear all curves of the plot window, preserve the old
selected variable and update its value with the new simulation
result.


	Simulation: support for all the simulation flags, read the simulation
output as soon as is is obtained, output window for simulations,
options to set matching algorithm and index reduction method for
simulation. Display all the files generated during the simulation is
now supported. Options to set OMC command line flags.


	Options: options for loading libraries via loadModel and loadFile
each time GUI starts, save the last open file directory location,
options for setting line wrap mode and syntax highlighting.


	Modelica Text Editor: preserving user customizations, new search &
replace functionality, support for comment/uncomment.


	Notifications: show custom dialogs to users allowing them to choose
whether they want to see this dialog again or not.


	Model Creation: Better support for creating new classes. Easy
creation of extends classes or nested classes.


	Messages Widget: Multi line error messages are now supported.


	Crash Detection: The GUI now automatically detects the crash and
writes a stack trace file. The user is given an option to send a
crash report along with the stack trace file and few other useful
files via email.


	Autosave: OMEdit saves the currently edited model regularly, in order
to avoid losing edits after GUI or compiler crash. The save interval
can be set in the Options menu.







ModelicaML


	Enhanced ModelicaML version with support for value bindings in




requirements-driven modeling available for the latest Eclipse and
Papyrus versions. GUI specific adaptations. Automated model composition
workflows (used for model-based design verification against
requirements) are modularized and have improved in terms of performance.






Release Notes for OpenModelica 1.8.1

The OpenModelica 1.8.1 release has a faster and more stable OMC model
compiler. It flattens and simulates more models than the previous 1.8.0
version. Significant flattening speedup of the compiler has been
achieved for certain large models. It also contains a New ModelicaML
version with support for value bindings in requirements-driven modeling
and importing Modelica library models into ModelicaML models. A beta
version of the new OpenModelica Python scripting is also included. The
release was made on 2012-04-03 (r11645).


OpenModelica Compiler (OMC)

This release includes bug fixes and improvements of the flattening
frontend part of the OpenModelica Compiler (OMC) and several
improvements of the backend, including, but not restricted to:


	A faster and more stable OMC model compiler. The 1.8.1 version
flattens and simulates more models than the previous 1.8.0 version.


	Support for operator overloading (except Complex numbers).


	New ModelicaML version with support for value bindings in
requirements-driven modeling and importing Modelica library models
into ModelicaML models.


	Faster plotting in OMNotebook. The feature sendData has been removed
from OpenModelica. As a result, the kernel no longer depends on Qt.
The plot3() family of functions have now replaced to plot(), which in
turn have been removed. The non-standard visualize() command has been
removed in favour of more recent alternatives.


	Store OpenModelica documentation as Modelica Documentation
annotations.


	Re-implementation of the simulation runtime using C instead of C++
(this was needed to export FMI source-based packages).


	FMI import/export bug fixes.


	Changed the internal representation of various structures to share
more memory. This significantly improved the performance for very
large models that use records.


	Faster model flattening, Improved simulation, some graphical API bug
fixes.


	More robust and general initialization, but currently time-consuming.


	New initialization flags to omc and options to simulate(), to control
whether fast or robust initialization is selected, or initialization
from an external (.mat) data file.


	New options to API calls list, loadFile, and more.


	Enforce the restriction that input arguments of functions may not be
assigned to.


	Improved the scripting environment. cl :=
$TypeName(Modelica);getClassComment(cl); now works as expected. As
does looping over lists of typenames and using reduction expressions.


	Beta version of Python scripting.


	Various bugfixes.


	NOTE: interactive simulation is not operational in this release. It
will be put back again in the near future, first available as a
nightly build. It is also available in the previous 1.8.0 release.







OpenModelica Notebook (OMNotebook)


	Faster and more stable plottning.







OpenModelica Shell (OMShell)


	No changes.







OpenModelica Eclipse Plug-in (MDT)


	Small fixes and improvements.







OpenModelica Development Environment (OMDev)


	No changes.







Graphic Editor OMEdit


	Bug fixes.







OMOptim Optimization Subsystem


	Bug fixes.







FMI Support


	Bug fixes.









OpenModelica 1.8.0, November 2011

The OpenModelica 1.8.0 release contains OMC flattening improvements for
the Media library - it now flattens the whole library and simulates
about 20% of its example models. Moreover, about half of the Fluid
library models also flatten. This release also includes two new tool
functionalities - the FMI for model exchange import and export, and a
new efficient Eclipse-based debugger for Modelica/MetaModelica
algorithmic code.


OpenModelica Compiler (OMC)

This release includes bug fixes and improvements of the flattening
frontend part of the OpenModelica Compiler (OMC) and several
improvements of the backend, including, but not restricted to: A faster
and more stable OMC model compiler. The 1.8.0 version flattens and
simulates more models than the previous 1.7.0 version.


	Flattening of the whole Media library, and about half of the Fluid




library. Simulation of approximately 20% of the Media library example
models. - Functional Mockup Interface FMI 1.0 for model exchange, export
and import, for the Windows platform. - Bug fixes in the OpenModelica
graphical model connection editor OMEdit, supporting easy-to-use
graphical drag-and-drop modeling and MSL 3.1. - Bug fixes in the OMOptim
optimization subsystem. - Beta version of compiler support for a new
Eclipse-based very efficient algorithmic code debugger for functions in
MetaModelica/Modelica, available in the development environment when
using the bootstrapped OpenModelica compiler. - Improvements in
initialization of simulations. - Improved index reduction with dynamic
state selection, which improves simulation. - Better error messages from
several parts of the compiler, including a new API call for giving
better error messages. - Automatic partitioning of equation systems and
multi-core parallel simulation of independent parts based on the
shared-memory OpenMP model. This version is a preliminary experimental
version without load balancing.




OpenModelica Notebook (OMNotebook)

No changes.




OpenModelica Shell (OMShell)

Small performance improvements.




OpenModelica Eclipse Plug-in (MDT)

Small fixes and improvements. MDT now also includes a beta version of a
new Eclipse-based very efficient algorithmic code debugger for functions
in MetaModelica/Modelica.




OpenModelica Development Environment (OMDev)

Third party binaries, including Qt libraries and executable Qt clients,
are now part of the OMDev package. Also, now uses GCC 4.4.0 instead of
the earlier GCC 3.4.5.




Graphic Editor OMEdit

Bug fixes. Access to FMI Import/Export through a pull-down menu.
Improved configuration of library loading. A function to go to a
specific line number. A button to cancel an on-going simulation. Support
for some updated OMC API calls.




New OMOptim Optimization Subsystem

Bug fixes, especially in the Linux version.




FMI Support

The Functional Mockup Interface FMI 1.0 for model exchange import and
export is supported by this release. The functionality is accessible via
API calls as well as via pull-down menu commands in OMEdit.






OpenModelica 1.7.0, April 2011

The OpenModelica 1.7.0 release contains OMC flattening improvements for
the Media library, better and faster event handling and simulation, and
fast MetaModelica support in the compiler, enabling it to compiler
itself. This release also includes two interesting new tools – the
OMOptim optimization subsystem, and a new performance profiler for
equation-based Modelica models.


OpenModelica Compiler (OMC)

This release includes bug fixes and performance improvements of the
flattening frontend part of the OpenModelica Compiler (OMC) and several
improvements of the backend, including, but not restricted to:


	Flattening of the whole Modelica Standard Library 3.1 (MSL 3.1),




except Media and Fluid. - Progress in supporting the Media library, some
models now flatten. - Much faster simulation of many models through more
efficient handling of alias variables, binary output format, and faster
event handling. - Faster and more stable simulation through new improved
event handling, which is now default. - Simulation result storage in
binary .mat files, and plotting from such files. - Support for Unicode
characters in quoted Modelica identifiers, including Japanese and
Chinese. - Preliminary MetaModelica 2.0 support. (use
setCommandLineOptions({"+g=MetaModelica"}) ). Execution is as fast as
MetaModelica 1.0, except for garbage collection. - Preliminary
bootstrapped OpenModelica compiler: OMC now compiles itself, and the
bootstrapped compiler passes the test suite. A garbage collector is
still missing. - Many bug fixes.




OpenModelica Notebook (OMNotebook)

Improved much faster and more stable 2D plotting through the new OMPlot
module. Plotting from binary .mat files. Better integration between
OMEdit and OMNotebook, copy/paste between them.




OpenModelica Shell (OMShell)

Same as previously, except the improved 2D plotting through OMPlot.




Graphic Editor OMEdit

Several enhancements of OMEdit are included in this release. Support for
Icon editing is now available. There is also an improved much faster 2D
plotting through the new OMPlot module. Better integration between
OMEdit and OMNotebook, with copy/paste between them. Interactive on-line
simulation is available in an easy-to-use way.




New OMOptim Optimization Subsystem

A new optimization subsystem called OMOptim has been added to
OpenModelica. Currently, parameter optimization using genetic algorithms
is supported in this version 0.9. Pareto front optimization is also
supported.




New Performance Profiler

A new, low overhead, performance profiler for Modelica models has been
developed.






OpenModelica 1.6.0, November 2010

The OpenModelica 1.6.0 release primarily contains flattening,
simulation, and performance improvements regarding Modelica Standard
Library 3.1 support, but also has an interesting new tool – the OMEdit
graphic connection editor, and a new educational material called
DrControl, and an improved ModelicaML UML/Modelica profile with better
support for modeling and requirement handling.


OpenModelica Compiler (OMC)

This release includes bug fix and performance improvemetns of the
flattening frontend part of the OpenModelica Compiler (OMC) and some
improvements of the backend, including, but not restricted to:


	Flattening of the whole Modelica Standard Library 3.1 (MSL 3.1),




except Media and Fluid. - Improved flattening speed of a factor of 5-20
compared to OpenModelica 1.5 for a number of models, especially in the
MultiBody library. - Reduced memory consumption by the OpenModelica
compiler frontend, for certain large models a reduction of a factor 50.
- Reorganized, more modular OpenModelica compiler backend, can now
handle approximately 30 000 equations, compared to previously
approximately 10 000 equations. - Better error messages from the
compiler, especially regarding functions. - Improved simulation coverage
of MSL 3.1. Many models that did not simulate before are now simulating.
However, there are still many models in certain sublibraries that do not
simulate. - Progress in supporting the Media library, but simulation is
not yet possible. - Improved support for enumerations, both in the
frontend and the backend. - Implementation of stream connectors. -
Support for linearization through symbolic Jacobians. - Many bug fixes.




OpenModelica Notebook (OMNotebook)

A new DrControl electronic notebook for teaching control and modeling
with Modelica.




OpenModelica Development Environment (OMDev)

Several enhancements. Support for match-expressions in addition to
matchcontinue. Support for real if-then-else. Support for if-then
without else-branches. Modelica Development Tooling 0.7.7 with small
improvements such as more settings, improved error detection in console,
etc.




New Graphic Editor OMEdit

A new improved open source graphic model connection editor called
OMEdit, supporting 3.1 graphical annotations, which makes it possible to
move models back and forth to other tools without problems. The editor
has been implemented by students at Linköping University and is based on
the C++ Qt library.






OpenModelica 1.5.0, July 2010

This OpenModelica 1.5 release has major improvements in the OpenModelica
compiler frontend and some in the backend. A major improvement of this
release is full flattening support for the MultiBody library as well as
limited simulation support for MultiBody. Interesting new facilities are
the interactive simulation and the integrated UML-Modelica modeling with
ModelicaML. Approximately 4 person-years of additional effort have been
invested in the compiler compared to the 1.4.5 version, e.g., in order
to have a more complete coverage of Modelica 3.0, mainly focusing on
improved flattening in the compiler frontend.


OpenModelica Compiler (OMC)

This release includes major improvements of the flattening frontend part
of the OpenModelica Compiler (OMC) and some improvements of the backend,
including, but not restricted to:


	Improved flattening speed of at least a factor of 10 or more compared




to the 1.4.5 release, primarily for larger models with inner-outer, but
also speedup for other models, e.g. the robot model flattens in
approximately 2 seconds. - Flattening of all MultiBody models, including
all elementary models, breaking connection graphs, world object, etc.
Moreover, simulation is now possible for at least five MultiBody models:
Pendulum, DoublePendulum, InitSpringConstant, World,
PointGravityWithPointMasses. - Progress in supporting the Media library,
but simulation is not yet possible. - Support for enumerations, both in
the frontend and the backend. - Support for expandable connectors. -
Support for the inline and late inline annotations in functions. -
Complete support for record constructors, also for records containing
other records. - Full support for iterators, including nested ones. -
Support for inferred iterator and for-loop ranges. - Support for the
function derivative annotation. - Prototype of interactive simulation. -
Prototype of integrated UML-Modelica modeling and simulation with
ModelicaML. - A new bidirectional external Java interface for calling
external Java functions, or for calling Modelica functions from Java. -
Complete implementation of replaceable model extends. - Fixed problems
involving arrays of unknown dimensions. - Limited support for tearing. -
Improved error handling at division by zero. - Support for Modelica 3.1
annotations. - Support for all MetaModelica language constructs inside
OpenModelica. - OpenModelica works also under 64-bit Linux and Mac
64-bit OSX. - Parallel builds and running test suites in parallel on
multi-core platforms. - New OpenModelica text template language for
easier implementation of code generators, XML generators, etc. - New
OpenModelica code generators to C and C# using the text template
language. - Faster simulation result data file output optionally as
comma-separated values. - Many bug fixes.

It is now possible to graphically edit models using parts from the
Modelica Standard Library 3.1, since the simForge graphical editor (from
Politecnico di Milano) that is used together with OpenModelica has been
updated to version 0.9.0 with a important new functionality, including
support for Modelica 3.1 and 3.0 annotations. The 1.6 and 2.2.1 Modelica
graphical annotation versions are still supported.




OpenModelica Notebook (OMNotebook)

Improvements in platform availability.


	Support for 64-bit Linux. - Support for Windows 7. - Better support




for MacOS, including 64-bit OSX.






OpenModelica 1.4.5, January 2009

This release has several improvements, especially platform availability,
less compiler memory usage, and supporting more aspects of Modelica 3.0.


OpenModelica Compiler (OMC)

This release includes small improvements and some bugfixes of the
OpenModelica Compiler (OMC):


	Less memory consumption and better memory management over time. This




also includes a better API supporting automatic memory management when
calling C functions from within the compiler. - Modelica 3.0 parsing
support. - Export of DAE to XML and MATLAB. - Support for several
platforms Linux, MacOS, Windows (2000, Xp, Vista). - Support for record
and strings as function arguments. - Many bug fixes. - (Not part of
OMC): Additional free graphic editor SimForge can be used with
OpenModelica.




OpenModelica Notebook (OMNotebook)

A number of improvements, primarily in the plotting functionality and
platform availability.


	A number of improvements in the plotting functionality: scalable




plots, zooming, logarithmic plots, grids, etc. - Programmable plotting
accessible through a Modelica API. - Simple 3D visualization. - Support
for several platforms Linux, MacOS, Windows (2000, Xp, Vista).






OpenModelica 1.4.4, Feb 2008

This release is primarily a bug fix release, except for a preliminary
version of new plotting functionality available both from the OMNotebook
and separately through a Modelica API. This is also the first release
under the open source license OSMC-PL (Open Source Modelica Consortium
Public License), with support from the recently created Open Source
Modelica Consortium. An integrated version handler, bug-, and issue
tracker has also been added.


OpenModelica Compiler (OMC)

This release includes small improvements and some bugfixes of the
OpenModelica Compiler (OMC):


	Better support for if-equations, also inside when. - Better support




for calling functions in parameter expressions and interactively through
dynamic loading of functions. - Less memory consumtion during
compilation and interactive evaluation. - A number of bug-fixes.




OpenModelica Notebook (OMNotebook)

Test release of improvements, primarily in the plotting functionality
and platform availability.


	Preliminary version of improvements in the plotting functionality:




scalable plots, zooming, logarithmic plots, grids, etc., currently
available in a preliminary version through the plot2 function. -
Programmable plotting accessible through a Modelica API.




OpenModelica Eclipse Plug-in (MDT)

This release includes minor bugfixes of MDT and the associated
MetaModelica debugger.




OpenModelica Development Environment (OMDev)

Extended test suite with a better structure. Version handling, bug
tracking, issue tracking, etc. now available under the integrated
Codebeamer.






OpenModelica 1.4.3, June 2007

This release has a number of significant improvements of the OMC
compiler, OMNotebook, the MDT plugin and the OMDev. Increased platform
availability now also for Linux and Macintosh, in addition to Windows.
OMShell is the same as previously, but now ported to Linux and Mac.


OpenModelica Compiler (OMC)

This release includes a number of improvements of the OpenModelica
Compiler (OMC):


	Significantly increased compilation speed, especially with large




models and many packages. - Now available also for Linux and Macintosh
platforms. - Support for when-equations in algorithm sections, including
elsewhen. - Support for inner/outer prefixes of components (but without
type error checking). - Improved solution of nonlinear systems. - Added
ability to compile generated simulation code using Visual Studio
compiler. - Added "smart setting of fixed attribute to false. If initial
equations, OMC instead has fixed=true as default for states due to
allowing overdetermined initial equation systems. - Better state select
heuristics. - New function getIncidenceMatrix(ClassName) for dumping the
incidence matrix. - Builtin functions String(), product(), ndims(),
implemented. - Support for terminate() and assert() in equations. - In
emitted flat form: protected variables are now prefixed with protected
when printing flat class. - Some support for tables, using
omcTableTimeIni instead of dymTableTimeIni2. - Better support for empty
arrays, and support for matrix operations like a*[1,2;3,4]. - Improved
val() function can now evaluate array elements and record fields, e.g.
val(x[n]), val(x.y) . - Support for reinit in algorithm sections. -
String support in external functions. - Double precision floating point
precision now also for interpreted expressions - Better simulation error
messages. - Support for der(expressions). - Support for iterator
expressions such as {3*i for i in 1..10}. - More test cases in the test
suite. - A number of bug fixes, including sample and event handling
bugs.




OpenModelica Notebook (OMNotebook)

A number of improvements, primarily in the platform availability.


	Available on the Linux and Macintosh platforms, in addition to




Windows. - Fixed cell copying bugs, plotting of derivatives now works,
etc.




OpenModelica Shell (OMShell)

Now available also on the Macintosh platform.




OpenModelica Eclipse Plug-in (MDT)

This release includes major improvements of MDT and the associated
MetaModelica debugger:


	Greatly improved browsing and code completion works both for standard




Modelica and for MetaModelica. - Hovering over identifiers displays type
information. - A new and greatly improved implementation of the debugger
for MetaModelica algorithmic code, operational in Eclipse. Greatly
improved performance - only approx 10% speed reduction even for 100 000
line programs. Greatly improved single stepping, step over, data
structure browsing, etc. - Many bug fixes.




OpenModelica Development Environment (OMDev)

Increased compilation speed for MetaModelica. Better if-expression
support in MetaModelica.






OpenModelica 1.4.2, October 2006

This release has improvements and bug fixes of the OMC compiler,
OMNotebook, the MDT plugin and the OMDev. OMShell is the same as
previously.


OpenModelica Compiler (OMC)

This release includes further improvements of the OpenModelica Compiler
(OMC):


	Improved initialization and index reduction. - Support for integer




arrays is now largely implemented. - The val(variable,time) scripting
function for accessing the value of a simulation result variable at a
certain point in the simulated time. - Interactive evalution of
for-loops, while-loops, if-statements, if-expressions, in the
interactive scripting mode. - Improved documentation and examples of
calling the Model Query and Manipulation API. - Many bug fixes.




OpenModelica Notebook (OMNotebook)

Search and replace functions have been added. The DrModelica tutorial
(all files) has been updated, obsolete sections removed, and models
which are not supported by the current implementation marked clearly.
Automatic recognition of the .onb suffix (e.g. when double-clicking) in
Windows makes it even more convenient to use.




OpenModelica Eclipse Plug-in (MDT)

Two major improvements are added in this release:


	Browsing and code completion works both for standard Modelica and for




MetaModelica. - The debugger for algorithmic code is now available and
operational in Eclipse for debugging of MetaModelica programs.






OpenModelica 1.4.1, June 2006

This release has only improvements and bug fixes of the OMC compiler,
the MDT plugin and the OMDev components. The OMShell and OMNotebook are
the same.


OpenModelica Compiler (OMC)

This release includes further improvements of the OpenModelica Compiler
(OMC):


	Support for external objects. - OMC now reports the version number




(via command line switches or CORBA API getVersion()). - Implemented
caching for faster instantiation of large models. - Many bug fixes.




OpenModelica Eclipse Plug-in (MDT)

Improvements of the error reporting when building the OMC compiler. The
errors are now added to the problems view. The latest MDT release is
version 0.6.6 (2006-06-06).




OpenModelica Development Environment (OMDev)

Small fixes in the MetaModelica compiler. MetaModelica Users Guide is
now part of the OMDev release. The latest OMDev was release in
2006-06-06.






OpenModelica 1.4.0, May 2006

This release has a number of improvements described below. The most
significant change is probably that OMC has now been translated to an
extended subset of Modelica (MetaModelica), and that all development of
the compiler is now done in this version..


OpenModelica Compiler (OMC)

This release includes further improvements of the OpenModelica Compiler
(OMC):


	Partial support for mixed system of equations. - New initialization




routine, based on optimization (minimizing residuals of initial
equations). - Symbolic simplification of builtin operators for vectors
and matrices. - Improved code generation in simulation code to support
e.g. Modelica functions. - Support for classes extending basic types,
e.g. connectors (support for MSL 2.2 block connectors). - Support for
parametric plotting via the plotParametric command. - Many bug fixes.




OpenModelica Shell (OMShell)

Essentially the same OMShell as in 1.3.1. One difference is that now all
error messages are sent to the command window instead of to a separate
log window.




OpenModelica Notebook (OMNotebook)

Many significant improvements and bug fixes. This version supports
graphic plots within the cells in the notebook. Improved cell handling
and Modelica code syntax highlighting. Command completion of the most
common OMC commands is now supported. The notebook has been used in
several courses.




OpenModelica Eclipse Plug-in (MDT)

This is the first really useful version of MDT. Full browsing of
Modelica code, e.g. the MSL 2.2, is now supported. (MetaModelica
browsing is not yet fully supported). Full support for automatic
indentation of Modelica code, including the MetaModelica extensions.
Many bug fixes. The Eclipse plug-in is now in use for OpenModelica
development at PELAB and MathCore Engineering AB since approximately one
month.




OpenModelica Development Environment (OMDev)

The following mechanisms have been put in place to support OpenModelica
development.


	A separate web page for OMDev (OpenModelica Development Environment).


	A pre-packaged OMDev zip-file with precompiled binaries for




development under Windows using the mingw Gnu compiler from the Eclipse
MDT plug-in. (Development is also possible using Visual Studio). - All
source code of the OpenModelica compiler has recently been translated to
an extended subset of Modelica, currently called MetaModelica. The
current size of OMC is approximately 100 000 lines All development is
now done in this version. - A new tutorial and users guide for
development in MetaModelica. - Successful builds and tests of OMC under
Linux and Solaris.






OpenModelica 1.3.1, November 2005

This release has several important highlights.

This is also the *first* release for which the New BSD (Berkeley)
open-source license applies to the source code, including the whole
compiler and run-time system. This makes is possible to use OpenModelica
for both academic and commercial purposes without restrictions.


OpenModelica Compiler (OMC)

This release includes a significantly improved OpenModelica Compiler
(OMC):


	Support for hybrid and discrete-event simulation (if-equations,




if-expressions, when-equations; not yet if-statements and
when-statements). - Parsing of full Modelica 2.2 - Improved support for
external functions. - Vectorization of function arguments;
each-modifiers, better implementation of replaceable, better handling of
structural parameters, better support for vector and array operations,
and many other improvements. - Flattening of the Modelica Block library
version 1.5 (except a few models), and simulation of most of these. -
Automatic index reduction (present also in previous release). - Updated
User's Guide including examples of hybrid simulation and external
functions.




OpenModelica Shell (OMShell)

An improved window-based interactive command shell, now including
command completion and better editing and font size support.




OpenModelica Notebook (OMNotebook)

A free implementation of an OpenModelica notebook (OMNotebook), for
electronic books with course material, including the DrModelica
interactive course material. It is possible to simulate and plot from
this notebook.




OpenModelica Eclipse Plug-in (MDT)

An early alpha version of the first Eclipse plug-in (called MDT for
Modelica Development Tooling) for Modelica Development. This version
gives compilation support and partial support for browsing Modelica
package hierarchies and classes.




OpenModelica Development Environment (OMDev)

The following mechanisms have been put in place to support OpenModelica
development.


	Bugzilla support for OpenModelica bug tracking, accessible to anybody.


	A system for automatic regression testing of the compiler and




simulator, (+ other system parts) usually run at check in time. -
Version handling is done using SVN, which is better than the previously
used CVS system. For example, name change of modules is now possible
within the version handling system.
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This Appendix lists the individuals who have made significant
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order.
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OpenModelica 1.3.1, November 2005

This release has several important highlights.

This is also the *first* release for which the New BSD (Berkeley)
open-source license applies to the source code, including the whole
compiler and run-time system. This makes is possible to use OpenModelica
for both academic and commercial purposes without restrictions.


OpenModelica Compiler (OMC)

This release includes a significantly improved OpenModelica Compiler
(OMC):


	Support for hybrid and discrete-event simulation (if-equations,




if-expressions, when-equations; not yet if-statements and
when-statements). - Parsing of full Modelica 2.2 - Improved support for
external functions. - Vectorization of function arguments;
each-modifiers, better implementation of replaceable, better handling of
structural parameters, better support for vector and array operations,
and many other improvements. - Flattening of the Modelica Block library
version 1.5 (except a few models), and simulation of most of these. -
Automatic index reduction (present also in previous release). - Updated
User's Guide including examples of hybrid simulation and external
functions.




OpenModelica Shell (OMShell)

An improved window-based interactive command shell, now including
command completion and better editing and font size support.




OpenModelica Notebook (OMNotebook)

A free implementation of an OpenModelica notebook (OMNotebook), for
electronic books with course material, including the DrModelica
interactive course material. It is possible to simulate and plot from
this notebook.




OpenModelica Eclipse Plug-in (MDT)

An early alpha version of the first Eclipse plug-in (called MDT for
Modelica Development Tooling) for Modelica Development. This version
gives compilation support and partial support for browsing Modelica
package hierarchies and classes.




OpenModelica Development Environment (OMDev)

The following mechanisms have been put in place to support OpenModelica
development.


	Bugzilla support for OpenModelica bug tracking, accessible to anybody.


	A system for automatic regression testing of the compiler and




simulator, (+ other system parts) usually run at check in time. -
Version handling is done using SVN, which is better than the previously
used CVS system. For example, name change of modules is now possible
within the version handling system.
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1 Kalman Filter

Often we don't have access to the internal states of a system and can only measure the outputs of the system and
have to reconstruct the state of the system based on these measurements. This is normally done with an observer.
The idea with an observer is that we feedback the difference of the measured output with the estimated output. If
i the estiamtion is correct then the difference should be zero.

Another difficulty is that the measured quantities often contain disturbance, i.e. noise.
{§=Asz+3u+e D
P=Cx+v

Here are e denoting a disturbance in the input signal and v is a measurement error. The quality of the estimate can
be evaluated by the difference

1
| K(@(2) — €2(8) — Du(t))
']

By using this quantity as feedback we obtain the observer
% = AR(t) + Bu(t) + K(y(t) — C2(¢) — Du(t))

Now form the error as

U The differential error is I
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1 Example
Consider a tank system with the following transfer function
1
G(S)ZH%
T

‘What is the weight function? Can you plot the step response of the tank?
1.1 Tank Transfer Function

loadModel (Modelica.Blocks)

model Tank
Modelica.Blocks.Continuous.TransferFunction G(b={1/A},
a={1,1/T},y_start(fixed=true)=1/A);
Modelica.Blocks.Continuous.TransferFunction GStep(b={1/A}, a={1,1/T});
parameter Real T = 15;
parameter Real A = 5;
Real u = if (time > O or time<o) then © else Modelica.Constants.inf;
Real uStep = if (time > O or time<o) then 1 else 0;
equation
G.u = if time > O then 0 else 1e10;
GStep.u = uStep;
end Tank;

{Tank}
simulate(Tank, startTime=-1e-10, number0fInterval.

plot({G.y,GStep.y})
true

Plot by OpenModelica
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Problem "Optinization" added to project

Problem "OptCooling" added to project
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Feedback

One important method in designing control system is a feedback loop. It can be used to eliminate the
influence of noise or to decrease the output error.

Example

Assume that we want to control the speed of a car on the road. The car has a mass m, velocity y, and
aerodynamic coefficient . The 0 i the road slope, which in this case can be regarded as noise.

my = u—ay —mgsin(9)

If we want a reference speed of 20 ms for a car with m=1500 kg, =250 Ns/m, 8=0 rad, how high should
the amplification factor be in the regulator?
Try with u = 250*r.

it =mganiB)=0

Open Loop
loadwModel (Modelica)

true

model noFeedback
import SI = Modelica.STunits;

SI.Velocity y; // output signal without
noise, theta = 0 -> v(t) = 0
QT Ualority vhinica: /7 outnut cinnal with noica

N0
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DrModelic amedstica edition

Copyright. (c) Linksping University, PELAB, 2003-2006, Wiley-IEEE Press, Modelica Association.
Contact: OpenModelica@ida linse, OpenModelica Project web site

www.ida v sefprojects/OpendModelica

Book web page: www.matheore. com/diModelica; Book anthor: Peter Fritzson(@ida fn.se

Dibadelica Authors: (2003 version) Susanna Monemar, EvaLena Lengaist Sandelin, Peter Fritzson, Peter Bunus
Dibadelica Authors: (2005 and later updates): Peter Fritzson

This DrModelica notebook has been developed to fucilitate learning the Modelica language as well as
providing an infroduction o object-oriented modeling and simulation. It is based on and is
supplementary material to the Modslica book: Peter Fritzson: “Principles of Object-Oriented
Modeling and Simulation with Modslica" (2004), 940 pages, Wiley-IEEE Press, ISBN 0-471-471631.
All of the examples and exercises in DrModelica and the page references are from that book. Most of
the text in DrModelica is also based on that book.

Detailed Copyright and Acknowledgment Information

Getting Started Using OMNotebook

OpenModelica commands

Berkeley license OpenModelica

A Quick Tour of Modelica

Getting Started - First Basic Examples

printing the string "Hello World" (p. 19 in Peter Fritzson's book). Since Modelica is an equation based
language, printing a string does not make much sence. Instead, our Hello World Modelica program solves
a trivial differential equation. The second example shows how you can write a model that solves a
Differential Algebraic Equation System (p. 19). In the Van der Pol (p. 22) example declaration as wel as

initalization and prefix usage are shown in a sightly more complicated way.

Classes and Instances

In Modelica objects are created implicity just by Declaring Instances of Classes (p. 26). Almost anything
in Modelica s a class, but there are some keywords for specific use of the class concept, called

There is a long tradition that the first sample program in any computer language is a trivial program l
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model KalmanFeedback
parameter Real A[:,size(A, 1)] = {{0,1},{1,0}} ;
parameter Real Blsize(a, 1),:] = {{0},{1}};
parameter Real C[:,size(a, 1)] = {{1,0}};

parameter Real[2,1] K = [2.4;3.4];
parameter Real[1,2] L = [2.4,3.4];
parameter Reall:,:] ABL = A-B*L;

parameter Reall:,:] BL
parameter Reall
parameter Reall
parameter Reall

BYL;
zeros (size (ABL,2),size (AKC,1));
ARC = A-K*C;
Anew = [0,1,0,0 ; -1.4, -3.4, 2.4,3.4; 0,0,-2.4,1;0,0,-2.4,01;
parameter Reall Bnew = [0;1;0;0];
parameter Reall[ Fnew = [1;0;0;0];
statespaceNoise Kalman(stateSpace.A=Anew,stateSpace.B=Bnew, stateSpace.C=[1,0,0,0],
stateSpace.F = Fnew);
statespaceNoise noRalman;
end RalmanFeedback;

simulate (RalmanFeedback, stopTime=3)
plot ({Ralman.stateSpace.y([1],noRalman.stateSpace.y[1]})

ue
Plot by OpenModelica
15
@Kaiman.statespace.y[1]
0
@noKaiman.statespace.y[1]

Ready  Ln12,Col39
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First Basic Class

1 HelloWorld

The program contains a declaration of a class called He 1 1oWoz 1 with two fields and one equation. The first field
is the variable x which i initalized to  start value 2 at the tim